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Bevezető
 Vigyázat!

A Fontos biztonsági figyelmeztetések szakaszt gondosan olvassuk és tanul-
mányozzuk át a készüléket használatát megelőzően.

Készülék felépítése
Montana 700i/750i készülék felépítése
 

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

GNSS antenna

Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)

Battery compartment

Mounting spine

Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .
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Iridium® és GNSS antenna

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

GNSS antenna

Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)

Battery compartment

Mounting spine

Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .
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SOS gomb

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

GNSS antenna

Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)

Battery compartment

Mounting spine

Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .
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Kamera objektív (csak Montana 750i készüléknél)

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

GNSS antenna

Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)

Battery compartment

Mounting spine

Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .

Introduction 1

Zseblámpa
Kamera vaku (csak Montana 750i készüléknél)

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

GNSS antenna

Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)

Battery compartment

Mounting spine

Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .

Introduction 1

Ki-/bekapcsológomb

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

GNSS antenna

Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)

Battery compartment

Mounting spine

Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .
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microSD® kártya foglalat (elemtartó rekesz alatt)

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

GNSS antenna

Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)

Battery compartment

Mounting spine

Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .
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Akkumulátor-tartó rekesz fedelét rögzítő D-gyűrű

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

GNSS antenna

Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)

Battery compartment

Mounting spine

Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .

Introduction 1

Micro-USB port (esővédő sapka alatt)

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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Külső iridium és GNSS antenna port (esővédő sapka alatt)

Montana 700 készülék felépítése

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

GNSS antenna

Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)

Battery compartment

Mounting spine

Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .
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GNSS antenna

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

GNSS antenna

Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)

Battery compartment

Mounting spine

Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .
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Zseblámpa

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

GNSS antenna

Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)

Battery compartment

Mounting spine

Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .
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Ki-/bekapcsológomb

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

GNSS antenna

Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)

Battery compartment

Mounting spine

Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .
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microSD® kártya foglalat (elemtartó rekesz alatt)

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

GNSS antenna

Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)

Battery compartment

Mounting spine

Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .
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Akkumulátor-tartó rekesz fedelét rögzítő D-gyűrű

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

GNSS antenna

Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)

Battery compartment

Mounting spine

Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .
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Micro-USB port (esővédő sapka alatt)

Állapotjelző LED
Az állapotjelző LED 

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overview

GNSS antenna

Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)

Battery compartment

Mounting spine

Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .
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 mutatja a készülék állapotát.
Introduction

 WARNING
See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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LED működés Állapot
Dupla zöld villogás Olvasatlan inReach® üzenet.
Zöld villogás A készülék expedíció módban van.
Piros villogás inReach üzenet elküldése sikertelen.

A készülék akkumulátorának töltöttségei szintje 
10 százalék alatt van.

Zöld-piros váltakozó 
villogás

A készülék SOS módban van.

Lítium-ion akkumulátor behelyezése
1.  Keressük meg a készülék dobozában alaptartozékként biztosított lítium-

ion akkumulátor egységet.
2.  Ellenőrizzük, hogy a tömítőgyűrű peremére és az akkumulátor-tartó re-

keszbe ne kerüljön piszok.
3.  Helyezzük be az akkumulátort a készülékbe.

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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4.  Fordítsuk a D-gyűrűt az óra mutatóval megegyező irányba az akkumulá-
tor rögzítéséhez.

5.  Nyomjuk a D-gyűrűt a készülék hátára.
Az akkumulátort ajánlott állandó jelleggel a készülékben tartani, így elkerül-
hetjük, hogy nedvesség és piszok kerüljön az érintkezőkre és a microSD kár-
tya foglalatába.

Akkumulátor töltése
Megjegyzés!

A rozsdásodást megelőzendő töltés vagy számítógéphez történő csatlakoz-
tatás előtt alaposan szárítsuk meg a mikro-USB portot, az esővédő sapkát, 
és a környező felületet.

A gyári Garmin® akkumulátortól eltérő akkumulátor töltésére ne használ-
juk a készüléket. A gyári Garmin akkumulátortól eltérő akkumulátor töltése 
károsíthatja a készüléket, valamint érvénytelenítheti a garanciát.

Előfordulhat, hogy mielőtt az USB-kábel csatlakozóját a készüléken találha-
tó csatlakozó aljzatba illeszthetnénk, le kell vennünk egyes kiegészítőket.
NE FELEDJÜK! A készülék az előírt hőmérsékleti tartományon kívül eső hő-
mérsékleten nem töltődik (Műszaki adatok, 24. oldal).
Az akkumulátort hálózati tápegységről vagy számítógépről, USB-porton ke-
resztül is tölthetjük.
1.   Hajtsuk fel az esővédő sapkát  az USB-portról .



2

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery

2 Introduction

2.   Az USB-kábel kisebbik végét csatlakoztassuk USB-portba .
3.   Az USB-kábel másik végét illesszük a hálózati tápegységhez vagy a szá-

mítógép USB-portjába.
4.   Csatlakoztassuk a hálózati tápegység dugvilláját a fali konnektorhoz. A 

készülék azonnal bekapcsol, ahogy áram alá kerül.
5.   Teljesen töltsük fel az akkumulátort.

TIPP! Az akkumulátor szintjelző megjelenik az állapotjelző sávban.

Energiamegtakarítás töltés közben
1.  Csatlakoztassuk a készüléket egy külső áramforráshoz.
2.  Nyomjuk le hosszan a ki-/bekapcsoló gombot, amíg a képernyő ki nem 

kapcsol.
  A készülék kevés áramot használó töltés üzemmódba lép, és a képer-

nyőn megjelenik az akkumulátor szintjelző.
3.  Töltsük fel teljesen a készüléket.

Hosszabb idejű tárolás
Amikor a készülék várhatóan több hónapon keresztül használaton kívül 
lesz, tárolás előtt először töltsük fel az akkumulátort legalább 50%-ra. A 
készüléket hűvös, száraz, átlagos háztartási hőmérsékletű helyen tároljuk. 
Hosszabb idejű tárolást követően használat előtt töltsük fel teljesen a ké-
szüléket.

Ki-/bekapcsoló gomb
A ki-/bekapcsoló gombbal alapértelmezetten ki- és bekapcsolhatjuk a készü-
léket, kikapcsolhatjuk a képernyőt, és beléphetünk az állapotjelző képernyő-
re. A ki-/bekapcsoló gomb funkcióit személyre is szabhatjuk (Ki-/bekapcsoló 
gomb testreszabása, 19. oldal).
•  Nyomjuk le a 
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 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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 gombot a készülék bekapcsolásához.
•  Nyomjuk le a 
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Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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 gombot az állapotjelző képernyőre lépéshez.
•  Nyomjuk le kétszer a 
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microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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 gombot a képernyő kikapcsolásához.
 TIPP! A 
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Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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 gomb megnyomásával újra bekapcsolhatjuk a képernyőt.
•  Nyomjuk le hosszan a 

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)
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Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .

Introduction 1

 gombot a készülék kikapcsolásához.

Állapotjelző képernyő megtekintése
Az állapotjelző képernyő az aktuális tevékenység rögzítését, a Bluetooth® 
és Wi-Fi® vezeték nélküli kapcsolatok állapotát jelzi, valamint gyors hozzáfé-
rést biztosít a gyakran használt funkciókhoz, mint például az útpontok meg-
jelölése, az érintőképernyő lezárása, valamint a háttérvilágítás fényerejének 
beállítása.
 Nyomjuk meg a 
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Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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 gombot vagy húzzuk az ujjunkat a képernyő tetejéről 
lefelé irányba az állapotjelző képernyő megnyitásához.

Háttérvilágítás fényerejének állítása
A háttérvilágítás huzamosabb ideig történő használata jelentősen csökkent-
heti az akkumulátor által biztosított működési időt. A háttérvilágítás fényerejét 
testreszabhatjuk a működési idő meghosszabbítása érdekében.
NE FELEDJÜK! A háttérvilágítás fényereje alacsony töltöttségi szint esetén 
korlátozott lehet.
1.  Nyomjuk meg a 
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The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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 gombot az állapotjelző képernyő megnyitásához.
2.  Állítsuk a fényerőt a csúszka segítségével.

Érintőképernyő használata
•  Érintsük meg a képernyőt a kívánt elem kiválasztásához.
•  Minden érintőképernyős választásunkat külön tevékenységként tegyük.
•  Válasszuk a 

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery
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 pontot a módosítások mentéséhez és az oldal bezárásá-
hoz.

•  Válasszuk az 

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
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 pontot a képernyő bezárásához.
•  Válasszuk a 

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery
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 pontot, ha vissza szeretnénk lépni az előző képernyőre.
•  Válasszuk a 

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery
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 pontot a főmenü megjelenítéséhez.
•  Válasszuk a 

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery

2 Introduction

 pontot az éppen megnyitott képernyő különleges menü-
elemeinek megtekintéséhez.

Érintőképernyő lezárása
Lezárhatjuk az érintőképernyőt, így megakadályozhatjuk a véletlenszerű 
képernyőérintéseket.
1.  Nyomjuk meg a 

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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 gombot az állapotjelző képernyő megnyitásához.
2.  Válasszuk a 

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery
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 pontot.

Érintőképernyő feloldása
Nyomjuk meg a 

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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 gombot.

Készülék aktiválása
Figyelem!

Mielőtt a Montana 700i/750i készüléken használhatnánk az inReach funkció-
kat, először aktiválnunk kell a készüléket (inReach funkciók, 3. oldal).
1.  Hozzunk létre egy fiókot, majd válasszunk műholdas előfizetést az 

explore.garmin.com oldalon.
2.  Kapcsoljuk be a készüléket.
3.  Válasszuk a Next (Következő) pontot.
4.  Kövessük a képernyőn megjelenő utasításokat.
 MEGJEGYZÉS! Mielőtt kültérre mennénk a készülékkel, az aktiválás 

online részének elvégzéséhez meg kell adnunk a készülék IMEI-számát 
és engedélyezési kódját.

5.  Menjünk ki egy nyitott helyre, ahol szabad rálátásunk van az égboltra, és 
az optimális teljesítmény érdekében a készülék antennáját irányítsuk az 
égbolt felé.

6.  Várjunk, amíg a készülék kapcsolatot nem létesít az Iridium műholdas há-
lózattal.

 MEGJEGYZÉS! A készülék aktiválása akár 20 percet is felvehet, mivel 
számos üzenetet kell küldenie és fogadnia, amely több időbe telik, mint a 
normál használat során egyetlen üzenet küldése. Az aktiválás befejezé-
séig maradjunk kültérben.

Iridium műholdas hálózat
A készüléknek szabad rálátásra van szüksége az égboltra az üzenetek és 
pályapontok az Iridium műholdas hálózaton keresztül történő küldéséhez. Az 
égboltra való szabad rálátás nélkül a készülék addig próbálkozik az infor-
mációk továbbításával, amíg műholdas kapcsolatot nem sikerül létesítenie.
TIPP! A legjobb műholdas kapcsolat elérése érdekében tartsuk a készülékek 
az antennájával az égbolt felé.

Műholdas kapcsolat létesítése
A műholdas kapcsolat létesítése 30-60 másodpercet vehet igénybe.
1.  Menjünk fedetlen, szabad térre.
2.  Ha eddig nem tettük meg, most kapcsoljuk be a készüléket.
3.  Várjuk meg, amíg a készülék megkeresi a műholdakat.
 Ezalatt a 

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery
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 ikon villog a képernyőn.
 A 

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery
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 jel mutatja a műholdas kapcsolat jelerősségét.
A műholdas kapcsolat létesítését követően a készülék automatikusan rögzí-
teni kezdi az útvonalunkat mint tevékenységet.

Állapotjelző ikonok

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery
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ANT+® mérő állapota

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery
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GPS-jelerősség

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery
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Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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Akkumulátor töltés befejeződöttCharging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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inReach üzenetek és nyomon követési pontok küldése,  
fogadása és keresése

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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Olvasatlan inReach üzenetek

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

inReach nyomon követési állapot

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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Érintőképernyő lezárva

inReach funkciók
Figyelem!

Üzenet küldéséhez, nyomon követéséhez és az SOS funkciókhoz aktív mű-
holdas előfizetéssel kell rendelkeznünk. Kültéri használat előtt mindig tesz-
teljük le a készüléket.

Az üzenetküldés, nyomon követés és SOS funkciók használata előtt bizo-
nyosodjunk meg róla, hogy szabad rálátásunk van az égboltra, mivel ezek a 
funkciók műholdas kapcsolat mellett érhetők el.
Ha a legtöbbet szeretnénk kihozni a Montana 700i/750i készülékünkből, 
akkor aktiválnunk kell azt. A készülék aktiválásával elérhetővé válnak az 
inReach funkciók, mint például az üzenetküldés, SOS, nyomon követés és 
inReach Időjárásjelzés.

Üzenetküldés
A Montana 700i/750i készülék szöveges üzenetek küldésére és fogadásá-
ra képes az Iridium műholdas hálózatban. SMS telefonszámra, e-mail címre, 
vagy egy másik, inReach technológiát használó készülékre küldhetünk üze-
neteket. Minden elküldött üzenet magában foglalja a helymeghatározási in-
formációnkat, ha ezt engedélyezzük.

Előre beállított üzenet küldése
Az előre beállított üzenetek előre megírt szöveggel, és előre meghatározott 
címzettel rendelkeznek. Az előre beállított üzeneteket a Garmin Explore™ 
weboldalán (explore.garmin.com) állíthatjuk be.
1.  Válasszuk az inReach > Üzenetek > Előre beáll. üzenet küldése pon-

tot.
2.  Válasszuk ki a kívánt előre beállított üzenetet, majd válasszuk az Előre 

beáll. üzenet küldése pontot.

Szöveges üzenet küldése
1.  Válasszuk az inReach > Üzenetek > Új üzenet pontot.
2.  Válasszunk az alábbiak közül:
 •    Ha előre megírt üzenettel szeretnénk kezdeni, akkor válasszuk a 

Gyorsüzenet küldése pontot.
   MEGJEGYZÉS! A gyorsüzeneteket szerkeszthetjük, illetve újakat ad-

hatunk hozzá a Garmin Explore weboldalon.
 •  Egyéni üzenet írásához válasszuk az Üzenet írása pontot.
3.  Válasszuk a Címzett pontot a címzettek kiválasztásához a névjegyzék-

ből, vagy adjuk meg az egyes címzettek elérhetőségét.
4.  Az üzenetírást és a címzettek kiválasztását követően válasszuk az Üze-

net küldése pontot.

Válasz üzenetre
1.  Válasszuk az inReach > Üzenetek pontot.
2.  Válasszuk ki a kívánt beszélgetést.
3.  Válasszuk a Válasz pontot.
4.  Válasszunk az alábbiak közül:
 •  Egyéni üzenet írásához válasszuk az Üzenet írása pontot.
 •   Ha előre megírt üzenettel szeretnénk kezdeni, akkor válasszuk a 

Gyorsüzenet küldése pontot, majd válasszuk ki a kívánt üzenetet.
5.  Az üzenetírást követően válasszuk az Üzenet küldése pontot.

Üzenetek ellenőrzése
Üzenetküldést követően a készülék 10 percen át figyel arra, hogy érkezik-e 
válasz. A készülék óránként is ellenőrzi a beérkezett üzeneteket.

Az inReach nyomon követés funkció használata során a készülék a meg-
adott nyomon követési intervallumban ellenőrzi a beérkezett üzeneteket.
MEGJEGYZÉS! A készüléknek az üzenetek fogadásához szabad rálátásra 
van szüksége az égboltra és műholdas kapcsolatot kell létesítenie az ellen-
őrzés időpontjában.
Az üzenetek ellenőrzését úgymond kényszeríthetjük is az üzenetek manuá-
lis ellenőrzésével, üzenet küldésével vagy nyomon követési pont küldésével. 
Ellenőrzés során a készülék műholdas kapcsolatot létesít, és fogadja a ké-
szülékre továbbításra váró üzeneteket.
 Válasszuk az inReach > inReach eszközök > Üzenet ellenőrzés > Pos-

tafiók ellenőrzés pontot.

Üzenet részletes információinak megtekintése
1.  Válasszuk az inReach > Üzenetek pontot.
2.  Válasszuk ki a kívánt beszélgetést.
3.  Válasszuk ki a kívánt üzenetet.
4.  Válasszuk az információ fület.

Navigáció üzenet helyszínére
Amikor egy másik inReach technológiát használó készülékről üzenetet ka-
punk, előfordulhat, hogy az üzenet magában foglalj a küldő helymeghatáro-
zási információit. Az ilyen jellegű üzenetek esetén elnavigálhatunk az üze-
netküldés helyszínére.
1.  Válasszuk az inReach > Üzenetek pontot.
2.  Válasszuk ki a helymeghatározási információval rendelkező beszélge-

tést.
3.  Válasszuk ki a térkép fület.
4.  Válasszuk az Indulás pontot.

Tartózkodási koordináták megadása üzenetben
Amennyiben olyan címzettnek küldünk üzenetet, akinek nincs internet kap-
cso lata, az üzenetben megadhatjuk a tartózkodási koordinátáinkat. Például 
ha a címzett régebbi mobiltelefonnal rendelkezik, amelyen nem lehetséges a 
térképek megtekintése, illetve ha a mobilhálózat lefedettségi területén kívül 
tartózkodik, és emiatt képtelen weboldalak megtekintésére.
1.  Válasszuk az inReach > Üzenetek > Új üzenet > Tart. hely küldése pon-

tot.
2. Adjunk meg egy, vagy akár több címzettet.
3.  Amennyiben szükséges, írjuk meg a kívánt üzenetet.
4.  Válasszuk az Üzenet küldése pontot.

Üzenet törlése
1.  Válasszuk az inReach > Üzenetek pontot.
2.  Válasszuk ki a törölni kívánt beszélgetést.
3.  Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 > Beszélgetés törlése pontot.

Üzenetbeállítások
Válasszuk a Beállítások > Üzenetek pontot.
Hangjelzés elolvasásig – beállíthatjuk a készüléket, hogy új üzenet beérke-

zése esetén addig adjon le hangjelzést, amíg el nem olvassuk az üzene-
tet. Ez a funkció például zajos környezetben lehet a segítségünkre.

Értesítések – bejövő inReach üzenetekre hívja fel a figyelmünket.
Megjelenítés térképen – az inReach üzeneteket megjeleníthetjük a térképen.

Nyomon követés
A Montana 700i/750i készüléken a nyomon követési funkció segítségével pá-
lyapontokat rögzíthetünk, amelyeket a készülék a meghatározott intervallu-
mon belül továbbítja az Iridium műhold hálózaton keresztül. A pályapontok a 
Garmin Explore weboldalon, valamint a MapShare™ nyomon követési olda-
lon jelennek meg.

Nyomon követés indítása
 Válasszuk az inReach > Nyomon követés > Nyomon követés indítása 

pontot.
 NE FELEDJÜK! A Nyomon követés funkció elindításával a készülék a pá-

lyánkat is rögzíti mint tevékenységet.

Nyomon követés leállítása
 Válasszuk inReach > Nyomon követés > Nyomon követés leállítása 

pontot.

http://explore.garmin.com
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 NE FELEDJÜK! A Nyomon követés funkció leállításával a tevékenység 
rögzítés is leáll.

MapShare oldalunk megosztása
A MapShare funkciót az explore.garmin.com oldalon engedélyezhetjük.
A MapShare oldalunk linkjét megoszthatjuk másokkal is. A rendszer az üze-
netünk végéhez automatikusan szöveget ad hozzá, beleértve a link informá-
cióit.
1.  Válasszuk az inReach > Nyomon követés > MapShare megosztás > 

OK pontot.
2.  Válasszuk a Címzett pontot a címzettek kiválasztásához a névjegyzé-

künkből, vagy adjuk meg külön-külön a címzettek elérhetőségeit.
3.  Válasszuk az Üzenet küldése pontot.

inReach nyomon követési beállítások
Válasszuk a Beállítások > Nyomon követés-t.
Auto Track: Beállíthatjuk a készüléket, hogy bekapcsolás után azonnal in-

dítsa a nyomon követést.
Mozgási intervallum: Megadhatjuk, hogy mozgás közben a készülék mi-

lyen gyakorisággal rögzítse és továbbítsa a műholdas hálózaton keresz-
tül a pályapontokat. Amennyiben professzionális vásárlók vagyunk, meg-
adhatjuk az állás közbeni rögzítési és továbbítási gyakoriságot.

SOS
Vészhelyzet során a Montana 700i/750i készülékkel segítséget kérhetünk a 
GEOS Nemzetközi Vészhelyzeti Mentési Koordinációs Központtól. Az SOS 
gomb megnyomásával egy üzenetet küldünk a mentési koordinációs köz-
pontnak, ők pedig értesítik az illetékes sürgősségi szolgálatot a helyzetünk-
ről. Vészhelyzet során kommunikálhatunk a mentési koordinációs központ-
tal, amíg a segítségre várunk. Az SOS funkciót kizárólag valódi vészhelyzet-
ben használjuk!

SOS mentés indítása
MEGJEGYZÉS! Ha a készülék akkumulátora nincs lemerülve, be- és kikap-
csolt készülékkel is indíthatunk SOS mentést.
1.  Emeljük fel az SOS gomb  védősapkáját .

NOTE: Stopping tracking also pauses your activity recording.

Sharing Your MapShare Web Page
You can enable MapShare at explore.garmin.com.
You can share a link to your MapShare web page with other 
people. The system automatically adds text, including link 
information, to the end of your message.
1 Select inReach > Tracking > Send MapShare > OK.
2 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
3 Select Send Message.

inReach Tracking Settings
Select Setup > Tracking.
Auto Track: Sets the device to start tracking when you turn on 

the device.
Moving Interval: Sets the frequency at which the device 

records a track point and transmits it over the satellite 
network when you are moving. If you are a professional 
customer, you can specify the interval when you are 
stationary.

SOS
During an emergency, you can use your Montana 700i/750i 
device to contact the GEOS International Emergency Rescue 
Coordination Center (IERCC) to request help. Pressing the SOS 
button sends a message to the rescue coordination center, and 
they notify the appropriate emergency responders of your 
situation. You can communicate with the rescue coordination 
center during your emergency while you wait for help to arrive. 
You should only use the SOS function in a real emergency 
situation.

Initiating an SOS Rescue
NOTE: You can initiate an SOS rescue with the device turned 
on or off if the device has battery power.
1 Lift the protective cap  from the SOS button .

2 Hold the SOS button.
3 Wait for the SOS countdown.

The device sends a default message to the emergency 
response service with details about your location.

4 Reply to the confirmation message from the emergency 
response service.
Your reply lets the emergency response service know that 
you are capable of interacting with them during the rescue. If 
you do not reply, the emergency response service will still 
initiate a rescue.

For the first 10 minutes of your rescue, an updated location is 
sent to the emergency response service every minute. To 
conserve battery power after the first 10 minutes, an updated 
location is sent every 10 minutes when moving, and every 30 
minutes when stationary.

NOTE: While in SOS mode, the device cannot be turned off.

Sending a Custom SOS Message
After pressing the SOS button to initiate an SOS rescue, you 
can reply with a custom message using the SOS page.
1 Select inReach > SOS > Reply.
2 Select Type Message to compose a custom SOS message.
3 Select Send Message.
Your reply lets the emergency response service know that you 
are capable of interacting with them during the rescue.

Canceling an SOS Request
If you no longer need assistance, you can cancel an SOS 
request after it is sent to the emergency response service.
1 Lift the protective cap, and hold the SOS button.
2 Select Cancel SOS.
3 When prompted to confirm your cancellation request, select 

Cancel SOS.
Your device transmits the cancellation request. When you 
receive a confirmation message from the emergency 
response service, the device returns to normal operation.

Testing the Device
 CAUTION

You should test the device outdoors before using it on a trip to 
ensure your satellite subscription is active.

Select inReach > inReach Utilities > Communications 
Test > Test.
Wait while the device sends a test message. When you 
receive a confirmation message, your device is ready to use.

Syncing inReach Data
You can sync data from your Garmin Explore account to your 
device using the Garmin Explore app. After you make edits to 
your data, such as plan changes, contacts, preset messages, or 
quick text messages, you must sync them to your device using 
the mobile app.

Open the Garmin Explore app.
Changes made to data such as collections, waypoints, 
routes, and tracks update automatically.

You can now sync your data to your Montana 700i/750i device.

Contacts
You can add, delete, and edit contacts on the Montana 700i/750i 
device.

Adding a Contact
1 Select inReach > Contacts > New Contact.
2 Select an item to edit.
3 Enter the new information.

Editing a Contact
1 Select inReach > Contacts.
2 Select a contact.
3 Select an item to edit.
4 Enter the new information.

Deleting a Contact
1 Select inReach > Contacts.
2 Select a contact.
3 Select  > Delete Contact.

4 inReach Features

2.  Nyomjuk le hosszan az SOS gombot.
3.  Várjuk meg az SOS visszaszámlálást.
 A készülék egy alapértelmezett üzenetben elküldi a helymeghatározási 

adatainkat a sürgősségi szolgálatnak.
4.  Válaszoljunk a sürgősségi szolgálat megerősítést kérő üzenetére.
 Válaszunkkal tudatjuk a sürgősségi szolgálattal, hogy mentés során ké-

pesek vagyunk fenntartani a segítőinkkel a kapcsolatot. Amennyiben nem 
válaszolunk, a sürgősségi szolgálat mentést indít.

A mentés első 10 percében a készülék percenként frissített helymeghatáro-
zási adatokat küld a sürgősségi szolgálatnak. Az akkumulátor által biztosí-
tott működési idő meghosszabbítása érdekében az első 10 percet követően 
a készülék mozgás közben 10 percenként küldi a frissített helymeghatározá-
si adatokat, mozdulatlanság esetén pedig 30 percenként.

MEGJEGYZÉS! Amíg az SOS üzemmód aktív, a készülék nem kapcsol-
ható ki.

Egyéni SOS üzenet küldése
Az sürgősségi mentést elindítandó SOS gomb megnyomását követően az 
SOS oldal segítségével egyéni válaszüzenetet küldhetünk.
1.  Válasszuk az inReach > SOS > Válasz pontot.
2.  Válasszuk az Üzenetírás pontot, és írjuk meg egyéni SOS üzenetün-

ket.
3.  Válasszuk az Üzenet küldése pontot.
Válaszunkkal tudatjuk a sürgősségi szolgálattal, hogy mentés során képesek 
vagyunk fenntartani a segítőinkkel a kapcsolatot.

SOS üzenet elvetése
Ha már nincs szükségünk segítségre, az SOS üzenetet elvethetjük akkor is, 
miután már elküldtük a sürgősségi szolgálatnak.
1.  Emeljük fel az esővédő sapkát, és nyomjuk le hosszn az SOS gombot.
2.  Válasszuk az SOS elvetése pontot.
3.  Amikor a készülék felszólít, hogy erősítsük meg az elvetési kérést, válasz-

szuk az SOS elvetése pontot.
A készülék elküldi az elvetési kérést. Amikor a sürgősségi szolgálattól 
megkapjuk a megerősítő üzenetet, a készülék visszaáll normál üzem-
módba.

Készülék tesztelése
Vigyázat!

Mielőtt elindulnánk egy utazásra, a készüléket teszteljük szabadtéren, így 
megbizonyosodhatunk róla, hogy a műholdas előfizetésünk aktív.
 Válasszunk az inReach > inReach eszközök > Kommunikációs teszt > 

Tesztelés pontot.
 Várjunk, amíg a készülék tesztüzenetet küld. A megerősítő üzenet foga-

dása után a készülék használatra kész.

inReach adatok szinkronizálása
A Garmin Explore fiókunkban tárolt adatokat a Garmin Explore alkalmazás 
segítségével szinkronizálhatjuk a készülékünkkel. Adataink módosítását 
(például tervek, ismerősök, előre beállított üzenetek vagy gyors szöveges 
üzenetek szerkesztését) követően a fiókunkat szinkronizálnunk kell a készü-
lékkel a mobilalkalmazás segítéségvel.
 Lépjünk be a Garmin Explore alkalmazásba.
 Az adatmódosítások, például gyűjtemények, útpontok, útvonalak és pá-

lyák automatikusan frissítésre kerülnek.
Ezt követően szinkronizálhatjuk az adatainkat a Montana 700i/750i készü-
lékünkkel.

Névjegyzék
A Montana 700i/750i készüléken ismerősöket adhatunk hozzá, törölhetünk 
és szerkeszthetünk.

Ismerős hozzáadása
1.  Válasszuk az inReach > Ismerősök > Új ismerős pontot.
2.  Válasszuk ki a szerkeszteni kívánt elemet.
3.  Adjuk meg az új információt.

Ismerős adatok szerkesztése
1.  Válasszuk az inReach > Ismerősök pontot.
2.  Válasszuk ki az ismerőst.
3.  Válasszuk ki a szerkeszteni kívánt elemet.
4.  Adjuk meg az új információt.

Ismerős törlése
1.  Válasszuk az inReach > Ismerősök pontot.
2.  Válasszuk ki a törölni kívánt ismerőst.
3.  Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 > Ismerős törlése pontot.
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Adathasználat és napló
A Montana 700i/750i készüléken megtekinthetjük a mobil adatcsomagunkat 
és -használatunkat.

Adatcsomag megtekintése
1.  Válasszuk az inReach > inReach eszközök pontot.
2.  Válasszuk az Adatcsomag pontot.

Adathasználat megtekintése
Megtekinthetjük az aktuális számlázási időszakban elküldött üzenetek, előre 
beállított üzenetek és pályapontok számát. Az adathasználatmérő minden új 
számlázási időszak kezdetén automatikusan újraindul.
1.  Válasszuk az inReach > inReach eszközök pontot.
2.  Válasszuk az Adathasználat pontot.

Főképernyők megtekintése
A főképernyők tartalmazzák mindazokat az információkat, amelyekre a ké-
szülék használata során szükségünk lehet. Az alapértelmezett képernyők a 
főmenü, térkép, iránytű, fedélzeti számítógép és Hova? képernyők.
 •   Válasszunk a Kedvencek sávban található ikonok között a főképer-

nyők közötti léptetéshez.
 •   A Kedvencek sávban nyomjunk le hosszan egy ikont, majd húzzuk el 

az ikonok sorrendjének módosításához vagy ikon eltávolításához.
   TIPP! A Kedvencek sávot a Beállítások > Menük > Kedvencek pont-

ban is módosíthatjuk. A 

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery

2 Introduction
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Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 nem törölhetők, és nem mozgatha-
tók.

Térkép képernyő
A 

2 Plug the small end of the USB cable into the mini-USB port.
3 Plug the USB end of the cable into an AC adapter or a 

computer USB port.
4 If necessary, plug the AC adapter into a standard wall outlet.

When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.

Turning On the Device
Hold .

Buttons

FIND Select to open the search menu.
Hold to mark your current location as a man overboard 
(MOB) location and activate navigation.

MARK Select to save your current location as a waypoint.
QUIT Select to cancel or return to the previous menu or page.

Select to scroll through the main pages.
ENTER Select to choose options and acknowledge messages.

Select to control the current activity recording (from the Map, 
Compass, Altimeter, and Trip Computer pages).

MENU Select to open the options menu for the page that is 
currently open.
Select twice to open the main menu (from any page).

PAGE Select to scroll through the main pages.
   Select , , , or  to select menu options and move the 

map cursor.
IN Select to zoom in on the map.
OUT Select to zoom out on the map.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

A question mark flashes while the device determines your 
location.

4 Select  to open the status page.
 shows the satellite signal strength.

When the bars are full, the device has acquired satellite signals.

Using the Main Pages
The information needed to operate this device is found on the 
main menu, map, compass, trip computer, and elevation plot 
pages.

Select PAGE to choose the active main page.

Opening the Main Menu
The main menu gives you access to tools and setup screens for 
waypoints, activities, routes, and more (Additional Main Menu 
Tools, page 7).

From any page, select MENU twice.

Map
 represents your location on the map. As you travel,  moves 

and displays your path. Depending on your zoom level, waypoint 
names and symbols may appear on the map. You can zoom in 
on the map to see more detail. When you are navigating to a 
destination, your route is marked with a colored line on the map.

Changing the Map Orientation
1 From the map, select MENU.
2 Select Setup Map > Orientation.
3 Select an option:

• Select North Up to show north at the top of the page.
• Select Track Up to show your current direction of travel at 

the top of the page.
• Select Automotive Mode to show an automotive 

perspective with the direction of travel at the top.

Measuring Distance on the Map
You can measure the distance between two locations.
1 From the map, select a location.
2 Select MENU > Measure Distance.
3 Move the pin to another location on the map.

Map Settings
Select Setup > Map.
Orientation: Adjusts how the map is shown on the page. North 

Up shows north at the top of the page. Track Up shows a top-
down view with your current direction of travel toward the top 
of the page. Automotive Mode shows an 3D automotive view 
with the direction of travel at the top.

Data Fields: Customizes the data fields and dashboards of the 
map, compass, elevation plot, and trip computer.

Advanced Map Setup: Enables you to open advanced map 
settings (Advanced Map Settings, page 2).

Map Information: Enables or disables the maps currently 
loaded on the device.

Advanced Map Settings
Select Setup > Map > Advanced Map Setup.
Auto Zoom: Automatically selects the appropriate zoom level 

for optimal use on your map. When Off is selected, you must 
zoom in or out manually.

Zoom Levels: Adjusts the zoom level at which map items will 
appear. The map items will not appear when the map zoom 
level is higher than the selected level.
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 ikon mutatja a felhasználót a térképen (pillanatnyi pozíciónkat). Ahogy 
haladunk, a pozíció ikon is elmozdul, követi helyzetünket, és az általunk be-
járt utat egy pontsor, az ún. nyomvonalat mutatja. A térképen nagyítástól füg-
gően útvonalak nevei és szimbólumai jelennek meg. Ránagyíthatunk a tér-
képre a részletesebb adatok megtekintéséhez. 
Navigáció esetén egy színes vonal mutatja a térképen a követendő útvona-
lat.

Navigáció a térképen
1.  Indítsunk el egy navigációt (Navigáció cél felé, 8. oldal).
2.  A térképen az alábbi műveletekre van lehetőség:
 •  Húzzuk el ujjunkat a térképen a különböző területek megtekintéséhez.
 •   Mutató és hüvelykujjunkat húzzuk közelebb egymáshoz, illetve távo-

lítsuk el egymástól az érintőképernyőn a térképen való kicsinyítéshez, 
illetve nagyításhoz.

 •   A 

Data Use and History
You can view plan details and data use on the Montana 700i/
750i device.

Viewing Plan Details
1 Select inReach > inReach Utilities.
2 Select Plan Details.

Viewing Data Use
You can view the number of messages, preset messages, and 
track points sent during the current billing cycle. The data use 
counter resets automatically at the beginning of each billing 
cycle.
1 Select inReach > inReach Utilities.
2 Select Plan Usage.

Viewing the Main Pages
The information needed to operate this device is found on the 
main pages. Default pages include the main menu, map, 
compass, trip computer, and Where To? pages.
• Select the icons in the Favorites bar to scroll through the 

main pages.
• Hold an icon in the Favorites bar, and drag it to a new 

location to change the order of the icons or remove an icon.
TIP: You can also select Setup > Menus > Favorites to 
customize the Favorites bar. The  and  icons cannot be 
removed or changed.

Map
 represents your location on the map. As you travel,  moves 

and displays your path. Depending on your zoom level, waypoint 
names and symbols may appear on the map. You can zoom in 
on the map to see more detail. When you are navigating to a 
destination, your route is marked with a colored line on the map.

Navigating with the Map
1 Begin navigating to a destination (Navigating to a 

Destination, page 8).
2 From the map, complete one or more actions:

• Drag the map to view different areas.
• Pinch or spread two fingers on the touchscreen to zoom in 

and out of the map.
• Select  and  to zoom in and out of the map.
• Double-tap the map to quickly zoom in.
• Select a location on the map (represented by a pin), and 

select the information bar at the top of the screen to view 
information about the selected location.

• Select  to select which map layers display on the map.

Map Page Settings
From the map, select .
Stop Navigation: Stops navigating the current route.
Map Setup: Enables you to open additional map settings (Map 

Settings, page 5).
Measure Distance: Allows you to measure the distance 

between multiple locations (Measuring Distance on the Map, 
page 5).

Restore Defaults: Restores the map to factory default settings.
Map Settings
From the map, select , and select Map Setup.
Configure Maps: Enables or disables the maps currently 

loaded on the device (Enabling Maps, page 9).
Orientation: Adjusts how the map is shown on the page 

(Changing the Map Orientation, page 5).

Dashboard: Sets a dashboard to display on the map. Each 
dashboard shows different information about your route or 
your location.

Guidance Text: Sets when the guidance text is shown on the 
map.

Advanced Setup: Enables you to open advanced map settings 
(Advanced Map Settings, page 5).

Advanced Map Settings
From the map, select , and select Map Setup > Advanced 
Setup.
Auto Zoom: Automatically selects the appropriate zoom level 

for optimal use on your map. When Off is selected, you must 
zoom in or out manually.

Detail: Selects the amount of detail shown on the map. Showing 
more detail may cause the map to redraw more slowly.

Shaded Relief: Shows detail relief on the map (if available) or 
turns off shading.

Vehicle: Sets the position icon, which represents your position 
on the map. The default icon is a small blue triangle.

Zoom Levels: Adjusts the zoom level at which map items 
appear. The map items do not appear when the map zoom 
level is higher than the selected level.

Text Size: Selects the text size for map items.
Map Speed: Adjusts the speed at which the map is drawn. A 

faster map drawing speed decreases the battery life.
Changing the Map Orientation
1 From the map, select .
2 Select Map Setup > Orientation.
3 Select an option:

• Select North Up to show north at the top of the page.
• Select Track Up to show your current direction of travel at 

the top of the page.
• Select Automotive Mode to show an automotive 

perspective with the direction of travel at the top.
Measuring Distance on the Map
You can measure the distance between two locations.
1 From the map, select a location.
2 Select  > Measure Distance > Use.
3 Move the pin to another location on the map.

Compass
When navigating,  points to your destination, regardless of the 
direction you are moving. When  points toward the top of the 
electronic compass, you are traveling directly toward your 
destination. If  points any other direction, turn until it points 
toward the top of the compass.

Navigating with the Compass
When navigating to a destination,  points to your destination, 
regardless of the direction you are moving.
1 Begin navigating to a destination (Navigating to a 

Destination, page 8).
2 Turn until  points toward the top of the compass, and 

continue moving in that direction to the destination.

Compass Settings
From the compass, select .
Sight 'N Go: Allows you to point the device at an object in the 

distance, and navigate using the object as a reference point 
(Navigating with Sight 'N Go, page 6).

Stop Navigation: Stops navigation of the current route.
Change Dashboard: Changes the theme and information 

displayed on the dashboard.
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 és 

Data Use and History
You can view plan details and data use on the Montana 700i/
750i device.

Viewing Plan Details
1 Select inReach > inReach Utilities.
2 Select Plan Details.

Viewing Data Use
You can view the number of messages, preset messages, and 
track points sent during the current billing cycle. The data use 
counter resets automatically at the beginning of each billing 
cycle.
1 Select inReach > inReach Utilities.
2 Select Plan Usage.

Viewing the Main Pages
The information needed to operate this device is found on the 
main pages. Default pages include the main menu, map, 
compass, trip computer, and Where To? pages.
• Select the icons in the Favorites bar to scroll through the 

main pages.
• Hold an icon in the Favorites bar, and drag it to a new 

location to change the order of the icons or remove an icon.
TIP: You can also select Setup > Menus > Favorites to 
customize the Favorites bar. The  and  icons cannot be 
removed or changed.

Map
 represents your location on the map. As you travel,  moves 

and displays your path. Depending on your zoom level, waypoint 
names and symbols may appear on the map. You can zoom in 
on the map to see more detail. When you are navigating to a 
destination, your route is marked with a colored line on the map.

Navigating with the Map
1 Begin navigating to a destination (Navigating to a 

Destination, page 8).
2 From the map, complete one or more actions:

• Drag the map to view different areas.
• Pinch or spread two fingers on the touchscreen to zoom in 

and out of the map.
• Select  and  to zoom in and out of the map.
• Double-tap the map to quickly zoom in.
• Select a location on the map (represented by a pin), and 

select the information bar at the top of the screen to view 
information about the selected location.

• Select  to select which map layers display on the map.

Map Page Settings
From the map, select .
Stop Navigation: Stops navigating the current route.
Map Setup: Enables you to open additional map settings (Map 

Settings, page 5).
Measure Distance: Allows you to measure the distance 

between multiple locations (Measuring Distance on the Map, 
page 5).

Restore Defaults: Restores the map to factory default settings.
Map Settings
From the map, select , and select Map Setup.
Configure Maps: Enables or disables the maps currently 

loaded on the device (Enabling Maps, page 9).
Orientation: Adjusts how the map is shown on the page 

(Changing the Map Orientation, page 5).

Dashboard: Sets a dashboard to display on the map. Each 
dashboard shows different information about your route or 
your location.

Guidance Text: Sets when the guidance text is shown on the 
map.

Advanced Setup: Enables you to open advanced map settings 
(Advanced Map Settings, page 5).

Advanced Map Settings
From the map, select , and select Map Setup > Advanced 
Setup.
Auto Zoom: Automatically selects the appropriate zoom level 

for optimal use on your map. When Off is selected, you must 
zoom in or out manually.

Detail: Selects the amount of detail shown on the map. Showing 
more detail may cause the map to redraw more slowly.

Shaded Relief: Shows detail relief on the map (if available) or 
turns off shading.

Vehicle: Sets the position icon, which represents your position 
on the map. The default icon is a small blue triangle.

Zoom Levels: Adjusts the zoom level at which map items 
appear. The map items do not appear when the map zoom 
level is higher than the selected level.

Text Size: Selects the text size for map items.
Map Speed: Adjusts the speed at which the map is drawn. A 

faster map drawing speed decreases the battery life.
Changing the Map Orientation
1 From the map, select .
2 Select Map Setup > Orientation.
3 Select an option:

• Select North Up to show north at the top of the page.
• Select Track Up to show your current direction of travel at 

the top of the page.
• Select Automotive Mode to show an automotive 

perspective with the direction of travel at the top.
Measuring Distance on the Map
You can measure the distance between two locations.
1 From the map, select a location.
2 Select  > Measure Distance > Use.
3 Move the pin to another location on the map.

Compass
When navigating,  points to your destination, regardless of the 
direction you are moving. When  points toward the top of the 
electronic compass, you are traveling directly toward your 
destination. If  points any other direction, turn until it points 
toward the top of the compass.

Navigating with the Compass
When navigating to a destination,  points to your destination, 
regardless of the direction you are moving.
1 Begin navigating to a destination (Navigating to a 

Destination, page 8).
2 Turn until  points toward the top of the compass, and 

continue moving in that direction to the destination.

Compass Settings
From the compass, select .
Sight 'N Go: Allows you to point the device at an object in the 

distance, and navigate using the object as a reference point 
(Navigating with Sight 'N Go, page 6).

Stop Navigation: Stops navigation of the current route.
Change Dashboard: Changes the theme and information 

displayed on the dashboard.
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 gombokkal nagyíthatunk, kicsinyíthetünk a térképen.
 •   Koppintsunk ugyanarra a pontra kétszer egymás után a térképen a 

gyors nagyításhoz.
 •   Jelöljünk ki egy pontot, helyet a térképen, majd érintsük meg a felső in-

formációs sávot, ekkor a kijelölt hely (melyet egy gombostű jelöl) ada-
tai jelennek meg.

 •   A 

Data Use and History
You can view plan details and data use on the Montana 700i/
750i device.

Viewing Plan Details
1 Select inReach > inReach Utilities.
2 Select Plan Details.

Viewing Data Use
You can view the number of messages, preset messages, and 
track points sent during the current billing cycle. The data use 
counter resets automatically at the beginning of each billing 
cycle.
1 Select inReach > inReach Utilities.
2 Select Plan Usage.

Viewing the Main Pages
The information needed to operate this device is found on the 
main pages. Default pages include the main menu, map, 
compass, trip computer, and Where To? pages.
• Select the icons in the Favorites bar to scroll through the 

main pages.
• Hold an icon in the Favorites bar, and drag it to a new 

location to change the order of the icons or remove an icon.
TIP: You can also select Setup > Menus > Favorites to 
customize the Favorites bar. The  and  icons cannot be 
removed or changed.

Map
 represents your location on the map. As you travel,  moves 

and displays your path. Depending on your zoom level, waypoint 
names and symbols may appear on the map. You can zoom in 
on the map to see more detail. When you are navigating to a 
destination, your route is marked with a colored line on the map.

Navigating with the Map
1 Begin navigating to a destination (Navigating to a 

Destination, page 8).
2 From the map, complete one or more actions:

• Drag the map to view different areas.
• Pinch or spread two fingers on the touchscreen to zoom in 

and out of the map.
• Select  and  to zoom in and out of the map.
• Double-tap the map to quickly zoom in.
• Select a location on the map (represented by a pin), and 

select the information bar at the top of the screen to view 
information about the selected location.

• Select  to select which map layers display on the map.

Map Page Settings
From the map, select .
Stop Navigation: Stops navigating the current route.
Map Setup: Enables you to open additional map settings (Map 

Settings, page 5).
Measure Distance: Allows you to measure the distance 

between multiple locations (Measuring Distance on the Map, 
page 5).

Restore Defaults: Restores the map to factory default settings.
Map Settings
From the map, select , and select Map Setup.
Configure Maps: Enables or disables the maps currently 

loaded on the device (Enabling Maps, page 9).
Orientation: Adjusts how the map is shown on the page 

(Changing the Map Orientation, page 5).

Dashboard: Sets a dashboard to display on the map. Each 
dashboard shows different information about your route or 
your location.

Guidance Text: Sets when the guidance text is shown on the 
map.

Advanced Setup: Enables you to open advanced map settings 
(Advanced Map Settings, page 5).

Advanced Map Settings
From the map, select , and select Map Setup > Advanced 
Setup.
Auto Zoom: Automatically selects the appropriate zoom level 

for optimal use on your map. When Off is selected, you must 
zoom in or out manually.

Detail: Selects the amount of detail shown on the map. Showing 
more detail may cause the map to redraw more slowly.

Shaded Relief: Shows detail relief on the map (if available) or 
turns off shading.

Vehicle: Sets the position icon, which represents your position 
on the map. The default icon is a small blue triangle.

Zoom Levels: Adjusts the zoom level at which map items 
appear. The map items do not appear when the map zoom 
level is higher than the selected level.

Text Size: Selects the text size for map items.
Map Speed: Adjusts the speed at which the map is drawn. A 

faster map drawing speed decreases the battery life.
Changing the Map Orientation
1 From the map, select .
2 Select Map Setup > Orientation.
3 Select an option:

• Select North Up to show north at the top of the page.
• Select Track Up to show your current direction of travel at 

the top of the page.
• Select Automotive Mode to show an automotive 

perspective with the direction of travel at the top.
Measuring Distance on the Map
You can measure the distance between two locations.
1 From the map, select a location.
2 Select  > Measure Distance > Use.
3 Move the pin to another location on the map.

Compass
When navigating,  points to your destination, regardless of the 
direction you are moving. When  points toward the top of the 
electronic compass, you are traveling directly toward your 
destination. If  points any other direction, turn until it points 
toward the top of the compass.

Navigating with the Compass
When navigating to a destination,  points to your destination, 
regardless of the direction you are moving.
1 Begin navigating to a destination (Navigating to a 

Destination, page 8).
2 Turn until  points toward the top of the compass, and 

continue moving in that direction to the destination.

Compass Settings
From the compass, select .
Sight 'N Go: Allows you to point the device at an object in the 

distance, and navigate using the object as a reference point 
(Navigating with Sight 'N Go, page 6).

Stop Navigation: Stops navigation of the current route.
Change Dashboard: Changes the theme and information 

displayed on the dashboard.
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 pont kiválasztásával megadhatjuk a térképen megjeleníteni kí-
vánt rétegeket.

Térkép képernyő beállításai
 A térkép képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 pontot.
Navigáció leállítása: aktuális útvonali navigáció leállítása.
Térkép beállítása: további térképi beállítások megnyitása (Térkép beállítá-

sa, 5. oldal).
Távolságmérés: távolságmérés egyidejűleg több helyszín között (Távolság-

mérés a térképen, 5. oldal).
Gyári visszaállítás: térkép gyári beállításainak visszaállítása.

Térkép beállítása
A térkép képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Térkép beállítása pontot.
Térkép információ: a készülékre aktuálisan betöltött térképeket aktiválhat-

juk vagy kapcsolhatjuk ki (Térképek aktiválása, 9. oldal).
Tájolás: a térkép forgatási irányát határozhatjuk meg (Térkép tájolásának 

beállítása, 5. oldal).

Műszerfal: egy műszerfalat jeleníthetünk meg a térképen. Az egyes műszer-
falak különféle információkat jelenítenek meg az útvonalunkkal vagy hely-
zetünkkel kapcsolatban.

Iránymutató szöveg: megadhatjuk, a térképen mikor jelenjen meg az irány-
mutató szöveg.

Speciális térképi beállítások: a speciális térképi beállítások megjelenítése 
(Speciális térképi beállítások, 5. oldal).

Speciális térképi beállítások
A térkép képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Térkép beállítása > Speciális térké-
pi beállítások pontot.
Auto zoom: az optimális nagyítási lépték automatikus kiválasztása. Ki ese-

tén magunk nagyítunk, kicsinyítünk.
Részletezés: a térképen megjelenő adatok részletességét állíthatjuk be. 

Minél részletesebb a térkép, annál hosszabb időt vesz igénybe a kiraj-
zolása.

Árnyékolt domborzat: mutatja a domborzati árnyékolást (amennyiben van), 
vagy ki is kapcsolhatjuk.

Jármű: jármű ikon kiválasztása, ez az ikon jelzi aktuális pozíciónkat a térké-
pen. Alapértelmezés szerint kis kék háromszög.

Nagyítási szintek: beállíthatjuk, hogy a térképi elemek milyen nagyítási 
szinten jelennek meg. A térképi elemek akkor nem jelennek meg, ha a 
térkép nagyítási szintje nagyobb, mint a kiválasztott szint.

Szövegméret: a szöveges térképi elemek betűméretét állíthatjuk be.
Térkép sebesség: a térkép berajzolási sebességét állíthatjuk be. A nagyobb 

berajzolási sebesség csökkenti az akkumulátor által biztosított működé-
si időt.

Térkép tájolásának beállítása
1.  A térkép képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 pontot.
2.   Válasszuk a Térkép beállítása > Tájolást.
3.  Válasszunk az alábbaik közül:
 •   Észak felül esetén a képernyő teteje mindig az északi irány (papírtér-

képhez hasonlóan).
 •    Menetirányba esetén aktuális haladási irányunk néz mindig a képer-

nyő teteje felé.
 •   Autós mód perspektivikus nézetből mutatja a térképet.

Távolságmérés a térképen
Két hely közötti távolságot mérhetjük.
1.  Válasszuk ki a kívánt helyet a térképen.
2.  Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Távolságmérés > Alkalmaz pontot.
3.  Mozgassuk a tűt egy másik helyre a térképen.

Iránytű
Amikor egy kijelölt cél felé navigálunk, a 

2 Plug the small end of the USB cable into the mini-USB port.
3 Plug the USB end of the cable into an AC adapter or a 

computer USB port.
4 If necessary, plug the AC adapter into a standard wall outlet.

When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.

Turning On the Device
Hold .

Buttons

FIND Select to open the search menu.
Hold to mark your current location as a man overboard 
(MOB) location and activate navigation.

MARK Select to save your current location as a waypoint.
QUIT Select to cancel or return to the previous menu or page.

Select to scroll through the main pages.
ENTER Select to choose options and acknowledge messages.

Select to control the current activity recording (from the Map, 
Compass, Altimeter, and Trip Computer pages).

MENU Select to open the options menu for the page that is 
currently open.
Select twice to open the main menu (from any page).

PAGE Select to scroll through the main pages.
   Select , , , or  to select menu options and move the 

map cursor.
IN Select to zoom in on the map.
OUT Select to zoom out on the map.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

A question mark flashes while the device determines your 
location.

4 Select  to open the status page.
 shows the satellite signal strength.

When the bars are full, the device has acquired satellite signals.

Using the Main Pages
The information needed to operate this device is found on the 
main menu, map, compass, trip computer, and elevation plot 
pages.

Select PAGE to choose the active main page.

Opening the Main Menu
The main menu gives you access to tools and setup screens for 
waypoints, activities, routes, and more (Additional Main Menu 
Tools, page 7).

From any page, select MENU twice.

Map
 represents your location on the map. As you travel,  moves 

and displays your path. Depending on your zoom level, waypoint 
names and symbols may appear on the map. You can zoom in 
on the map to see more detail. When you are navigating to a 
destination, your route is marked with a colored line on the map.

Changing the Map Orientation
1 From the map, select MENU.
2 Select Setup Map > Orientation.
3 Select an option:

• Select North Up to show north at the top of the page.
• Select Track Up to show your current direction of travel at 

the top of the page.
• Select Automotive Mode to show an automotive 

perspective with the direction of travel at the top.

Measuring Distance on the Map
You can measure the distance between two locations.
1 From the map, select a location.
2 Select MENU > Measure Distance.
3 Move the pin to another location on the map.

Map Settings
Select Setup > Map.
Orientation: Adjusts how the map is shown on the page. North 

Up shows north at the top of the page. Track Up shows a top-
down view with your current direction of travel toward the top 
of the page. Automotive Mode shows an 3D automotive view 
with the direction of travel at the top.

Data Fields: Customizes the data fields and dashboards of the 
map, compass, elevation plot, and trip computer.

Advanced Map Setup: Enables you to open advanced map 
settings (Advanced Map Settings, page 2).

Map Information: Enables or disables the maps currently 
loaded on the device.

Advanced Map Settings
Select Setup > Map > Advanced Map Setup.
Auto Zoom: Automatically selects the appropriate zoom level 

for optimal use on your map. When Off is selected, you must 
zoom in or out manually.

Zoom Levels: Adjusts the zoom level at which map items will 
appear. The map items will not appear when the map zoom 
level is higher than the selected level.

2 Using the Main Pages

 célirány-mutató folyamatosan a 
cél felé mutató irányt mutatja. Amikor a céliránymutató a gyűrű legfelső pont-
jába mutat (ahol haladási irányunk is látható), akkor éppen a cél felé hala-
dunk. Ha a mutató eltérő irányba mutat, forduljunk úgy, hogy a mutató a gyű-
rű legfelső pontja felé kezdjen közeledni, ez azt jelenti, hogy magunk is a cél 
felé fordulunk.

Navigáció az iránytűvel
Amikor kijelölt cél felé navigálunk, a 

2 Plug the small end of the USB cable into the mini-USB port.
3 Plug the USB end of the cable into an AC adapter or a 

computer USB port.
4 If necessary, plug the AC adapter into a standard wall outlet.

When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.

Turning On the Device
Hold .

Buttons

FIND Select to open the search menu.
Hold to mark your current location as a man overboard 
(MOB) location and activate navigation.

MARK Select to save your current location as a waypoint.
QUIT Select to cancel or return to the previous menu or page.

Select to scroll through the main pages.
ENTER Select to choose options and acknowledge messages.

Select to control the current activity recording (from the Map, 
Compass, Altimeter, and Trip Computer pages).

MENU Select to open the options menu for the page that is 
currently open.
Select twice to open the main menu (from any page).

PAGE Select to scroll through the main pages.
   Select , , , or  to select menu options and move the 

map cursor.
IN Select to zoom in on the map.
OUT Select to zoom out on the map.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

A question mark flashes while the device determines your 
location.

4 Select  to open the status page.
 shows the satellite signal strength.

When the bars are full, the device has acquired satellite signals.

Using the Main Pages
The information needed to operate this device is found on the 
main menu, map, compass, trip computer, and elevation plot 
pages.

Select PAGE to choose the active main page.

Opening the Main Menu
The main menu gives you access to tools and setup screens for 
waypoints, activities, routes, and more (Additional Main Menu 
Tools, page 7).

From any page, select MENU twice.

Map
 represents your location on the map. As you travel,  moves 

and displays your path. Depending on your zoom level, waypoint 
names and symbols may appear on the map. You can zoom in 
on the map to see more detail. When you are navigating to a 
destination, your route is marked with a colored line on the map.

Changing the Map Orientation
1 From the map, select MENU.
2 Select Setup Map > Orientation.
3 Select an option:

• Select North Up to show north at the top of the page.
• Select Track Up to show your current direction of travel at 

the top of the page.
• Select Automotive Mode to show an automotive 

perspective with the direction of travel at the top.

Measuring Distance on the Map
You can measure the distance between two locations.
1 From the map, select a location.
2 Select MENU > Measure Distance.
3 Move the pin to another location on the map.

Map Settings
Select Setup > Map.
Orientation: Adjusts how the map is shown on the page. North 

Up shows north at the top of the page. Track Up shows a top-
down view with your current direction of travel toward the top 
of the page. Automotive Mode shows an 3D automotive view 
with the direction of travel at the top.

Data Fields: Customizes the data fields and dashboards of the 
map, compass, elevation plot, and trip computer.

Advanced Map Setup: Enables you to open advanced map 
settings (Advanced Map Settings, page 2).

Map Information: Enables or disables the maps currently 
loaded on the device.

Advanced Map Settings
Select Setup > Map > Advanced Map Setup.
Auto Zoom: Automatically selects the appropriate zoom level 

for optimal use on your map. When Off is selected, you must 
zoom in or out manually.

Zoom Levels: Adjusts the zoom level at which map items will 
appear. The map items will not appear when the map zoom 
level is higher than the selected level.

2 Using the Main Pages

 céliránymutató folyamatosan a cél felé 
mutató irányt mutatja, függetlenül az aktuális haladási irányunktól.
1.  Indítsuk a navigációt egy kijelölt cél felé (Navigáció cél felé, 8. oldal).
2.  Forduljunk úgy, hogy a 

2 Plug the small end of the USB cable into the mini-USB port.
3 Plug the USB end of the cable into an AC adapter or a 

computer USB port.
4 If necessary, plug the AC adapter into a standard wall outlet.

When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.

Turning On the Device
Hold .

Buttons

FIND Select to open the search menu.
Hold to mark your current location as a man overboard 
(MOB) location and activate navigation.

MARK Select to save your current location as a waypoint.
QUIT Select to cancel or return to the previous menu or page.

Select to scroll through the main pages.
ENTER Select to choose options and acknowledge messages.

Select to control the current activity recording (from the Map, 
Compass, Altimeter, and Trip Computer pages).

MENU Select to open the options menu for the page that is 
currently open.
Select twice to open the main menu (from any page).

PAGE Select to scroll through the main pages.
   Select , , , or  to select menu options and move the 

map cursor.
IN Select to zoom in on the map.
OUT Select to zoom out on the map.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

A question mark flashes while the device determines your 
location.

4 Select  to open the status page.
 shows the satellite signal strength.

When the bars are full, the device has acquired satellite signals.

Using the Main Pages
The information needed to operate this device is found on the 
main menu, map, compass, trip computer, and elevation plot 
pages.

Select PAGE to choose the active main page.

Opening the Main Menu
The main menu gives you access to tools and setup screens for 
waypoints, activities, routes, and more (Additional Main Menu 
Tools, page 7).

From any page, select MENU twice.

Map
 represents your location on the map. As you travel,  moves 

and displays your path. Depending on your zoom level, waypoint 
names and symbols may appear on the map. You can zoom in 
on the map to see more detail. When you are navigating to a 
destination, your route is marked with a colored line on the map.

Changing the Map Orientation
1 From the map, select MENU.
2 Select Setup Map > Orientation.
3 Select an option:

• Select North Up to show north at the top of the page.
• Select Track Up to show your current direction of travel at 

the top of the page.
• Select Automotive Mode to show an automotive 

perspective with the direction of travel at the top.

Measuring Distance on the Map
You can measure the distance between two locations.
1 From the map, select a location.
2 Select MENU > Measure Distance.
3 Move the pin to another location on the map.

Map Settings
Select Setup > Map.
Orientation: Adjusts how the map is shown on the page. North 

Up shows north at the top of the page. Track Up shows a top-
down view with your current direction of travel toward the top 
of the page. Automotive Mode shows an 3D automotive view 
with the direction of travel at the top.

Data Fields: Customizes the data fields and dashboards of the 
map, compass, elevation plot, and trip computer.

Advanced Map Setup: Enables you to open advanced map 
settings (Advanced Map Settings, page 2).

Map Information: Enables or disables the maps currently 
loaded on the device.

Advanced Map Settings
Select Setup > Map > Advanced Map Setup.
Auto Zoom: Automatically selects the appropriate zoom level 

for optimal use on your map. When Off is selected, you must 
zoom in or out manually.

Zoom Levels: Adjusts the zoom level at which map items will 
appear. The map items will not appear when the map zoom 
level is higher than the selected level.

2 Using the Main Pages

 céliránymutató az iránytű teteje felé mutat, majd 
a célig kövessük az ikon által kijelölt irányt.

Iránytű beállítások
Az iránytű képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 pontot.
Mutat és megy – egy távoli tárgyra mutathatunk, és azt referenciapontként 

használva navigálhatunk (Mutat és megy navigáció, 6. oldal)
Navigáció leállítása – aktuális útvonal navigálásának leállítása.
Műszerfal módosítás – műszerfal által megjelenített téma és információk 

módosítása
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Mérték beállítása – a letérés mutatón megjelenő pontok közöti távolság 
mértékének beállítása

Iránytű kalibrálása – az iránytű nem megfelelő működése esetén kalibrál-
hatjuk az iránytűt, például hosszú táv megtétele után vagy szélsőséges 
hőmérsékleti változás esetén (Iránytű kalibrálása, 6. oldal).

Irány beállítása – az iránytű irány beállításainak módosítása (Irány beállí-
tások, 6. oldal).

Adatmezők zárolása – adatmezők zárolása. Az adatmezőket feloldhatjuk, 
ha személyre szeretnénk szabni őket.

Gyári értékek visszaállítása – az iránytű gyári értékekre való visszaállí-
tása.

Mutat és megy navigáció
A funkcióval rámutathatunk egy távoli tárgyra, kivetíthetjük azt útpontként, 
majd az irányt rögzítve navigációt indíthatunk a távoli tárgy felé.
1.  Az iránytű képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 > Mutat és megy pontot.
2.  A készülékkel mutassunk rá a kívánt tárgyra.
3.  Válasszuk a Fix irány > Irány beállítás pontot.
4.  Az iránytű segítségével navigáljunk a távoli tárgy felé.

Iránytű kalibrálása
Az elektronikus iránytűt szabadtéren kalibráljuk, távol minden olyan tárgy-
tól, amely befolyásolja a mágneses mezőket, pl. autóktól, épületektől, nagy-
feszültségű vezetéktől.
A készülék háromtengelyű elektronikus iránytűvel rendelkezik. Az iránytű ka-
librálása nagy távolságok megtételét követően, jelentős hőmérsékletváltozás 
után válhat szükségessé.
1.  Az iránytű képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 pontot.
2.  Válasszuk az Iránytű kalibrálás > Indítás pontot.
3.  Kövessük a képernyőn megjelenő utasításokat.

Irány beállítások
Az iránytű képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Irány beállítások pontot.
Kijelző – az iránytű által megjelenített irány típusának beállítása.
Északi referencia – az iránytű által használt északi referencia beállítása.
Ugrás vonalhoz/mutatóhoz – a követendő irány kijelzési módja. A tájolás az 

úti cél felé mutat. A pálya (CDI) mutató mutatja a helyzetünket az úti cél 
felé vezető pályavonalhoz képest.

Iránytű – beállíthatjuk, hogy amennyiben egy adott időtartamon át tartósan 
egy megadott sebességnél gyorsabban haladunk, a készülék az elektro-
nikus iránytű helyett a GPS irányra álljon át (automatikus).

Iránytű kalibrálás – amennyiben az iránytű rendellenes módon működik, ka-
librálhatjuk azt. Ez többek között nagy távolságok megtétele esetén vagy 
szélsőséges hőmérsékleti viszonyok, ingadozás esetén következhet be 
(Iránytű kalibrálása, 6. oldal).

Pálya mutató
Az eredeti kiindulási pontot és a célt összekötő egyenes mentén navigáló pá-
lya mutató hajózás során a leginkább hasznos, ahol utunk során nem kerül-
nek elénk nagyobb akadályok. Segít a kijelölt útvonal két oldalán leselkedő 
veszélyek, pl. víz alatti sziklák, zátonyok elkerülésében.
A pálya mutató bekapcsolásához az iránytű képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > 
Irány beállítás > Ugrás a vonalhoz/mutatóhoz > Pálya (CDI) pontot.

Set Scale: Sets the scale for the distance between the dots on 
the course deviation indicator.

Calibrate Compass: Allows you to calibrate the compass if you 
experience irregular compass behavior, for example, after 
moving long distances or after extreme temperature changes 
(Calibrating the Compass, page 6).

Heading Setup: Allows you to customize the compass heading 
settings (Heading Settings, page 6).

Lock Data Fields: Locks the data fields. You can unlock the 
data fields to customize them.

Restore Defaults: Restores the compass to factory default 
settings.

Navigating with Sight 'N Go
You can point the device at an object in the distance with the 
compass direction locked in, project the object as a waypoint, 
and navigate using the object as a reference point.
1 From the compass, select  > Sight 'N Go.
2 Point the device at an object.
3 Select Lock Direction > Set Course.
4 Navigate using the compass.
Calibrating the Compass
Before you can calibrate the electronic compass, you must be 
outdoors, away from objects that influence magnetic fields, such 
as cars, buildings, or overhead power lines.
The device has a 3-axis electronic compass. You should 
calibrate the compass after moving long distances or 
experiencing temperature changes.
1 From the compass, select .
2 Select Calibrate Compass > Start.
3 Follow the on-screen instructions.
Heading Settings
From the compass, select , and select Heading Setup.
Display: Sets the type of directional heading shown on the 

compass.
North Reference: Sets the north reference used on the 

compass.
Go To Line (Pointer): Sets the behavior of the pointer that 

appears on the map. Bearing points in the direction of your 
destination. Course (CDI) shows your relationship to the 
course line leading to the destination.

Compass: Automatically switches from an electronic compass 
to a GPS compass when you are traveling at a higher rate of 
speed for a period of time.

Calibrate Compass: Allows you to calibrate the compass if you 
experience irregular compass behavior, for example, after 
moving long distances or after extreme temperature changes 
(Calibrating the Compass, page 6).

Course Pointer
The course pointer is most useful when you are navigating to 
your destination in a straight line, such as when you are 
navigating on water. It can help you navigate back to the course 
line when you go off-course to avoid obstacles or hazards.
To enable the course pointer, from the compass, select  > 
Heading Setup > Go To Line (Pointer) > Course (CDI).

Course line pointer. Indicates the direction of the desired course 
line from your starting point to your next waypoint.
Course deviation indicator (CDI). Indicates the location of the 
desired course line in relation to your location. If the CDI is aligned 
with the course line pointer, you are on course.
Course deviation distance. The dots indicate your distance off 
course. The distance represented by each dot is indicated by the 
scale in the upper-right corner.
To-and-from indicator. Indicates whether you are headed to or from 
the next waypoint.

Trip Computer
The trip computer displays your current speed, average speed, 
trip odometer, and other helpful statistics. You can customize 
the trip computer layout, dashboard, and data fields.

Trip Computer Settings
From the trip computer, select .
Reset: Resets all the trip computer values to zero. For accurate 

information, reset the trip information before beginning a trip.
Change Dashboard: Changes the theme and information 

displayed on the dashboard.
NOTE: Your customized settings are remembered by the 
dashboard. Your settings are not lost when you change 
profiles (Profiles, page 21).

Lock Data Fields: Locks the data fields. You can unlock the 
data fields to customize them.

Insert Page: Inserts an additional page of customizable data 
fields.

Remove Page: Removes an additional page of customizable 
data fields.

More Data: Adds additional data fields to the trip computer.
Less Data: Removes data fields from the trip computer.
Restore Defaults: Restores the trip computer to its factory 

default settings.

Altimeter
By default, the altimeter plot displays the elevation over the 
distance traveled. You can customize the altimeter settings 
(Altimeter Settings, page 6). You can select any point on the 
plot to view details about that point.
You can customize the favorites bar to add the altimeter page 
(Customizing the Favorites Bar, page 21).

Altimeter Plot Settings
From the altimeter, select .
Reset: Resets the altimeter data, including waypoint, track, and 

trip data.
Altimeter Setup: Enables you to open additional altimeter 

settings (Altimeter Settings, page 6).
Restore Defaults: Restores the altimeter to factory default 

settings.
Altimeter Settings
From the altimeter, select  > Altimeter Setup.
Auto Calibration: Once allows the altimeter to automatically 

calibrate one time when you start an activity. Continuous 
allows the altimeter to calibrate throughout the duration of 
your activity.

Barometer Mode: Variable Elevation allows the barometer to 
measure changes in elevation while you are moving. Fixed 
Elevation assumes the device is stationary at a fixed 
elevation, so the barometric pressure should only change 
due to weather.

Pressure Trending: Sets how the device records pressure 
data. Save Always records all pressure data, which can be 
helpful when you are watching for pressure fronts.
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 WARNING
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product box for product warnings and other important 
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Device Overview
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Buttons

Power button

Mini-USB port (under weather cap)

microSD® card slot (under batteries)
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Battery cover D-ring

Battery Information
 WARNING

The temperature rating for the device may exceed the usable 
range of some batteries. Alkaline batteries can rupture at high 
temperatures.

NOTICE
Alkaline batteries lose a significant amount of their capacity as 
the temperature decreases. Use lithium batteries when 
operating the device in below freezing conditions.

Maximizing Battery Life
You can do several things to extend the life of the batteries.
• Reduce the backlight brightness (Adjusting the Backlight 

Brightness, page 9).
• Reduce the backlight timeout (Display Settings, page 9).
• Use battery save mode (Turning On Battery Save Mode, 

page 1).
• Decrease the map drawing speed (Advanced Map Settings, 

page 2).
• Turn off Bluetooth® technology (Bluetooth Settings, 

page 9).
• Turn off additional satellites (Satellite Settings, page 9).

Turning On Battery Save Mode
You can use battery save mode to prolong the battery life.

From the app drawer, select Setup > Display > Battery 
Save > On.

In battery save mode, the screen shuts off when the backlight 
times out. You can select  to turn on the screen.

Long-Term Storage
When you do not plan to use the device for several months, 
remove the batteries. Stored data is not lost when batteries are 
removed.

Installing AA Batteries
Instead of the optional NiMH battery pack (Installing a NiMH 
Battery Pack, page 1), you can use two alkaline, NiMH, or 
lithium batteries. This is useful when you are on the trail and 
cannot charge the NiMH battery pack. Use NiMH or lithium 
batteries for best results.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Insert two AA batteries, observing polarity.

3 Replace the battery cover, and turn the D-ring clockwise.
4 Hold .
5 Select Setup > System > AA Battery Type.
6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 

NiMH.

Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .
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Pályavonal mutató. A kiindulási ponttól a következő útpontig ve-
zető megfelelő pályavonalat jelzi.
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6 Select Alkaline, Lithium, Traditional NiMH, or Precharged 
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Installing a NiMH Battery Pack
The device operates using a NiMH battery pack (optional) or two 
AA batteries (Installing AA Batteries, page 1).
1 Turn the D-ring counter-clockwise, and pull up to remove the 

cover.
2 Locate the battery pack .

3 Insert the battery pack, observing polarity.
4 Gently press the battery pack into place.
5 Replace the battery cover, and turn the D-ring clockwise.

Charging the Battery Pack
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To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the straight connector of the USB cable 
to your device, you may need to remove optional mount 
accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 12).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the mini-USB port .
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Letérési mutató (CDI). A megfelelő pályavonal aktuális pozíciónk-
hoz viszonyított helyzetét jelzi. Ha a CDI ugyanazon a vonalon 
fut, mint a pályavonal mutató, akkor a megfelelő irányba hala-
dunk.
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The device operates using a NiMH battery pack (optional) or two 
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4 Gently press the battery pack into place.
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cap, and the surrounding area before charging or connecting to 
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Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
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Before you can connect the straight connector of the USB cable 
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Letérés mértéke. A pontok mutatják a pályáról való letérés távol-
ságát. Az egyes pontok által képviselt távolságot a jobb felső sa-
rokban található mérték jelzi.
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Közeledés-eltávolodás mutató. Azt jelzi, hogy a következő út-
ponthoz éppen közeledünk vagy eltávolodunk tőle.

Fedélzeti számítógép képernyő
A fedélzeti számítógép képernyő menetadatokat, hasznos statisztikákat mu-
tat, mint pl. az aktuális sebesség, átlagsebesség, napi kilométerszámláló 
adatokat. Személyre szabhatjuk a fedélzeti számítógépen megjelenő mű-
szerfalat és adatmezőket, valamint azok elrendezését.

Fedélzeti számítógép képernyő beállításai
A fedélzeti számítógép képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 pontot.
Visszaállítás – az összes menetadatot, számlálót nulla értékre állítja át. 

Pontos értékek kijelzéséhez a túra indítása előtt nullázzuk a számlálókat.
Műszerf.módosít. – a fedélzeti számítógépen az adatmezők feletti képer-

nyőrészt a tevékenységhez illő háttérképpel tölthetjük fel, vagy megjele-
níthetünk egy funkciót.

 MEGJEGYZÉS! Egyedi beállításainkat elmenti a képernyő, és profilvál-
tás során nem vesznek el (Profilváltás, 17. oldal).

Adatmezők zárolása – adatmezők zárolása. Az adatmezőket feloldhatjuk, 
ha személyre szeretnénk szabni őket.

Képernyő hozzáadása – további módosítható adatmezős képernyőt ad 
hozzá.

Képernyő eltávolítása – további módosítható adatmezős képernyőt tá-
volít el.

Több adat – további adatmezőket ad hozzá a fedélzeti számítógéphez.
Kevesebb adat – adatmezőket távolít el a fedélzeti számítógépről.
Gyári visszaállítás – a fedélzeti számítógép gyári beállításainak visszaál-

lítása.

Magasságmérő
Alapbeállítás szerint a magassági értékek a megtett távolság függvényében 
jelennek meg. A magasság beállításokat módosíthatjuk (Magasságmérő be-
állítások, 6. oldal). A grafikonon bármely pont kiválasztásával megjeleníthet-
jük az adott pont részletes információit.
A Kedvencek sávhoz hozzáadhatjuk a magasságmérő képernyőt (Kedven-
cek sáv testreszabása, 21. oldal).

Magassági grafikon beállítása
A magasságmérő képernyőn válasszuk a 
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inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 pontot.
Visszaállítás – Magasságmérő adatainak visszaállítása, beleértve az útpon-

tokat, útvonalat és utazási adatokat.
Magasságmérő beállítás – További magasságmérő beállítások elérése 

(Magasságmérő beállítások, 6. oldal.
Gyári visszaállítás – Magasságmérő gyári beállításainak visszaállítása.

Magasságmérő beállítások
A magasságmérő képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 > Magasságmérő beállítá-
sok pontot.
Automata kalibráció: a készülék minden egyes bekapcsolásakor a magas-

ságmérő kalibrálja önmagát. 
Barométer üzemmód: Változó magasság – lehetővé teszi, hogy a baromé-

ter haladás közben mérje a magasság változásait. – 
  Fix magasság – feltételezi, hogy a készülék egy adott magasságon fixen 

tartózkodik. Így a légköri nyomás változása kizárólag az időjárás változá-
sából eredhet.

Nyomásváltozás: A nyomásadatok rögzítésének módja. A Mentés mindig 
opcióval minden nyomásadatot rögzítünk, amely nyomásfrontok figyelé-
sénél hasznos lehet.
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Rajz típusa: a grafikonon megjelenő adatpárosítást választhatjuk ki: ma-
gasság változása az idő függvényében, magasság változása a távolság 
függvényében, barométernyomás változása idő függvényében, légnyo-
más változása az idő függvényében.

Magasságmérő kalibrálás: a barometrikus magasságmérőt kalibrálhat-
juk (Barometrikus magasságmérő kalibrálása, 7. oldal).

Barometrikus magasságmérő kalibrálása
Amennyiben ismerjük tartózkodási helyünk pontos magasságát vagy a jel-
lemző légnyomást, kézzel elvégezhetjük a nyomásmérő kalibrációját.
1.  Menjünk arra a helyre, amelynek ismerjük pontos magasságát vagy lég-

köri nyomását.
2.  A magasságmérő képernyőjén válasszuk a a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Magasságmérő beál-
lítások > Magasságmérő kalibrálása pontot.

3.  Kövessük a képernyőn megjelenő utasításokat.

Vezeték nélküli kapcsolaton keresztül elérhető 
funkciók

A készüléket vezeték nélküli hálózatra, vagy Bluetooth®-funkción keresztül 
kompatibilis okostelefonra csatlakoztatva számos kiegészítő funkció elérhe-
tővé válik. Egyes funkciókhoz a csatlakoztatott okostelefonon telepítenünk 
kell a Garmin Connect™ vagy a Garmin Explore alkalmazást. Az alkalmazás-
ról a garmin.com/apps oldalon tájékozódhatunk.
Bluetooth-kompatibilis érzékelők – Bluetooth-kompatibilis érzékelők (mint 

pl. a pulzusszámmérő) csatlakoztatását teszi lehetővé.
Connect IQ™ – a készülék funkcióit új alkalmazásokkal, widgetekkel, adat-

mezőkkel bővíthetjük ki.
EPO letöltések – a Garmin Connect alkalmazás segítségével vagy Wi-Fi há-

lózati kapcsolaton keresztül GPS-műholdak bemérését meggyorsíthatjuk, 
illetve a pozíció meghatározásához szükséges időt lerövidíthetjük olyan 
speciális fájlok letöltésével, melyek a földkörüli pályán a műholdak becsült 
helyzetét tartalmazzák.

BirdsEye műholdképek – Wi-Fi kapcsolaton keresztül BirdsEye műholdké-
peket tölthetünk le a készülékre.

Garmin Explore – a Garmin Explore alkalmazás útpontokat, pályákat és út-
vonalakat szinkronizál a készülékünkkel. Segítségével okostelefonunkra 
térképeket is letölthetünk, hogy internetkapcsolat nélkül is használni tud-
juk azokat.

Élő geoláda adatok – ingyenes és előfizetést igénylő szolgáltatások igény-
be vételével a www.geocaching.com oldalról élő geoláda-hely adatokhoz 
férhetünk hozzá a Garmin Connect alkalmazás segítségével, illetve Wi-Fi 
kapcsolaton keresztül.

Nyomon követés – pályapontokat rögzíthetünk, és továbbíthatjuk azokat az 
Iridium műholdas hálózaton keresztül. A terepről inReach üzenetet küld-
ve meghívhatjuk ismerőseinket is. Ez a funkció lehetővé teszi ismerőse-
ink számára, hogy élő adatainkat a MapShare követő oldalon nézhessék 
a Garmin Explore fiókunk segítségével.

Élő követés – barátok és családtagok valós időben követhetik nyomon a ver-
senyt, tevékenységet. Emailben vagy közösségi hálón keresztül is hívha-
tunk „nézőket”, akik a Garmin Connect követő oldalán élőben látják a mé-
rési adatokat.

Telefonos értesítések – telefonos értesítések, üzenetek megjelenítése a ké-
szüléken.

Szoftverfrissítések – a készülékre szoftverfrissítéseket tölthetünk le a 
Garmin Connect alkalmazáson vagy Wi-Fi hálózaton keresztül.

Aktív időjárás – a Garmin Connect alkalmazás segítségével vagy Wi-Fi há-
lózaton keresztül megtekinthetjük az aktuális időjárási viszonyokat és az 
időjárás előrejelzéseket.

inReach időjárás – inReach előfizetésünkön keresztül is kaphatunk időjárá-
si adatokat. Kérhetjük az alapvető, prémium vagy tengeri időjárási ada-
tok előrejelzését.

Vezeték nélküli kapcsolattal elérhető funkciók 
rendszerkövetelményei
Egyes funkciókhoz okostelefon és az okostelefonon futó külön alkalmazás-
ra van szükség.

Funkció

Csatlakoztatás párosított 
okostelefonhoz, melyen 

fut a Garmin Connect 
Mobile alkalmazás

Csatlakoztatás  
Wi-Fi® 

hálózathoz

Tevékenység feltöltése a 
Garmin Connect fiókba igen igen

Szoftverfrissítés igen igen
EPO letöltés igen igen
Élő geoláda adatok igen igen
Időjárás igen igen
Telefonos értesítések igen* nem
Connect IQ igen nem
BirdsEye műholdképek nem igen

* A készülék párosított iOS telefonról közvetlenül, Android telefon esetén a 
Garmin Connect alkalmazáson keresztül képes fogadni a telefonos értesí-
téseket.

Okostelefon párosítása
1.  Hozzuk az okostelefont és a készüléket 10 méteres távolságon belülre.
2.  A készüléken az alkalmazás fiókbanválasszuk a Beállítások > Bluetooth 

> Telefon beállítása pontot.
3.  Kompatibilis okostelefonunkon aktiváljuk a Bluetooth funkciót, majd indít-

suk el a Garmin Connect alkalmazást.
4.  A Garmin Connect alkalmazás 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 vagy 

Plot Type: Records elevation changes over a period of time or 
distance, records barometric pressure over a period of time, 
or records ambient pressure changes over a period of time.

Calibrate Altimeter: Allows you to manually calibrate the 
barometric altimeter (Calibrating the Barometric Altimeter, 
page 7).

Calibrating the Barometric Altimeter
You can manually calibrate the barometric altimeter if you know 
the correct elevation or the correct barometric pressure.
1 Go to a location where the elevation or barometric pressure 

is known.
2 From the altimeter, select  > Altimeter Setup > Calibrate 

Altimeter.
3 Follow the on-screen instructions.

Connected Features
Connected features are available for your Montana device when 
you connect the device to a wireless network or a compatible 
smartphone using Bluetooth technology. Some features require 
you to install the Garmin Connect™ app or Garmin Explore app 
on your smartphone. Go to garmin.com/apps for more 
information.
Bluetooth sensors: Allows you to connect Bluetooth 

compatible sensors, such as a heart rate monitor.
Connect IQ™: Allows you to extend your device features with 

widgets, data fields, and apps using the Connect IQ app.
EPO Downloads: Allows you to download an extended 

prediction orbit file to quickly locate GPS satellites and 
reduce the time it takes to get an initial GPS fix using the 
Garmin Connect app or when connected to a Wi‑Fi network.

BirdsEye imagery: Allows you to download BirdsEye Satellite 
Imagery directly to your device when connected to a Wi‑Fi 
network.

Garmin Explore: The Garmin Explore app syncs and shares 
waypoints, tracks, and routes with your device. You can also 
download maps to your smartphone for offline access.

Live Geocache Data: Provides paid or subscription-free 
services to view live geocache data from 
www.geocaching.com using the Garmin Connect app or 
when connected to a Wi‑Fi network.

Tracking: Allows you to record track points and transmit them 
over the Iridium satellite network. You can invite contacts by 
sending them an inReach message from the field. This 
feature allows your contacts to view your live data on a 
MapShare tracking page using your Garmin Explore account.

LiveTrack: Allows friends and family to follow your activities in 
real time. You can invite followers using email or social 
media, allowing them to view your live data on a Garmin 
Connect tracking page.

Phone notifications: Displays phone notifications and 
messages on your Montana device using the Garmin 
Connect app.

Software Updates: Allows you to receive updates for your 
device software using the Garmin Connect app or when 
connected to a Wi‑Fi network.

Active Weather: Allows you to view current weather conditions 
and weather forecasts using the Garmin Connect app or 
when connected to a Wi‑Fi network.

inReach Weather: Allows you to receive weather information 
through your inReach subscription. You can request a basic, 
premium, or marine weather forecast.

Connected Feature Requirements
Some features require a smartphone and a specific app on your 
smartphone.
Feature Connected to a Paired 

Smartphone with the 
Garmin Connect App

Connected to a 
Wi‑Fi Network

Activity uploads to 
Garmin Connect

Yes Yes

Software updates Yes Yes
EPO downloads Yes Yes
Live geocache data Yes Yes
Weather Yes Yes
Phone notifications Yes1 No
Connect IQ Yes No
BirdsEye Direct imagery No Yes

Pairing a Smartphone with Your Device
1 Bring your compatible smartphone within 10 m (33 ft.) of your 

device.
2 Select Setup > Bluetooth > Phone Setup.
3 On your compatible smartphone, enable Bluetooth 

technology, and open the Garmin Connect app.
4 From the  or  menu in the Garmin Connect app, select 

Garmin Devices > Add Device, and follow the on-screen 
instructions to pair your device.

5 Download and open the Garmin Explore app.
6 Log in to the Garmin Explore app using your Garmin Connect 

username and password.
7 Select the device option to pair your device with the Garmin 

Explore app.

Phone Notifications
Phone notifications require a compatible smartphone to be 
paired with the Montana device. When your phone receives 
messages, it sends notifications to your device.
Viewing Phone Notifications
Before you can view notifications, you must pair your device with 
your compatible smartphone.
1 Select  > Notifications.
2 Select a notification.
Hiding Notifications
Notifications are enabled by default when you pair your device 
with a compatible smartphone. You can hide notifications so 
they do not appear on your device screen.
1 Select Setup > Bluetooth > Phone Setup.
2 Select Notifications to turn off notifications on the device.
Managing Notifications
You can use your compatible smartphone to manage 
notifications that appear on your Montana device.

Select an option:
• If you are using an iPhone® device, go to the iOS 

notifications settings to select the items to show on the 
device.

• If you are using an Android smartphone, from the Garmin 
Connect app, select Settings > Smart Notifications.

Connecting to a Wireless Network
1 Select Setup > Wi-Fi.
2 If necessary, select the toggle switch to enable Wi‑Fi 

technology.

1 The device receives phone notifications from a paired iOS® phone directly, and 
through the Garmin Connect app on an Android™ phone.
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 menüjében válasszuk a 
Garmin készülékek > Készülék hozzáadása pontot, majd kövessük a 
képernyőn megjelenő utasításokat a párosításhoz.

5.  Töltsük le és lépjünk be a Garmin Explore™ alkalmazásba.
6.  Jelentkezzük be a Garmin Explore alkalmazásba a Garmin Connect fel-

használónevünk és jelszónk segítségével.
7.  Válasszuk a készülék opciót a Garmin Explore alkalmazás és a készülék 

párosításához.

Telefonos értesítések
Ehhez először kompatibilis okostelefonunkat párosítanunk kell a Montana 
készülékkel. Amikor a telefonunk üzenetet kap, értesítést küld a készülékre.

Telefonos értesítések megtekintése
Ehhez először párosítanunk kell a készüléket a kompatibilis okostelefonunkkal.
1.   Nyomjuk le a 

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .

Introduction 1

 gombot, majd válasszuk az Értesítések pontot.
2.   Válasszuk ki az értesítést.

Értesítések elrejtése
Az értesítések alapértelmezetten megjelenítésre kerülnek, amikor az 
okostelefona készülékre küldi azokat. Az értesítéseket elrejthetjük, így nem 
jelennek meg.
1. Válasszuk a Beállítások > Bluetooth > Telefon beállítása pontot.
2. Válasszuk az Értesítések pontot az értesítések kikapcsolásához a ké-

szüléken.

Értesítések kezelése
Az okostelefonon kezelhetjük a készüléken megjelenő értesítéseket. Válasz-
szunk az alábbi lehetőségek közül:

• iPhone® készülék esetén az iOS értesítési beállításain keresztül vá-
laszthatjuk ki azon elemeket, melyekről a készüléken értesítést kívá-
nunk kapni.

•  Android™ készülék esetén a Garmin Connect alkalmazásban válasz-
szuk a Beállítások > Okos értesítések pontot.

Csatlakozás vezeték nélküli hálózathoz
1.  Válasszuk a Beállítások > Wi-Fi pontot.
2.  Ha szükséges, a billenőkapcsolóval kapcsoljuk be és ki a Wi-Fi-t.
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3. Válasszuk a Hálózat hozzáadása pontot.
4. Válasszunk az alábbiak közül:

• Szabadon elérhető vezeték nélküli hálózathoz való csatlakozáshoz vá-
lasszunk egy hálózatot a listából, és amennyiben szükséges, adjuk meg 
a jelszót.

• Lokális vezeték nélküli hálózathoz való csatlakozáshoz válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 
> Hálózat hozzáadása pontot, majd adjuk meg a hálózat SSID azono-
sítóját és jelszavát.

A készülék csatlakozik a vezeték nélküli hálózathoz és egyúttal eltárolja a há-
lózat adatokat, majd automatikusan csatlakozik, amikor visszatérünk ugyan-
erre a helyre.

Wi-Fi kapcsolat beállítása
A Wi-Fi funkciók használatához először be kell állítanunk a Wi-Fi kapcsolatot 
a Garmin Express™ alkalmazás segítségével.
1.  Lépjünk fel a garmin.com/express oldalra, és töltsük le a Garmin Express 

alkalmazást.
2.  Válasszuk ki a készülékünket.
3.  Válasszuk az Eszközök > Segédeszközök pontot.
4.  Kövessük a képernyőn megjelenő utasításokat a Wi-Fi kapcsolat beállítá-

sához a Garmin Express alkalmazás segítségével.

Connect IQ funkciók
A Garmin Connect alkalmazáson keresztül a Garmintól vagy más külső fej-
lesztőtől származó Connect IQ bővítményeket adhatunk a készülékhez. 
Ezek lehetnek adatmezők, widgetek, alkalmazások.
Adatmezők: olyan új adattípusokkal bővíthetjük a készüléket, melyek a mé-

rők által közölt adatokat, a végzett tevékenységet, illetve a napló tartal-
mát teljes új szemszögből mutatják be. A Connect IQ adatmezőket a gyári 
funkciókhoz és képernyőkhöz gond nélkül hozzárendelhetjük.

Widgetek: információs ablakok, melyek révén egyetlen pillantással tájéko-
zódhatunk a mérési adatokról, értesítésekről.

Alkalmazások: interaktív funkciókkal bővítik a készüléket, pl. új szabadtéri 
és sport tevékenységek.

Connect IQ funkciók letöltése
Amennyiben a Connect IQ funkciókat a Garmin Connect alkalmazá-
son keresztül kívánjuk letölteni, először párosítsuk a készüléket egy kom-
patibilis okostelefonnal, melyen futtassuk a Garmin Connect alkalmazást 
(Okostelefon párosítása, 7. oldal).
1.   Okostelefonunk alkalmazás áruházábból telepítsük és lépjünk be a  

Connect IQ alkalmazásba.
2.  Ha szükséges, válasszuk ki a készüléket.
3. Válasszuk ki a Connect IQ funkciót.
4. Kövessük a képernyőn megjelenő utasításokat.

Connect IQ funkciók letöltése számítógépről
1.   USB-kábellel csatlakoztassuk a készüléket a számítógéphez.
2.   Lépjünk fel az apps.garmin.com oldalra, és lépjünk be fiókunkba.
3.   Válasszuk ki a kívánt Connect IQ funkciót, majd töltsük le.
4.   Kövessük a képernyőn megjelenő utasításokat.

Garmin Explore™
A Garmin Explore weboldal és mobil alkalmazás lehetővé teszik az utazások 
megtervezését, valamint az úticéljaink, útvonalaink és pályáink felhő alapú 
tárolását. Összetett tervezési lehetőséget biztosítanak, amely lehetővé teszi, 
hogy adatainkat megosszuk és szinkronizáljuk kompatibilis Garmin eszkö-
zünkkel. A mobil alkalmazást térképek letöltésére használhatjuk, amelyeket 
offline módban használhatunk, és bármerre navigálhatunk velük, mobil adat-
forgalom használata nélkül.
A Garmin Explore alkalmazást okostelefonunk alkalmazás áruházából tölt-
hetjük le, illetve felléphetünk az explore.garmin.com oldalra.

Vezeték nélküli fülhallgató
A készülék hangos navigációs parancsokat képes lejátszani Bluetooth veze-
ték nélküli kapcsolattal működő fülhallgatón keresztül.

Vezeték nélküli fülhallgató párosítása a készülékkel
A navigációs utasítások fülhallgatón keresztüli lejátszásához először páro-
sítanunk kell a kompatibilis fülhallgatóval Bluetooth technológián keresztül.
MEGJEGYZÉS! Egyszerre csak egy fülhallgatóval létesíthetünk kapcsolatot.
1.  Hozzuk az eszközt és a fülhallgatót 10 méteres távolságon belül egymáshoz.
2.  A fülhallgatón kapcsoljuk be a Bluetooth technológiát, és gondoskodjunk 

róla, hogy más Bluetooth technológiás készülékek számára látható le-
gyen.

3.  A Montana készüléken válasszuk a Beállítások > Bluetooth > Audio ké-
szülék > Készülék hozzáadása pontot.

 Megjelenik a közeli Bluetooth technológiás készülékek listája.
4.  Válasszuk ki a fülhallgatónkat a listából.
Útvonalon történő navigáció során a készülék a fülhallgatón keresztül navi-
gációs utasításokat ad le.

Vezeték nélküli fülhallgatóval létesített kapcsolat bontása, 
fülhallgató eltávolítása
1.  Válasszuk a Beállítások > Bluetooth > Audio készülék pontot.
2.  Válasszuk ki a fülhallgatónkat.
3.  Válasszunk az alábbi lehetőségek közül:
 •   A Kapcsolat bontása ponttal bontjuk a fülhallgatóval létesített kap-

csolatot anélkül, hogy törölnénk a párosított készülékek listájából.
 •   Az Eltávolítás ponttal töröljük a fülhallgatót a párosított készülékek lis-

tájából.

Navigáció
Hova? képernyő
A 

3 Select Add Network.
4 Select an option:

• To select a broadcast wireless network, select a wireless 
network from the list and enter the password, if necessary.

• To select a non-broadcast wireless network, select  > 
Add Network, and enter the network SSID and password.

The device stores the network information and connects 
automatically when you return to this location.

Setting Up Wi‑Fi Connectivity
Before you can use Wi‑Fi features, you must set up the Wi‑Fi 
connection using the Garmin Express™ application.
1 Go to garmin.com/express, and download the Garmin 

Express application.
2 Select the device.
3 Select Tools > Utilities.
4 Follow the on-screen instructions to set up Wi‑Fi connectivity 

with the Garmin Express application.

Connect IQ Features
You can add Connect IQ features to your device from Garmin 
and other providers using the Connect IQ app. You can 
customize your device with data fields, widgets, and apps.
Data Fields: Allow you to download new data fields that present 

sensor, activity, and history data in new ways. You can add 
Connect IQ data fields to built-in features and pages.

Widgets: Provide information at a glance, including sensor data 
and notifications.

Apps: Add interactive features to your device, such as new 
outdoor and fitness activity types.

Downloading Connect IQ Features
Before you can download features from the Connect IQ app, you 
must pair your Montana device with your smartphone (Pairing a 
Smartphone with Your Device, page 7).
1 From the app store on your smartphone, install and open the 

Connect IQ app.
2 If necessary, select your device.
3 Select a Connect IQ feature.
4 Follow the on-screen instructions.

Downloading Connect IQ Features Using Your 
Computer
1 Connect the device to your computer using a USB cable.
2 Go to apps.garmin.com, and sign in.
3 Select a Connect IQ feature, and download it.
4 Follow the on-screen instructions.

Garmin Explore
The Garmin Explore website and mobile app allow you to plan 
trips and use cloud storage for your waypoints, routes, and 
tracks. They offer advanced planning both online and offline, 
allowing you to share and sync data with your compatible 
Garmin device. You can use the mobile app to download maps 
for offline access, and then navigate anywhere without using 
your cellular service.
You can download the Garmin Explore app from the app store 
on your smartphone, or you can go to explore.garmin.com.

Wireless Headsets
Your device can send audio navigation prompts to a Bluetooth 
enabled wireless headset.

Pairing a Wireless Headset with Your Device
Before you can receive navigation prompts through your 
headset, you must pair your device with a compatible headset 
with Bluetooth technology.
NOTE: Only one headset can be active at a time.
1 Place your headset and your Montana device within 10 m 

(33 ft.) of each other.
2 On your headset, enable Bluetooth technology and make it 

visible to other Bluetooth devices.
3 On your Montana device, select Setup > Bluetooth > Audio 

Device > Add Device.
A list of nearby Bluetooth devices appears.

4 Select your headset from the list.
Your device sends navigation prompts to your headset as you 
navigate a route.

Disconnecting or Removing a Wireless Headset
1 Select Setup > Bluetooth > Audio Device.
2 Select your headset.
3 Select an option:

• To temporarily disconnect a headset without deleting it 
from the paired devices list, select Disconnect Device.

• To delete a headset from the paired devices list, select 
Remove.

Navigation
Where To? Page
You can use the  page to find a destination to navigate to. Not 
all Where To? categories are available in all areas and maps.

Navigating to a Destination
1 Select .
2 Select a category.
3 If necessary, select  > Spell Search, and enter the 

destination name or part of the name.
4 Select a destination.
5 Select Go.
6 If necessary, select the activity type.
7 If necessary, select the route calculation method.

Your route appears as a colored line on the map.
8 Navigate using the map (Navigating with the Map, page 5) or 

compass (Navigating with the Compass, page 5).
Stopping Navigation

From the map or compass, select  > Stop Navigation.

Finding an Address
You can use the preloaded City Navigator® maps on the 
Montana 700i/750i device to search for addresses.
You can purchase City Navigator maps for the Montana 700 
device. See Optional Maps, page 9 for more information.
1 Select  > Addresses.
2 Select Search Area, and enter the country, region, or city.
3 Select Number, and enter the house number.
4 Select Street Name, and enter the street.
Navigating a Driving Route
Before you can navigate street routes, you must have City 
Navigator maps or other maps with street routes installed.
1 Select Profile Change > Driving.
2 Select a destination.
3 Navigate using the map.
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 képernyő segítségével úticélokra kereshetünk rá, ahová aztán elnavi-
gálhatunk. Nem minden Hova? kategória érhető el az egyes helyeken és tér-
képeken.

Navigáció cél felé
1.  Válasszuk a 

3 Select Add Network.
4 Select an option:

• To select a broadcast wireless network, select a wireless 
network from the list and enter the password, if necessary.

• To select a non-broadcast wireless network, select  > 
Add Network, and enter the network SSID and password.

The device stores the network information and connects 
automatically when you return to this location.

Setting Up Wi‑Fi Connectivity
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customize your device with data fields, widgets, and apps.
Data Fields: Allow you to download new data fields that present 

sensor, activity, and history data in new ways. You can add 
Connect IQ data fields to built-in features and pages.

Widgets: Provide information at a glance, including sensor data 
and notifications.
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Before you can download features from the Connect IQ app, you 
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Connect IQ app.
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for offline access, and then navigate anywhere without using 
your cellular service.
You can download the Garmin Explore app from the app store 
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Wireless Headsets
Your device can send audio navigation prompts to a Bluetooth 
enabled wireless headset.

Pairing a Wireless Headset with Your Device
Before you can receive navigation prompts through your 
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with Bluetooth technology.
NOTE: Only one headset can be active at a time.
1 Place your headset and your Montana device within 10 m 

(33 ft.) of each other.
2 On your headset, enable Bluetooth technology and make it 

visible to other Bluetooth devices.
3 On your Montana device, select Setup > Bluetooth > Audio 

Device > Add Device.
A list of nearby Bluetooth devices appears.

4 Select your headset from the list.
Your device sends navigation prompts to your headset as you 
navigate a route.

Disconnecting or Removing a Wireless Headset
1 Select Setup > Bluetooth > Audio Device.
2 Select your headset.
3 Select an option:

• To temporarily disconnect a headset without deleting it 
from the paired devices list, select Disconnect Device.

• To delete a headset from the paired devices list, select 
Remove.

Navigation
Where To? Page
You can use the  page to find a destination to navigate to. Not 
all Where To? categories are available in all areas and maps.

Navigating to a Destination
1 Select .
2 Select a category.
3 If necessary, select  > Spell Search, and enter the 

destination name or part of the name.
4 Select a destination.
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6 If necessary, select the activity type.
7 If necessary, select the route calculation method.

Your route appears as a colored line on the map.
8 Navigate using the map (Navigating with the Map, page 5) or 

compass (Navigating with the Compass, page 5).
Stopping Navigation

From the map or compass, select  > Stop Navigation.

Finding an Address
You can use the preloaded City Navigator® maps on the 
Montana 700i/750i device to search for addresses.
You can purchase City Navigator maps for the Montana 700 
device. See Optional Maps, page 9 for more information.
1 Select  > Addresses.
2 Select Search Area, and enter the country, region, or city.
3 Select Number, and enter the house number.
4 Select Street Name, and enter the street.
Navigating a Driving Route
Before you can navigate street routes, you must have City 
Navigator maps or other maps with street routes installed.
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 pontot.
2.  Válasszunk egy kategóriát.
3.  Amennyiben szükséges, válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Betűzés pontot, és adjuk meg 
az úticél teljes vagy részleges nevét.

4.  Válasszuk ki a kívánt úticélt.
5.  Válasszuk a Menj pontot.
6.  Amennyiben szükséges, válasszuk ki a tevékenység típusát.
7.  Amennyiben szükséges, válasszuk ki az útvonalszámítás módszerét.
8.  Navigáljunk a térképen (Navigáció a térképen, 5. oldal) vagy az iránytűvel 

(Navigáció az iránytűvel, 5. oldal).

Navigáció leállítása
A térkép vagy iránytű képernyőről válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Navigáció leállítása 
pontot.

Cím keresése
Cím kereséséhez a Montana 700i/750i készülékre előre feltöltött City 
Navigator® térképeket használhatunk.
City Navigator térképeket vásárolhatunk a Montana 700 készülékre. További 
információkért lásd az Opcionális térképek, 9. oldalon.
1.  Válasszuk a 

3 Select Add Network.
4 Select an option:

• To select a broadcast wireless network, select a wireless 
network from the list and enter the password, if necessary.

• To select a non-broadcast wireless network, select  > 
Add Network, and enter the network SSID and password.

The device stores the network information and connects 
automatically when you return to this location.

Setting Up Wi‑Fi Connectivity
Before you can use Wi‑Fi features, you must set up the Wi‑Fi 
connection using the Garmin Express™ application.
1 Go to garmin.com/express, and download the Garmin 

Express application.
2 Select the device.
3 Select Tools > Utilities.
4 Follow the on-screen instructions to set up Wi‑Fi connectivity 

with the Garmin Express application.

Connect IQ Features
You can add Connect IQ features to your device from Garmin 
and other providers using the Connect IQ app. You can 
customize your device with data fields, widgets, and apps.
Data Fields: Allow you to download new data fields that present 

sensor, activity, and history data in new ways. You can add 
Connect IQ data fields to built-in features and pages.

Widgets: Provide information at a glance, including sensor data 
and notifications.

Apps: Add interactive features to your device, such as new 
outdoor and fitness activity types.

Downloading Connect IQ Features
Before you can download features from the Connect IQ app, you 
must pair your Montana device with your smartphone (Pairing a 
Smartphone with Your Device, page 7).
1 From the app store on your smartphone, install and open the 

Connect IQ app.
2 If necessary, select your device.
3 Select a Connect IQ feature.
4 Follow the on-screen instructions.

Downloading Connect IQ Features Using Your 
Computer
1 Connect the device to your computer using a USB cable.
2 Go to apps.garmin.com, and sign in.
3 Select a Connect IQ feature, and download it.
4 Follow the on-screen instructions.

Garmin Explore
The Garmin Explore website and mobile app allow you to plan 
trips and use cloud storage for your waypoints, routes, and 
tracks. They offer advanced planning both online and offline, 
allowing you to share and sync data with your compatible 
Garmin device. You can use the mobile app to download maps 
for offline access, and then navigate anywhere without using 
your cellular service.
You can download the Garmin Explore app from the app store 
on your smartphone, or you can go to explore.garmin.com.

Wireless Headsets
Your device can send audio navigation prompts to a Bluetooth 
enabled wireless headset.

Pairing a Wireless Headset with Your Device
Before you can receive navigation prompts through your 
headset, you must pair your device with a compatible headset 
with Bluetooth technology.
NOTE: Only one headset can be active at a time.
1 Place your headset and your Montana device within 10 m 

(33 ft.) of each other.
2 On your headset, enable Bluetooth technology and make it 

visible to other Bluetooth devices.
3 On your Montana device, select Setup > Bluetooth > Audio 

Device > Add Device.
A list of nearby Bluetooth devices appears.

4 Select your headset from the list.
Your device sends navigation prompts to your headset as you 
navigate a route.

Disconnecting or Removing a Wireless Headset
1 Select Setup > Bluetooth > Audio Device.
2 Select your headset.
3 Select an option:

• To temporarily disconnect a headset without deleting it 
from the paired devices list, select Disconnect Device.

• To delete a headset from the paired devices list, select 
Remove.

Navigation
Where To? Page
You can use the  page to find a destination to navigate to. Not 
all Where To? categories are available in all areas and maps.

Navigating to a Destination
1 Select .
2 Select a category.
3 If necessary, select  > Spell Search, and enter the 

destination name or part of the name.
4 Select a destination.
5 Select Go.
6 If necessary, select the activity type.
7 If necessary, select the route calculation method.

Your route appears as a colored line on the map.
8 Navigate using the map (Navigating with the Map, page 5) or 

compass (Navigating with the Compass, page 5).
Stopping Navigation

From the map or compass, select  > Stop Navigation.

Finding an Address
You can use the preloaded City Navigator® maps on the 
Montana 700i/750i device to search for addresses.
You can purchase City Navigator maps for the Montana 700 
device. See Optional Maps, page 9 for more information.
1 Select  > Addresses.
2 Select Search Area, and enter the country, region, or city.
3 Select Number, and enter the house number.
4 Select Street Name, and enter the street.
Navigating a Driving Route
Before you can navigate street routes, you must have City 
Navigator maps or other maps with street routes installed.
1 Select Profile Change > Driving.
2 Select a destination.
3 Navigate using the map.

8 Navigation

 > Címek pontot.
2.  Válasszuk a Keresési zóna pontot, majd adjuk meg az ország, régió 

vagy város nevét.
3.  Válasszuk a Házszám pontot, majd adjuk meg a házszámot.
4.  Válasszuk az Utcanév pontot, majd adjuk meg az utcanevet.

Navigáció vezetőútvonal mentén
Utcai útvonalakon történő navigációhoz először City Navigator térképeket, il-
letve egyéb, utcai útvonalakkal rendelkező térképeket kell telepítenünk a ké-
szülékre.
1.  Válasszuk a Profilváltás > Vezetés pontot.
2.  Válasszuk ki az úticélt.
3.  Navigáljunk a térkép segítségével.

http://garmin.com/express
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 A kanyarok a térkép tetején található szövegsávban jelennek meg. Az út-
vonalon található kanyarokat a készülék hangjelzésekkel jelzi.

Opcionális térképek
A készülékkel opcionálisan beszerezhető térképeket is használhatunk. Ilye-
nek például a BirdsEye műholdképek, a City Navigator térképek, valamint a 
Garmin HuntView™ Plus részletes térképek. A részletes térképek további ér-
dekes helyeket tartalmazhatnak, mint például éttermeket vagy tengeri szol-
gáltatásokat. További információkért forduljunk a Garmin ügyfélszolgálathoz.

Térképek aktiválása
Aktiválhatjuk a készülékre telepített térképeket.
1.  A térkép képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 > Térkép beállítása > Térkép infor-
máció pontot.

2.  A billenőkapcsolók segítségével aktiválhatjuk az egyes térképeket.

Hely közelében található hely keresése
1.  Válasszuk a 

3 Select Add Network.
4 Select an option:

• To select a broadcast wireless network, select a wireless 
network from the list and enter the password, if necessary.

• To select a non-broadcast wireless network, select  > 
Add Network, and enter the network SSID and password.

The device stores the network information and connects 
automatically when you return to this location.

Setting Up Wi‑Fi Connectivity
Before you can use Wi‑Fi features, you must set up the Wi‑Fi 
connection using the Garmin Express™ application.
1 Go to garmin.com/express, and download the Garmin 

Express application.
2 Select the device.
3 Select Tools > Utilities.
4 Follow the on-screen instructions to set up Wi‑Fi connectivity 

with the Garmin Express application.

Connect IQ Features
You can add Connect IQ features to your device from Garmin 
and other providers using the Connect IQ app. You can 
customize your device with data fields, widgets, and apps.
Data Fields: Allow you to download new data fields that present 

sensor, activity, and history data in new ways. You can add 
Connect IQ data fields to built-in features and pages.

Widgets: Provide information at a glance, including sensor data 
and notifications.

Apps: Add interactive features to your device, such as new 
outdoor and fitness activity types.

Downloading Connect IQ Features
Before you can download features from the Connect IQ app, you 
must pair your Montana device with your smartphone (Pairing a 
Smartphone with Your Device, page 7).
1 From the app store on your smartphone, install and open the 

Connect IQ app.
2 If necessary, select your device.
3 Select a Connect IQ feature.
4 Follow the on-screen instructions.

Downloading Connect IQ Features Using Your 
Computer
1 Connect the device to your computer using a USB cable.
2 Go to apps.garmin.com, and sign in.
3 Select a Connect IQ feature, and download it.
4 Follow the on-screen instructions.

Garmin Explore
The Garmin Explore website and mobile app allow you to plan 
trips and use cloud storage for your waypoints, routes, and 
tracks. They offer advanced planning both online and offline, 
allowing you to share and sync data with your compatible 
Garmin device. You can use the mobile app to download maps 
for offline access, and then navigate anywhere without using 
your cellular service.
You can download the Garmin Explore app from the app store 
on your smartphone, or you can go to explore.garmin.com.

Wireless Headsets
Your device can send audio navigation prompts to a Bluetooth 
enabled wireless headset.

Pairing a Wireless Headset with Your Device
Before you can receive navigation prompts through your 
headset, you must pair your device with a compatible headset 
with Bluetooth technology.
NOTE: Only one headset can be active at a time.
1 Place your headset and your Montana device within 10 m 

(33 ft.) of each other.
2 On your headset, enable Bluetooth technology and make it 

visible to other Bluetooth devices.
3 On your Montana device, select Setup > Bluetooth > Audio 

Device > Add Device.
A list of nearby Bluetooth devices appears.

4 Select your headset from the list.
Your device sends navigation prompts to your headset as you 
navigate a route.

Disconnecting or Removing a Wireless Headset
1 Select Setup > Bluetooth > Audio Device.
2 Select your headset.
3 Select an option:

• To temporarily disconnect a headset without deleting it 
from the paired devices list, select Disconnect Device.

• To delete a headset from the paired devices list, select 
Remove.

Navigation
Where To? Page
You can use the  page to find a destination to navigate to. Not 
all Where To? categories are available in all areas and maps.

Navigating to a Destination
1 Select .
2 Select a category.
3 If necessary, select  > Spell Search, and enter the 

destination name or part of the name.
4 Select a destination.
5 Select Go.
6 If necessary, select the activity type.
7 If necessary, select the route calculation method.

Your route appears as a colored line on the map.
8 Navigate using the map (Navigating with the Map, page 5) or 

compass (Navigating with the Compass, page 5).
Stopping Navigation

From the map or compass, select  > Stop Navigation.

Finding an Address
You can use the preloaded City Navigator® maps on the 
Montana 700i/750i device to search for addresses.
You can purchase City Navigator maps for the Montana 700 
device. See Optional Maps, page 9 for more information.
1 Select  > Addresses.
2 Select Search Area, and enter the country, region, or city.
3 Select Number, and enter the house number.
4 Select Street Name, and enter the street.
Navigating a Driving Route
Before you can navigate street routes, you must have City 
Navigator maps or other maps with street routes installed.
1 Select Profile Change > Driving.
2 Select a destination.
3 Navigate using the map.

8 Navigation

 > 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Keresés közelben pontot.
2.  Válasszunk egy lehetőséget.
3.  Válasszunk egy helyet.

Útpontok
Az útpontok általunk megjelölt és elmentett helyek. Útponttal rögzíthetjük, 
hogy éppen hol tartózkodunk, hogy korábban hol tartózkodtunk, vagy hova 
kívánunk eljutni.

Útpont létrehozása
Pillanatnyi tartózkodási helyünket megjelölhetjük és elmenthetjük útpontként.
1.  Válasszuk az Útpont megjelölése pontot.
2.  Amennyiben szükséges, válasszunk egy mezőt az útpont szerkesztésé-

hez.
3.  Válasszuk a Mentés pontot.

Navigáció útpont felé
1. Válasszuk a 

3 Select Add Network.
4 Select an option:

• To select a broadcast wireless network, select a wireless 
network from the list and enter the password, if necessary.

• To select a non-broadcast wireless network, select  > 
Add Network, and enter the network SSID and password.

The device stores the network information and connects 
automatically when you return to this location.

Setting Up Wi‑Fi Connectivity
Before you can use Wi‑Fi features, you must set up the Wi‑Fi 
connection using the Garmin Express™ application.
1 Go to garmin.com/express, and download the Garmin 

Express application.
2 Select the device.
3 Select Tools > Utilities.
4 Follow the on-screen instructions to set up Wi‑Fi connectivity 

with the Garmin Express application.

Connect IQ Features
You can add Connect IQ features to your device from Garmin 
and other providers using the Connect IQ app. You can 
customize your device with data fields, widgets, and apps.
Data Fields: Allow you to download new data fields that present 

sensor, activity, and history data in new ways. You can add 
Connect IQ data fields to built-in features and pages.

Widgets: Provide information at a glance, including sensor data 
and notifications.

Apps: Add interactive features to your device, such as new 
outdoor and fitness activity types.

Downloading Connect IQ Features
Before you can download features from the Connect IQ app, you 
must pair your Montana device with your smartphone (Pairing a 
Smartphone with Your Device, page 7).
1 From the app store on your smartphone, install and open the 

Connect IQ app.
2 If necessary, select your device.
3 Select a Connect IQ feature.
4 Follow the on-screen instructions.

Downloading Connect IQ Features Using Your 
Computer
1 Connect the device to your computer using a USB cable.
2 Go to apps.garmin.com, and sign in.
3 Select a Connect IQ feature, and download it.
4 Follow the on-screen instructions.

Garmin Explore
The Garmin Explore website and mobile app allow you to plan 
trips and use cloud storage for your waypoints, routes, and 
tracks. They offer advanced planning both online and offline, 
allowing you to share and sync data with your compatible 
Garmin device. You can use the mobile app to download maps 
for offline access, and then navigate anywhere without using 
your cellular service.
You can download the Garmin Explore app from the app store 
on your smartphone, or you can go to explore.garmin.com.

Wireless Headsets
Your device can send audio navigation prompts to a Bluetooth 
enabled wireless headset.

Pairing a Wireless Headset with Your Device
Before you can receive navigation prompts through your 
headset, you must pair your device with a compatible headset 
with Bluetooth technology.
NOTE: Only one headset can be active at a time.
1 Place your headset and your Montana device within 10 m 

(33 ft.) of each other.
2 On your headset, enable Bluetooth technology and make it 

visible to other Bluetooth devices.
3 On your Montana device, select Setup > Bluetooth > Audio 

Device > Add Device.
A list of nearby Bluetooth devices appears.

4 Select your headset from the list.
Your device sends navigation prompts to your headset as you 
navigate a route.

Disconnecting or Removing a Wireless Headset
1 Select Setup > Bluetooth > Audio Device.
2 Select your headset.
3 Select an option:

• To temporarily disconnect a headset without deleting it 
from the paired devices list, select Disconnect Device.

• To delete a headset from the paired devices list, select 
Remove.

Navigation
Where To? Page
You can use the  page to find a destination to navigate to. Not 
all Where To? categories are available in all areas and maps.

Navigating to a Destination
1 Select .
2 Select a category.
3 If necessary, select  > Spell Search, and enter the 

destination name or part of the name.
4 Select a destination.
5 Select Go.
6 If necessary, select the activity type.
7 If necessary, select the route calculation method.

Your route appears as a colored line on the map.
8 Navigate using the map (Navigating with the Map, page 5) or 

compass (Navigating with the Compass, page 5).
Stopping Navigation

From the map or compass, select  > Stop Navigation.

Finding an Address
You can use the preloaded City Navigator® maps on the 
Montana 700i/750i device to search for addresses.
You can purchase City Navigator maps for the Montana 700 
device. See Optional Maps, page 9 for more information.
1 Select  > Addresses.
2 Select Search Area, and enter the country, region, or city.
3 Select Number, and enter the house number.
4 Select Street Name, and enter the street.
Navigating a Driving Route
Before you can navigate street routes, you must have City 
Navigator maps or other maps with street routes installed.
1 Select Profile Change > Driving.
2 Select a destination.
3 Navigate using the map.
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 > Útpontok pontot.
2.  Válasszunk egy útpontot.
3.  Válasszuk a Menj pontot.
 Az útponthoz vezető útvonal alapértelmezetten színezett egyenes vonal-

ként jelenik meg a térképen.

Útpont keresése
1.  Válasszuk az Útpontkezelő pontot.
2.  Válasszunk egy útpontot a listából.
3.  Amennyiben szükséges a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 kiválasztásával szűkíthetjük a keresési 
kört.

4.  Válasszunk az alábbiak közül:
 •  Betűzés – az útpont nevére kereshetünk rá.
 •   Szimbólum kiválasztás – az útpont szimbóluma, típusa alapján 

kereshetünk.
 •   Keresés közelben – nemrég megtalált hely, egy másik útpont, aktuá-

lis helyünk vagy a térkép egy pontja közelében kereshetünk.
 •    Rendezés – megtekinthetjük az útpontokat távolság szerinti vagy be-

tűrendi elrendezésben.

Útpont szerkesztése
1.  Válasszuk az Útpontkezelőt.
2.  Válasszunk ki egy útpontot.
3.  Válasszuk ki a módosítandó adatot, például a nevet.
4.  Adjuk meg az új adatokat, majd válasszuk a 

Turns appear in the text bar along the top of the map. Audible 
tones signal turns in the route.

Optional Maps
You can use additional maps with the device, such as BirdsEye 
satellite imagery, City Navigator, and Garmin HuntView™ Plus 
detailed maps. Detailed maps may contain additional points of 
interest, such as restaurants or marine services. For more 
information, go to buy.garmin.com or contact your Garmin 
dealer.
Enabling Maps
You can enable map products installed on your device.
1 From the map, select  > Map Setup > Configure Maps.
2 Select the toggle switch to enable each installed map.

Finding a Location Near Another Location
1 Select  >  > Search Near.
2 Select an option.
3 Select a location.

Waypoints
Waypoints are locations you record and store in the device. 
Waypoints can mark where you are, where you are going, or 
where you have been.

Creating a Waypoint
You can save your current location as a waypoint.
1 Select Mark Waypoint.
2 If necessary, select a field to edit the waypoint.
3 Select Save.

Navigating to a Waypoint
1 Select  > Waypoints.
2 Select a waypoint.
3 Select Go.

By default, your route to the waypoint appears as a straight, 
colored line on the map.

Finding a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint from the list.
3 If necessary, select  to narrow the search.
4 Select an option:

• Select Spell Search to search using the name of the 
waypoint.

• Select Select Symbol to search using the symbol of the 
waypoint.

• Select Search Near to search near a recently found 
location, another waypoint, your current location, or a 
point on the map.

• Select Sort to view the list of waypoints based on nearest 
distance or alphabetical order.

Editing a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select an item to edit, such as the name.
4 Enter the new information, and select .

Deleting a Waypoint
1 Select Waypoint Manager >  > Delete.
2 Select an option:

• To delete one waypoint, select a waypoint.
• To delete multiple waypoints, select multiple waypoints.
• To delete all waypoints, select Select All.

3 Select Delete.

Increasing the Accuracy of a Waypoint Location
You can refine the accuracy of a waypoint location by averaging 
the location data. When averaging, the device takes several 
GPS readings at the same location and uses the average value 
to provide more accuracy.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Average Location.
4 Move to the waypoint location.
5 Select Start.
6 Follow the on-screen instructions.
7 When the confidence status bar reaches 100%, select Save.
For best results, collect four to eight samples for the waypoint, 
waiting at least 90 minutes between samples.

Projecting a Waypoint
You can save a new waypoint by projecting the distance and 
bearing from a saved waypoint to a new location.
For example, if you would like to navigate to a location you 
observe on the other side of a river or stream, you can project a 
waypoint from your current location to the observed location, 
then navigate to the new location after crossing the river or 
stream at a more suitable location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Project Waypoint.
4 Enter the bearing, and select .
5 Select a unit of measure.
6 Enter the distance, and select .
7 Select Save.

Moving a Waypoint on the Map
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Move Waypoint.
4 Select a location on the map.
5 Select Move.

Finding a Location Near a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Find Near Here.
4 Select a category.
The list displays locations near the selected waypoint.

Setting a Waypoint Proximity Alarm
You can add a proximity alarm for a waypoint. Proximity alarms 
alert you when you are within a specified range of a particular 
location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Set Proximity.
4 Enter the radius.

When you enter an area with a proximity alarm, the device 
sounds a tone.

Adding a Waypoint to a Route
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Add to Route.
4 Select a route.
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 pontot.

Útpont törlése
1.  Válasszuk az Útpontkezelő > 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Törlés pontot.
2.  Válasszunk az alábbiak közül:
 •  Egyetlen útpont törléséhez válasszuk ki a törölni kívánt útpontot.
 •  Több útpont törléséhez válasszuk ki a törölni kívánt útpontokat.
 •   Az összes útpont törléséhez válasszuk az Összes kiválasztása pon-

tot.

3. Válasszuk a Törlés pontot.

Útpont helyzetének pontosítása
Az útpontok helyzetét átlagolással pontosíthatjuk a reálisabb adatok érdeké-
ben. Átlagolás közben a készülék több mérést végez egyszerre, és a ponto-
sabb adatok biztosítása érdekében ezek átlagát használja fel.
1.  Válasszuk az Útpontkezelőt.
2.  Válasszunk ki egy útpontot.
3.  Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Hely átlagolása pontot.
4.  Menjünk az útponthoz.
5.  Válasszuk az Indít parancsot.
6.  Kövessük a képernyőn megjelenő utasításokat.
7.  Amikor a bizonyossági állapotjelző sáv 100%-on van, válasszuk a Tárol 

parancsot.
A legjobb eredmény elérése érdekében az útponthoz 4-8 mintát vegyünk, és 
a mintavételek között legalább 90 percet várjunk.

Útpont kivetítése
Egy adott útpontból kiindulva az irány és a távolság megadásával határoz-
hatjuk meg egy új útpont helyét.
Például, ha egy folyó vagy patak másik oldalán látott helyre szeretnénk eljut-
ni, aktuális pozíciónkból úgy útpontot vetíthetünk a kívánt helyre, majd miu-
tán egy megfelelőbb helyen átkeltünk a folyón vagy patakon, elnavigálhatunk 
a kivetített útponthoz.
1.  Válasszuk az Útpontkezelőt.
2.  Válasszunk ki egy útpontot.
3.  Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Útpont kivetítése pontot.
4.  Adjunk meg az irányt, majd válasszuk a 

Turns appear in the text bar along the top of the map. Audible 
tones signal turns in the route.

Optional Maps
You can use additional maps with the device, such as BirdsEye 
satellite imagery, City Navigator, and Garmin HuntView™ Plus 
detailed maps. Detailed maps may contain additional points of 
interest, such as restaurants or marine services. For more 
information, go to buy.garmin.com or contact your Garmin 
dealer.
Enabling Maps
You can enable map products installed on your device.
1 From the map, select  > Map Setup > Configure Maps.
2 Select the toggle switch to enable each installed map.

Finding a Location Near Another Location
1 Select  >  > Search Near.
2 Select an option.
3 Select a location.

Waypoints
Waypoints are locations you record and store in the device. 
Waypoints can mark where you are, where you are going, or 
where you have been.

Creating a Waypoint
You can save your current location as a waypoint.
1 Select Mark Waypoint.
2 If necessary, select a field to edit the waypoint.
3 Select Save.

Navigating to a Waypoint
1 Select  > Waypoints.
2 Select a waypoint.
3 Select Go.

By default, your route to the waypoint appears as a straight, 
colored line on the map.

Finding a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint from the list.
3 If necessary, select  to narrow the search.
4 Select an option:

• Select Spell Search to search using the name of the 
waypoint.

• Select Select Symbol to search using the symbol of the 
waypoint.

• Select Search Near to search near a recently found 
location, another waypoint, your current location, or a 
point on the map.

• Select Sort to view the list of waypoints based on nearest 
distance or alphabetical order.

Editing a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select an item to edit, such as the name.
4 Enter the new information, and select .

Deleting a Waypoint
1 Select Waypoint Manager >  > Delete.
2 Select an option:

• To delete one waypoint, select a waypoint.
• To delete multiple waypoints, select multiple waypoints.
• To delete all waypoints, select Select All.

3 Select Delete.

Increasing the Accuracy of a Waypoint Location
You can refine the accuracy of a waypoint location by averaging 
the location data. When averaging, the device takes several 
GPS readings at the same location and uses the average value 
to provide more accuracy.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Average Location.
4 Move to the waypoint location.
5 Select Start.
6 Follow the on-screen instructions.
7 When the confidence status bar reaches 100%, select Save.
For best results, collect four to eight samples for the waypoint, 
waiting at least 90 minutes between samples.

Projecting a Waypoint
You can save a new waypoint by projecting the distance and 
bearing from a saved waypoint to a new location.
For example, if you would like to navigate to a location you 
observe on the other side of a river or stream, you can project a 
waypoint from your current location to the observed location, 
then navigate to the new location after crossing the river or 
stream at a more suitable location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Project Waypoint.
4 Enter the bearing, and select .
5 Select a unit of measure.
6 Enter the distance, and select .
7 Select Save.

Moving a Waypoint on the Map
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Move Waypoint.
4 Select a location on the map.
5 Select Move.

Finding a Location Near a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Find Near Here.
4 Select a category.
The list displays locations near the selected waypoint.

Setting a Waypoint Proximity Alarm
You can add a proximity alarm for a waypoint. Proximity alarms 
alert you when you are within a specified range of a particular 
location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Set Proximity.
4 Enter the radius.

When you enter an area with a proximity alarm, the device 
sounds a tone.

Adding a Waypoint to a Route
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Add to Route.
4 Select a route.
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-t.
5.  Válasszunk mértékegységet.
6.  Adjuk meg a távolságot, majd válasszuk a 

Turns appear in the text bar along the top of the map. Audible 
tones signal turns in the route.

Optional Maps
You can use additional maps with the device, such as BirdsEye 
satellite imagery, City Navigator, and Garmin HuntView™ Plus 
detailed maps. Detailed maps may contain additional points of 
interest, such as restaurants or marine services. For more 
information, go to buy.garmin.com or contact your Garmin 
dealer.
Enabling Maps
You can enable map products installed on your device.
1 From the map, select  > Map Setup > Configure Maps.
2 Select the toggle switch to enable each installed map.

Finding a Location Near Another Location
1 Select  >  > Search Near.
2 Select an option.
3 Select a location.

Waypoints
Waypoints are locations you record and store in the device. 
Waypoints can mark where you are, where you are going, or 
where you have been.

Creating a Waypoint
You can save your current location as a waypoint.
1 Select Mark Waypoint.
2 If necessary, select a field to edit the waypoint.
3 Select Save.

Navigating to a Waypoint
1 Select  > Waypoints.
2 Select a waypoint.
3 Select Go.

By default, your route to the waypoint appears as a straight, 
colored line on the map.

Finding a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint from the list.
3 If necessary, select  to narrow the search.
4 Select an option:

• Select Spell Search to search using the name of the 
waypoint.

• Select Select Symbol to search using the symbol of the 
waypoint.

• Select Search Near to search near a recently found 
location, another waypoint, your current location, or a 
point on the map.

• Select Sort to view the list of waypoints based on nearest 
distance or alphabetical order.

Editing a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select an item to edit, such as the name.
4 Enter the new information, and select .

Deleting a Waypoint
1 Select Waypoint Manager >  > Delete.
2 Select an option:

• To delete one waypoint, select a waypoint.
• To delete multiple waypoints, select multiple waypoints.
• To delete all waypoints, select Select All.

3 Select Delete.

Increasing the Accuracy of a Waypoint Location
You can refine the accuracy of a waypoint location by averaging 
the location data. When averaging, the device takes several 
GPS readings at the same location and uses the average value 
to provide more accuracy.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Average Location.
4 Move to the waypoint location.
5 Select Start.
6 Follow the on-screen instructions.
7 When the confidence status bar reaches 100%, select Save.
For best results, collect four to eight samples for the waypoint, 
waiting at least 90 minutes between samples.

Projecting a Waypoint
You can save a new waypoint by projecting the distance and 
bearing from a saved waypoint to a new location.
For example, if you would like to navigate to a location you 
observe on the other side of a river or stream, you can project a 
waypoint from your current location to the observed location, 
then navigate to the new location after crossing the river or 
stream at a more suitable location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Project Waypoint.
4 Enter the bearing, and select .
5 Select a unit of measure.
6 Enter the distance, and select .
7 Select Save.

Moving a Waypoint on the Map
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Move Waypoint.
4 Select a location on the map.
5 Select Move.

Finding a Location Near a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Find Near Here.
4 Select a category.
The list displays locations near the selected waypoint.

Setting a Waypoint Proximity Alarm
You can add a proximity alarm for a waypoint. Proximity alarms 
alert you when you are within a specified range of a particular 
location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Set Proximity.
4 Enter the radius.

When you enter an area with a proximity alarm, the device 
sounds a tone.

Adding a Waypoint to a Route
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Add to Route.
4 Select a route.
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7.  Válasszunk a Mentés pontot.

Útpont áthelyezése a Térképen
1.  Válasszuk az Útpontkezelőt.
2.  Válasszunk ki egy útpontot.
3.  Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Útpont áthelyezés pontot.
4.  Válasszunk egy helyet a térképen.
5.  Válasszuk az Áthelyez parancsot.

Útponthoz közeli hely keresése
1.  Válasszuk az Útpontkezelő-t.
2.  Válasszunk ki egy útpontot.
3.  Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Keresés a közelben pontot.
4.  Válasszunk kategóriát.
A listán megjelennek a kiválasztott útponthoz közeli helyek.

Útpont közelségi riasztó beállítása
Az útpontokhoz közelségi riasztót adhatunk hozzá. A közelségi riasztó je-
lez, amikor az adott helyhez képest meghatározott távolságon belül va-
gyunk.
1.  Válasszuk az Útpontkezelőt.
2.  Válasszunk ki egy útpontot.
3.  Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Közelség beállításat.
4.  Adjuk meg a hatósugarat.
Amikor a távolságilag beriasztott területre lépünk, a készülék hangjelzést 
ad le.

Útpont hozzáadása útvonalhoz
1.  Válasszuk az Útpontkezelőt.
2.  Válasszunk ki egy útpontot.
3.  Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Hozzáadás útvonalhoz pontot.
4.  Válasszunk egy útvonalat.
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Útpont áthelyezése jelenlegi tartózkodási helyünkre
Az útpontok helyzetét módosíthatjuk. Például a járművünk elmozdításakor 
módosíthatjuk a jelenlegi tartózkodási helyünket.
1.  Válasszuk az Útpontkezelőt.
2.  Válasszunk ki egy útpontot.
3.  Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Áthelyezés ide pontot.
Az útpont helye a jelenlegi tartózkodási helyünkre módosul.

Útvonalak
Az útvonal útpontok sorozatából áll, melyeket adott sorrendben megtéve jut-
hatunk el a célig.

Útvonal létrehozása
1.  Válasszuk az Útvonaltervező > Út létrehozása > Vál. első pontot-t.
2.  Válasszuk ki a kiindulási pont kategóriáját.
3.  Válasszuk ki az útvonal első pontját.
4.  Válasszuk a Használ pontot.
5.  Válasszuk a Következő pont opciót további köztes pontok megadásához.
6.  A 

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery
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 kiválasztásával mentjük az útvonalat.

Útvonal létrehozása a térképen
1.  Válasszuk az Útvonaltervező > Út létrehozása > Vál. első pontot > 

Térkép használata pontot.
2.  Válasszunk egy pontot a térképen.
3.  Válasszunk a Használ pontot.
4.  Pásztázzunk és válasszunk ki további pontokat a térképen az útvonal bő-

vítéséhez.
5.  Válasszunk a 

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery
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Körutazás létrehozása
Az általunk megadott távolság és a bejárási irány alapján a készülék képes 
megtervezni egy, a kiindulási
pontba visszatérő túrát.
1.  Válasszuk a 

3 Select Add Network.
4 Select an option:

• To select a broadcast wireless network, select a wireless 
network from the list and enter the password, if necessary.

• To select a non-broadcast wireless network, select  > 
Add Network, and enter the network SSID and password.

The device stores the network information and connects 
automatically when you return to this location.

Setting Up Wi‑Fi Connectivity
Before you can use Wi‑Fi features, you must set up the Wi‑Fi 
connection using the Garmin Express™ application.
1 Go to garmin.com/express, and download the Garmin 

Express application.
2 Select the device.
3 Select Tools > Utilities.
4 Follow the on-screen instructions to set up Wi‑Fi connectivity 

with the Garmin Express application.

Connect IQ Features
You can add Connect IQ features to your device from Garmin 
and other providers using the Connect IQ app. You can 
customize your device with data fields, widgets, and apps.
Data Fields: Allow you to download new data fields that present 

sensor, activity, and history data in new ways. You can add 
Connect IQ data fields to built-in features and pages.

Widgets: Provide information at a glance, including sensor data 
and notifications.

Apps: Add interactive features to your device, such as new 
outdoor and fitness activity types.

Downloading Connect IQ Features
Before you can download features from the Connect IQ app, you 
must pair your Montana device with your smartphone (Pairing a 
Smartphone with Your Device, page 7).
1 From the app store on your smartphone, install and open the 

Connect IQ app.
2 If necessary, select your device.
3 Select a Connect IQ feature.
4 Follow the on-screen instructions.

Downloading Connect IQ Features Using Your 
Computer
1 Connect the device to your computer using a USB cable.
2 Go to apps.garmin.com, and sign in.
3 Select a Connect IQ feature, and download it.
4 Follow the on-screen instructions.

Garmin Explore
The Garmin Explore website and mobile app allow you to plan 
trips and use cloud storage for your waypoints, routes, and 
tracks. They offer advanced planning both online and offline, 
allowing you to share and sync data with your compatible 
Garmin device. You can use the mobile app to download maps 
for offline access, and then navigate anywhere without using 
your cellular service.
You can download the Garmin Explore app from the app store 
on your smartphone, or you can go to explore.garmin.com.

Wireless Headsets
Your device can send audio navigation prompts to a Bluetooth 
enabled wireless headset.

Pairing a Wireless Headset with Your Device
Before you can receive navigation prompts through your 
headset, you must pair your device with a compatible headset 
with Bluetooth technology.
NOTE: Only one headset can be active at a time.
1 Place your headset and your Montana device within 10 m 

(33 ft.) of each other.
2 On your headset, enable Bluetooth technology and make it 

visible to other Bluetooth devices.
3 On your Montana device, select Setup > Bluetooth > Audio 

Device > Add Device.
A list of nearby Bluetooth devices appears.

4 Select your headset from the list.
Your device sends navigation prompts to your headset as you 
navigate a route.

Disconnecting or Removing a Wireless Headset
1 Select Setup > Bluetooth > Audio Device.
2 Select your headset.
3 Select an option:

• To temporarily disconnect a headset without deleting it 
from the paired devices list, select Disconnect Device.

• To delete a headset from the paired devices list, select 
Remove.

Navigation
Where To? Page
You can use the  page to find a destination to navigate to. Not 
all Where To? categories are available in all areas and maps.

Navigating to a Destination
1 Select .
2 Select a category.
3 If necessary, select  > Spell Search, and enter the 

destination name or part of the name.
4 Select a destination.
5 Select Go.
6 If necessary, select the activity type.
7 If necessary, select the route calculation method.

Your route appears as a colored line on the map.
8 Navigate using the map (Navigating with the Map, page 5) or 

compass (Navigating with the Compass, page 5).
Stopping Navigation

From the map or compass, select  > Stop Navigation.

Finding an Address
You can use the preloaded City Navigator® maps on the 
Montana 700i/750i device to search for addresses.
You can purchase City Navigator maps for the Montana 700 
device. See Optional Maps, page 9 for more information.
1 Select  > Addresses.
2 Select Search Area, and enter the country, region, or city.
3 Select Number, and enter the house number.
4 Select Street Name, and enter the street.
Navigating a Driving Route
Before you can navigate street routes, you must have City 
Navigator maps or other maps with street routes installed.
1 Select Profile Change > Driving.
2 Select a destination.
3 Navigate using the map.
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 > Körutazás tervezés pontot.
2.  Válasszuk a Távolság pontot, és adjuk meg az útvonal össztávolságát.
3.  Válasszuk a Kiindulópont opciót.
4.  Válasszunk az alábbiak közül:
 •  Válasszuk az Aktuális pozíció pontot.
   MEGJEGYZÉS! Ha a készülék az aktuális pozíciónk meghatározása 

érdekében nem képes műholdas kapcsolatot létesíteni, akkor felszólít 
a legutóbbi pozíció kijelölésére, vagy a pozíció térképen történő meg-
adására.

 •   Válasszuk a Térkép használata pontot a pozíció térképen történő 
megadásához.

 A készülék akár három útvonalat is tervez.
5.  Amennyiben szükséges, válasszuk a Tevékenység pontot a tevékeny-

ségtípus módosításához az útvonaltervezés során.
 TIPP! A 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 > Keresés ponttal újbóli keresést indíthatunk.
6.  Válasszunk ki egy útvonalat a térképen történő megtekintéséhez.
7.  Válasszuk a Menj pontot.

Navigáció mentett útvonal mentén
1.  Válasszuk a 

3 Select Add Network.
4 Select an option:

• To select a broadcast wireless network, select a wireless 
network from the list and enter the password, if necessary.

• To select a non-broadcast wireless network, select  > 
Add Network, and enter the network SSID and password.

The device stores the network information and connects 
automatically when you return to this location.

Setting Up Wi‑Fi Connectivity
Before you can use Wi‑Fi features, you must set up the Wi‑Fi 
connection using the Garmin Express™ application.
1 Go to garmin.com/express, and download the Garmin 

Express application.
2 Select the device.
3 Select Tools > Utilities.
4 Follow the on-screen instructions to set up Wi‑Fi connectivity 

with the Garmin Express application.

Connect IQ Features
You can add Connect IQ features to your device from Garmin 
and other providers using the Connect IQ app. You can 
customize your device with data fields, widgets, and apps.
Data Fields: Allow you to download new data fields that present 

sensor, activity, and history data in new ways. You can add 
Connect IQ data fields to built-in features and pages.

Widgets: Provide information at a glance, including sensor data 
and notifications.

Apps: Add interactive features to your device, such as new 
outdoor and fitness activity types.

Downloading Connect IQ Features
Before you can download features from the Connect IQ app, you 
must pair your Montana device with your smartphone (Pairing a 
Smartphone with Your Device, page 7).
1 From the app store on your smartphone, install and open the 

Connect IQ app.
2 If necessary, select your device.
3 Select a Connect IQ feature.
4 Follow the on-screen instructions.

Downloading Connect IQ Features Using Your 
Computer
1 Connect the device to your computer using a USB cable.
2 Go to apps.garmin.com, and sign in.
3 Select a Connect IQ feature, and download it.
4 Follow the on-screen instructions.

Garmin Explore
The Garmin Explore website and mobile app allow you to plan 
trips and use cloud storage for your waypoints, routes, and 
tracks. They offer advanced planning both online and offline, 
allowing you to share and sync data with your compatible 
Garmin device. You can use the mobile app to download maps 
for offline access, and then navigate anywhere without using 
your cellular service.
You can download the Garmin Explore app from the app store 
on your smartphone, or you can go to explore.garmin.com.

Wireless Headsets
Your device can send audio navigation prompts to a Bluetooth 
enabled wireless headset.

Pairing a Wireless Headset with Your Device
Before you can receive navigation prompts through your 
headset, you must pair your device with a compatible headset 
with Bluetooth technology.
NOTE: Only one headset can be active at a time.
1 Place your headset and your Montana device within 10 m 

(33 ft.) of each other.
2 On your headset, enable Bluetooth technology and make it 

visible to other Bluetooth devices.
3 On your Montana device, select Setup > Bluetooth > Audio 

Device > Add Device.
A list of nearby Bluetooth devices appears.

4 Select your headset from the list.
Your device sends navigation prompts to your headset as you 
navigate a route.

Disconnecting or Removing a Wireless Headset
1 Select Setup > Bluetooth > Audio Device.
2 Select your headset.
3 Select an option:

• To temporarily disconnect a headset without deleting it 
from the paired devices list, select Disconnect Device.

• To delete a headset from the paired devices list, select 
Remove.

Navigation
Where To? Page
You can use the  page to find a destination to navigate to. Not 
all Where To? categories are available in all areas and maps.

Navigating to a Destination
1 Select .
2 Select a category.
3 If necessary, select  > Spell Search, and enter the 

destination name or part of the name.
4 Select a destination.
5 Select Go.
6 If necessary, select the activity type.
7 If necessary, select the route calculation method.

Your route appears as a colored line on the map.
8 Navigate using the map (Navigating with the Map, page 5) or 

compass (Navigating with the Compass, page 5).
Stopping Navigation

From the map or compass, select  > Stop Navigation.

Finding an Address
You can use the preloaded City Navigator® maps on the 
Montana 700i/750i device to search for addresses.
You can purchase City Navigator maps for the Montana 700 
device. See Optional Maps, page 9 for more information.
1 Select  > Addresses.
2 Select Search Area, and enter the country, region, or city.
3 Select Number, and enter the house number.
4 Select Street Name, and enter the street.
Navigating a Driving Route
Before you can navigate street routes, you must have City 
Navigator maps or other maps with street routes installed.
1 Select Profile Change > Driving.
2 Select a destination.
3 Navigate using the map.
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 > Útvonalak pontot.
2.  Válasszuk ki a kívánt útvonalat.
3.  Válasszuk a Menj pontot.
  Az útvonal alapértelmezetten színezett egyenes vonalként jelenik meg a 

térképen.

További pontok hozzáadása útvonalhoz
1.  Útvonalon történő navigáció során válasszuk ki a pontot, ahová navigálni 

szeretnénk.
2.  Válasszunk az alábbi lehetőségek közül:
 •   Hozzáadás köztes pontként – a kiválasztott pontot köztes úticélként 

adhatjuk az aktuális útvonalhoz.

 •   Megjelölés új célként – az aktuális útvonal úticéljaként az új pontot 
nevezzük ki.

Aktív útvonal megtekintése
1.  Miközben navigálunk egy kijelölt cél felé, válasszuk az Aktív útvonal 

pontot.
2.  Válasszuk ki az útvonal egy pontját a jellemző adatok megtekintéséhez

Útvonal átnevezése
A kívánt útvonalnak egyedi nevet adhatunk, így feltűnőbbé tehetjük.
1.  Válasszuk az Útvonaltervező pontot.
2.  Válasszuk ki az útvonalat.
3.  Válasszuk a Név megváltoztat. pontot.
4.  Adjuk meg az új nevet.

Útvonal szerkesztése
1.   Válasszuk az Útvonaltervezőt.
2.   Válasszuk ki az útvonalat.
3.   Válasszuk az Út szerkesztése-t.
4.   Válasszunk ki az útvonalat alkotó pontok egyikét.
5.   Válasszunk az alábbi lehetőségek közül:
 •     A pont térképen történő megtekintéséhez válasszuk az Olvas gom-

bot.
 •    Az adott pont az útvonalat alkotó többi útpont közötti helyének módo-

sításához válasszuk a Lépés fel és Lépés le gombot.
 •    Új útpont beszúrásához – a kiválasztott útpont elé – válasszuk a Beil-

leszt gombot.
 •   A pont törléséhez válasszuk az Eltávolít gombot.
6.   A 

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery
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 pont kiválasztásával menthetjük az útvonalat.

Útvonal megtekintése a térképen
1.  Válasszuk az Útvonaltervező-t.
2.  Válasszuk ki az útvonalat.
3.  Válasszuk a Térkép megtekintése pontot.

Útvonal magassági grafikonjának megtekintése
A magassági grafikon mutatja az útvonal magasságbeli változásait az 
útvonaltervezési beállításaink alapján. Amennyiben a készülékünk közvetlen 
útvonaltervezésre van beállítva, a magassági grafikon az útvonalpontok kö-
zötti egyenes vonali emelkedéseket mutatja. Amennyiben a készülék köz-
lekedési útvonalak alapján történő útvonaltervezésre van beállítva, a ma-
gassági grafikon az útvonalunkhoz tartozó közutak magasságbeli változá-
sait mutatja.
1.  Válasszuk az Útvonaltervező-t.
2.  Válasszuk ki az útvonalat.
3.  Válasszuk a Magassági grafikon pontot.

Útvonal megfordítása
Megváltoztathatjuk az útvonal kiinduló és végső pontját, hogy azon fordít-
va navigáljunk.
1.   Válasszuk az Útvonaltervező-t.
2.   Válasszuk ki az útvonalat.
3.   Válasszuk az Útvonal fordítást.

Útvonal törlése
1.   Válasszuk az Útvonaltervező-t.
2.   Válasszuk ki az útvonalat.
3.   Válasszuk az Útvonal törlése-t.

Megtett útvonal (nyomvonal) rögzítése
Ahogy haladunk, a készülék a megtett utunkat elmenti tevékenységéként, 
amely információkat tartalmaz az útvonalunkon rögzített pontokról: idő, hely, 
az egyes pontok magassága.

Rögzítés beállítása
Válasszuk a Beállítás > Rögzítést.



11

Rögzítési mód – felvételi módszer beállítása. Az Auto opcióval változó 
arányban rögzítjük a pontokat, így az utunkat optimális módon jeleníti 
meg a készülék. A nyomvonalpontokat adott idő- vagy távolsági interval-
lumokban is felvehetjük.

Intervallum – Rögzítési gyakoriság beállítása. A gyakoribb pontrögzítés 
részletesebben rögzíti az utat, de ugyanakkor gyorsabban betölti a fel-
vételi memóriát.

Auto Pause – Beállíthatjuk, hogy megálláskor a készülék ne készítsen fel-
vételt.

Auto Start – Beállíthatjuk, hogy a készülék az utolsó felvétel leállítását köve-
tően azonnal új felvételt indítson.

Tevékenység típus – a készülék alapértelmezett tevékenységének beállítása. 
További felvétel beállítások – A felvétel funkcióhoz további beállításokat ér-

hetünk el (További felvételi beállítások, 11. oldal).

További felvételi beállítások
Válasszuk a Beállítások > Felvétel > További beállítások pontot.
Kimeneti formátum – Beállíthatjuk, hogy a készülék FIT vagy GPX/FIT fájl-

ként mentse a felvételt (Ismert fájlformátumok, 23. oldal).
• FIT – Garmin Connect™ alkalmazáshoz készített információkkal veszi 

fel a tevékenységet. Navigációnál is használható.
• FIT és GPX – a térképen megtekinthető és navigáláshoz is használha-

tó útvonalként rögzíti a tevékenységet, valamint fitnesz információt tar-
talmazó tevékenységként is.

Automatikus mentés – Automata mentési programot állíthatunk be a fel-
vételeink elmentésére. Ezzel könnyebben szervezhetjük meg utazásain-
kat, és kevesebb tárhelyet használunk (Automatikus mentési beállítások, 
11. oldal).

Túra rögzítése – túra rögzítési opció beállítása.
Rögzített adatok visszaállítása – Visszaállítás lehetőségének beállítása. A 

Tevékenység és Utazás opció visszaállítja a rögzítést és utazási adato-
kat, amikor véget ér az aktív felvétel. A Felszólít opcióval a készülék fel-
szólít az adatok visszaállítására.

Automatikus mentési beállítások
Válasszuk a Beállítások > Felvétel > Speciális beállítások > Auto. men-
tés pontot.
Megteléskor: Az aktuálisan rögzített nyomvonal automatikus mentése és új 

indítása, amikor az aktuális felvétel 20.000 pályaponthoz közelít.
Napi: Előző napi felvétel automatikus mentése és új felvétel indítása, amikor 

a készüléket egy új napon kapcsoljuk be.
Heti: Előző heti felvétel automatikus mentése és új felvétel indítása, amikor a 

készüléket egy új héten kapcsoljuk be.
Auto.: Az aktuálisan rögzített nyomvonal automatikus mentése hossz és fel-

vett pályapontok száma alapján.
Soha: A Soha opcióval az aktuálisan rögzített nyomvonal automatikusan 

nem kerül elmentésre. Amikor az aktuális felvétel megközelíti a 20,000 
pályapontot, a készülék szűrést végez az aktív pályán, és eltávolítja a 
szükségtelen pontokat, miközben megtartja a felvétel alakját és előzmé-
nyi adatait. A ki nem szűrt pontok ideiglenes GPS és FIT fájlban kerülnek 
elmentésre, amelyet a felvétel leállítását követően menthetünk vagy el-
vethetünk.

 MEGJEGYZÉS! Több, mint 20,000 ponttal rendelkező FIT tevékenysé-
get és GPX pályák letöltése során a készülék szűrést végez a vonalon, 
hogy az ráférjen a tárhelyre, valamint ezzel javul a térkép kirajzolási tel-
jesítmény is, miközben a rögzített nyomvonal alakja és előzményi adatai 
megmaradnak. A FIT és GPX fájlokban minden eredeti pályapont megma-
rad.

Aktuális tevékenység megtekintése
A készülék bekapcsolást és műholdas kapcsolat létesítését követően alap-
értelmezetten elkezdi az aktuális útvonalunk felvételét mint tevékenységet. A 
felvételt manuálisan szüneteltethetjük és le is állíthatjuk.
1.  Nyomjuk le a 

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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 gombot az állapotjelző képernyő megnyitásához.
2.  Válasszuk a Tevékenység felvétel pontot.
3.  Válasszunk az alábbiak közül:

 •   Az aktuális tevékenység felvételének vezérléséhez válasszuk a 

Record Method: Sets the recording method. The Auto option 
records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.
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pontot.

 •  A tevékenység adatmezőinek megtekintéséhez válasszuk a Record Method: Sets the recording method. The Auto option 
records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.
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 pontot.
 •   Az aktuális tevékenység megtekintéséhez a térképen, válasszuk a 

Record Method: Sets the recording method. The Auto option 
records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.
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 •   Az aktuális tevékenység magassági grafikonjának megtekintéséhez 
válasszuk a 

Record Method: Sets the recording method. The Auto option 
records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.
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Tevékenységnapló testreszabása
Tetszés szerint beállíthatjuk, hogy a készülék miként jelenítse meg és vegye 
fel a tevékenységeinket.
1.  Nyomjuk le a 

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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 gombot az állapotjelző képernyő megnyitásához.
2.  Válasszuk a Tevékenység rögzítés > Record Method: Sets the recording method. The Auto option 

records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.
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3.  Válasszunk az alábbiak közül:
 •   Ha azt szeretnénk, hogy a tevékenység vonala a térképen más szín-

ben jelenjen meg, válasszuk a Szín pontot.
 •   Tevékenységünket jelző vonal megjelenítéséhez a térképen nyomjuk 

meg a Térképen mutat pontot.
4.  Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 > Tevékenység beállítások > Rögzítési módszer pon-
tot.

5.  Válasszunk az alábbiak közül:
 •   Az Auto ponttal a készülék a tevékenységi felvételeket változó időköz-

önként veszi fel, így optimalizálja a tevékenységeink bemutatását.
 •   A Távolság ponttal a készülék meghatározott távolságban veszi fel a 

tevékenységeket.
 •   Az Idő ponttal a készülék meghatározott időben veszi fel a tevékenysége-

ket.
6.  Válasszuk az Intervallum pontot.
7.  Végezzük el az alábbi műveletek egyikét:
 •   Amennyiben Rögzítési módszernek az Auto pontot választottuk, ad-

juk meg, hogy a készülék a tevékenységeket nagyobb vagy kisebb 
gyakorisággal felvételezze.

   MEGJEGYZÉS! A Leggyakoribb ponttal a készülék a legnagyobb 
részletességgel veszi fel a tevékenységet, azonban ezzel gyorsabban 
megtelik a tárhely is.

 •   Ha a Távolság vagy Idő pontokat válaszottuk Rögzítési módszer-
nek, adjuk meg az értéket, majd válasszuk a 

Turns appear in the text bar along the top of the map. Audible 
tones signal turns in the route.

Optional Maps
You can use additional maps with the device, such as BirdsEye 
satellite imagery, City Navigator, and Garmin HuntView™ Plus 
detailed maps. Detailed maps may contain additional points of 
interest, such as restaurants or marine services. For more 
information, go to buy.garmin.com or contact your Garmin 
dealer.
Enabling Maps
You can enable map products installed on your device.
1 From the map, select  > Map Setup > Configure Maps.
2 Select the toggle switch to enable each installed map.

Finding a Location Near Another Location
1 Select  >  > Search Near.
2 Select an option.
3 Select a location.

Waypoints
Waypoints are locations you record and store in the device. 
Waypoints can mark where you are, where you are going, or 
where you have been.

Creating a Waypoint
You can save your current location as a waypoint.
1 Select Mark Waypoint.
2 If necessary, select a field to edit the waypoint.
3 Select Save.

Navigating to a Waypoint
1 Select  > Waypoints.
2 Select a waypoint.
3 Select Go.

By default, your route to the waypoint appears as a straight, 
colored line on the map.

Finding a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint from the list.
3 If necessary, select  to narrow the search.
4 Select an option:

• Select Spell Search to search using the name of the 
waypoint.

• Select Select Symbol to search using the symbol of the 
waypoint.

• Select Search Near to search near a recently found 
location, another waypoint, your current location, or a 
point on the map.

• Select Sort to view the list of waypoints based on nearest 
distance or alphabetical order.

Editing a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select an item to edit, such as the name.
4 Enter the new information, and select .

Deleting a Waypoint
1 Select Waypoint Manager >  > Delete.
2 Select an option:

• To delete one waypoint, select a waypoint.
• To delete multiple waypoints, select multiple waypoints.
• To delete all waypoints, select Select All.

3 Select Delete.

Increasing the Accuracy of a Waypoint Location
You can refine the accuracy of a waypoint location by averaging 
the location data. When averaging, the device takes several 
GPS readings at the same location and uses the average value 
to provide more accuracy.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Average Location.
4 Move to the waypoint location.
5 Select Start.
6 Follow the on-screen instructions.
7 When the confidence status bar reaches 100%, select Save.
For best results, collect four to eight samples for the waypoint, 
waiting at least 90 minutes between samples.

Projecting a Waypoint
You can save a new waypoint by projecting the distance and 
bearing from a saved waypoint to a new location.
For example, if you would like to navigate to a location you 
observe on the other side of a river or stream, you can project a 
waypoint from your current location to the observed location, 
then navigate to the new location after crossing the river or 
stream at a more suitable location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Project Waypoint.
4 Enter the bearing, and select .
5 Select a unit of measure.
6 Enter the distance, and select .
7 Select Save.

Moving a Waypoint on the Map
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Move Waypoint.
4 Select a location on the map.
5 Select Move.

Finding a Location Near a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Find Near Here.
4 Select a category.
The list displays locations near the selected waypoint.

Setting a Waypoint Proximity Alarm
You can add a proximity alarm for a waypoint. Proximity alarms 
alert you when you are within a specified range of a particular 
location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Set Proximity.
4 Enter the radius.

When you enter an area with a proximity alarm, the device 
sounds a tone.

Adding a Waypoint to a Route
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Add to Route.
4 Select a route.
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Navigáció a TracBack® funkcióval
Navigáció közben, visszanavigálhatunk a tevékenységünk kezdési pontjá-
hoz. Ez akkor lehet hasznos, amikor táborunkba vagy akár az ösvényre visz-
szavezető utat szeretnénk megtalálni.
1.  Nyomjuk le a 

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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 gombot az állapotjelző képernyő megnyitásához.
2.  Válasszuk a Tevékenység felvétel > 

Record Method: Sets the recording method. The Auto option 
records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.
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 > TracBack pontot.
3.  Navigáljunk a térkép vagy az iránytű segítségével.
Aktuális tevékenység mentése
1.  Nyomjuk le a 

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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 gombot az állapotjelző képernyő megnyitásához.
2.  Válasszuk a Tevékenység felvétel > 

Record Method: Sets the recording method. The Auto option 
records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.
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3.  Válasszunk az alábbiak közül:
 •  Teljes tevékenység mentéséhez válasszuk a 

Record Method: Sets the recording method. The Auto option 
records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.
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 •   Tevékenység egy részének mentéséhez válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3
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tése pontot.

Aktuális tevékenység törlése
1.  Nyomjuk le a 

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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 gombot az állapotjelző képernyő megnyitásához.
2.  Válasszuk a Tevékenység felvétel pontot.
3.  Válasszuk a 

Record Method: Sets the recording method. The Auto option 
records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.
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Record Method: Sets the recording method. The Auto option 
records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.

Navigation 11

 > Töröl pontot.

Napló
A napló tárolja az időt, a távolságot, a kalóriát, az átlagos tempót vagy át-
lagos sebességet, emelkedést, ereszkedést valamint az opcionális vezeték 
nélküli mérők által szolgáltatott adatokat.
NE FELEDJÜK! Amikor a számlálót leállítjuk vagy felfüggesztjük, az adatok nem 
kerülnek mentésre. A napló csak akkor menti az adatokat, amikor a számláló fut.
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Amikor a készülék memóriája megtelt, egy üzenet jelenik meg. A készülék auto-
matikusan nem törli, nem írja felül a régi adatokat. A napló tartalmát rendszere-
sen töltsük fel a Garmin Connect fiókba (Garmin Connect használata, 23. oldal).

Tevékenység adatok megtekintése
1.  Válasszuk a Rögzített tevékenységek pontot.
2.  Válasszunk egy tevékenységet.
3.  Válasszuk a Record Method: Sets the recording method. The Auto option 

records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.

Navigation 11

 pontot.

Tevékenység magassági grafikonjának megtekintése
1.  Válasszuk a Rögzített tevékenységek pontot.
2.  Válasszunk egy tevékenységet.
3.  Válasszuk a 

Record Method: Sets the recording method. The Auto option 
records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.

Navigation 11

 pontot.

Tevékenység során bejárt hely mentése
1.  Válasszuk a Rögzített tevékenységek pontot.
2.  Válasszunk egy tevékenységet.
3.  Válaszuk a 

Record Method: Sets the recording method. The Auto option 
records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.

Navigation 11

 pontot.
4.  Válasszunk ki a kívánt helyen a tevékenységen belül.
5.  Válasszuk a térkép tetején található helymeghatározási információkat.
 Megjelennek a hellyel kapcsolatos információk.
6.  Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 > Mentés útpontként pontot.

Pálya létrehozása mentett tevékenységből
Mentett tevékenységeinkből pályákat hozhatunk létre. Ezáltal lehetővé válik, 
hogy a pályát vezeték nélküli kapcsolaton keresztül további Garmin eszkö-
zeinkkel megosszuk.
1.  Válasszuk a Rögzített tevékenységek pontot.
2.  Válasszunk egy tevékenységet.
3.  Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Mentés pályaként pontot.

Tevékenység kezdő- és végpontjainak felcserélése
Tevékenységünk kezdő- és végpontját felcserélhetjük, így az útvonalon visz-
szafelé navigálhatunk.
1. Válasszuk a Rögzített tevékenységek pontot.
2. Válasszunk egy tevékenységet.
3. Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Másolás felcserélve pontot.

Navigáció mentett tevékenység mentén
1. Válasszuk a 

3 Select Add Network.
4 Select an option:

• To select a broadcast wireless network, select a wireless 
network from the list and enter the password, if necessary.

• To select a non-broadcast wireless network, select  > 
Add Network, and enter the network SSID and password.

The device stores the network information and connects 
automatically when you return to this location.

Setting Up Wi‑Fi Connectivity
Before you can use Wi‑Fi features, you must set up the Wi‑Fi 
connection using the Garmin Express™ application.
1 Go to garmin.com/express, and download the Garmin 

Express application.
2 Select the device.
3 Select Tools > Utilities.
4 Follow the on-screen instructions to set up Wi‑Fi connectivity 

with the Garmin Express application.

Connect IQ Features
You can add Connect IQ features to your device from Garmin 
and other providers using the Connect IQ app. You can 
customize your device with data fields, widgets, and apps.
Data Fields: Allow you to download new data fields that present 

sensor, activity, and history data in new ways. You can add 
Connect IQ data fields to built-in features and pages.

Widgets: Provide information at a glance, including sensor data 
and notifications.

Apps: Add interactive features to your device, such as new 
outdoor and fitness activity types.

Downloading Connect IQ Features
Before you can download features from the Connect IQ app, you 
must pair your Montana device with your smartphone (Pairing a 
Smartphone with Your Device, page 7).
1 From the app store on your smartphone, install and open the 

Connect IQ app.
2 If necessary, select your device.
3 Select a Connect IQ feature.
4 Follow the on-screen instructions.

Downloading Connect IQ Features Using Your 
Computer
1 Connect the device to your computer using a USB cable.
2 Go to apps.garmin.com, and sign in.
3 Select a Connect IQ feature, and download it.
4 Follow the on-screen instructions.

Garmin Explore
The Garmin Explore website and mobile app allow you to plan 
trips and use cloud storage for your waypoints, routes, and 
tracks. They offer advanced planning both online and offline, 
allowing you to share and sync data with your compatible 
Garmin device. You can use the mobile app to download maps 
for offline access, and then navigate anywhere without using 
your cellular service.
You can download the Garmin Explore app from the app store 
on your smartphone, or you can go to explore.garmin.com.

Wireless Headsets
Your device can send audio navigation prompts to a Bluetooth 
enabled wireless headset.

Pairing a Wireless Headset with Your Device
Before you can receive navigation prompts through your 
headset, you must pair your device with a compatible headset 
with Bluetooth technology.
NOTE: Only one headset can be active at a time.
1 Place your headset and your Montana device within 10 m 

(33 ft.) of each other.
2 On your headset, enable Bluetooth technology and make it 

visible to other Bluetooth devices.
3 On your Montana device, select Setup > Bluetooth > Audio 

Device > Add Device.
A list of nearby Bluetooth devices appears.

4 Select your headset from the list.
Your device sends navigation prompts to your headset as you 
navigate a route.

Disconnecting or Removing a Wireless Headset
1 Select Setup > Bluetooth > Audio Device.
2 Select your headset.
3 Select an option:

• To temporarily disconnect a headset without deleting it 
from the paired devices list, select Disconnect Device.

• To delete a headset from the paired devices list, select 
Remove.

Navigation
Where To? Page
You can use the  page to find a destination to navigate to. Not 
all Where To? categories are available in all areas and maps.

Navigating to a Destination
1 Select .
2 Select a category.
3 If necessary, select  > Spell Search, and enter the 

destination name or part of the name.
4 Select a destination.
5 Select Go.
6 If necessary, select the activity type.
7 If necessary, select the route calculation method.

Your route appears as a colored line on the map.
8 Navigate using the map (Navigating with the Map, page 5) or 

compass (Navigating with the Compass, page 5).
Stopping Navigation

From the map or compass, select  > Stop Navigation.

Finding an Address
You can use the preloaded City Navigator® maps on the 
Montana 700i/750i device to search for addresses.
You can purchase City Navigator maps for the Montana 700 
device. See Optional Maps, page 9 for more information.
1 Select  > Addresses.
2 Select Search Area, and enter the country, region, or city.
3 Select Number, and enter the house number.
4 Select Street Name, and enter the street.
Navigating a Driving Route
Before you can navigate street routes, you must have City 
Navigator maps or other maps with street routes installed.
1 Select Profile Change > Driving.
2 Select a destination.
3 Navigate using the map.

8 Navigation

 > Rögzített tevékenységek pontot.
2. Válasszunk egy tevékenységet.
3. Válasszuk a Menj pontot.

Mentett tevékenység törlése
1. Válasszuk a Felvett tevékenységek pontot.
2. Válasszunk egy tevékenységet.
3. Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Törlés pontot.

Időjárás
Aktív időjárás: Az időjárási viszonyok, előrejelzések és radarképek 

megtekintéséhez a készüléket olyan okostelefonhoz kell csatlakoz-
tatnunk, melyen van internet hozzáférés, vagy vezeték nélküli (Wi-Fi) 
hálózatra kell csatlakoznunk a készülékkel. A funkcióval óránkénti és 
napi előrejelzésekhez, valamint grafikus időjárási térképekhez férhe-
tünk hozzá.

inReach időjárás: A Montana 700i/750i készülék inReach előfizetésün-
kön keresztül is hozzáfér időjárási adatokhoz. A készülék inReach üze-
netben igényelhet alapvető, prémium vagy akár tengeri időjárási elő-
rejelzéseket. Aktuális pozíciónk, kijelölt útpont, GPS-koordináták vagy 
a térképen kiválasztott hely időjárási előrejelzéseit tekinthetjük meg.

inReach időjárási előrejelzés igénylése
A legjobb eredményekért gondoskodjunk róla, hogy inReach időjárási előre-
jelzés igénylése során a készüléknek szabad rálátása van az égboltra.
A készülék inReach üzenetben igényelhet alapvető, prémium vagy akár 
tengeri időjárási előrejelzéseket. Aktuális pozíciónk, kijelölt útpont, GPS-
koordináták vagy a térképen kiválasztott hely időjárási előrejelzéseit tekint-
hetjük meg. Az időjárási előrejelzések további adatforgalmi vagy inReach 
előfizetési díjakkal járnak.

1.  Válasszuk az inReach > inReach Időjárás > Új előrejelzés pontot.
2.  Amennyiben szükséges, válasszuk az Előrejelzés típusa pontot, és vá-

lasszunk az Alapvető és Prémium előrejelzés között.
3.  Amennyiben szükséges, válasszuk a Helyszín pontot, majd válasszuk ki 

a kívánt helyet.
 A készülék alapértelmezetten az aktuális pozíciónkra kér időjárási adato-

kat.
4.  Amennyiben szükséges, válasszuk a Tengeri pontot tengeri időjárási elő-

rejelzés igényléséhez.
 MEGJEGYZÉS! A legjobb eredményekért kizárólag parttól távol eső hely-

re, nagy vízfelületre igényeljünk tengeri időjárás előrejelzést. A tengeri 
előrejelzések szárazföldi helyekre, valamint belföldi tavakra nem elérhe-
tők.

5.  Válasszuk az Előrejelzés igénylése pontot.
A készülék előrejelzési igénylést küld. Az időjárási előrejelzés legfeljebb né-
hány percen belül megérkezik.
Az adatok letöltését követően bármikor megtekinthetjük az időjárás előrejel-
zést, amíg az előrejelzési adatok érvénytelenné nem válnak. Az előrejelzést 
bármikor aktualizálhatjuk.

inReach időjárás előrejelzés aktualizálása
Az érvénytelen vagy elavult információkat tartalmazó időjárási előrejelzést 
aktualizálhatjuk. Az előrejelzés aktualizálása ugyanazokkal az adatforgalmi 
és előfizetési díjakkal jár, mint az előrejelzés igénylése.
1.  Válasszuk az inReach > inReach Időjárás pontot.
2.  Válasszuk ki a helyet, ahol elavult az időjárás előrejelzés.
3.  Válasszuk az Előrejelzés aktualizálása pontot.
A készülék aktualizált előrejelzést igényel. Amennyiben a Saját hely előrejel-
zést aktualizáljuk, a készülék a jelenlegi pozíciónkra igényel aktualizált elő-
rejelzést. Az aktualizált előrejelzési adatok elküldése akár néhány percet is 
felvehet.

inReach időjárás előrejelzés törlése
Az érvénytelen vagy szükségtelenné vált helyre szóló előrejelzéseket törölhetjük.
1.  Válasszuk az inReach > inReach Időjárás pontot.
2.  Válasszuk ki az előrejelzési helyet.
 NE FELEDJÜK! A Saját pozíció előrejelzést nem törölhetjük.
3.  Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Törlés pontot.

Aktív időjárás előrejelzés megtekintése
Amíg a Montana készülék aktív internetkapcsolattal rendelkező 
okostelefonhoz vagy Wi-Fi hálózathoz csatlakozik, képes részletes időjárási 
információk fogadására az internetről.
1.  Válasszuk az Aktív időjárás pontot.
  A készülék automatikusan letölti az aktuális pozíciónkra vonatkozó időjá-

rás előrejelzést.
2.  Válasszuk ki a kívánt napot az óránkénti előrejelzéshez, amennyiben el-

érhető.
3.  Válasszuk ki a kívánt időintervallumot a részletes időjárási adatok megte-

kintéséhez.

Aktív időjárási térkép megtekintése
Amíg a Montana készülék aktív internetkapcsolattal rendelkező 
okostelefonhoz vagy Wi-Fi hálózathoz csatlakozik, élő időjárási térképhez 
férhetünk hozzá, amelyen időjárási radart, felhőfedést, hőmérsékleti és szél-
viszonyokat tekinthetünk meg.
1.  Válasszuk az Aktív időjárás pontot.
2.  Válasszunk az alábbiak közül:
 MEGJEGYZÉS! Előfordulhat, hogy egyes funkciók nem minden területen 

érhetők el.
 •  Időjárási radar megtekintéséhez válasszuk a 

3 Select .
Viewing the Elevation Plot of an Activity
1 Select Recorded Activities.
2 Select an activity.
3 Select .
Saving a Location from an Activity
1 Select Recorded Activities.
2 Select an activity.
3 Select .
4 Select a location in the activity.
5 Select the location information at the top of the map.

Information about the location appears.
6 Select  > Save as Waypoint.
Creating a Track from a Saved Activity
You can create a track from a saved activity. This allows you to 
share your track wirelessly with other compatible Garmin 
devices.
1 Select Recorded Activities.
2 Select an activity.
3 Select  > Save as Track.
Reversing an Activity
You can switch the start and end points of your activity to 
navigate the activity in reverse.
1 Select Recorded Activities.
2 Select an activity.
3 Select  > Copy Reversed.
Navigating a Saved Activity
1 Select  > Recorded Activities.
2 Select an activity.
3 Select Go.
Deleting a Saved Activity
1 Select Recorded Activities.
2 Select an activity.
3 Select  > Delete.

Weather
Active Weather: While your Montana device is connected to 

your smartphone or to a Wi‑Fi network and has an active 
internet connection, it can receive detailed weather 
information from the internet. This feature provides hourly 
and daily forecasts and live graphical weather maps.

inReach Weather: Your Montana 700i/750i can receive weather 
information through your inReach subscription. Your device 
can send an inReach message to request basic, premium, or 
marine weather forecasts. You can receive weather forecasts 
for your current location, a waypoint, GPS coordinates, or a 
location you choose on the map.

Requesting an inReach Weather Forecast
For the best results, you should ensure your device has a clear 
view of the sky when you request an inReach weather forecast.
Your device can send a message to request a basic, premium, 
or marine weather forecast using your inReach subscription. 
You can receive weather forecasts for your current location, a 
waypoint, GPS coordinates, or a location you choose on the 
map. Weather forecasts incur data charges or additional 
charges on your inReach subscription.
1 Select inReach > inReach Weather > New Forecast.

2 If necessary, select Forecast Type, and select a Basic or 
Premium weather forecast.

3 If necessary, select Location, and select a location.
By default, the device requests weather for your current 
location.

4 If necessary, select Marine to request a marine weather 
forecast.
NOTE: For best results, you should only request a marine 
forecast for a location away from shore and over a large body 
of water. Marine forecasts are not available for land locations 
or inland lakes.

5 Select Get Forecast.
The device sends a request for the forecast. It may take several 
minutes to receive the weather forecast data.
After the device finishes downloading the data, you can view the 
forecast at any time until all the information in the forecast has 
expired. You can also update the forecast at any time.

Updating an inReach Weather Forecast
You can update an inReach weather forecast that has expired or 
contains outdated information. Updating a forecast incurs the 
same data charges or additional charges as requesting a 
forecast.
1 Select inReach > inReach Weather.
2 Select a location with an outdated weather forecast.
3 Select Update Forecast.
The device requests an updated forecast. If you update the My 
Location forecast, the device requests an updated forecast for 
your current location. It may take several minutes to receive the 
updated weather forecast data.

Deleting an inReach Weather Forecast
You can delete an expired forecast or a forecast for a location 
that you no longer need.
1 Select inReach > inReach Weather.
2 Select a weather location.

NOTE: You cannot delete the My Location forecast.
3 Select  > Delete.

Viewing an Active Weather Forecast
While your Montana device is connected to your smartphone or 
to a Wi‑Fi network and has an active internet connection, it can 
receive detailed weather information from the internet.
1 Select Active Weather.

The device automatically downloads a weather forecast for 
your current location.

2 Select a day to view an hourly forecast, if available.
3 Select a time interval to view detailed weather information.

Viewing an Active Weather Map
While your device is connected to a smartphone or Wi‑Fi 
network with internet access, you can view a live weather map 
showing weather radar, cloud cover, temperature, or wind 
conditions.
1 Select Active Weather.
2 Select an option:

NOTE: Some options may not be available in all areas.
• To view a weather radar, select .
• To view cloud coverage, select .
• To view temperatures, select .
• To view wind speeds and directions, select .
The selected data appears on the map. The device may take 
a few moments to load the weather map data.

12 Weather

 pontot.
 •  Felhőfedés megtekintéséhez válasszuk a 

3 Select .
Viewing the Elevation Plot of an Activity
1 Select Recorded Activities.
2 Select an activity.
3 Select .
Saving a Location from an Activity
1 Select Recorded Activities.
2 Select an activity.
3 Select .
4 Select a location in the activity.
5 Select the location information at the top of the map.

Information about the location appears.
6 Select  > Save as Waypoint.
Creating a Track from a Saved Activity
You can create a track from a saved activity. This allows you to 
share your track wirelessly with other compatible Garmin 
devices.
1 Select Recorded Activities.
2 Select an activity.
3 Select  > Save as Track.
Reversing an Activity
You can switch the start and end points of your activity to 
navigate the activity in reverse.
1 Select Recorded Activities.
2 Select an activity.
3 Select  > Copy Reversed.
Navigating a Saved Activity
1 Select  > Recorded Activities.
2 Select an activity.
3 Select Go.
Deleting a Saved Activity
1 Select Recorded Activities.
2 Select an activity.
3 Select  > Delete.

Weather
Active Weather: While your Montana device is connected to 

your smartphone or to a Wi‑Fi network and has an active 
internet connection, it can receive detailed weather 
information from the internet. This feature provides hourly 
and daily forecasts and live graphical weather maps.

inReach Weather: Your Montana 700i/750i can receive weather 
information through your inReach subscription. Your device 
can send an inReach message to request basic, premium, or 
marine weather forecasts. You can receive weather forecasts 
for your current location, a waypoint, GPS coordinates, or a 
location you choose on the map.

Requesting an inReach Weather Forecast
For the best results, you should ensure your device has a clear 
view of the sky when you request an inReach weather forecast.
Your device can send a message to request a basic, premium, 
or marine weather forecast using your inReach subscription. 
You can receive weather forecasts for your current location, a 
waypoint, GPS coordinates, or a location you choose on the 
map. Weather forecasts incur data charges or additional 
charges on your inReach subscription.
1 Select inReach > inReach Weather > New Forecast.

2 If necessary, select Forecast Type, and select a Basic or 
Premium weather forecast.

3 If necessary, select Location, and select a location.
By default, the device requests weather for your current 
location.

4 If necessary, select Marine to request a marine weather 
forecast.
NOTE: For best results, you should only request a marine 
forecast for a location away from shore and over a large body 
of water. Marine forecasts are not available for land locations 
or inland lakes.

5 Select Get Forecast.
The device sends a request for the forecast. It may take several 
minutes to receive the weather forecast data.
After the device finishes downloading the data, you can view the 
forecast at any time until all the information in the forecast has 
expired. You can also update the forecast at any time.

Updating an inReach Weather Forecast
You can update an inReach weather forecast that has expired or 
contains outdated information. Updating a forecast incurs the 
same data charges or additional charges as requesting a 
forecast.
1 Select inReach > inReach Weather.
2 Select a location with an outdated weather forecast.
3 Select Update Forecast.
The device requests an updated forecast. If you update the My 
Location forecast, the device requests an updated forecast for 
your current location. It may take several minutes to receive the 
updated weather forecast data.

Deleting an inReach Weather Forecast
You can delete an expired forecast or a forecast for a location 
that you no longer need.
1 Select inReach > inReach Weather.
2 Select a weather location.

NOTE: You cannot delete the My Location forecast.
3 Select  > Delete.

Viewing an Active Weather Forecast
While your Montana device is connected to your smartphone or 
to a Wi‑Fi network and has an active internet connection, it can 
receive detailed weather information from the internet.
1 Select Active Weather.

The device automatically downloads a weather forecast for 
your current location.

2 Select a day to view an hourly forecast, if available.
3 Select a time interval to view detailed weather information.

Viewing an Active Weather Map
While your device is connected to a smartphone or Wi‑Fi 
network with internet access, you can view a live weather map 
showing weather radar, cloud cover, temperature, or wind 
conditions.
1 Select Active Weather.
2 Select an option:

NOTE: Some options may not be available in all areas.
• To view a weather radar, select .
• To view cloud coverage, select .
• To view temperatures, select .
• To view wind speeds and directions, select .
The selected data appears on the map. The device may take 
a few moments to load the weather map data.
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 pontot.
 •  Hőmérsékleti adatok megtekintéséhez válasszuk a 

3 Select .
Viewing the Elevation Plot of an Activity
1 Select Recorded Activities.
2 Select an activity.
3 Select .
Saving a Location from an Activity
1 Select Recorded Activities.
2 Select an activity.
3 Select .
4 Select a location in the activity.
5 Select the location information at the top of the map.

Information about the location appears.
6 Select  > Save as Waypoint.
Creating a Track from a Saved Activity
You can create a track from a saved activity. This allows you to 
share your track wirelessly with other compatible Garmin 
devices.
1 Select Recorded Activities.
2 Select an activity.
3 Select  > Save as Track.
Reversing an Activity
You can switch the start and end points of your activity to 
navigate the activity in reverse.
1 Select Recorded Activities.
2 Select an activity.
3 Select  > Copy Reversed.
Navigating a Saved Activity
1 Select  > Recorded Activities.
2 Select an activity.
3 Select Go.
Deleting a Saved Activity
1 Select Recorded Activities.
2 Select an activity.
3 Select  > Delete.

Weather
Active Weather: While your Montana device is connected to 

your smartphone or to a Wi‑Fi network and has an active 
internet connection, it can receive detailed weather 
information from the internet. This feature provides hourly 
and daily forecasts and live graphical weather maps.

inReach Weather: Your Montana 700i/750i can receive weather 
information through your inReach subscription. Your device 
can send an inReach message to request basic, premium, or 
marine weather forecasts. You can receive weather forecasts 
for your current location, a waypoint, GPS coordinates, or a 
location you choose on the map.

Requesting an inReach Weather Forecast
For the best results, you should ensure your device has a clear 
view of the sky when you request an inReach weather forecast.
Your device can send a message to request a basic, premium, 
or marine weather forecast using your inReach subscription. 
You can receive weather forecasts for your current location, a 
waypoint, GPS coordinates, or a location you choose on the 
map. Weather forecasts incur data charges or additional 
charges on your inReach subscription.
1 Select inReach > inReach Weather > New Forecast.

2 If necessary, select Forecast Type, and select a Basic or 
Premium weather forecast.

3 If necessary, select Location, and select a location.
By default, the device requests weather for your current 
location.

4 If necessary, select Marine to request a marine weather 
forecast.
NOTE: For best results, you should only request a marine 
forecast for a location away from shore and over a large body 
of water. Marine forecasts are not available for land locations 
or inland lakes.

5 Select Get Forecast.
The device sends a request for the forecast. It may take several 
minutes to receive the weather forecast data.
After the device finishes downloading the data, you can view the 
forecast at any time until all the information in the forecast has 
expired. You can also update the forecast at any time.

Updating an inReach Weather Forecast
You can update an inReach weather forecast that has expired or 
contains outdated information. Updating a forecast incurs the 
same data charges or additional charges as requesting a 
forecast.
1 Select inReach > inReach Weather.
2 Select a location with an outdated weather forecast.
3 Select Update Forecast.
The device requests an updated forecast. If you update the My 
Location forecast, the device requests an updated forecast for 
your current location. It may take several minutes to receive the 
updated weather forecast data.

Deleting an inReach Weather Forecast
You can delete an expired forecast or a forecast for a location 
that you no longer need.
1 Select inReach > inReach Weather.
2 Select a weather location.

NOTE: You cannot delete the My Location forecast.
3 Select  > Delete.

Viewing an Active Weather Forecast
While your Montana device is connected to your smartphone or 
to a Wi‑Fi network and has an active internet connection, it can 
receive detailed weather information from the internet.
1 Select Active Weather.

The device automatically downloads a weather forecast for 
your current location.

2 Select a day to view an hourly forecast, if available.
3 Select a time interval to view detailed weather information.

Viewing an Active Weather Map
While your device is connected to a smartphone or Wi‑Fi 
network with internet access, you can view a live weather map 
showing weather radar, cloud cover, temperature, or wind 
conditions.
1 Select Active Weather.
2 Select an option:

NOTE: Some options may not be available in all areas.
• To view a weather radar, select .
• To view cloud coverage, select .
• To view temperatures, select .
• To view wind speeds and directions, select .
The selected data appears on the map. The device may take 
a few moments to load the weather map data.
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 •  A szélsebesség és -irány megtekintéséhez válasszuk a 

3 Select .
Viewing the Elevation Plot of an Activity
1 Select Recorded Activities.
2 Select an activity.
3 Select .
Saving a Location from an Activity
1 Select Recorded Activities.
2 Select an activity.
3 Select .
4 Select a location in the activity.
5 Select the location information at the top of the map.

Information about the location appears.
6 Select  > Save as Waypoint.
Creating a Track from a Saved Activity
You can create a track from a saved activity. This allows you to 
share your track wirelessly with other compatible Garmin 
devices.
1 Select Recorded Activities.
2 Select an activity.
3 Select  > Save as Track.
Reversing an Activity
You can switch the start and end points of your activity to 
navigate the activity in reverse.
1 Select Recorded Activities.
2 Select an activity.
3 Select  > Copy Reversed.
Navigating a Saved Activity
1 Select  > Recorded Activities.
2 Select an activity.
3 Select Go.
Deleting a Saved Activity
1 Select Recorded Activities.
2 Select an activity.
3 Select  > Delete.

Weather
Active Weather: While your Montana device is connected to 

your smartphone or to a Wi‑Fi network and has an active 
internet connection, it can receive detailed weather 
information from the internet. This feature provides hourly 
and daily forecasts and live graphical weather maps.

inReach Weather: Your Montana 700i/750i can receive weather 
information through your inReach subscription. Your device 
can send an inReach message to request basic, premium, or 
marine weather forecasts. You can receive weather forecasts 
for your current location, a waypoint, GPS coordinates, or a 
location you choose on the map.

Requesting an inReach Weather Forecast
For the best results, you should ensure your device has a clear 
view of the sky when you request an inReach weather forecast.
Your device can send a message to request a basic, premium, 
or marine weather forecast using your inReach subscription. 
You can receive weather forecasts for your current location, a 
waypoint, GPS coordinates, or a location you choose on the 
map. Weather forecasts incur data charges or additional 
charges on your inReach subscription.
1 Select inReach > inReach Weather > New Forecast.

2 If necessary, select Forecast Type, and select a Basic or 
Premium weather forecast.

3 If necessary, select Location, and select a location.
By default, the device requests weather for your current 
location.

4 If necessary, select Marine to request a marine weather 
forecast.
NOTE: For best results, you should only request a marine 
forecast for a location away from shore and over a large body 
of water. Marine forecasts are not available for land locations 
or inland lakes.

5 Select Get Forecast.
The device sends a request for the forecast. It may take several 
minutes to receive the weather forecast data.
After the device finishes downloading the data, you can view the 
forecast at any time until all the information in the forecast has 
expired. You can also update the forecast at any time.

Updating an inReach Weather Forecast
You can update an inReach weather forecast that has expired or 
contains outdated information. Updating a forecast incurs the 
same data charges or additional charges as requesting a 
forecast.
1 Select inReach > inReach Weather.
2 Select a location with an outdated weather forecast.
3 Select Update Forecast.
The device requests an updated forecast. If you update the My 
Location forecast, the device requests an updated forecast for 
your current location. It may take several minutes to receive the 
updated weather forecast data.

Deleting an inReach Weather Forecast
You can delete an expired forecast or a forecast for a location 
that you no longer need.
1 Select inReach > inReach Weather.
2 Select a weather location.

NOTE: You cannot delete the My Location forecast.
3 Select  > Delete.

Viewing an Active Weather Forecast
While your Montana device is connected to your smartphone or 
to a Wi‑Fi network and has an active internet connection, it can 
receive detailed weather information from the internet.
1 Select Active Weather.

The device automatically downloads a weather forecast for 
your current location.

2 Select a day to view an hourly forecast, if available.
3 Select a time interval to view detailed weather information.

Viewing an Active Weather Map
While your device is connected to a smartphone or Wi‑Fi 
network with internet access, you can view a live weather map 
showing weather radar, cloud cover, temperature, or wind 
conditions.
1 Select Active Weather.
2 Select an option:

NOTE: Some options may not be available in all areas.
• To view a weather radar, select .
• To view cloud coverage, select .
• To view temperatures, select .
• To view wind speeds and directions, select .
The selected data appears on the map. The device may take 
a few moments to load the weather map data.
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 pontot.
A kiválasztott adatok megjelennek a térképen. A készüléknek az időjárási tér-
kép adatainak megjelenítéséhez néhány pillanatra van szüksége.
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3.  Válasszunk az alábbiak közül:
 •  A térképen a 

3 Select an option:
• To zoom in or out on the map, select  or .
• To view different areas, drag the map.

Adding an Active Weather Location
You can add a weather location to view active weather for 
waypoints, GPS coordinates, or other locations.
1 While viewing an active weather forecast, select  > 

Manage Locations > New Location.
2 Select a location.
3 Select Use.

The device downloads a forecast for the selected location.
Switching the Active Weather Location
You can quickly switch between forecasts for active weather 
locations you have previously added.
1 While viewing an active weather forecast, select  > 

Manage Locations.
2 Select a location from the list.

TIP: The My Location option always downloads a forecast for 
your current location.

3 Select Use.
The device downloads the most recent forecast for the 
selected location.

Deleting an Active Weather Location
1 While viewing an active weather forecast, select  > 

Manage Locations.
2 Select a location from the list.

NOTE: You cannot delete the My Location forecast.
3 Select Delete.

Main Menu Applications
Select .
NOTE: Some applications do not appear in the main menu by 
default. You may need to add applications to the main menu 
before you can select them (Customizing the Main Menu, 
page 14).
Active Route: Displays your active route and any upcoming 

waypoints (Routes, page 10).
Active Weather: Displays the current temperature, temperature 

forecast, weather forecast, weather radar, cloud cover, and 
wind conditions (Viewing an Active Weather Forecast, 
page 12).

Adventures: Displays a list of adventures from the BaseCamp™

application (Garmin Adventures, page 14).
Alarm Clock: Sets an audible alarm. If you are not currently 

using the device, you can set the device to turn on at a 
specific time (Setting an Alarm, page 14).

Altimeter: Displays the elevation over distance traveled 
(Altimeter, page 6).

Area Calculation: Allows you to calculate the size of an area 
(Calculating the Size of an Area, page 14).

BirdsEye Direct: Allows you to download BirdsEye Satellite 
Imagery to your device (BirdsEye Imagery, page 14).

Calculator: Displays a calculator.
Calendar: Displays a calendar.
Camera: Allows you to take photos with the camera (Camera 

and Photos, page 15).
NOTE: The camera is available only on the Montana 750i 
device.

Compass: Displays the compass (Compass, page 5).

Connect IQ: Displays a list of installed Connect IQ apps 
(Connect IQ Features, page 8).

Contacts: Allows you to add, edit, and delete contacts for 
inReach messages (inReach Features, page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

DogTrack: Allows you to see information transmitted from a 
handheld dog tracking device on your Montana device (Dog 
Tracking, page 15).

Flashlight: Turns on the flashlight (Using the Flashlight, 
page 15).

Geocaching: Displays a list of downloaded geocaches 
(Geocaches, page 15).

Hunt and Fish: Displays the predicted best dates and times for 
hunting and fishing at your current location.

inReach: Provides access to inReach features, including 
messaging, SOS, tracking, and inReach Weather (inReach 
Features, page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

inReach Remote: Allows you to send messages on your paired 
inReach device (Using the inReach Remote, page 17).
NOTE: The inReach Remote feature is available only on the 
Montana 700 device.

inReach Utilities: Allows you to view details about your 
inReach subscription, check mail, and test the device 
(inReach Features, page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

inReach Weather: Allows you to request basic, premium, or 
marine weather forecasts using your inReach subscription 
device (inReach Features, page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

Man Overboard: Allows you to save a man overboard (MOB) 
location and navigate back to it (Marking and Starting 
Navigation to a Man Overboard Location, page 17).

Map: Displays the map (Map, page 5).
Mark Waypoint: Saves your current location as a waypoint.
Messages: Allows you to send a preset or text message over 

the Iridium satellite network (inReach Features, page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

Notifications: Alerts you to incoming calls, texts, social network 
updates, and more, based on your smartphone notification 
settings (Phone Notifications, page 7).

Photo Viewer: Displays saved photos.
Profile Change: Allows you to change the device profile to 

customize your settings and data fields for a particular activity 
or trip (Selecting a Profile, page 17).

Proximity Alarms: Allows you to set alerts to sound within 
range of particular locations (Setting a Proximity Alarm, 
page 17).

Recorded Activities: Displays your current activity and a list of 
recorded activities (Recordings, page 10).

Recording Controls: Allows you to view details about the 
current activity and control the current activity recording 
(Viewing the Current Activity, page 11).

Route Planner: Displays a list of saved routes and allows you to 
create new routes (Creating a Route, page 10).

Satellite: Displays your current GPS satellite information 
(Satellite Page, page 17).
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3 Select an option:

• To zoom in or out on the map, select  or .
• To view different areas, drag the map.

Adding an Active Weather Location
You can add a weather location to view active weather for 
waypoints, GPS coordinates, or other locations.
1 While viewing an active weather forecast, select  > 

Manage Locations > New Location.
2 Select a location.
3 Select Use.

The device downloads a forecast for the selected location.
Switching the Active Weather Location
You can quickly switch between forecasts for active weather 
locations you have previously added.
1 While viewing an active weather forecast, select  > 

Manage Locations.
2 Select a location from the list.

TIP: The My Location option always downloads a forecast for 
your current location.

3 Select Use.
The device downloads the most recent forecast for the 
selected location.

Deleting an Active Weather Location
1 While viewing an active weather forecast, select  > 

Manage Locations.
2 Select a location from the list.

NOTE: You cannot delete the My Location forecast.
3 Select Delete.

Main Menu Applications
Select .
NOTE: Some applications do not appear in the main menu by 
default. You may need to add applications to the main menu 
before you can select them (Customizing the Main Menu, 
page 14).
Active Route: Displays your active route and any upcoming 

waypoints (Routes, page 10).
Active Weather: Displays the current temperature, temperature 

forecast, weather forecast, weather radar, cloud cover, and 
wind conditions (Viewing an Active Weather Forecast, 
page 12).

Adventures: Displays a list of adventures from the BaseCamp™

application (Garmin Adventures, page 14).
Alarm Clock: Sets an audible alarm. If you are not currently 

using the device, you can set the device to turn on at a 
specific time (Setting an Alarm, page 14).

Altimeter: Displays the elevation over distance traveled 
(Altimeter, page 6).

Area Calculation: Allows you to calculate the size of an area 
(Calculating the Size of an Area, page 14).

BirdsEye Direct: Allows you to download BirdsEye Satellite 
Imagery to your device (BirdsEye Imagery, page 14).

Calculator: Displays a calculator.
Calendar: Displays a calendar.
Camera: Allows you to take photos with the camera (Camera 

and Photos, page 15).
NOTE: The camera is available only on the Montana 750i 
device.

Compass: Displays the compass (Compass, page 5).

Connect IQ: Displays a list of installed Connect IQ apps 
(Connect IQ Features, page 8).

Contacts: Allows you to add, edit, and delete contacts for 
inReach messages (inReach Features, page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

DogTrack: Allows you to see information transmitted from a 
handheld dog tracking device on your Montana device (Dog 
Tracking, page 15).

Flashlight: Turns on the flashlight (Using the Flashlight, 
page 15).

Geocaching: Displays a list of downloaded geocaches 
(Geocaches, page 15).

Hunt and Fish: Displays the predicted best dates and times for 
hunting and fishing at your current location.

inReach: Provides access to inReach features, including 
messaging, SOS, tracking, and inReach Weather (inReach 
Features, page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

inReach Remote: Allows you to send messages on your paired 
inReach device (Using the inReach Remote, page 17).
NOTE: The inReach Remote feature is available only on the 
Montana 700 device.

inReach Utilities: Allows you to view details about your 
inReach subscription, check mail, and test the device 
(inReach Features, page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

inReach Weather: Allows you to request basic, premium, or 
marine weather forecasts using your inReach subscription 
device (inReach Features, page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

Man Overboard: Allows you to save a man overboard (MOB) 
location and navigate back to it (Marking and Starting 
Navigation to a Man Overboard Location, page 17).

Map: Displays the map (Map, page 5).
Mark Waypoint: Saves your current location as a waypoint.
Messages: Allows you to send a preset or text message over 

the Iridium satellite network (inReach Features, page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

Notifications: Alerts you to incoming calls, texts, social network 
updates, and more, based on your smartphone notification 
settings (Phone Notifications, page 7).

Photo Viewer: Displays saved photos.
Profile Change: Allows you to change the device profile to 

customize your settings and data fields for a particular activity 
or trip (Selecting a Profile, page 17).

Proximity Alarms: Allows you to set alerts to sound within 
range of particular locations (Setting a Proximity Alarm, 
page 17).

Recorded Activities: Displays your current activity and a list of 
recorded activities (Recordings, page 10).

Recording Controls: Allows you to view details about the 
current activity and control the current activity recording 
(Viewing the Current Activity, page 11).

Route Planner: Displays a list of saved routes and allows you to 
create new routes (Creating a Route, page 10).

Satellite: Displays your current GPS satellite information 
(Satellite Page, page 17).
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 pontokkal nagyíthatunk és kicsinyíthetünk.
 •   A különböző területek megtekintéséhez ujjunk az érintőképernyőn tör-

ténő elhúzásával pásztázzunk a térképen.

Aktív időjárási hely hozzáadása
Időjárási helyeket adhatunk hozzá, így útpontok, GPS-koordináták és egyéb 
helyek aktív időjárási viszonyait tekinthetjük meg.
1.   Aktív időjárási előrejelzés képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 > Helyek kezelése 
> Új hely pontot.

2.  Válasszuk ki a kívánt helyet.
3.  Válasszuk a Használ pontot.
 A készülék előrejelzést tölt le a kiválasztott helyre.

Léptetés aktív időjárási helyek között
A korábban hozzáadott aktív időjárási helyek között gyorsan léptethe-
tünk.
1.  Aktív időjárási előrejelzés képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 > Helyek kezelése 
pontot.

2.  Válasszunk egy helyet a listából.
 TIPP! A Saját pozíció pont mindig az aktuális pozíciónkra tölti le az elő-

rejelzést.
3.  Válasszuk a Használ pontot.
 A készülék letölti a legfrissebb előrejelzést a kiválasztott helyre.

Aktív időjárási hely törlése
1.  Aktív időjárási előrejelzés képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 > Helyek kezelése 
pontot.

2.  Válasszunk egy helyet a listából.
 NE FELEDJÜK! A Saját pozíció előrejelzést nem törölhetjük.
3.  Válasszuk a Törlés pontot.

Főmenü funkciók
Válaszuk a 

2 Plug the small end of the USB cable into the USB port on 
your device.

3 Plug the large end of the USB cable into an AC adapter or a 
computer USB port.

4 If necessary, plug the AC adapter into a standard wall outlet.
When you connect the device to a power source, the device 
turns on.

5 Charge the battery completely.
TIP: The battery gauge appears in the status bar.

Saving Energy While Charging the Device
1 Connect your device to an external power source.
2 Hold the power button until the screen turns off.

The device goes into a low power, battery charging mode, 
and the battery gauge appears.

3 Charge the device completely.

Long-Term Storage
When you do not plan to use the device for several months, you 
should charge the battery to at least 50% before you store the 
device. You should store the device in a cool, dry place with 
temperatures around the typical household level. After storage, 
you should fully recharge the device before using it.

Using the Power Button
By default, you can use the power button to turn the device on 
and off, turn off the screen, and open the status page. You can 
customize the power button functions (Customizing the Power 
Button, page 19).
• Press  to turn on the device.
• Press  to open the status page.
• Press  twice to turn off the screen.

TIP: You can press  to turn the screen back on.
• Hold  to turn off the device.

Viewing the Status Page
The status page displays the current activity recording, 
Bluetooth® and Wi‑Fi® connection status, and provides quick 
access to frequently used functions such as marking waypoints, 
locking the touchscreen, and adjusting the backlight brightness.

Press  or swipe down from the top of the screen to open 
the status page.

Adjusting the Backlight
Extensive use of screen backlighting can significantly reduce 
battery life. You can adjust the backlight brightness to maximize 
the battery life.
NOTE: The backlight brightness may be limited when the 
remaining battery power is low.
1 Press  to open the status page.
2 Use the slider to adjust the backlight brightness.

Using the Touchscreen
• Tap the screen to select an item.
• Make each touchscreen selection a separate action.
• Select  to save your changes and close the page.
• Select  to close the page.
• Select  to return to the previous page.
• Select  to return to the main menu.
• Select  to view specific menu items for the page you are 

viewing.

Locking the Touchscreen
You can lock the screen to prevent inadvertent screen touches.
1 Press  to open the status page.
2 Select .

Unlocking the Touchscreen
Press .

Activating the Device
 WARNING

Before you can use the inReach features of your Montana 700i/
750i device, you must activate it (inReach Features, page 3).

1 Create an account, and select a satellite subscription at 
explore.garmin.com.

2 Turn on the device.
3 Select Next.
4 Follow the on-screen instructions.

NOTE: You must enter the device IMEI number and 
authorization code to complete the online portion of activation 
before you go outdoors.

5 Go outdoors to an open area with a clear view of the sky, and 
point the antenna on the device toward the sky for optimal 
performance.

6 Wait while the device communicates with the Iridium satellite 
network.
NOTE: It may take up to 20 minutes to activate your device. 
The device must send and receive several messages, which 
takes longer than sending a single message during regular 
use. You should remain outdoors until activation completes.

Iridium Satellite Network
Your device requires a clear view of the sky to transmit 
messages and track points over the Iridium satellite network. 
Without a clear view of the sky, your device attempts to send the 
information until it acquires satellite signals.
TIP: For the best connection with satellites, hold the device with 
the antenna pointed toward the sky.

Acquiring Satellite Signals
It may take 30 to 60 seconds to acquire satellite signals.
1 Go outdoors to an open area.
2 If necessary, turn on the device.
3 Wait while the device searches for satellites.

 flashes while the device determines your GNSS location.
 in the status bar shows the satellite signal strength.

When the device acquires satellite signals, it automatically starts 
recording your path as an activity.

Status Icons
ANT+® sensor status
GPS signal strength
Charging battery

2 Introduction

 pontot.
MEGJEGYZÉS! Egyes funkciók alapértelmezetten nem jelennek meg a fő-
menüben. Ha ezeket a funkciókat szeretnénk használni, akkor hozzá kell ad-
nunk őket a főmenühöz (Főmenü személyre szabása, 14. oldal).
Aktív útvonal: Megjeleníti az aktív útvonalunkat és a következő útpontokat 

(Útvonalak, 10. oldal).
Aktív időjárás: Megjeleníti az aktuális hőmérsékletet, hőmérséklet előrejel-

zést, időjárás előrejelzést, időjárási radart, felhőfedést, és szélviszonyo-
kat (Aktív időjárás előrejelzés megtekintése, 12. oldal).

Kalandok: Kalandok listáját jeleníti meg BaseCamp™ alkalmazásból 
(Garmin kalandok, 14. oldal).

Ébresztőóra: Hangjelzéses ébresztőt állíthatunk be. Amennyiben jelenleg 
nem használjuk a készüléket, beállíthatjuk, hogy az adott időben bekap-
csoljon.

Magasságmérő: Megjeleníti a megtett távolság emelkedését (Magasság-
mérő, 6. oldal).

Területszámítás: Egy adott terület nagyságát mérhetjük meg (Területszá-
mítás, 14. oldal).

BirdsEye Direct: BirdsEye műholdképeket tölthetünk le a készülékre 
(BirdsEye műholdképek, 14. oldal).

Számológép: Egy számológépet jelenít meg.
Naptár: Egy naptárat jelenít meg.
Kamera: Fotók készítését teszi lehetővé a kamerával (Fotó készítése, 15. ol-

dal).
 MEGJEGYZÉS! A kamera kizárólag a Montana 750i készüléken érhető 

el.
Iránytű: Megjeleníti az iránytűt (Iránytű, 5. oldal).
Connect IQ: Megjeleníti a telepített Connect IQ alkalmazások listáját 

(Connect IQ funkciók, 8. oldal).

Ismerősök: Ismerősöket adhatunk hozzá, szerkeszthetünk, akiknek inReach 
üzeneteket küldhetünk, illetve törölhetjük őket (inReach funkciók, 3. oldal).

 MEGJEGYZÉS! Az inReach funkciók kizárólag a Montana 700i/750i ké-
szüléken érhetők el.

DogTrack: Kézi kutya nyomkövető eszközről sugárzott információkat tekint-
hetünk meg a Montana készüléken (Kutya követés, 15. oldal).

Zseblámpa: Aktiválja a zseblámpát (Zseblámpa funkció, 15. oldal).
Geoláda-keresés: Megjeleníti a letöltött geoládák listáját (Geoláda-keresés, 

15. oldal).
Vadászat és halászat: Megjeleníti az előrelátható legjobb időpontokat vadá-

szathoz és halászathoz az aktuális tartózkodási helyünkön.
inReach: Hozzáférést biztosít az inReach funkciókhoz, mint például üzenet-

küldés, SOS, nyomon követés, és inReach időjárás (inReach funkciók, 
3. oldal).

 MEGJEGYZÉS! Az inReach funkciók kizárólag a Montana 700i/750i ké-
szüléken érhetők el.

inReach távvezérlő: Lehetővé teszi az üzenetek küldését a párosított 
inReach készülékünkről (inReach távvezérlő funkció, 17. oldal).

 MEGJEGYZÉS! Az inReach távvezérlő funkció kizárólag a Montana 700 
készüléken érhetők el.

inReach eszközök: Lehetővé teszi az inReach előfizetésünkkel kapcsola-
tos információk megtekintését, elektronikus postafiókunk ellenőrzését és 
a készülék tesztelését (inReach funkciók, 3. oldal).

 MEGJEGYZÉS! Az inReach funkciók kizárólag a Montana 700i/750i ké-
szüléken érhetők el.

inReach időjárás: Lehetővé teszi az alapvető, prémium és tengeri időjá-
rás előrejelzések igénylését az inReach előfizetésünkkel (inReach funk-
ciók, 3. oldal).

 MEGJEGYZÉS! Az inReach funkciók kizárólag a Montana 700i/750i ké-
szüléken érhetők el.

Ember a vízben: Ember a vízben (MOB) helyszínt menthetünk el, ahova 
visszanavigálhatunk (Ember a vízben hely megjelölése és navigáció in-
dítása felé, 17. oldal).

Térkép: Megjeleníti a térképet (Térkép képernyő, 5. oldal).
Útpont megjelölés: Aktuális pozíciónkat menti útpontként.
Üzenetek: Lehetővé teszi az előre beállított vagy szöveges üzenetek küldé-

sét az Iridium műholdas hálózaton keresztül (inReach funkciók, 3. oldal).
 MEGJEGYZÉS! Az inReach funkciók kizárólag a Montana 700i/750i ké-

szüléken érhetők el.
Értesítések: tájékoztatást kapunk a telefonra beérkező hívásokról, szöve-

ges üzenetekről, a közösségi hálón aktiválódó frissítésekről (a funkció az 
okostelefon beállításaitól függően működik) (Telefonos értesítések, 7. ol-
dal).

Fényképnézegető: Mentett fotókat jeleníti meg.
Profilváltás: Módosíthatjuk a készülék profilját, hogy a beállításokat és adat-

mezőket egy adott tevékenységhez vagy utazáshoz igazítsuk (Profilvál-
tás, 17. oldal).

Közelségi riasztások: Egyes helyektől bizonyos távolságon belül lépés ese-
tén közelségi riasztásokat állíthatunk be a készüléken (Közelségi riasztás 
beállítása, 17. oldal).

Rögzített tevékenységek: Megjeleníti az aktuális tevékenységünket, vala-
mint a felvett tevékenységek listáját (Felvételek, 10. oldal).

Rögzített vezérlők: Részleteket jeleníthetünk meg az aktuális tevékenység-
ről, valamint vezérelhetjük az aktuális tevékenység felvételét (Aktuális te-
vékenység megtekintése, 11. oldal).

Útvonaltervező: Megjeleníti a mentett útvonalak listáját, és lehetővé teszi új 
útvonalak létrehozását (Útpont létrehozása, 9. oldal).

Műhold: Megjeleníti az aktuális GPS-es műholdinformációkat (Műhold kép-
ernyő, 17. oldal).

Mentett nyomvonalak: Megjeleníti a mentett nyomvonalak listáját (Pálya 
létrehozása mentett tevékenységből, 12. oldal).
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Beállítások: Testreszabhatjuk a készüléket a beállítások menü eszközei se-
gítségével (Beállítások képernyő, 18. oldal).

Vezeték nélküli megosztás: Egy másik kompatibilis eszközzel vezeték nél-
küli csatlakozáson keresztül oszthatunk meg fájlokat (Adatmegosztás ve-
zeték nélküli kapcsolaton keresztül, 18. oldal).

Mutat és megy: A készüléket egy távoli tárgy irányába mutatva referencia-
pontként állíthatjuk be, és aszerint navigálhatunk (Mutat és megy navigá-
ció, 6. oldal).

SOS: SOS mentést kezdeményezhetünk (inReach funkciók, 3. oldal).
 MEGJEGYZÉS! Az inReach funkciók kizárólag a Montana 700i/750i ké-

szüléken érhetők el.
Stopper: Stopper használatát, körök jelölését és időzítését teszi lehetővé.
Nap és Hold: mutatja a napfelkelte, naplemente és a hold fázisát a GPS tar-

tózkodási helyünk alapján.
Fedélzeti számítógép: Megjeleníti a fedélzeti számítógépet (Fedélzeti szá-

mítógép képernyő, 6. oldal).
Nyomon követés: Nyomvonal-pontokat vehetünk fel, amiket az Iridium mű-

holdas hálózaton keresztül továbbíthatunk (inReach funkciók, 3. oldal).
 MEGJEGYZÉS! Az inReach funkciók kizárólag a Montana 700i/750i ké-

szüléken érhetők el.
VIRB távvezérlés: a készülékhez VIRB akciókamerát csatlakoztatva a ké-

szülékről vezérelhetjük a felvételt. (VIRB® akciókamera távvezérlő funk-
ció, 18. oldal).

Útpont átlagolás: Pontosíthatunk egy útpont helyén a pontosabb adatok el-
érése érdekében (Útpont helyzetének pontosítása, 9. oldal).

Útpontkezelő: Megjeleníti a készülékre lementett összes útpontot (Útpon-
tok, 9. oldal).

Hova?: Úticélra kereshetünk rá, amihez elnavigálhatunk (Hova? képernyő, 
8. oldal).

XERO helyek: lézeres helyinformációkat mutat, amikor Xero® íjászati irány-
zék van a készülékkel párosítva.

Főmenü személyre szabása
A főmenühöz funkciókat adhatunk hozzá, eltávolíthatjuk, illetve megváltoztat-
hatjuk a funkciók sorrendjét.
 •   Nyomjuk le hosszan a kívánt ikont a főmenüben, és húzzuk át a kívánt 

helyre.
 •   Nyomjuk le hosszan bármelyik ikont a főmenüben, majd húzzuk azt a  

Record Method: Sets the recording method. The Auto option 
records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.
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 pontra a főmenüből való törléséhez.
 •   Válaszuk a Képernyő hozzáadása pontot, válasszunk egy fület, majd 

válasszuk ki a főmenühöz hozzáadni kívánt funkciót.
 •   Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Funkciósorrend módosítása pontot, válasszuk ki 
a kívánt funkciót, és kövessük a képernyőn megjelenő utasításokat a 
funkciók sorrendjének megváltoztatásához, illetve funkciók hozzáadá-
sához vagy eltávolításához a főmenüből.

Garmin kalandok
Az összekapcsolódó elemeket „kalandként” csoportosíthatjuk. Például hoz-
zunk létre egy kalandot a legutolsó hegyi túra megosztásához. A kaland tar-
talmazhatja a túra nyomvonalnaplóját, a túra során készült fotókat, a megta-
lált geoládákat. A BaseCamp™ segítségével hozhatunk létre és kezelhetjük 
a kalandokat. További részletek a garmin.com/basecamp oldalon.

Fájlok küldése és fogadása BaseCamp szoftverrel
1.  Nyissuk meg a BaseCamp programot.
2.  Csatlakoztassuk a készüléket a számítógéphez.
3.  Válasszunk az alábbiak küzül:
 •   Válasszunk egy elemet a csatlakoztatott készülékről, és azt húzzuk a 

Saját gyűjtemény-be vagy egy listába.
 •   Válasszunk egy elemet a Saját gyűjtemény-búé vagy egy listából, és 

húzzuk a csatlakoztatott készülékre.

Kaland létrehozása
Először le kell töltenünk a BaseCamp szoftvert, a nyomvonalat át kell másol-
nunk a számítógépre, csak ezután hozhatjuk létre a kalandot (Fájlok küldé-
se és fogadása BaseCamp szoftverrel, 14. oldal).
1.  Nyissuk meg a BaseCamp szoftvert.
2.   Válasszuk a File (Fájl) > New (Új) > Garmin Adventure (Garmin Ka-

land) pontot.
3.   Válasszunk egy nyomvonalat, majd a Next (Tovább) pontot.
4.   Ha szükséges, adjunk további elemeket a BaseCampből.
5.   Töltsük ki a szükséges adatmezőket (név, leírás stb.).
6.   Amennyiben a borítóképet módosítani kívánjuk, válasszuk a Change 

(Módosít) pontot, majd válasszunk ki egy eltérő fotót.
7.   Válasszuk a Finish pontot.

Kaland indítása
Kaland indításázoz először le kell töltsük a kalandot a BaseCamp szoft-
verről a készülékre (Fájlok küldése és fogadása BaseCamp szoftverrel, 
14. oldal).
Mentett kaland indítása esetén a készülék követi az elmentett pályát, és rövi-
dítéseket, kapcsolódó információkat (pl. fotók és útpontok) jelenít meg a pá-
lya mentén.
1.  Válasszuk a Kalandok pontot.
 MEGJEGYZÉS! Előfordulhat, hogy a funkciót hozzá kell adnunk a főmenü-

höz, mielőtt kiválaszthatnánk (Főmenü személyre szabása, 14. oldal).
2.  Válasszunk ki egy kalandot.
3.  Válasszuk az Indítás pontot.

Ébresztés beállítása
1.  Válasszuk a Ébresztőóra pontot
 MEGJEGYZÉS! Előfordulhat, hogy a funkciót hozzá kell adnunk a fő-

menühöz, mielőtt kiválaszthatnánk (Főmenü személyre szabása, 14. ol-
dal).

2.  A 

Saved Tracks: Displays a list of saved tracks (Creating a Track 
from a Saved Activity, page 12).

Setup: Allows you to customize the device using the setup 
menu tools (Setup Menu, page 18).

Share Wirelessly: Allows you to wirelessly transfer files to 
another compatible Garmin device (Sending and Receiving 
Data Wirelessly, page 18).

Sight 'N Go: Allows you to point the device at an object in the 
distance, and navigate using the object as a reference point 
(Navigating with Sight 'N Go, page 6).

SOS: Allows you to initiate an SOS rescue (inReach Features, 
page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

Stopwatch: Allows you to use a timer, mark a lap, and time 
laps.

Sun and Moon: Displays sunrise and sunset times, along with 
the moon phase, based on your GPS position.

Trip Computer: Displays the trip computer (Trip Computer, 
page 6).

Tracking: Allows you to record track points and transmit them 
over the Iridium satellite network (inReach Features, page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

VIRB Remote: Provides camera controls when you have a 
VIRB® camera paired with your Montana device (Using the 
VIRB Remote, page 18).

Waypoint Averaging: Allows you to refine a waypoint location 
for more accuracy (Increasing the Accuracy of a Waypoint 
Location, page 9).

Waypoint Manager: Displays all waypoints saved to the device 
(Waypoints, page 9).

Where To?: Allows you to find a destination to navigate to 
(Where To? Page, page 8).

XERO Locations: Displays laser location information when you 
have a compatible Xero® device paired with your Montana 
device.

Customizing the Main Menu
You can add, remove, and change the order of items in the main 
menu.
• Hold any icon in the main menu, and drag it to a new 

location.
• Hold any icon in the main menu, and drag it to  to remove it 

from the main menu.
• Select Add Page, select a tab, and select an item to add to 

the main menu.
• Select  > Change Item Order, select an item, and follow 

the on-screen instructions to change the order, add, or 
remove the item from the main menu.

Garmin Adventures
You can group related items together as an adventure. For 
example, you can create an adventure for your latest hiking trip. 
The adventure could contain the track log of the trip, photos of 
the trip, and geocaches you hunted. You can use BaseCamp to 
create and manage your adventures. For more information, go 
to garmin.com/basecamp.

Sending Files to and from BaseCamp
1 Open BaseCamp.
2 Connect the device to your computer.
3 Select an option:

• Select an item from a connected device and drag it to My 
Collection or to a list.

• Select an item from My Collection or a list and drag it to a 
connected device.

Creating an Adventure
Before you can create an adventure and send it to your device, 
you must download BaseCamp to your computer and transfer a 
track from your device to your computer (Sending Files to and 
from BaseCamp, page 14).
1 Open BaseCamp.
2 Select File > New > Garmin Adventure.
3 Select a track, and select Next.
4 If necessary, add items from BaseCamp.
5 Complete the required fields to name and describe the 

adventure.
6 If you want to change the cover photo for the adventure, 

select Change, and select a different photo.
7 Select Finish.

Starting an Adventure
Before you can start an adventure, you must send an adventure 
from BaseCamp to your device (Sending Files to and from 
BaseCamp, page 14).
When you start a saved adventure, the device follows the saved 
track and displays shortcuts to related information along the 
track, such as photos and waypoints.
1 Select Adventures.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Select an adventure.
3 Select Start.

Setting an Alarm
1 Select Alarm Clock.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Select  and  to set the time.
3 Select Turn Alarm On.
4 Select an option.

The alarm sounds at the selected time. If the device is off at 
the alarm time, the device turns on and sounds the alarm.

Starting the Countdown Timer
1 Select Alarm Clock >  > Timer.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Select  and  to set the time.
3 Select Start Timer.

Calculating the Size of an Area
1 Select Area Calculation > Start.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Walk around the perimeter of the area you want to calculate.
3 Select Calculate when finished.

BirdsEye Imagery
BirdsEye imagery provides downloadable, high-resolution map 
imagery, including detailed satellite imagery and raster-based 
topographical maps. You can download BirdsEye Satellite 
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Saved Tracks: Displays a list of saved tracks (Creating a Track 
from a Saved Activity, page 12).

Setup: Allows you to customize the device using the setup 
menu tools (Setup Menu, page 18).

Share Wirelessly: Allows you to wirelessly transfer files to 
another compatible Garmin device (Sending and Receiving 
Data Wirelessly, page 18).

Sight 'N Go: Allows you to point the device at an object in the 
distance, and navigate using the object as a reference point 
(Navigating with Sight 'N Go, page 6).

SOS: Allows you to initiate an SOS rescue (inReach Features, 
page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

Stopwatch: Allows you to use a timer, mark a lap, and time 
laps.

Sun and Moon: Displays sunrise and sunset times, along with 
the moon phase, based on your GPS position.

Trip Computer: Displays the trip computer (Trip Computer, 
page 6).

Tracking: Allows you to record track points and transmit them 
over the Iridium satellite network (inReach Features, page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

VIRB Remote: Provides camera controls when you have a 
VIRB® camera paired with your Montana device (Using the 
VIRB Remote, page 18).

Waypoint Averaging: Allows you to refine a waypoint location 
for more accuracy (Increasing the Accuracy of a Waypoint 
Location, page 9).

Waypoint Manager: Displays all waypoints saved to the device 
(Waypoints, page 9).

Where To?: Allows you to find a destination to navigate to 
(Where To? Page, page 8).

XERO Locations: Displays laser location information when you 
have a compatible Xero® device paired with your Montana 
device.

Customizing the Main Menu
You can add, remove, and change the order of items in the main 
menu.
• Hold any icon in the main menu, and drag it to a new 

location.
• Hold any icon in the main menu, and drag it to  to remove it 

from the main menu.
• Select Add Page, select a tab, and select an item to add to 

the main menu.
• Select  > Change Item Order, select an item, and follow 

the on-screen instructions to change the order, add, or 
remove the item from the main menu.

Garmin Adventures
You can group related items together as an adventure. For 
example, you can create an adventure for your latest hiking trip. 
The adventure could contain the track log of the trip, photos of 
the trip, and geocaches you hunted. You can use BaseCamp to 
create and manage your adventures. For more information, go 
to garmin.com/basecamp.

Sending Files to and from BaseCamp
1 Open BaseCamp.
2 Connect the device to your computer.
3 Select an option:

• Select an item from a connected device and drag it to My 
Collection or to a list.

• Select an item from My Collection or a list and drag it to a 
connected device.

Creating an Adventure
Before you can create an adventure and send it to your device, 
you must download BaseCamp to your computer and transfer a 
track from your device to your computer (Sending Files to and 
from BaseCamp, page 14).
1 Open BaseCamp.
2 Select File > New > Garmin Adventure.
3 Select a track, and select Next.
4 If necessary, add items from BaseCamp.
5 Complete the required fields to name and describe the 

adventure.
6 If you want to change the cover photo for the adventure, 

select Change, and select a different photo.
7 Select Finish.

Starting an Adventure
Before you can start an adventure, you must send an adventure 
from BaseCamp to your device (Sending Files to and from 
BaseCamp, page 14).
When you start a saved adventure, the device follows the saved 
track and displays shortcuts to related information along the 
track, such as photos and waypoints.
1 Select Adventures.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Select an adventure.
3 Select Start.

Setting an Alarm
1 Select Alarm Clock.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Select  and  to set the time.
3 Select Turn Alarm On.
4 Select an option.

The alarm sounds at the selected time. If the device is off at 
the alarm time, the device turns on and sounds the alarm.

Starting the Countdown Timer
1 Select Alarm Clock >  > Timer.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Select  and  to set the time.
3 Select Start Timer.

Calculating the Size of an Area
1 Select Area Calculation > Start.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Walk around the perimeter of the area you want to calculate.
3 Select Calculate when finished.

BirdsEye Imagery
BirdsEye imagery provides downloadable, high-resolution map 
imagery, including detailed satellite imagery and raster-based 
topographical maps. You can download BirdsEye Satellite 

14 Main Menu Applications

 gombokkal állítsuk be az ébresztés idejét.
3. Válasszuk a Riasztás bekapcs. pontot az ébresztés aktiválásához.
4.  Válasszunk egy lehetőséget.
 A készülék a megadott időben riaszt, illetve amennyiben ki van kapcsolva 

a megadott időpontban, bekapcsol és ezután riaszt.

Visszaszámlálás indítása
1.  Válasszuk az Ébresztőóra > 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Időzítő pontot.
 MEGJEGYZÉS! Előfordulhat, hogy a funkciót hozzá kell adnunk a főmenü-

höz, mielőtt kiválaszthatnánk (Főmenü személyre szabása, 14. oldal).
2.  A 

Saved Tracks: Displays a list of saved tracks (Creating a Track 
from a Saved Activity, page 12).

Setup: Allows you to customize the device using the setup 
menu tools (Setup Menu, page 18).

Share Wirelessly: Allows you to wirelessly transfer files to 
another compatible Garmin device (Sending and Receiving 
Data Wirelessly, page 18).

Sight 'N Go: Allows you to point the device at an object in the 
distance, and navigate using the object as a reference point 
(Navigating with Sight 'N Go, page 6).

SOS: Allows you to initiate an SOS rescue (inReach Features, 
page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

Stopwatch: Allows you to use a timer, mark a lap, and time 
laps.

Sun and Moon: Displays sunrise and sunset times, along with 
the moon phase, based on your GPS position.

Trip Computer: Displays the trip computer (Trip Computer, 
page 6).

Tracking: Allows you to record track points and transmit them 
over the Iridium satellite network (inReach Features, page 3).
NOTE: inReach features are available only on the Montana 
700i/750i device.

VIRB Remote: Provides camera controls when you have a 
VIRB® camera paired with your Montana device (Using the 
VIRB Remote, page 18).

Waypoint Averaging: Allows you to refine a waypoint location 
for more accuracy (Increasing the Accuracy of a Waypoint 
Location, page 9).

Waypoint Manager: Displays all waypoints saved to the device 
(Waypoints, page 9).

Where To?: Allows you to find a destination to navigate to 
(Where To? Page, page 8).

XERO Locations: Displays laser location information when you 
have a compatible Xero® device paired with your Montana 
device.

Customizing the Main Menu
You can add, remove, and change the order of items in the main 
menu.
• Hold any icon in the main menu, and drag it to a new 

location.
• Hold any icon in the main menu, and drag it to  to remove it 

from the main menu.
• Select Add Page, select a tab, and select an item to add to 

the main menu.
• Select  > Change Item Order, select an item, and follow 

the on-screen instructions to change the order, add, or 
remove the item from the main menu.

Garmin Adventures
You can group related items together as an adventure. For 
example, you can create an adventure for your latest hiking trip. 
The adventure could contain the track log of the trip, photos of 
the trip, and geocaches you hunted. You can use BaseCamp to 
create and manage your adventures. For more information, go 
to garmin.com/basecamp.

Sending Files to and from BaseCamp
1 Open BaseCamp.
2 Connect the device to your computer.
3 Select an option:

• Select an item from a connected device and drag it to My 
Collection or to a list.

• Select an item from My Collection or a list and drag it to a 
connected device.

Creating an Adventure
Before you can create an adventure and send it to your device, 
you must download BaseCamp to your computer and transfer a 
track from your device to your computer (Sending Files to and 
from BaseCamp, page 14).
1 Open BaseCamp.
2 Select File > New > Garmin Adventure.
3 Select a track, and select Next.
4 If necessary, add items from BaseCamp.
5 Complete the required fields to name and describe the 

adventure.
6 If you want to change the cover photo for the adventure, 

select Change, and select a different photo.
7 Select Finish.

Starting an Adventure
Before you can start an adventure, you must send an adventure 
from BaseCamp to your device (Sending Files to and from 
BaseCamp, page 14).
When you start a saved adventure, the device follows the saved 
track and displays shortcuts to related information along the 
track, such as photos and waypoints.
1 Select Adventures.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Select an adventure.
3 Select Start.

Setting an Alarm
1 Select Alarm Clock.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Select  and  to set the time.
3 Select Turn Alarm On.
4 Select an option.

The alarm sounds at the selected time. If the device is off at 
the alarm time, the device turns on and sounds the alarm.

Starting the Countdown Timer
1 Select Alarm Clock >  > Timer.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Select  and  to set the time.
3 Select Start Timer.

Calculating the Size of an Area
1 Select Area Calculation > Start.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Walk around the perimeter of the area you want to calculate.
3 Select Calculate when finished.

BirdsEye Imagery
BirdsEye imagery provides downloadable, high-resolution map 
imagery, including detailed satellite imagery and raster-based 
topographical maps. You can download BirdsEye Satellite 
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Saved Tracks: Displays a list of saved tracks (Creating a Track 
from a Saved Activity, page 12).
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menu tools (Setup Menu, page 18).
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Data Wirelessly, page 18).
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SOS: Allows you to initiate an SOS rescue (inReach Features, 
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Stopwatch: Allows you to use a timer, mark a lap, and time 
laps.
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Where To?: Allows you to find a destination to navigate to 
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XERO Locations: Displays laser location information when you 
have a compatible Xero® device paired with your Montana 
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• Hold any icon in the main menu, and drag it to  to remove it 
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example, you can create an adventure for your latest hiking trip. 
The adventure could contain the track log of the trip, photos of 
the trip, and geocaches you hunted. You can use BaseCamp to 
create and manage your adventures. For more information, go 
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• Select an item from My Collection or a list and drag it to a 
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Creating an Adventure
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3 Select a track, and select Next.
4 If necessary, add items from BaseCamp.
5 Complete the required fields to name and describe the 
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6 If you want to change the cover photo for the adventure, 

select Change, and select a different photo.
7 Select Finish.

Starting an Adventure
Before you can start an adventure, you must send an adventure 
from BaseCamp to your device (Sending Files to and from 
BaseCamp, page 14).
When you start a saved adventure, the device follows the saved 
track and displays shortcuts to related information along the 
track, such as photos and waypoints.
1 Select Adventures.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Select an adventure.
3 Select Start.

Setting an Alarm
1 Select Alarm Clock.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Select  and  to set the time.
3 Select Turn Alarm On.
4 Select an option.

The alarm sounds at the selected time. If the device is off at 
the alarm time, the device turns on and sounds the alarm.

Starting the Countdown Timer
1 Select Alarm Clock >  > Timer.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Select  and  to set the time.
3 Select Start Timer.

Calculating the Size of an Area
1 Select Area Calculation > Start.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Walk around the perimeter of the area you want to calculate.
3 Select Calculate when finished.

BirdsEye Imagery
BirdsEye imagery provides downloadable, high-resolution map 
imagery, including detailed satellite imagery and raster-based 
topographical maps. You can download BirdsEye Satellite 
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 gombokkal állítsuk be az időtartamot.
3.  Válasszuk az Időzítő indítása pontot.

Területszámítás
1.  Válasszuk a Területmérés > Indítás pontot.
 MEGJEGYZÉS! Előfordulhat, hogy a funkciót hozzá kell adnunk a fő-

menühöz, mielőtt kiválaszthatnánk (Főmenü személyre szabása, 14. ol-
dal).

2.  Sétáljuk körbe a megmérni kívánt területet.
3.  Amikor körbejártuk a területet, válasszuk a Számítás pontot.

BirdsEye műholdképek
A BirdsEye nagy felbontású térképek letöltését teszi lehetővé, beleértve a 
részletes műholdképeket, és raszter alapú topográfiai térképeket. A BirdsEye 
Wi-Fi kapcsolat mellett letölthető közvetlenül a Garmin készülékre.
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BirdsEye műholdképek letöltése
Mielőtt a BirdsEye-t letölthetnénk a készülékre, először csatlakoznunk kell 
egy vezeték nélküli hálózatra (Csatlakozás vezeték nélküli hálózathoz, 7. ol-
dal).
1.   Válasszuk a BirdsEye Direct > Műholdképek letöltése pontot.
2.   Válasszunk az alábbiak közül:
 •   Adott helyre vagy területre vonatkozó BirdsEye műholdképek letölté-

séhez válasszuk a Hely opciót, majd válasszunk kategóriát.
    MEGJEGYZÉS! Az alapértelmezett helye a jelenlegi tartózkodási he-

lyünk.
 •   A letöltött műholdképek átnevezéséhez válasszuk a Név pontot.
 •   A képek minőségének módosításához válasszuk a Részletesség 

pontot.
 •   A letöltött műholdképek által megjelenítendő terület nagyságának 

beállításához válasszuk a Sugár pontot, majd adjuk meg a hatósu-
garat.

  Egy becsült fájlméret jelenik meg a kiválasztott képminőségre és méret-
re vonatkozóan. Ellenőrizzük, hogy a műholdkép letöltéséhez a készülék 
elegendő tárhellyel rendelkezik.

3.   Válasszuk a Letöltés pontot.

Fényképezőgép és fotók
A Montana 750i típusú készülék tartalmaz beépített kamerát. Amennyiben 
engedélyezzük ezt a funkciót, fotó vagy videó készítésekor a kiegészítő ada-
tok között a fénykép készítésének földrajzi helye (pozíciója) is automatiku-
san mentésre kerül. Később a fényképet kiválasztva navigációt indíthatunk 
a fényképhez.

Fotó készítése
1.  Válasszuk a Kamera pontot.
2.   A fénykép formátumát állítsuk be a készülék vízszintes vagy függőleges 

helyzetbe történő elforgatásával.
3.   Igény szerint a  kiválasztásával kapcsoljuk be a vakut.
 TIPP! Az Automatikus beállítást kiválasztva a készülék a környezeti 

fényviszonyok alapján automatikusan kezeli a vakut.
4.   Amennyiben szükséges, az érintőképernyőn két ujjunk összehúzásával 

közelítsünk, széthúzásával távolítsunk (Érintőképernyő használata, 2. ol-
dal).

5.   Érintsük hosszan a  gombot a fókuszáláshoz, közben tartsuk stabilan 
a készüléket. Fehér keret jelenik meg a képernyőn. A készülék a kereten 
belüli tárgyra fókuszál. Amikor a kép éles, a keret zöldre vált. 

6.   Engedjük el a  gombot az exponáláshoz.

Kutya követés
A kutya nyomkövető funkció segítségével kompatibilis kézi kutya nyomkö-
vető eszközről sugárzott információkat tekinthetünk meg a Montana készü-
léken. Elnavigálhatunk a kutyáink pozíciójára, megtekinthetjük aktuális ál-
lapotukat és tartózkodási helyüket, valamint a kézi készüléktől mért távol-
ságukat.

Kézi kutyakövető készülékről sugárzott információk 
fogadása
Adatok fogadása előtt a kompatibilis kutyakövető készüléken aktiválnunk kell 
az adatsugárzás funkciót. További információkért lásd a kézi kutyakövető ké-
szülék használati utasítását.
1.  Hozzuk a kézi kutyakövető készüléket és a Montana készüléket egymás-

tól 3 méteres távolságon belül.
 TIPP! A Montana készülék egyszerre csak egy kompatibilis készülékről 

érkező adatokat képes fogadni. Tartsunk 3 méternél nagyobb távolságot 
más készülékektől, illetve kapcsoljuk ki azon készülékek adatsugárzás 
funkcióját, amelyekről nem szeretnénk adatokat fogadni.

2.  A Montana készüléken válasszuk a DogTrack pontot.
 MEGJEGYZÉS! Előfordulhat, hogy a funkciót hozzá kell adnunk a fő-

menühöz, mielőtt kiválaszthatnánk (Főmenü személyre szabása, 14. ol-
dal).

3.  Amennyiben szükséges, válasszuk az Igent a kutya nyomkövető funkció 
engedélyezéséhez.

4.  Válasszuk az Állapot > Új keresése pontot.
  A közeli készülékek listája jelenik meg.
5.  Válasszuk ki a kutyakövető készülékünket a listából.
A készülékek kapcsolatot létesítenek és automatikusan szinkronizálják ada-
taikat.

Kutya nyomon követése
1.  Válasszuk a DogTrack pontot.
 A kézi készülékkel kapcsolatban lévő kutyák megjelennek a képernyőn.
2.  Válasszunk egy kutyát.
 A kutya tartózkodási helye és pályanaplója megjelenik a térképen.
3. Válasszuk a Menj pontot, és navigáljunk el a kutyánkig.

Kutya állapotjelző ikonok
A kutya listán látható ikonok jelzik a kutyáink állapotát és helyét.

Imagery directly to your device when it is connected to a Wi‑Fi 
network.

Downloading BirdsEye Imagery
Before you can download BirdsEye imagery directly to your 
device, you must connect to a wireless network (Connecting to a 
Wireless Network, page 7).
1 Select BirdsEye Direct > Download Imagery.
2 Select an option:

• To download BirdsEye imagery files for a specific location 
or area, select Location, and select a category.
NOTE: The location defaults to your current location.

• To edit the name of the downloaded imagery files, select 
Name.

• To select an image quality option, select Detail.
• To define the size of the area to be shown in the 

downloaded imagery files, select Radius, and enter a 
distance from the selected location.

An estimated file size appears for the selected image quality 
and radius. You should verify your device has enough 
available storage space for the imagery file.

3 Select Download.

Camera and Photos
You can take photos with your Montana 750i device. If enabled, 
the geographic location is automatically saved in the photo 
information. You can navigate to the location.

Taking a Photo
1 Select Camera.
2 Turn the device horizontally or vertically to change the 

orientation of the photo.
3 If necessary, select  to turn on the flash.

TIP: You can select Auto to use the flash only when the 
camera detects a low-light scene.

4 If necessary, pinch or spread two fingers on the touchscreen 
to zoom in or out (Using the Touchscreen, page 2).

5 Hold  to focus and hold the device still.
A white frame appears on the screen. The device focuses on 
the object inside of the frame. When the photo is in focus, the 
frame turns green.

6 Release  to take a photo.

Dog Tracking
The dog tracking features allow you to see information 
transmitted from your compatible handheld dog tracking device 
on your Montana device. You can navigate to your dogs, view 
their current status and location, and view their distance from 
the handheld device.

Receiving Data From Your Handheld Dog Device
Before you can receive data, you must enable broadcasting on 
your compatible handheld dog tracking device. See the owner's 
manual for your handheld dog tracking device for more 
information.
1 Place your handheld dog tracking device within 3 m (10 ft.) of 

your Montana device.
TIP: Your Montana device receives data from one compatible 
device at a time. Stay more than 3 m (10 ft.) away from other 
devices or disable broadcasting on devices from which you 
do not want to receive data.

2 On your Montana device, select DogTrack.
NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

3 If necessary, select Yes to enable the dog tracking feature.
4 Select Status > Search For New.

A list of nearby devices appears.
5 Select your dog tracking device from the list.
The devices connect and synchronize automatically.

Tracking Your Dogs
1 Select DogTrack.

The dogs connected to your handheld device appear on the 
screen.

2 Select a dog.
The dog's location and track log appear on the map.

3 Select Go to navigate to your dog.
Dog Status Icons
Icons on the dog list page indicate the status and location of 
your dogs.

Sitting
Running
On point
Treed
Unknown1

Using the Flashlight
NOTE: Using the flashlight can reduce battery life. You can 
reduce the brightness or flash frequency to extend the life of the 
battery.
1 Select Flashlight > .

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 If necessary, use the brightness slider to adjust the 
brightness.

3 If necessary, select a different flash type.
0 No strobe, constant beam.
1 through 9 Number of strobes per second.
SOS Emergency strobe.

NOTE: Wi‑Fi, Bluetooth, and ANT+ connections are 
disabled in SOS mode.

Geocaches
Geocaching is a treasure hunting activity in which players hide 
or search for hidden caches using clues and GPS coordinates.

Registering Your Device at Geocaching.com
You can register your device at www.geocaching.com to search 
for a list of nearby geocaches, or to search live information for 
millions of geocaches.
1 Connect to a wireless network (Connecting to a Wireless 

Network, page 7) or to the Garmin Connect app (Pairing a 
Smartphone with Your Device, page 7).

2 Select Setup > Geocaching > Register Device.
An activation code appears.

3 Follow the on-screen instructions.
4 Select Confirm Registration.
Connecting to Geocaching.com
After you register, you can view geocaches from 
www.geocaching.com on your device while connected 
wirelessly.
• Connect to the Garmin Connect app.

1 The unknown status icon indicates the collar has not acquired a satellite signal 
and the handheld device cannot determine the location of the dog.
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Imagery directly to your device when it is connected to a Wi‑Fi 
network.

Downloading BirdsEye Imagery
Before you can download BirdsEye imagery directly to your 
device, you must connect to a wireless network (Connecting to a 
Wireless Network, page 7).
1 Select BirdsEye Direct > Download Imagery.
2 Select an option:

• To download BirdsEye imagery files for a specific location 
or area, select Location, and select a category.
NOTE: The location defaults to your current location.

• To edit the name of the downloaded imagery files, select 
Name.

• To select an image quality option, select Detail.
• To define the size of the area to be shown in the 

downloaded imagery files, select Radius, and enter a 
distance from the selected location.

An estimated file size appears for the selected image quality 
and radius. You should verify your device has enough 
available storage space for the imagery file.

3 Select Download.

Camera and Photos
You can take photos with your Montana 750i device. If enabled, 
the geographic location is automatically saved in the photo 
information. You can navigate to the location.

Taking a Photo
1 Select Camera.
2 Turn the device horizontally or vertically to change the 

orientation of the photo.
3 If necessary, select  to turn on the flash.

TIP: You can select Auto to use the flash only when the 
camera detects a low-light scene.

4 If necessary, pinch or spread two fingers on the touchscreen 
to zoom in or out (Using the Touchscreen, page 2).

5 Hold  to focus and hold the device still.
A white frame appears on the screen. The device focuses on 
the object inside of the frame. When the photo is in focus, the 
frame turns green.

6 Release  to take a photo.

Dog Tracking
The dog tracking features allow you to see information 
transmitted from your compatible handheld dog tracking device 
on your Montana device. You can navigate to your dogs, view 
their current status and location, and view their distance from 
the handheld device.

Receiving Data From Your Handheld Dog Device
Before you can receive data, you must enable broadcasting on 
your compatible handheld dog tracking device. See the owner's 
manual for your handheld dog tracking device for more 
information.
1 Place your handheld dog tracking device within 3 m (10 ft.) of 

your Montana device.
TIP: Your Montana device receives data from one compatible 
device at a time. Stay more than 3 m (10 ft.) away from other 
devices or disable broadcasting on devices from which you 
do not want to receive data.

2 On your Montana device, select DogTrack.
NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

3 If necessary, select Yes to enable the dog tracking feature.
4 Select Status > Search For New.

A list of nearby devices appears.
5 Select your dog tracking device from the list.
The devices connect and synchronize automatically.

Tracking Your Dogs
1 Select DogTrack.

The dogs connected to your handheld device appear on the 
screen.

2 Select a dog.
The dog's location and track log appear on the map.

3 Select Go to navigate to your dog.
Dog Status Icons
Icons on the dog list page indicate the status and location of 
your dogs.

Sitting
Running
On point
Treed
Unknown1

Using the Flashlight
NOTE: Using the flashlight can reduce battery life. You can 
reduce the brightness or flash frequency to extend the life of the 
battery.
1 Select Flashlight > .

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 If necessary, use the brightness slider to adjust the 
brightness.

3 If necessary, select a different flash type.
0 No strobe, constant beam.
1 through 9 Number of strobes per second.
SOS Emergency strobe.

NOTE: Wi‑Fi, Bluetooth, and ANT+ connections are 
disabled in SOS mode.

Geocaches
Geocaching is a treasure hunting activity in which players hide 
or search for hidden caches using clues and GPS coordinates.

Registering Your Device at Geocaching.com
You can register your device at www.geocaching.com to search 
for a list of nearby geocaches, or to search live information for 
millions of geocaches.
1 Connect to a wireless network (Connecting to a Wireless 

Network, page 7) or to the Garmin Connect app (Pairing a 
Smartphone with Your Device, page 7).

2 Select Setup > Geocaching > Register Device.
An activation code appears.

3 Follow the on-screen instructions.
4 Select Confirm Registration.
Connecting to Geocaching.com
After you register, you can view geocaches from 
www.geocaching.com on your device while connected 
wirelessly.
• Connect to the Garmin Connect app.

1 The unknown status icon indicates the collar has not acquired a satellite signal 
and the handheld device cannot determine the location of the dog.
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Imagery directly to your device when it is connected to a Wi‑Fi 
network.

Downloading BirdsEye Imagery
Before you can download BirdsEye imagery directly to your 
device, you must connect to a wireless network (Connecting to a 
Wireless Network, page 7).
1 Select BirdsEye Direct > Download Imagery.
2 Select an option:

• To download BirdsEye imagery files for a specific location 
or area, select Location, and select a category.
NOTE: The location defaults to your current location.

• To edit the name of the downloaded imagery files, select 
Name.

• To select an image quality option, select Detail.
• To define the size of the area to be shown in the 

downloaded imagery files, select Radius, and enter a 
distance from the selected location.

An estimated file size appears for the selected image quality 
and radius. You should verify your device has enough 
available storage space for the imagery file.

3 Select Download.

Camera and Photos
You can take photos with your Montana 750i device. If enabled, 
the geographic location is automatically saved in the photo 
information. You can navigate to the location.

Taking a Photo
1 Select Camera.
2 Turn the device horizontally or vertically to change the 

orientation of the photo.
3 If necessary, select  to turn on the flash.

TIP: You can select Auto to use the flash only when the 
camera detects a low-light scene.

4 If necessary, pinch or spread two fingers on the touchscreen 
to zoom in or out (Using the Touchscreen, page 2).

5 Hold  to focus and hold the device still.
A white frame appears on the screen. The device focuses on 
the object inside of the frame. When the photo is in focus, the 
frame turns green.

6 Release  to take a photo.

Dog Tracking
The dog tracking features allow you to see information 
transmitted from your compatible handheld dog tracking device 
on your Montana device. You can navigate to your dogs, view 
their current status and location, and view their distance from 
the handheld device.

Receiving Data From Your Handheld Dog Device
Before you can receive data, you must enable broadcasting on 
your compatible handheld dog tracking device. See the owner's 
manual for your handheld dog tracking device for more 
information.
1 Place your handheld dog tracking device within 3 m (10 ft.) of 

your Montana device.
TIP: Your Montana device receives data from one compatible 
device at a time. Stay more than 3 m (10 ft.) away from other 
devices or disable broadcasting on devices from which you 
do not want to receive data.

2 On your Montana device, select DogTrack.
NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

3 If necessary, select Yes to enable the dog tracking feature.
4 Select Status > Search For New.

A list of nearby devices appears.
5 Select your dog tracking device from the list.
The devices connect and synchronize automatically.

Tracking Your Dogs
1 Select DogTrack.

The dogs connected to your handheld device appear on the 
screen.

2 Select a dog.
The dog's location and track log appear on the map.

3 Select Go to navigate to your dog.
Dog Status Icons
Icons on the dog list page indicate the status and location of 
your dogs.

Sitting
Running
On point
Treed
Unknown1

Using the Flashlight
NOTE: Using the flashlight can reduce battery life. You can 
reduce the brightness or flash frequency to extend the life of the 
battery.
1 Select Flashlight > .

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 If necessary, use the brightness slider to adjust the 
brightness.

3 If necessary, select a different flash type.
0 No strobe, constant beam.
1 through 9 Number of strobes per second.
SOS Emergency strobe.

NOTE: Wi‑Fi, Bluetooth, and ANT+ connections are 
disabled in SOS mode.

Geocaches
Geocaching is a treasure hunting activity in which players hide 
or search for hidden caches using clues and GPS coordinates.

Registering Your Device at Geocaching.com
You can register your device at www.geocaching.com to search 
for a list of nearby geocaches, or to search live information for 
millions of geocaches.
1 Connect to a wireless network (Connecting to a Wireless 

Network, page 7) or to the Garmin Connect app (Pairing a 
Smartphone with Your Device, page 7).

2 Select Setup > Geocaching > Register Device.
An activation code appears.

3 Follow the on-screen instructions.
4 Select Confirm Registration.
Connecting to Geocaching.com
After you register, you can view geocaches from 
www.geocaching.com on your device while connected 
wirelessly.
• Connect to the Garmin Connect app.

1 The unknown status icon indicates the collar has not acquired a satellite signal 
and the handheld device cannot determine the location of the dog.
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A kutya valamely irányba figyel

Imagery directly to your device when it is connected to a Wi‑Fi 
network.

Downloading BirdsEye Imagery
Before you can download BirdsEye imagery directly to your 
device, you must connect to a wireless network (Connecting to a 
Wireless Network, page 7).
1 Select BirdsEye Direct > Download Imagery.
2 Select an option:

• To download BirdsEye imagery files for a specific location 
or area, select Location, and select a category.
NOTE: The location defaults to your current location.

• To edit the name of the downloaded imagery files, select 
Name.

• To select an image quality option, select Detail.
• To define the size of the area to be shown in the 

downloaded imagery files, select Radius, and enter a 
distance from the selected location.

An estimated file size appears for the selected image quality 
and radius. You should verify your device has enough 
available storage space for the imagery file.

3 Select Download.

Camera and Photos
You can take photos with your Montana 750i device. If enabled, 
the geographic location is automatically saved in the photo 
information. You can navigate to the location.

Taking a Photo
1 Select Camera.
2 Turn the device horizontally or vertically to change the 

orientation of the photo.
3 If necessary, select  to turn on the flash.

TIP: You can select Auto to use the flash only when the 
camera detects a low-light scene.

4 If necessary, pinch or spread two fingers on the touchscreen 
to zoom in or out (Using the Touchscreen, page 2).

5 Hold  to focus and hold the device still.
A white frame appears on the screen. The device focuses on 
the object inside of the frame. When the photo is in focus, the 
frame turns green.

6 Release  to take a photo.

Dog Tracking
The dog tracking features allow you to see information 
transmitted from your compatible handheld dog tracking device 
on your Montana device. You can navigate to your dogs, view 
their current status and location, and view their distance from 
the handheld device.

Receiving Data From Your Handheld Dog Device
Before you can receive data, you must enable broadcasting on 
your compatible handheld dog tracking device. See the owner's 
manual for your handheld dog tracking device for more 
information.
1 Place your handheld dog tracking device within 3 m (10 ft.) of 

your Montana device.
TIP: Your Montana device receives data from one compatible 
device at a time. Stay more than 3 m (10 ft.) away from other 
devices or disable broadcasting on devices from which you 
do not want to receive data.

2 On your Montana device, select DogTrack.
NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

3 If necessary, select Yes to enable the dog tracking feature.
4 Select Status > Search For New.

A list of nearby devices appears.
5 Select your dog tracking device from the list.
The devices connect and synchronize automatically.

Tracking Your Dogs
1 Select DogTrack.

The dogs connected to your handheld device appear on the 
screen.

2 Select a dog.
The dog's location and track log appear on the map.

3 Select Go to navigate to your dog.
Dog Status Icons
Icons on the dog list page indicate the status and location of 
your dogs.

Sitting
Running
On point
Treed
Unknown1

Using the Flashlight
NOTE: Using the flashlight can reduce battery life. You can 
reduce the brightness or flash frequency to extend the life of the 
battery.
1 Select Flashlight > .

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 If necessary, use the brightness slider to adjust the 
brightness.

3 If necessary, select a different flash type.
0 No strobe, constant beam.
1 through 9 Number of strobes per second.
SOS Emergency strobe.

NOTE: Wi‑Fi, Bluetooth, and ANT+ connections are 
disabled in SOS mode.

Geocaches
Geocaching is a treasure hunting activity in which players hide 
or search for hidden caches using clues and GPS coordinates.

Registering Your Device at Geocaching.com
You can register your device at www.geocaching.com to search 
for a list of nearby geocaches, or to search live information for 
millions of geocaches.
1 Connect to a wireless network (Connecting to a Wireless 

Network, page 7) or to the Garmin Connect app (Pairing a 
Smartphone with Your Device, page 7).

2 Select Setup > Geocaching > Register Device.
An activation code appears.

3 Follow the on-screen instructions.
4 Select Confirm Registration.
Connecting to Geocaching.com
After you register, you can view geocaches from 
www.geocaching.com on your device while connected 
wirelessly.
• Connect to the Garmin Connect app.

1 The unknown status icon indicates the collar has not acquired a satellite signal 
and the handheld device cannot determine the location of the dog.
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A kutya fán található tárgyra/élőlényre összpontosít

Imagery directly to your device when it is connected to a Wi‑Fi 
network.

Downloading BirdsEye Imagery
Before you can download BirdsEye imagery directly to your 
device, you must connect to a wireless network (Connecting to a 
Wireless Network, page 7).
1 Select BirdsEye Direct > Download Imagery.
2 Select an option:

• To download BirdsEye imagery files for a specific location 
or area, select Location, and select a category.
NOTE: The location defaults to your current location.

• To edit the name of the downloaded imagery files, select 
Name.

• To select an image quality option, select Detail.
• To define the size of the area to be shown in the 

downloaded imagery files, select Radius, and enter a 
distance from the selected location.

An estimated file size appears for the selected image quality 
and radius. You should verify your device has enough 
available storage space for the imagery file.

3 Select Download.

Camera and Photos
You can take photos with your Montana 750i device. If enabled, 
the geographic location is automatically saved in the photo 
information. You can navigate to the location.

Taking a Photo
1 Select Camera.
2 Turn the device horizontally or vertically to change the 

orientation of the photo.
3 If necessary, select  to turn on the flash.

TIP: You can select Auto to use the flash only when the 
camera detects a low-light scene.

4 If necessary, pinch or spread two fingers on the touchscreen 
to zoom in or out (Using the Touchscreen, page 2).

5 Hold  to focus and hold the device still.
A white frame appears on the screen. The device focuses on 
the object inside of the frame. When the photo is in focus, the 
frame turns green.

6 Release  to take a photo.

Dog Tracking
The dog tracking features allow you to see information 
transmitted from your compatible handheld dog tracking device 
on your Montana device. You can navigate to your dogs, view 
their current status and location, and view their distance from 
the handheld device.

Receiving Data From Your Handheld Dog Device
Before you can receive data, you must enable broadcasting on 
your compatible handheld dog tracking device. See the owner's 
manual for your handheld dog tracking device for more 
information.
1 Place your handheld dog tracking device within 3 m (10 ft.) of 

your Montana device.
TIP: Your Montana device receives data from one compatible 
device at a time. Stay more than 3 m (10 ft.) away from other 
devices or disable broadcasting on devices from which you 
do not want to receive data.

2 On your Montana device, select DogTrack.
NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

3 If necessary, select Yes to enable the dog tracking feature.
4 Select Status > Search For New.

A list of nearby devices appears.
5 Select your dog tracking device from the list.
The devices connect and synchronize automatically.

Tracking Your Dogs
1 Select DogTrack.

The dogs connected to your handheld device appear on the 
screen.

2 Select a dog.
The dog's location and track log appear on the map.

3 Select Go to navigate to your dog.
Dog Status Icons
Icons on the dog list page indicate the status and location of 
your dogs.

Sitting
Running
On point
Treed
Unknown1

Using the Flashlight
NOTE: Using the flashlight can reduce battery life. You can 
reduce the brightness or flash frequency to extend the life of the 
battery.
1 Select Flashlight > .

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 If necessary, use the brightness slider to adjust the 
brightness.

3 If necessary, select a different flash type.
0 No strobe, constant beam.
1 through 9 Number of strobes per second.
SOS Emergency strobe.

NOTE: Wi‑Fi, Bluetooth, and ANT+ connections are 
disabled in SOS mode.

Geocaches
Geocaching is a treasure hunting activity in which players hide 
or search for hidden caches using clues and GPS coordinates.

Registering Your Device at Geocaching.com
You can register your device at www.geocaching.com to search 
for a list of nearby geocaches, or to search live information for 
millions of geocaches.
1 Connect to a wireless network (Connecting to a Wireless 

Network, page 7) or to the Garmin Connect app (Pairing a 
Smartphone with Your Device, page 7).

2 Select Setup > Geocaching > Register Device.
An activation code appears.

3 Follow the on-screen instructions.
4 Select Confirm Registration.
Connecting to Geocaching.com
After you register, you can view geocaches from 
www.geocaching.com on your device while connected 
wirelessly.
• Connect to the Garmin Connect app.

1 The unknown status icon indicates the collar has not acquired a satellite signal 
and the handheld device cannot determine the location of the dog.
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Ismeretlen*
*  Az ismeretlen állapot azt jelenti, hogy a kutyanyakörv nem létesített műhol-

das kapcsolatot, és a kézi készülék képtelen meghatározni a kutya tartóz-
kodási helyét.

Zseblámpa funkció
MEGJEGYZÉS! A zseblámpa használata felgyorsítja az akkumulátor lemerí-
tését. Kevesebb energiahasználathoz csökkenthetjük a zseblámpa fényere-
jét vagy villanási frekvenciáját.
1.   Válasszuk a Zseblámpa pontot, majd nyomjuk meg a 

Imagery directly to your device when it is connected to a Wi‑Fi 
network.

Downloading BirdsEye Imagery
Before you can download BirdsEye imagery directly to your 
device, you must connect to a wireless network (Connecting to a 
Wireless Network, page 7).
1 Select BirdsEye Direct > Download Imagery.
2 Select an option:

• To download BirdsEye imagery files for a specific location 
or area, select Location, and select a category.
NOTE: The location defaults to your current location.

• To edit the name of the downloaded imagery files, select 
Name.

• To select an image quality option, select Detail.
• To define the size of the area to be shown in the 

downloaded imagery files, select Radius, and enter a 
distance from the selected location.

An estimated file size appears for the selected image quality 
and radius. You should verify your device has enough 
available storage space for the imagery file.

3 Select Download.

Camera and Photos
You can take photos with your Montana 750i device. If enabled, 
the geographic location is automatically saved in the photo 
information. You can navigate to the location.

Taking a Photo
1 Select Camera.
2 Turn the device horizontally or vertically to change the 

orientation of the photo.
3 If necessary, select  to turn on the flash.

TIP: You can select Auto to use the flash only when the 
camera detects a low-light scene.

4 If necessary, pinch or spread two fingers on the touchscreen 
to zoom in or out (Using the Touchscreen, page 2).

5 Hold  to focus and hold the device still.
A white frame appears on the screen. The device focuses on 
the object inside of the frame. When the photo is in focus, the 
frame turns green.

6 Release  to take a photo.

Dog Tracking
The dog tracking features allow you to see information 
transmitted from your compatible handheld dog tracking device 
on your Montana device. You can navigate to your dogs, view 
their current status and location, and view their distance from 
the handheld device.

Receiving Data From Your Handheld Dog Device
Before you can receive data, you must enable broadcasting on 
your compatible handheld dog tracking device. See the owner's 
manual for your handheld dog tracking device for more 
information.
1 Place your handheld dog tracking device within 3 m (10 ft.) of 

your Montana device.
TIP: Your Montana device receives data from one compatible 
device at a time. Stay more than 3 m (10 ft.) away from other 
devices or disable broadcasting on devices from which you 
do not want to receive data.

2 On your Montana device, select DogTrack.
NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

3 If necessary, select Yes to enable the dog tracking feature.
4 Select Status > Search For New.

A list of nearby devices appears.
5 Select your dog tracking device from the list.
The devices connect and synchronize automatically.

Tracking Your Dogs
1 Select DogTrack.

The dogs connected to your handheld device appear on the 
screen.

2 Select a dog.
The dog's location and track log appear on the map.

3 Select Go to navigate to your dog.
Dog Status Icons
Icons on the dog list page indicate the status and location of 
your dogs.

Sitting
Running
On point
Treed
Unknown1

Using the Flashlight
NOTE: Using the flashlight can reduce battery life. You can 
reduce the brightness or flash frequency to extend the life of the 
battery.
1 Select Flashlight > .

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 If necessary, use the brightness slider to adjust the 
brightness.

3 If necessary, select a different flash type.
0 No strobe, constant beam.
1 through 9 Number of strobes per second.
SOS Emergency strobe.

NOTE: Wi‑Fi, Bluetooth, and ANT+ connections are 
disabled in SOS mode.

Geocaches
Geocaching is a treasure hunting activity in which players hide 
or search for hidden caches using clues and GPS coordinates.

Registering Your Device at Geocaching.com
You can register your device at www.geocaching.com to search 
for a list of nearby geocaches, or to search live information for 
millions of geocaches.
1 Connect to a wireless network (Connecting to a Wireless 

Network, page 7) or to the Garmin Connect app (Pairing a 
Smartphone with Your Device, page 7).

2 Select Setup > Geocaching > Register Device.
An activation code appears.

3 Follow the on-screen instructions.
4 Select Confirm Registration.
Connecting to Geocaching.com
After you register, you can view geocaches from 
www.geocaching.com on your device while connected 
wirelessly.
• Connect to the Garmin Connect app.

1 The unknown status icon indicates the collar has not acquired a satellite signal 
and the handheld device cannot determine the location of the dog.
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 gombot.
 MEGJEZGYZÉS! Előfordulhat, hogy a funkciót hozzá kell adnunk a fő-

menühöz, mielőtt kiválaszthatnánk (Főmenü személyre szabása, 14. ol-
dal).

2.   Ha szükséges, a fényerő csúszkájával beállíthatjuk a fényerőt.
3.   Ha szükséges, válasszunk villanási módot.
0 Nincs villogás, folyamatos fény.
1-9 Másodpercenkénti villanások száma

SOS
Vészhelyzeti (stroboszkóp) villogás.
VIGYÁZAT! SOS módban a Wi-Fi, a Bluetooth 
és ANT+ kikapcsolt állapotban vannak.

Geoláda-keresés
A geoláda keresés tulajdonképp egy modern kincsvadászat. A feladat a GPS-
koordináták és egyéb nyomok alapján az elrejtett „kincsesládák” megkere-
sése.

Bejelentkezés a készülékkel a Geocaching.com oldalra
A www.geocaching.com oldalra beregisztrálva kereshetünk a közeli 
geoládahelyek között és valós időben kutathatunk a több milliós geoláda-
hely adatbázisban.
1.  Csatlakozzunk a vezeték nélküli hálózathoz (Csatlakozás vezeték nélküli 

hálózathoz, 7. oldal) vagy a Garmin Connect alkalmazáshoz (Okostelefon 
párosítása, 7. oldal).

2.  Válasszuk a Beállítások > Geocaching > Készülék regisztrálása pon-
tot.

 Egy aktivációs kód jelenik meg.
3.  Kövessük a képernyőn megjelenő utasításokat.
4.  Válasszuk a Regisztráció megerősítése pontot.

Belépés a Geocaching.com oldalra
A regisztrációt követően a készülékkel vezeték nélküli hálózatra csatlakoz-
va válogathatunk a www.geocaching.com oldalon található geoláda-helyek 
közül.

http://www.geocaching.com
http://www.geocaching.com
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•  Csatlakozzunk a Garmin Connect alkalmazáshoz.
•  Csatlakozzunk Wi-Fi hálózathoz.

Geoláda-helyek letöltése számítógép használatával
Számítógép használatával manuálisan is letölthetünk geoláda-helyeket (Fáj-
lok letöltése számítógépről a készülékre, 23. oldal). A geoláda-fájlokat alakít-
suk GPX fájlokká, majd ezeket másoljuk a készülék GPS mappájába. Ameny-
nyiben a geocaching.com oldalon prémium tagsággal rendelkezünk, a „zseb 
lekérés” (Pocket Query) funkcióval nagy számban tölthetünk le geoláda he-
lyeket úgy, hogy azokat egyetlen GPX fájlba „tömörítve” kapjuk meg.
1.   Az USB-kábellel csatlakoztassuk számítógéphez a készüléket.
2.   Lépjünk fel a www.geocaching.com oldalra.
3.   Amennyiben még nincs, hozzunk létre egy saját regisztrációs fiókot.
4.  Lépjünk be.
5.   Kövessük az utasításokat a geoláda pozíciók lekereséséhez és letöltésé-

hez.

Geoládák keresése
A készülékre letöltött geoláda-helyek között kereshetünk. Amennyiben fellép-
tünk a www.geocaching.com oldalra, valós időben kereshetünk a geoláda-
hely adatbázisban és azonnal le is tölthetünk geoláda-helyeket.
NE FELEDJÜK! Prémium fiókkal naponta több, mint három geoládáról tölthe-
tünk le részletes információkat. További részleteket lásd a www.geogaching.
com oldalon.

Geoláda-hely keresése
A készülékre letöltött geoláda-helyek között kereshetünk. Amennyiben fellép-
tünk a www.geocaching.com oldalra, valós időben kereshetünk a geoláda-
hely adatbázisban és azonnal le is tölthetünk geoládahelyeket.
NE FELEDJÜK! Részletes adatokat naponta korlátozott mennyiségű 
geoládához tölthetünk le. Több letöltéshez prémium fiókot hozhatunk létre. 
További részleteket lásd a www.geocaching.com oldalon.
1.  Válasszuk a Geocaching pontot.
2.  Válasszuk a 

• Connect to a Wi‑Fi network.

Downloading Geocaches Using a Computer
You can load geocaches manually onto your device using a 
computer (Transferring Files to Your Device, page 23). You 
can place the geocache files into a GPX file and import them 
into the GPX folder on the device. With a premium membership 
to geocaching.com, you can use the "pocket query" feature to 
load a large group of geocaches onto your device as a single 
GPX file.
1 Connect the device to your computer using a USB cable.
2 Go to www.geocaching.com.
3 If necessary, create an account.
4 Sign in.
5 Follow the instructions at geocaching.com to find and 

download geocaches to your device.

Geocache Searches
You can search the geocaches loaded on your device. If you are 
connected to www.geocaching.com, you can search live 
geocache data and download geocaches.
NOTE: You can download detailed information for more than 
three geocaches per day with a premium membership. Go to 
www.geocaching.com for more information.
Searching for a Geocache
You can search the geocaches loaded on your device. If you are 
connected to geocaching.com, you can search live geocache 
data and download geocaches.
NOTE: You can download detailed information for a limited 
number of geocaches per day. You can purchase a premium 
subscription to download more. Go to www.geocaching.com for 
more information.
1 Select Geocaching.
2 Select  > .
3 Select an option:

• To search the geocaches loaded on your device by name, 
select Spell Search, and enter a search term.

• To search for geocaches near you or near another 
location, select Search Near, and select a location.
If you are connected to www.geocaching.com, the search 
results include live geocache data obtained by GC Live 
Download.

• To search for live geocaches by code, select GC Live 
Download > GC Code, and enter the geocache code.
This feature allows you to download a specific geocache 
from www.geocaching.com when you know the geocache 
code.

4 Select  > Filter to filter the search results (optional).
5 Select a geocache.

The geocache details appear. If you selected a live geocache 
and you are connected, the device downloads the full 
geocache details to the internal storage, if necessary.

Searching for a Geocache on the Map
1 Select Geocaching.
2 Select .

If you are connected to www.geocaching.com, you can select 
 to refresh live geocaches near your location on the map.

3 Select  to filter the results (optional).
4 Select a geocache.

The geocache details appear. If you selected a live geocache 
and you are connected, the device downloads the full 
geocache details to the internal storage.

Filtering the Geocache List
You can filter your geocache list based on certain factors, such 
as the level of difficulty.
1 Select Geocaching >  > Filter.
2 Select one or more options to filter:

• To filter by a geocache category, such as puzzle or event, 
select Type.

• To filter by the physical size of the geocache container, 
select Cache Size.

• To filter by Unattempted, Did Not Find, or Found 
geocaches, select Status.

• To filter by the difficulty level of finding the geocache, or 
the difficulty of the terrain, select a level from 1 to 5.

3 Select  to view the filtered geocache list.
Saving a Custom Geocache Filter
You can create and save custom filters for geocaches based on 
specific factors.
1 Select Setup > Geocaching > Filter Setup > Create Filter.
2 Select the items to filter.
3 Select .

By default, the new filter is saved automatically as Filter 
followed by a number. For example, Filter 2. You can edit the 
geocache filter to change the name (Editing a Custom 
Geocache Filter, page 16).

Editing a Custom Geocache Filter
1 Select Setup > Geocaching > Filter Setup.
2 Select a filter.
3 Select an item to edit.
Applying a Custom Filter to a Geocache List
After you create a filter, you can apply it to the geocache list.
1 Select Geocaching >  >  >  > Apply a Saved Filter.
2 Select a filter.

Viewing Geocache Details
1 Select Geocaching.
2 Select a geocache.
3 Select  > Review Point.

The geocache description and logs appear.

Navigating to a Geocache
1 Select Geocaching.
2 Select a geocache.
3 Select Go.
Using Hints and Clues to find a Geocache
You can use hints or clues, such as a description or coordinates, 
to help you find a geocache.
1 While navigating to a geocache, select the geocache name.
2 Select an option:

• To view details about the geocache, select Description.
• To view a clue about a geocache location, select Hint.
• To view latitude and longitude for a geocache, select 

Coordinates.
• To view feedback about the geocache from previous 

searchers, select Logs.
• To turn chirp™ searching on, select chirp.

Logging the Attempt
After you have attempted to find a geocache, you can log your 
results. You can verify some geocaches at 
www.geocaching.com.
1 Select Geocaching > Log.
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Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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3.  Válasszunk az alábbiak közül:
 •   A Betűzés pontot választva a név vagy a név egy részletének meg-

adásával kereshetünk a geoláda-helyek között.
 •   Aktuális pozíciónk vagy egy eltérő hely közelében történő kereséshez 

válasszuk a Keresés a közelben pontot.
    Amennyiben felléptünk a geocaching.com oldalra, a GC Live 

Download pontot választva vagy a térképen a frissítés gombot érintve 
a listában a valós idejű geoláda-hely adatbázis találatai is szerepelnek 
majd.

 •   A valós idejű adatbázisban kód szerint történő kereséshez válasszuk a 
GC Live Download > GC Code pontot, és adjuk meg a geoláda kód-
ját.

    Amennyiben ismerjük a geoláda-hely kódját, letölthetjük azt a www.
geocaching.com oldal adatbázisából.

4.  A 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Szűrő ponttal leszűkíthetjük a találati listát (szűrhetünk a találatok 
között).

5.  Válasszunk ki egy geoláda-helyet.
 A hely adatai megjelennek. Amennyiben valós idejű geoláda-helyet vá-

lasztottunk ki, és csatlakozva vagyunk a geocaching.com oldalra, igény 
esetén a készülék a hely összes részletét letölti a készülék belső memó-
riájába.

Geoláda-hely keresése térképen
1.  Válasszuk a Geocaching pontot.
2.  Válasszuk a 

Record Method: Sets the recording method. The Auto option 
records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.
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 pontot.
 Amennyiben csatlakoztunk a www.geocaching.com oldalhoz, a 

• Connect to a Wi‑Fi network.

Downloading Geocaches Using a Computer
You can load geocaches manually onto your device using a 
computer (Transferring Files to Your Device, page 23). You 
can place the geocache files into a GPX file and import them 
into the GPX folder on the device. With a premium membership 
to geocaching.com, you can use the "pocket query" feature to 
load a large group of geocaches onto your device as a single 
GPX file.
1 Connect the device to your computer using a USB cable.
2 Go to www.geocaching.com.
3 If necessary, create an account.
4 Sign in.
5 Follow the instructions at geocaching.com to find and 

download geocaches to your device.

Geocache Searches
You can search the geocaches loaded on your device. If you are 
connected to www.geocaching.com, you can search live 
geocache data and download geocaches.
NOTE: You can download detailed information for more than 
three geocaches per day with a premium membership. Go to 
www.geocaching.com for more information.
Searching for a Geocache
You can search the geocaches loaded on your device. If you are 
connected to geocaching.com, you can search live geocache 
data and download geocaches.
NOTE: You can download detailed information for a limited 
number of geocaches per day. You can purchase a premium 
subscription to download more. Go to www.geocaching.com for 
more information.
1 Select Geocaching.
2 Select  > .
3 Select an option:

• To search the geocaches loaded on your device by name, 
select Spell Search, and enter a search term.

• To search for geocaches near you or near another 
location, select Search Near, and select a location.
If you are connected to www.geocaching.com, the search 
results include live geocache data obtained by GC Live 
Download.

• To search for live geocaches by code, select GC Live 
Download > GC Code, and enter the geocache code.
This feature allows you to download a specific geocache 
from www.geocaching.com when you know the geocache 
code.

4 Select  > Filter to filter the search results (optional).
5 Select a geocache.

The geocache details appear. If you selected a live geocache 
and you are connected, the device downloads the full 
geocache details to the internal storage, if necessary.

Searching for a Geocache on the Map
1 Select Geocaching.
2 Select .

If you are connected to www.geocaching.com, you can select 
 to refresh live geocaches near your location on the map.

3 Select  to filter the results (optional).
4 Select a geocache.

The geocache details appear. If you selected a live geocache 
and you are connected, the device downloads the full 
geocache details to the internal storage.

Filtering the Geocache List
You can filter your geocache list based on certain factors, such 
as the level of difficulty.
1 Select Geocaching >  > Filter.
2 Select one or more options to filter:

• To filter by a geocache category, such as puzzle or event, 
select Type.

• To filter by the physical size of the geocache container, 
select Cache Size.

• To filter by Unattempted, Did Not Find, or Found 
geocaches, select Status.

• To filter by the difficulty level of finding the geocache, or 
the difficulty of the terrain, select a level from 1 to 5.

3 Select  to view the filtered geocache list.
Saving a Custom Geocache Filter
You can create and save custom filters for geocaches based on 
specific factors.
1 Select Setup > Geocaching > Filter Setup > Create Filter.
2 Select the items to filter.
3 Select .

By default, the new filter is saved automatically as Filter 
followed by a number. For example, Filter 2. You can edit the 
geocache filter to change the name (Editing a Custom 
Geocache Filter, page 16).

Editing a Custom Geocache Filter
1 Select Setup > Geocaching > Filter Setup.
2 Select a filter.
3 Select an item to edit.
Applying a Custom Filter to a Geocache List
After you create a filter, you can apply it to the geocache list.
1 Select Geocaching >  >  >  > Apply a Saved Filter.
2 Select a filter.

Viewing Geocache Details
1 Select Geocaching.
2 Select a geocache.
3 Select  > Review Point.

The geocache description and logs appear.

Navigating to a Geocache
1 Select Geocaching.
2 Select a geocache.
3 Select Go.
Using Hints and Clues to find a Geocache
You can use hints or clues, such as a description or coordinates, 
to help you find a geocache.
1 While navigating to a geocache, select the geocache name.
2 Select an option:

• To view details about the geocache, select Description.
• To view a clue about a geocache location, select Hint.
• To view latitude and longitude for a geocache, select 

Coordinates.
• To view feedback about the geocache from previous 

searchers, select Logs.
• To turn chirp™ searching on, select chirp.

Logging the Attempt
After you have attempted to find a geocache, you can log your 
results. You can verify some geocaches at 
www.geocaching.com.
1 Select Geocaching > Log.
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 pont-
tal frissíthetjük a térképi pozíciónk közelében lévő valós idejű geoláda-
helyeket.

3.  A 

• Connect to a Wi‑Fi network.

Downloading Geocaches Using a Computer
You can load geocaches manually onto your device using a 
computer (Transferring Files to Your Device, page 23). You 
can place the geocache files into a GPX file and import them 
into the GPX folder on the device. With a premium membership 
to geocaching.com, you can use the "pocket query" feature to 
load a large group of geocaches onto your device as a single 
GPX file.
1 Connect the device to your computer using a USB cable.
2 Go to www.geocaching.com.
3 If necessary, create an account.
4 Sign in.
5 Follow the instructions at geocaching.com to find and 

download geocaches to your device.

Geocache Searches
You can search the geocaches loaded on your device. If you are 
connected to www.geocaching.com, you can search live 
geocache data and download geocaches.
NOTE: You can download detailed information for more than 
three geocaches per day with a premium membership. Go to 
www.geocaching.com for more information.
Searching for a Geocache
You can search the geocaches loaded on your device. If you are 
connected to geocaching.com, you can search live geocache 
data and download geocaches.
NOTE: You can download detailed information for a limited 
number of geocaches per day. You can purchase a premium 
subscription to download more. Go to www.geocaching.com for 
more information.
1 Select Geocaching.
2 Select  > .
3 Select an option:

• To search the geocaches loaded on your device by name, 
select Spell Search, and enter a search term.

• To search for geocaches near you or near another 
location, select Search Near, and select a location.
If you are connected to www.geocaching.com, the search 
results include live geocache data obtained by GC Live 
Download.

• To search for live geocaches by code, select GC Live 
Download > GC Code, and enter the geocache code.
This feature allows you to download a specific geocache 
from www.geocaching.com when you know the geocache 
code.

4 Select  > Filter to filter the search results (optional).
5 Select a geocache.

The geocache details appear. If you selected a live geocache 
and you are connected, the device downloads the full 
geocache details to the internal storage, if necessary.

Searching for a Geocache on the Map
1 Select Geocaching.
2 Select .

If you are connected to www.geocaching.com, you can select 
 to refresh live geocaches near your location on the map.

3 Select  to filter the results (optional).
4 Select a geocache.

The geocache details appear. If you selected a live geocache 
and you are connected, the device downloads the full 
geocache details to the internal storage.

Filtering the Geocache List
You can filter your geocache list based on certain factors, such 
as the level of difficulty.
1 Select Geocaching >  > Filter.
2 Select one or more options to filter:

• To filter by a geocache category, such as puzzle or event, 
select Type.

• To filter by the physical size of the geocache container, 
select Cache Size.

• To filter by Unattempted, Did Not Find, or Found 
geocaches, select Status.

• To filter by the difficulty level of finding the geocache, or 
the difficulty of the terrain, select a level from 1 to 5.

3 Select  to view the filtered geocache list.
Saving a Custom Geocache Filter
You can create and save custom filters for geocaches based on 
specific factors.
1 Select Setup > Geocaching > Filter Setup > Create Filter.
2 Select the items to filter.
3 Select .

By default, the new filter is saved automatically as Filter 
followed by a number. For example, Filter 2. You can edit the 
geocache filter to change the name (Editing a Custom 
Geocache Filter, page 16).

Editing a Custom Geocache Filter
1 Select Setup > Geocaching > Filter Setup.
2 Select a filter.
3 Select an item to edit.
Applying a Custom Filter to a Geocache List
After you create a filter, you can apply it to the geocache list.
1 Select Geocaching >  >  >  > Apply a Saved Filter.
2 Select a filter.

Viewing Geocache Details
1 Select Geocaching.
2 Select a geocache.
3 Select  > Review Point.

The geocache description and logs appear.

Navigating to a Geocache
1 Select Geocaching.
2 Select a geocache.
3 Select Go.
Using Hints and Clues to find a Geocache
You can use hints or clues, such as a description or coordinates, 
to help you find a geocache.
1 While navigating to a geocache, select the geocache name.
2 Select an option:

• To view details about the geocache, select Description.
• To view a clue about a geocache location, select Hint.
• To view latitude and longitude for a geocache, select 

Coordinates.
• To view feedback about the geocache from previous 

searchers, select Logs.
• To turn chirp™ searching on, select chirp.

Logging the Attempt
After you have attempted to find a geocache, you can log your 
results. You can verify some geocaches at 
www.geocaching.com.
1 Select Geocaching > Log.
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 ponttal leszűkíthetjük a találati listát (szűrhetünk a találatok között).
4.  Válasszunk egy geoláda-helyet.
 A hely adatai megjelennek. Amennyiben valós idejű geoláda-helyet vá-

lasztottunk ki, és csatlakozva vagyunk a geocaching.com oldalra, igény 

esetén a készülék a hely összes részletét letölti a készülék belső memó-
riájába.

Szűrés a geoláda-helyek között
A letöltött geoláda helyeket bizonyos paraméterek, pl. a nehézségi fokozat 
szerint szűrhetjük.
1.  Válasszuk a Geocaching > 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Szűrő pontot.
2.  Válasszuk ki a szűrési szempontokat.
 •   Geoláda kategória (pl. hogy kirakós vagy esemény) szerint szűrhe-

tünk, ehhez válasszuk a Típus pontot.
 •   A geoládát tároló edény mérete szerinti szűréshez válasszuk a Méret pon-

tot.
 •   A megtalálás szerint, vagyis a Nem kísérelt, Nem talált és Megtalált 

állapotok közötti szűréshez válasszuk az Állapot pontot.
 •   A geoláda-hely felkutatásának nehézsége vagy a terep nehézsége 

szerinti kereséshez válasszunk egy szintet 1 és 5 között.
3.  Válasszuk a 

Turns appear in the text bar along the top of the map. Audible 
tones signal turns in the route.

Optional Maps
You can use additional maps with the device, such as BirdsEye 
satellite imagery, City Navigator, and Garmin HuntView™ Plus 
detailed maps. Detailed maps may contain additional points of 
interest, such as restaurants or marine services. For more 
information, go to buy.garmin.com or contact your Garmin 
dealer.
Enabling Maps
You can enable map products installed on your device.
1 From the map, select  > Map Setup > Configure Maps.
2 Select the toggle switch to enable each installed map.

Finding a Location Near Another Location
1 Select  >  > Search Near.
2 Select an option.
3 Select a location.

Waypoints
Waypoints are locations you record and store in the device. 
Waypoints can mark where you are, where you are going, or 
where you have been.

Creating a Waypoint
You can save your current location as a waypoint.
1 Select Mark Waypoint.
2 If necessary, select a field to edit the waypoint.
3 Select Save.

Navigating to a Waypoint
1 Select  > Waypoints.
2 Select a waypoint.
3 Select Go.

By default, your route to the waypoint appears as a straight, 
colored line on the map.

Finding a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint from the list.
3 If necessary, select  to narrow the search.
4 Select an option:

• Select Spell Search to search using the name of the 
waypoint.

• Select Select Symbol to search using the symbol of the 
waypoint.

• Select Search Near to search near a recently found 
location, another waypoint, your current location, or a 
point on the map.

• Select Sort to view the list of waypoints based on nearest 
distance or alphabetical order.

Editing a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select an item to edit, such as the name.
4 Enter the new information, and select .

Deleting a Waypoint
1 Select Waypoint Manager >  > Delete.
2 Select an option:

• To delete one waypoint, select a waypoint.
• To delete multiple waypoints, select multiple waypoints.
• To delete all waypoints, select Select All.

3 Select Delete.

Increasing the Accuracy of a Waypoint Location
You can refine the accuracy of a waypoint location by averaging 
the location data. When averaging, the device takes several 
GPS readings at the same location and uses the average value 
to provide more accuracy.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Average Location.
4 Move to the waypoint location.
5 Select Start.
6 Follow the on-screen instructions.
7 When the confidence status bar reaches 100%, select Save.
For best results, collect four to eight samples for the waypoint, 
waiting at least 90 minutes between samples.

Projecting a Waypoint
You can save a new waypoint by projecting the distance and 
bearing from a saved waypoint to a new location.
For example, if you would like to navigate to a location you 
observe on the other side of a river or stream, you can project a 
waypoint from your current location to the observed location, 
then navigate to the new location after crossing the river or 
stream at a more suitable location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Project Waypoint.
4 Enter the bearing, and select .
5 Select a unit of measure.
6 Enter the distance, and select .
7 Select Save.

Moving a Waypoint on the Map
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Move Waypoint.
4 Select a location on the map.
5 Select Move.

Finding a Location Near a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Find Near Here.
4 Select a category.
The list displays locations near the selected waypoint.

Setting a Waypoint Proximity Alarm
You can add a proximity alarm for a waypoint. Proximity alarms 
alert you when you are within a specified range of a particular 
location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Set Proximity.
4 Enter the radius.

When you enter an area with a proximity alarm, the device 
sounds a tone.

Adding a Waypoint to a Route
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Add to Route.
4 Select a route.
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 pontot a szűrt találati lista megtekintéséhez.

Geoláda szűrő létrehozása és mentése
Létrehozhatunk és elmenthetünk egyedi szűrési beállításokat. A szűrési 
szempontok összeállítását követően ezen szempontok szerint szűkíthetjük 
a geoláda helyek listáját.
1.  Válasszuk a Beállítások > Geocaching > Szűrőbeállítás > Szűrő létre-

hozása pontot.
2.  Válasszuk ki a szűrési szempontokat:
3.  A szűrő mentéséhez válasszuk a 

Turns appear in the text bar along the top of the map. Audible 
tones signal turns in the route.

Optional Maps
You can use additional maps with the device, such as BirdsEye 
satellite imagery, City Navigator, and Garmin HuntView™ Plus 
detailed maps. Detailed maps may contain additional points of 
interest, such as restaurants or marine services. For more 
information, go to buy.garmin.com or contact your Garmin 
dealer.
Enabling Maps
You can enable map products installed on your device.
1 From the map, select  > Map Setup > Configure Maps.
2 Select the toggle switch to enable each installed map.

Finding a Location Near Another Location
1 Select  >  > Search Near.
2 Select an option.
3 Select a location.

Waypoints
Waypoints are locations you record and store in the device. 
Waypoints can mark where you are, where you are going, or 
where you have been.

Creating a Waypoint
You can save your current location as a waypoint.
1 Select Mark Waypoint.
2 If necessary, select a field to edit the waypoint.
3 Select Save.

Navigating to a Waypoint
1 Select  > Waypoints.
2 Select a waypoint.
3 Select Go.

By default, your route to the waypoint appears as a straight, 
colored line on the map.

Finding a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint from the list.
3 If necessary, select  to narrow the search.
4 Select an option:

• Select Spell Search to search using the name of the 
waypoint.

• Select Select Symbol to search using the symbol of the 
waypoint.

• Select Search Near to search near a recently found 
location, another waypoint, your current location, or a 
point on the map.

• Select Sort to view the list of waypoints based on nearest 
distance or alphabetical order.

Editing a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select an item to edit, such as the name.
4 Enter the new information, and select .

Deleting a Waypoint
1 Select Waypoint Manager >  > Delete.
2 Select an option:

• To delete one waypoint, select a waypoint.
• To delete multiple waypoints, select multiple waypoints.
• To delete all waypoints, select Select All.

3 Select Delete.

Increasing the Accuracy of a Waypoint Location
You can refine the accuracy of a waypoint location by averaging 
the location data. When averaging, the device takes several 
GPS readings at the same location and uses the average value 
to provide more accuracy.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Average Location.
4 Move to the waypoint location.
5 Select Start.
6 Follow the on-screen instructions.
7 When the confidence status bar reaches 100%, select Save.
For best results, collect four to eight samples for the waypoint, 
waiting at least 90 minutes between samples.

Projecting a Waypoint
You can save a new waypoint by projecting the distance and 
bearing from a saved waypoint to a new location.
For example, if you would like to navigate to a location you 
observe on the other side of a river or stream, you can project a 
waypoint from your current location to the observed location, 
then navigate to the new location after crossing the river or 
stream at a more suitable location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Project Waypoint.
4 Enter the bearing, and select .
5 Select a unit of measure.
6 Enter the distance, and select .
7 Select Save.

Moving a Waypoint on the Map
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Move Waypoint.
4 Select a location on the map.
5 Select Move.

Finding a Location Near a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Find Near Here.
4 Select a category.
The list displays locations near the selected waypoint.

Setting a Waypoint Proximity Alarm
You can add a proximity alarm for a waypoint. Proximity alarms 
alert you when you are within a specified range of a particular 
location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Set Proximity.
4 Enter the radius.

When you enter an area with a proximity alarm, the device 
sounds a tone.

Adding a Waypoint to a Route
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Add to Route.
4 Select a route.
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-t.
 Mentéskor a szűrő automatikusan nevet kap, amely a „Filter” szóból áll és 

egy számból, pl. „Filter 2”. Módosíthatjuk a nevet (Egyedi geoláda szűrő 
szerkesztése, 16. oldal).

Egyedi geoláda szűrő szerkesztése
1.  Válasszuk a Beállítások > Geocaching > Szűrőbeállítás pontot.
2.  Válasszuk ki a szerkeszteni kívánt szűrőt.
3.  Válasszuk ki a szerkeszteni kívánt jellemzőt.

Egyedi szűrő alkalmazása geoláda-hely listán
A létrehozott szűrőket geoláda-hely listákon alkalmazhatjuk.
1.  Válasszuk a Geocaching > 

Record Method: Sets the recording method. The Auto option 
records points at a variable rate to create an optimum 
representation of your path. You can also record points at 
specific time or distance intervals.

Interval: Sets the recording rate. Recording points more 
frequently creates a more-detailed path, but fills the recording 
log faster.

Auto Pause: Sets the device to stop recording your path when 
you are not moving.

Auto Start: Sets the device to start a new recording 
automatically when the previous recording ends.

Activity Type: Sets the default activity type for the device.
Advanced Setup: Enables you to open additional recording 

settings (Advanced Recording Settings, page 11).
Advanced Recording Settings
Select Setup > Recording > Advanced Setup.
Output Format: Sets the device to save the recording as a FIT 

or a GPX and FIT file (File Types, page 23). The FIT option 
records your activity with fitness information that is tailored for 
the Garmin Connect application and can be used for 
navigation. The FIT and GPX option records your activity as 
both a traditional track that can be viewed on the map and 
used for navigation, and as an activity with fitness 
information.

Auto Save: Sets an automated schedule to save your 
recordings. This helps organize your trips and save memory 
space (Auto Save Settings, page 11).

Trip Recording: Sets a trip recording option.
Recorded Data Reset: Sets a reset option. The Activity and 

Trip option resets the recording and trip data when you finish 
the active recording. The Prompted option prompts you to 
select the data to reset.

Auto Save Settings
Select Setup > Recording > Advanced Setup > Auto Save.
When Full: Automatically saves the current recording and starts 

a new one when the current recording is near 20,000 track 
points.

Daily: Automatically saves the previous day's recording and 
starts a new one when you turn on the device on a new day.

Weekly: Automatically saves the previous week's recording and 
starts a new one when you turn on the device on a new 
week.

Auto: Automatically saves the current recording based on its 
length and the number of track points taken.

Never: Never saves the current recording automatically. When 
the current recording nears 20,000 track points, the device 
filters the active track to remove redundant points while 
retaining the shape and history of the recording. Unfiltered 
points are saved in a temporary GPX and FIT file that is 
saved or discarded when the recording stops.
NOTE: When importing FIT activities or GPX tracks with 
more than 20,000 track points, the device filters the line to fit 
in the device memory and improve map drawing 
performance, while retaining the shape and history of the 
recording. The FIT and GPX files retain all of their original 
track points.

Viewing the Current Activity
By default, the device automatically starts recording your path 
as an activity when it is turned on and has acquired satellite 
signals. You can pause and start recording manually.
1 Select  to open the status page.
2 Select Activity Recording.
3 Select an option:

• To control the current activity recording, select .

• To view data fields for the activity, select .
• To view the current activity on the map, select .
• To view the elevation plot for the current activity, select .

Customizing Your Activity Log
You can customize how your device displays and records 
activities.
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• To change the color of the activity line on the map, select 
Color.

• To display a line on the map indicating your activity, select 
Show On Map.

4 Select  > Activities Setup > Record Method.
5 Select an option:

• To record activities at a variable rate that creates an 
optimum representation of your activities, select Auto.

• To record activities at a specified distance, select 
Distance.

• To record activities at a specified time, select Time.
6 Select Interval.
7 Complete an action:

• If you selected Auto for the Record Method, select an 
option to record activities more or less often.
NOTE: Using the Most Often interval provides the most 
activity detail, but fills up the device memory quicker.

• If you selected Distance or Time for the Record Method, 
enter a value, and select .

Navigating Using TracBack®

While navigating, you can navigate back to the beginning of your 
activity. This can be helpful when finding your way back to camp 
or the trail head.
1 Select  to open the status page.
2 Select Activity Recording >  > TracBack.
3 Navigate using the map or the compass.

Saving the Current Activity
1 Select  to open the status page.
2 Select Activity Recording > .
3 Select an option:

• Select  to save the entire activity.
• Select  > Save Portion, and select a portion.

Clearing the Current Activity
1 Select  to open the status page.
2 Select Activity Recording.
3 Select  >  > Clear.

History
History includes date, time, distance, calories, average speed or 
pace, ascent, descent, and optional wireless sensor information.
NOTE: History is not recorded while the timer is stopped or 
paused.
When the device memory is full, a message appears. The 
device does not automatically delete or overwrite your history. 
You can upload your history to Garmin Connect periodically to 
keep track of all your activity data (Using Garmin Connect, 
page 23).
Viewing Activity Information
1 Select Recorded Activities.
2 Select an activity.
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• Connect to a Wi‑Fi network.

Downloading Geocaches Using a Computer
You can load geocaches manually onto your device using a 
computer (Transferring Files to Your Device, page 23). You 
can place the geocache files into a GPX file and import them 
into the GPX folder on the device. With a premium membership 
to geocaching.com, you can use the "pocket query" feature to 
load a large group of geocaches onto your device as a single 
GPX file.
1 Connect the device to your computer using a USB cable.
2 Go to www.geocaching.com.
3 If necessary, create an account.
4 Sign in.
5 Follow the instructions at geocaching.com to find and 

download geocaches to your device.

Geocache Searches
You can search the geocaches loaded on your device. If you are 
connected to www.geocaching.com, you can search live 
geocache data and download geocaches.
NOTE: You can download detailed information for more than 
three geocaches per day with a premium membership. Go to 
www.geocaching.com for more information.
Searching for a Geocache
You can search the geocaches loaded on your device. If you are 
connected to geocaching.com, you can search live geocache 
data and download geocaches.
NOTE: You can download detailed information for a limited 
number of geocaches per day. You can purchase a premium 
subscription to download more. Go to www.geocaching.com for 
more information.
1 Select Geocaching.
2 Select  > .
3 Select an option:

• To search the geocaches loaded on your device by name, 
select Spell Search, and enter a search term.

• To search for geocaches near you or near another 
location, select Search Near, and select a location.
If you are connected to www.geocaching.com, the search 
results include live geocache data obtained by GC Live 
Download.

• To search for live geocaches by code, select GC Live 
Download > GC Code, and enter the geocache code.
This feature allows you to download a specific geocache 
from www.geocaching.com when you know the geocache 
code.

4 Select  > Filter to filter the search results (optional).
5 Select a geocache.

The geocache details appear. If you selected a live geocache 
and you are connected, the device downloads the full 
geocache details to the internal storage, if necessary.

Searching for a Geocache on the Map
1 Select Geocaching.
2 Select .

If you are connected to www.geocaching.com, you can select 
 to refresh live geocaches near your location on the map.

3 Select  to filter the results (optional).
4 Select a geocache.

The geocache details appear. If you selected a live geocache 
and you are connected, the device downloads the full 
geocache details to the internal storage.

Filtering the Geocache List
You can filter your geocache list based on certain factors, such 
as the level of difficulty.
1 Select Geocaching >  > Filter.
2 Select one or more options to filter:

• To filter by a geocache category, such as puzzle or event, 
select Type.

• To filter by the physical size of the geocache container, 
select Cache Size.

• To filter by Unattempted, Did Not Find, or Found 
geocaches, select Status.

• To filter by the difficulty level of finding the geocache, or 
the difficulty of the terrain, select a level from 1 to 5.

3 Select  to view the filtered geocache list.
Saving a Custom Geocache Filter
You can create and save custom filters for geocaches based on 
specific factors.
1 Select Setup > Geocaching > Filter Setup > Create Filter.
2 Select the items to filter.
3 Select .

By default, the new filter is saved automatically as Filter 
followed by a number. For example, Filter 2. You can edit the 
geocache filter to change the name (Editing a Custom 
Geocache Filter, page 16).

Editing a Custom Geocache Filter
1 Select Setup > Geocaching > Filter Setup.
2 Select a filter.
3 Select an item to edit.
Applying a Custom Filter to a Geocache List
After you create a filter, you can apply it to the geocache list.
1 Select Geocaching >  >  >  > Apply a Saved Filter.
2 Select a filter.

Viewing Geocache Details
1 Select Geocaching.
2 Select a geocache.
3 Select  > Review Point.

The geocache description and logs appear.

Navigating to a Geocache
1 Select Geocaching.
2 Select a geocache.
3 Select Go.
Using Hints and Clues to find a Geocache
You can use hints or clues, such as a description or coordinates, 
to help you find a geocache.
1 While navigating to a geocache, select the geocache name.
2 Select an option:

• To view details about the geocache, select Description.
• To view a clue about a geocache location, select Hint.
• To view latitude and longitude for a geocache, select 

Coordinates.
• To view feedback about the geocache from previous 

searchers, select Logs.
• To turn chirp™ searching on, select chirp.

Logging the Attempt
After you have attempted to find a geocache, you can log your 
results. You can verify some geocaches at 
www.geocaching.com.
1 Select Geocaching > Log.
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Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Mentett szűrő alkalmazá-
sa pontot.

2.  Válasszuk ki az alkalmazni kívánt szűrőt.

Geoláda részletek megtekintése
1.  Válasszuk a Geocaching pontot.
2.  Válasszuk ki a kívánt geoládát.
3.  Válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Pont ellenőrzés pontot.
 Megjelennek a geoláda leírása és naplóadatai.

Navigáció geoláda felé
1.  Válasszuk a Geocaching pontot.
2.  Válasszuk ki a kívánt geoládát.
3.  Válasszuk a Menj pontot.

Nyomok és tippek felhasználása a geoláda-hely felleléséhez
A rejtekhely felleléséhez felhasználhatjuk olyan segédinformációkat, mint a 
hely leírása vagy koordinátái.
1.   A geoláda-hely felé történő aktív navigáció közben válasszuk ki a geoláda-

hely nevét.
2.  Válasszunk az alábbi lehetőségek közül:
 •  A geoláda-hely leírásának megtekintéséhez válasszuk a Leírást.
 •  A helyhez vezető nyom megtekintéséhez válasszuk a Nyom pontot.
 •  A geoláda-hely hosszúsági és szélességi koordinátájának megtekinté-

séhez válasszuk a Koordináták pontot.
 •  A helyet korábban felkutatók visszajelzéseinek megtekintéséhez válasz-

szuk a Naplók pontot.
 •  A chirp™ keresés bekapcsolásához válasszuk a chirp pontot.

http://www.geocaching.com
http://www.geocaching.com
http://www.geogaching.com
http://www.geogaching.com
http://www.geocaching.com
http://www.geocaching.com
http://www.geocaching.com
http://www.geocaching.com
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Keresési kísérlet naplózása
Miután megpróbáltunk megkeresni egy geoláda-helyet, a kísérlet eredmé-
nyeit elmenthetjük. Egyes geoládákat megerősíthetünk a www.geocaching.
com oldalon.
1.   Válasszuk a Geocaching > Naplót.
2.   Válasszunk a Megtalált, Nem talált, Javításra van szüks, Megkereset-

len lehetőségek közül.
3.   Válasszunk az alábbi lehetőségek közül:
 •   A naplózás befejezéséhez válasszuk a Kész pontot.
 •    A legközelebbi geoláda felé indítunk navigációt a Legközelebbi meg-

keresése ponttal.
 •    A Megjegyzés szerkesztése ponttal megjegyzést fűzhetünk magá-

hoz a ládához vagy a kereséshez. Gépeljük be a megjegyzést, majd 
válasszuk a Kész pontot..

Amennyiben felléptünk a geocaching.com oldalra, a napló automatikusan fel-
töltésre kerül a geocaching.com fiókunkba.

chirp™
A chirp egy apró Garmin műszer, melyet beprogramozhatunk és a geoládában 
hagyhatunk. A készülék segítségével a geoládákban chirp-eket találhatunk. A 
chirp programozásáról a www.garmin.com honlapról letölthető chirp haszná-
lati útmutatóban olvashatunk.

chirp keresés bekapcsolása
1.  Válasszuk a Beállítások > Geocaching pontot.
2.  Válasszuk a chirp™ keresés > Be-t.

chirpet tartalmazó geoláda megkeresése
1.  Kapcsoljuk be a chirp keresést, és így indítsunk navigációt a geoláda-hely 

felé.
 Amikor a chirpet tartalmazó geoláda már 10 méter távolságon belül van, 

a chirp adatai megjelennek.
5.   Válasszuk a Részleteket mutat pontot.
6.   Amennyiben megjelenik, válasszuk a Menj parancsot a geoláda követke-

ző helyszínéhez vezető navigáció indításához.

Valós idejű geoláda-hely adatok törlése a készülék 
memóriájából
Törölhetjük a valós időben megjelenő geoláda-hely adatokat, így csak a ké-
szülékre manuálisan, számítógépről letöltött geoláda-helyeket látjuk majd.
 Válasszuk a Beállítások > Geocaching > Geocaching Live > Élő adat 

törlése pontot.
 A valós idejű adatok törlődnek és ezután már nem jelennek meg a 

geoláda-hely listában.

Geocaching.com regisztráció törlése
Amennyiben eladjuk, átadjuk a készüléket, törölhetjük regisztrációnkat a 
Geocaching.com oldalról.
 Válasszuk a Beállítások > Geocaching > Geocaching Live > Regiszt-

ráció törlése pontot.

inReach távvezérlő funkció
Az inReach távvezérlő funkció lehetővé teszi, hogy a Montana 700 készülék-
kel vezéreljük az inReach készülékünket.
1.  Kapcsoljuk be az inReach készüléket.
2.  A Montana 700 készüléken válasszuk az inReach távvezérlő pontot.
 MEGJEGYZÉS! Előfordulhat, hogy a funkciót hozzá kell adnunk a főmenü-

höz, mielőtt kiválaszthatnánk (Főmenü személyre szabása, 14. oldal).
3.  Szükség esetén válasszuk az Igen pontot.
4.  Várjunk, amíg a Montana 700 készülék csatlakozik az inReach készülék-

hez.
5.  Válasszunk a megjelenő lehetőségek közül:

• Előre beállított üzenet: előre beállított üzenet küldése a megjelenő lis-
tából.

• Új Üzenet: üzenet küldése, a címzettek kiválasztása és az üzenet begé-
pelése vagy az egyik gyorsüzenet opció kiválasztása által.

• 

2 Select Found, Did Not Find, Needs Repair, or 
Unattempted.

3 Select an option:
• To stop logging, select Done.
• To begin navigation to the geocache nearest you, select 

Find Next Closest.
• To enter a comment about looking for the cache or about 

the cache itself, select Edit Comment, enter a comment, 
and select Done.

If you are signed in to www.geocaching.com, the log uploads to 
your www.geocaching.com account automatically.

chirp
A chirp is a small Garmin accessory that is programmed and left 
in a geocache. You can use your device to find a chirp in a 
geocache.
Enabling chirp Searching
1 Select Setup > Geocaching.
2 Select chirp Searching > On.
Finding a Geocache with a chirp
1 With chirp searching enabled, navigate to a geocache.

When you are within approximately 10 m (33 ft.) of the 
geocache that contains a chirp, details about the chirp 
appear.

2 Select Show Details.
3 If necessary, select Go to navigate to the next stage of the 

geocache.

Removing Live Geocache Data from the Device
You can remove live geocache data to show only geocaches 
manually loaded on the device using a computer.

Select Setup > Geocaching > Geocaching Live > Remove 
Live Data.
Live geocaching data is removed from the device and no 
longer appears in the geocache list.

Removing Your Device Registration From 
Geocaching.com
If you transfer ownership of your device, you can remove your 
device registration from the geocaching website.

Select Setup > Geocaching > Geocaching Live > 
Unregister Device.

Using the inReach Remote
The inReach remote function allows you to control a compatible 
inReach device using your Montana 700 device.
1 Turn on the inReach device.
2 On your Montana 700 device, select inReach Remote.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

3 If necessary, select Yes.
4 Wait while the Montana 700 device connects to your inReach 

device.
5 Select an option:

• To send a preset message, select Send Preset, and 
select a message from the list.

• To send a text message, select New Message, select the 
message contacts, and enter the message text or select a 
quick text option.

• To send an SOS message, select  > Yes.
NOTE: You should only use the SOS function in a real 
emergency situation.

• To view the timer and distance traveled, select .

Marking and Starting Navigation to a Man 
Overboard Location
Before you can save a man overboard (MOB) location and 
navigate back to it, you must add the Man Overboard application 
to the main menu (Customizing the Main Menu, page 14).
1 Select Man Overboard > Start.

The map opens, showing the route to the MOB location. By 
default, the route appears as a magenta line.

2 Navigate using the map (Navigating with the Map, page 5) or 
compass (Navigating with the Compass, page 5).

Selecting a Profile
When you change activities, you can change the setup of the 
device by changing the profile.
1 Select Profile Change.
2 Select a profile.

Setting a Proximity Alarm
Proximity alarms alert you when you are within a specified range 
of a particular location.
1 Select Proximity Alarms > Create Alarm.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Select a category.
3 Select a location.
4 Select Use.
5 Enter a radius.
When you enter an area with a proximity alarm, the device 
sounds a tone.

Editing or Deleting a Proximity Alarm
1 Select Proximity Alarms.
2 Select an alarm.
3 Select an option:

• To edit the radius, select Change Radius.
• To view the alarm on a map, select View Map.
• To delete the alarm, select Delete.

Setting the Proximity Alarm Tones
You can customize tones for proximity alarms.
1 Select Proximity Alarms >  > Alarm Tones Setup.
2 Select a tone for each audible alarm type.

Disabling All Proximity Alarms
Select Proximity Alarms >  > Disable All Alarms.

Satellite Page
The satellite page shows your current location, GPS accuracy, 
satellite locations, and signal strength.

GPS Satellite Settings
Select Satellite > .
Use With GPS On: Allows you to turn the GPS on.
Track Up: Indicates whether satellites are shown with their rings 

oriented with north toward the top of the screen, or oriented 
with your current track toward the top of the screen.

Single Color: Allows you to select whether the satellite page is 
displayed in multicolor or single color format.

Set Location On Map: Allows you to mark your current location 
on the map. You can use this location to create routes or 
search for saved locations.
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 > Igen: böngészés a fülek között a nyíl gombokkal, és SOS üze-
net küldése.

 NE FELEDJÜK! Az SOS funkciót kizárólag tényleges vészhelyzetek-
ben használjuk.

• 

2 Select Found, Did Not Find, Needs Repair, or 
Unattempted.

3 Select an option:
• To stop logging, select Done.
• To begin navigation to the geocache nearest you, select 

Find Next Closest.
• To enter a comment about looking for the cache or about 

the cache itself, select Edit Comment, enter a comment, 
and select Done.

If you are signed in to www.geocaching.com, the log uploads to 
your www.geocaching.com account automatically.

chirp
A chirp is a small Garmin accessory that is programmed and left 
in a geocache. You can use your device to find a chirp in a 
geocache.
Enabling chirp Searching
1 Select Setup > Geocaching.
2 Select chirp Searching > On.
Finding a Geocache with a chirp
1 With chirp searching enabled, navigate to a geocache.

When you are within approximately 10 m (33 ft.) of the 
geocache that contains a chirp, details about the chirp 
appear.

2 Select Show Details.
3 If necessary, select Go to navigate to the next stage of the 

geocache.

Removing Live Geocache Data from the Device
You can remove live geocache data to show only geocaches 
manually loaded on the device using a computer.

Select Setup > Geocaching > Geocaching Live > Remove 
Live Data.
Live geocaching data is removed from the device and no 
longer appears in the geocache list.

Removing Your Device Registration From 
Geocaching.com
If you transfer ownership of your device, you can remove your 
device registration from the geocaching website.

Select Setup > Geocaching > Geocaching Live > 
Unregister Device.

Using the inReach Remote
The inReach remote function allows you to control a compatible 
inReach device using your Montana 700 device.
1 Turn on the inReach device.
2 On your Montana 700 device, select inReach Remote.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

3 If necessary, select Yes.
4 Wait while the Montana 700 device connects to your inReach 

device.
5 Select an option:

• To send a preset message, select Send Preset, and 
select a message from the list.

• To send a text message, select New Message, select the 
message contacts, and enter the message text or select a 
quick text option.

• To send an SOS message, select  > Yes.
NOTE: You should only use the SOS function in a real 
emergency situation.

• To view the timer and distance traveled, select .

Marking and Starting Navigation to a Man 
Overboard Location
Before you can save a man overboard (MOB) location and 
navigate back to it, you must add the Man Overboard application 
to the main menu (Customizing the Main Menu, page 14).
1 Select Man Overboard > Start.

The map opens, showing the route to the MOB location. By 
default, the route appears as a magenta line.

2 Navigate using the map (Navigating with the Map, page 5) or 
compass (Navigating with the Compass, page 5).

Selecting a Profile
When you change activities, you can change the setup of the 
device by changing the profile.
1 Select Profile Change.
2 Select a profile.

Setting a Proximity Alarm
Proximity alarms alert you when you are within a specified range 
of a particular location.
1 Select Proximity Alarms > Create Alarm.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

2 Select a category.
3 Select a location.
4 Select Use.
5 Enter a radius.
When you enter an area with a proximity alarm, the device 
sounds a tone.

Editing or Deleting a Proximity Alarm
1 Select Proximity Alarms.
2 Select an alarm.
3 Select an option:

• To edit the radius, select Change Radius.
• To view the alarm on a map, select View Map.
• To delete the alarm, select Delete.

Setting the Proximity Alarm Tones
You can customize tones for proximity alarms.
1 Select Proximity Alarms >  > Alarm Tones Setup.
2 Select a tone for each audible alarm type.

Disabling All Proximity Alarms
Select Proximity Alarms >  > Disable All Alarms.

Satellite Page
The satellite page shows your current location, GPS accuracy, 
satellite locations, and signal strength.

GPS Satellite Settings
Select Satellite > .
Use With GPS On: Allows you to turn the GPS on.
Track Up: Indicates whether satellites are shown with their rings 

oriented with north toward the top of the screen, or oriented 
with your current track toward the top of the screen.

Single Color: Allows you to select whether the satellite page is 
displayed in multicolor or single color format.

Set Location On Map: Allows you to mark your current location 
on the map. You can use this location to create routes or 
search for saved locations.
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: stopper és bejárt út megtekintése.

Ember a vízben hely (MOB) megjelölése  
és navigáció indítása felé
A funkció használatához először hozzá kell adnunk az Ember a vízben alkal-
mazást a főmenühöz (Főmenü személyre szabása, 14. oldal).
1.  Válasszuk az Ember a vízben > Indítás pontot.
 A térkép jelenik meg, mutatva az Ember a vízben pozíció helyét. Az útvo-

nal alapértelmezés szerint bordó színű.
2.  Navigálhatunk a térkép alapján (Navigáció a térképen, 5. oldal) vagy az 

iránytű útmutatásával (Navigáció az iránytűvel, 5. oldal).

Profilváltás
Amikor tevékenységet váltunk, a profilváltás funkcióval a készülék beállítása-
it is módosíthatjuk, hogy azok megfeleljenek az adott profilnak.
1.  Válasszuk a Profilváltás pontot.
2.  Válasszunk egy profilt.

Közelségi riasztás beállítása
A közelségi riasztás jelez, amikor az adott helyhez képest meghatározott tá-
volságon belül vagyunk.
1.  Válasszuk a Közelségi riasztások > Riasztás létrehoz. pontot.
 MEGJEGYZÉS! Előfordulhat, hogy a funkciót hozzá kell adnunk a főme-

nühöz, mielőtt kiválaszthatnánk (Főmenü személyre szabása, 14. oldal).
2.  Válasszunk egy kategóriát.
3.  Válasszuk ki a kívánt helyet.
4.  Válasszuk a Használ pontot.
5.  Adjuk meg a tartományt.
Amikor belépünk a közelségi riasztási területre, a készülék egy hangjelzést ad.

Közelségi riasztás szerkesztése és törlése
1. Válasszuk a Közelségi riasztások pontot.
2. Válasszunk egy riasztást.
3. Válasszunk az alábbi lehetőségek közül:

• A riasztási tartomány módosításához válasszuk a Rádiusz mód. pontot.
• A riasztás megtekintéséhez a térképen válasszuk a Térkép megtekint. 

pontot.
• A riasztás törléséhez válasszuk a Törlés pontot.

Közelségi riasztás hangjelzésének beállítása
A közelségi riasztások hangjelzéseit személyre szabhatjuk.
1. Válasszuk a Közelségi riasztások > 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 > Riasztás hangjelz. beáll. pon-
tot.

2. Válasszuk ki az egyes hangjelzéssel működő riasztástípusok hangjelzé-
seit.

Közelségi riasztások kikapcsolása
Válasszuk a Közelségi riasztások > 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 > Összes riasztás kikapcsolá-
sa pontot.

Műhold képernyő
A műhold képernyő mutatja pillanatnyi pozíciónkat, a GPS-pozíció meg ha-
tá rozás pontosságát, a műholdak helyzetét az égbolton, valamint a jelerős-
séget.

GPS műholdas beállítások
Válasszuk ki a Műhold > 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.

inReach Features 3

 pontot.
Haszn. bekapcs. GPS-szel – GPS bekapcsolása.
Útvonal fel – Kimutatja, hogy a műholdak gyűrűikkel a képernyő tetején 

északot, vagy a jelenlegi útvonalunkat mutatják.
Single Color – Beállíthatjuk, hogy a műhold képernyő egy színben vagy szí-

nesen jelenjen-e meg.
Helyz. megad. kép. – Megadhatjuk pillanatnyi pozíciónkat a térképen. Ez az 

opció csak kikapcsolt GPS-vevő mellett elérhető. Útvonalakat hozhatunk 
létre távoli helyeken vagy mentett helyekre kereshetünk.

http://www.geocaching.com
http://www.geocaching.com
http://geocaching.com
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Helyz.autm.keres – a Garmin AutoLocate® funkcióval meghatározza a po-
zíciót.

Műhold beállítások – Műholdrendszer beállítása (Műholdas beállítások, 19. 
oldal).

Adatmegosztás vezeték nélküli kapcsolaton keresztül
Vezeték nélküli adatátvitelhez a két kompatibilis készüléknek 3 méteres tá-
volságon belül kell lennie.
A Montana 700i/750i másik kompatibilis készülékkel, okostelefonnal képes 
vezeték nélküli adatátvitelre ANT+® technológián keresztül. Megoszthatunk 
útpontokat, geoláda-helyeket, útvonalakat, pályákat, és egyéb adatokat.
1.   Válasszuk a Vez. nélküli megosztás pontot.
2.   Válasszunk az alábbi lehetőségek közül:
 •   Válasszuk a Küld pontot, majd adjuk meg a küldeni kívánt adat típu-

sát.
 •    A Fogadás pontot választva másik készülékről fogadhatunk adatokat. 

Ehhez a másik készüléken előzőleg el kell indítanunk az adatok küldé-
sét.

3. Kövessük az utasításokat.

VIRB akciókamera távvezérlő funkció
A funkció használatához először a VIRB kamerán kell engedélyeznünk a táv-
vezérlési funkciót (lásd a VIRB kamera útmutatójában). Ezzel a VIRB akció-
kamerát a készülékről irányíthatjuk.
1.  Kapcsoljuk be a VIRB kamerát.
2.  A Montana készüléken válasszuk a VIRB távvezérlés pontot.
 MEGJEGYZÉS! Előfordulhat, hogy a funkciót hozzá kell adnunk a főme-

nühöz, mielőtt kiválaszthatnánk (Főmenü személyre szabása, 14. oldal).
3.  Várjunk, amíg a készülék csatlakozik a VIRB kamerához.
4.  Válasszunk az alábbiak közül:
 •  Videófelvétel indításához érintsük meg a 

AutoLocate Position: Calculates your GPS position using the 
Garmin AutoLocate® feature.

Satellite Setup: Sets the satellite system options (Satellite 
Settings, page 19).

Sending and Receiving Data Wirelessly
Before you can share data wirelessly, you must be within 3 m 
(10 ft.) of a compatible Garmin device.
Your device can send and receive data wirelessly when 
connected with a compatible Garmin device using ANT+ 
technology. You can share waypoints, geocaches, routes, 
tracks, and more.
1 Select Share Wirelessly.
2 Select an option:

• Select Send, and select a type of data.
• Select Receive to receive data from another device. The 

other compatible device must be attempting to send data.
3 Follow the on-screen instructions.

Using the VIRB Remote
Before you can use the VIRB remote function, you must enable 
the remote setting on your VIRB camera. See the VIRB Series 
Owner's Manual for more information.
The VIRB remote function allows you to control your VIRB 
action camera using your device.
1 Turn on your VIRB camera.
2 On your Montana device, select VIRB Remote.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

3 Wait while the device connects to your VIRB camera.
4 Select an option:

• To record video, select .
• To take a photograph, select .

Customizing the Device
Custom Data Fields and Dashboards
Data fields display information about your location or other 
specified data. Dashboards are a custom grouping of data that 
can be helpful to a specific or general task, such as geocaching.

Enabling the Map Data Fields
You can show custom data fields on the map.
1 From the map, select  > Map Setup > Dashboard.
2 Select Large Data Field or Small Data Fields.
3 If necessary, on the map, select  at the top of the screen to 

show the data fields.

Customizing the Data Fields
Before you can change the map data fields, you must enable 
them (Enabling the Map Data Fields, page 18).
You can customize the data fields and dashboards of the map, 
compass, trip computer, and altimeter pages.
1 From a page that displays data fields, select a data field.
2 Select a data field category and a data field.

Customizing Dashboards
1 Select a page.
2 Select an option:

• From the map, select  > Map Setup > Dashboard.
• From the compass or trip computer, select  > Change 

Dashboard.

3 Select a dashboard.

Rotating the Screen
Rotate your device to view in horizontal (landscape) or 
vertical (portrait) mode.

NOTE: While using the inReach features of your Montana 
700i/750i device, you should use the device in vertical 
(portrait) mode, with the antenna pointed toward the sky.

Setup Menu
Select Setup.
System: Allows you to customize system settings (System 

Settings, page 19).
Display: Adjusts the backlight and display settings (Display 

Settings, page 19).
Bluetooth: Pairs your device to a smartphone or audio device, 

and allows you to customize the Bluetooth settings (Bluetooth 
Settings, page 19).

Wi-Fi: Allows you to connect to wireless networks (Wi‑Fi 
Settings, page 20).

Tracking: Allows you to customize the inReach tracking settings 
on your Montana 700i/750i device (inReach Tracking 
Settings, page 4).

Messages: Allows you to customize the settings for inReach 
messages on your Montana 700i/750i device (Messages 
Settings, page 3).

Map: Sets the map appearance (Map Settings, page 5).
Recording: Allows you to customize activity recording settings 

(Recording Settings, page 10).
Routing: Allows you to customize how the device calculates 

routes for each activity (Routing Settings, page 20).
Expedition Mode: Allows you to customize settings for turning 

on expedition mode (Turning On Expedition Mode, 
page 20).

Waypoints: Allows you to enter a custom prefix for 
automatically named waypoints.

Tones: Sets the device sounds, such as alarm tones and alerts 
(Setting the Device Tones, page 20).

Heading: Allows you to customize the compass heading 
settings (Heading Settings, page 6).

Altimeter: Allows you to customize the altimeter settings 
(Altimeter Settings, page 6).

Camera: Adjusts the camera settings on your Montana 750i 
device (Camera Settings, page 20).

Geocaching: Allows you to customize your geocache settings 
(Geocaching Settings, page 20).

Sensors: Pairs wireless sensors with your device (Wireless 
Sensors, page 20).

Fitness: Allows you to customize settings for recording fitness 
activities (Fitness Settings, page 20).

Marine: Sets the appearance of marine data on the map 
(Marine Settings, page 21).
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 •  Álló fotó készítéséhez érintsük meg a 

AutoLocate Position: Calculates your GPS position using the 
Garmin AutoLocate® feature.

Satellite Setup: Sets the satellite system options (Satellite 
Settings, page 19).

Sending and Receiving Data Wirelessly
Before you can share data wirelessly, you must be within 3 m 
(10 ft.) of a compatible Garmin device.
Your device can send and receive data wirelessly when 
connected with a compatible Garmin device using ANT+ 
technology. You can share waypoints, geocaches, routes, 
tracks, and more.
1 Select Share Wirelessly.
2 Select an option:

• Select Send, and select a type of data.
• Select Receive to receive data from another device. The 

other compatible device must be attempting to send data.
3 Follow the on-screen instructions.

Using the VIRB Remote
Before you can use the VIRB remote function, you must enable 
the remote setting on your VIRB camera. See the VIRB Series 
Owner's Manual for more information.
The VIRB remote function allows you to control your VIRB 
action camera using your device.
1 Turn on your VIRB camera.
2 On your Montana device, select VIRB Remote.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

3 Wait while the device connects to your VIRB camera.
4 Select an option:

• To record video, select .
• To take a photograph, select .

Customizing the Device
Custom Data Fields and Dashboards
Data fields display information about your location or other 
specified data. Dashboards are a custom grouping of data that 
can be helpful to a specific or general task, such as geocaching.

Enabling the Map Data Fields
You can show custom data fields on the map.
1 From the map, select  > Map Setup > Dashboard.
2 Select Large Data Field or Small Data Fields.
3 If necessary, on the map, select  at the top of the screen to 

show the data fields.

Customizing the Data Fields
Before you can change the map data fields, you must enable 
them (Enabling the Map Data Fields, page 18).
You can customize the data fields and dashboards of the map, 
compass, trip computer, and altimeter pages.
1 From a page that displays data fields, select a data field.
2 Select a data field category and a data field.

Customizing Dashboards
1 Select a page.
2 Select an option:

• From the map, select  > Map Setup > Dashboard.
• From the compass or trip computer, select  > Change 

Dashboard.

3 Select a dashboard.

Rotating the Screen
Rotate your device to view in horizontal (landscape) or 
vertical (portrait) mode.

NOTE: While using the inReach features of your Montana 
700i/750i device, you should use the device in vertical 
(portrait) mode, with the antenna pointed toward the sky.

Setup Menu
Select Setup.
System: Allows you to customize system settings (System 

Settings, page 19).
Display: Adjusts the backlight and display settings (Display 

Settings, page 19).
Bluetooth: Pairs your device to a smartphone or audio device, 

and allows you to customize the Bluetooth settings (Bluetooth 
Settings, page 19).

Wi-Fi: Allows you to connect to wireless networks (Wi‑Fi 
Settings, page 20).

Tracking: Allows you to customize the inReach tracking settings 
on your Montana 700i/750i device (inReach Tracking 
Settings, page 4).

Messages: Allows you to customize the settings for inReach 
messages on your Montana 700i/750i device (Messages 
Settings, page 3).

Map: Sets the map appearance (Map Settings, page 5).
Recording: Allows you to customize activity recording settings 

(Recording Settings, page 10).
Routing: Allows you to customize how the device calculates 

routes for each activity (Routing Settings, page 20).
Expedition Mode: Allows you to customize settings for turning 

on expedition mode (Turning On Expedition Mode, 
page 20).

Waypoints: Allows you to enter a custom prefix for 
automatically named waypoints.

Tones: Sets the device sounds, such as alarm tones and alerts 
(Setting the Device Tones, page 20).

Heading: Allows you to customize the compass heading 
settings (Heading Settings, page 6).

Altimeter: Allows you to customize the altimeter settings 
(Altimeter Settings, page 6).

Camera: Adjusts the camera settings on your Montana 750i 
device (Camera Settings, page 20).

Geocaching: Allows you to customize your geocache settings 
(Geocaching Settings, page 20).

Sensors: Pairs wireless sensors with your device (Wireless 
Sensors, page 20).

Fitness: Allows you to customize settings for recording fitness 
activities (Fitness Settings, page 20).

Marine: Sets the appearance of marine data on the map 
(Marine Settings, page 21).
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 pontot.

Készülék testreszabása
Egyedi adatmezők, műszerfalak
Az adatmezők tartózkodási helyünkről jelenítenek meg adatokat, vagy méré-
si adatokat mutatnak. A műszerfalak adott adatmező összeállítások, melyek 
a kiválasztott feladathoz, tevékenységhez tartozó adatokat összefogják. Pél-
dául találunk geoláda-keresés során hasznos adatokat mutató műszerfalat.

Térképi adatmezők megjelenítésének bekapcsolása
A térképen egyedi adatmezőket jeleníthetünk meg.
1.  A térkép képernyőn válasszuk a 

Charging complete
Bluetooth technology status
Wi‑Fi status
Sending, receiving, or searching for inReach messages and 
tracking points
Unread inReach messages
inReach tracking status
Touchscreen locked

inReach Features
 WARNING

Messaging, tracking, and SOS functions require an active 
satellite subscription. Always test your device before you use it 
outdoors.
Ensure you have a clear view of the sky when using the 
messaging, tracking, and SOS functions, because these 
features require satellite access to operate properly.

To get the most out of your Montana 700i/750i device, you 
should activate it. Activating the device allows you to use 
inReach features, including messaging, SOS, tracking, and 
inReach Weather.

Messages
Your Montana 700i/750i device sends and receives text 
messages using the Iridium satellite network. You can send 
messages to an SMS phone number, an email address, or 
another device that uses inReach technology. Each message 
you send includes your location details where allowed. 

Sending a Preset Message
Preset messages have predefined text and predetermined 
recipients. Preset messages must be set up on the Garmin 
Explore™ website at explore.garmin.com.
1 Select inReach > Messages > Send Preset.
2 Choose a preset message, and select Send Preset.

Sending a Text Message
1 Select inReach > Messages > New Message.
2 Select an option:

• To start with a pre-written message, select Send Quick 
Text.
NOTE: You can add and edit quick text messages on the 
Garmin Explore website.

• To write a custom message, select Type Message.
3 Select To to choose recipients from your contacts list, or 

enter each recipient's contact information.
4 After you have finished your message, select Send 

Message.

Replying to a Message
1 Select inReach > Messages.
2 Select a conversation.
3 Select Reply.
4 Select an option:

• To write a custom message, select Type Message.
• To start with a pre-written message, select Send Quick 

Text and select a message.
5 When you have finished your message, select Send 

Message.

Checking for Messages
When you send a message, your device listens for replies for 10 
minutes. The device also checks for new messages every hour. 

When you are using the inReach tracking feature, your device 
automatically checks for messages at your tracking interval.
NOTE: Your device must have a clear view of the sky and be in 
view of a satellite at the time of the listen to receive messages.
You can force a check for messages by manually checking for 
messages, sending a message, or sending a track point. During 
a check, your device connects to satellites and receives 
messages waiting to be sent to your device.

Select inReach > inReach Utilities > Mail Check > Check 
Mailbox.

Viewing Message Details
1 Select inReach > Messages.
2 Select a conversation.
3 Select a message.
4 Select the information tab.

Navigating to a Message Location
When you receive a message from another device with inReach 
technology, the message may include location information. For 
these messages, you can navigate to the location from which 
the message was sent.
1 Select inReach > Messages.
2 Select a conversation with location information.
3 Select the map tab.
4 Select Go.

Including Location Coordinates in a Message
If you are sending a message to a recipient who may not have 
internet access, you can include your location coordinates in the 
message. For example, if your recipient has an older model cell 
phone that does not support viewing maps or is outside of a 
mobile data coverage area and cannot view a web page.
1 Select inReach > Messages > New Message > Send 

Location.
2 Enter one or more recipients.
3 If necessary, enter a message.
4 Select Send Message.

Deleting Messages
1 Select inReach > Messages.
2 Select a conversation.
3 Select  > Delete Thread.

Messages Settings
Select Setup > Messages.
Ring Until Read: Sets the device to ring until you read a new 

message. This feature is helpful if you are in a noisy 
environment.

Notifications: Alerts you to incoming inReach messages.
Show On Map: Displays inReach messages on the map.

Tracking
You can use the tracking feature on your Montana 700i/750i 
device to record track points and transmit them over the Iridium 
satellite network at the specified send interval. Track points 
appear on the Garmin Explore website and the MapShare™

tracking page.

Starting Tracking
Select inReach > Tracking > Start Tracking.
NOTE: Starting the Tracking feature also starts recording 
your path as an activity.

Stopping Tracking
Select inReach > Tracking > Stop Tracking.
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 > Térkép beállítása > Műszerfal 
pontot.

2.  Válasszunk a Nagy adatmező és Kis adatmezők lehetőségek közül.
3.  Amennyiben szükséges a térkép képernyőn válasszuk a képernyő tetején 

található 

AutoLocate Position: Calculates your GPS position using the 
Garmin AutoLocate® feature.

Satellite Setup: Sets the satellite system options (Satellite 
Settings, page 19).

Sending and Receiving Data Wirelessly
Before you can share data wirelessly, you must be within 3 m 
(10 ft.) of a compatible Garmin device.
Your device can send and receive data wirelessly when 
connected with a compatible Garmin device using ANT+ 
technology. You can share waypoints, geocaches, routes, 
tracks, and more.
1 Select Share Wirelessly.
2 Select an option:

• Select Send, and select a type of data.
• Select Receive to receive data from another device. The 

other compatible device must be attempting to send data.
3 Follow the on-screen instructions.

Using the VIRB Remote
Before you can use the VIRB remote function, you must enable 
the remote setting on your VIRB camera. See the VIRB Series 
Owner's Manual for more information.
The VIRB remote function allows you to control your VIRB 
action camera using your device.
1 Turn on your VIRB camera.
2 On your Montana device, select VIRB Remote.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

3 Wait while the device connects to your VIRB camera.
4 Select an option:

• To record video, select .
• To take a photograph, select .

Customizing the Device
Custom Data Fields and Dashboards
Data fields display information about your location or other 
specified data. Dashboards are a custom grouping of data that 
can be helpful to a specific or general task, such as geocaching.

Enabling the Map Data Fields
You can show custom data fields on the map.
1 From the map, select  > Map Setup > Dashboard.
2 Select Large Data Field or Small Data Fields.
3 If necessary, on the map, select  at the top of the screen to 

show the data fields.

Customizing the Data Fields
Before you can change the map data fields, you must enable 
them (Enabling the Map Data Fields, page 18).
You can customize the data fields and dashboards of the map, 
compass, trip computer, and altimeter pages.
1 From a page that displays data fields, select a data field.
2 Select a data field category and a data field.

Customizing Dashboards
1 Select a page.
2 Select an option:

• From the map, select  > Map Setup > Dashboard.
• From the compass or trip computer, select  > Change 

Dashboard.

3 Select a dashboard.

Rotating the Screen
Rotate your device to view in horizontal (landscape) or 
vertical (portrait) mode.

NOTE: While using the inReach features of your Montana 
700i/750i device, you should use the device in vertical 
(portrait) mode, with the antenna pointed toward the sky.

Setup Menu
Select Setup.
System: Allows you to customize system settings (System 

Settings, page 19).
Display: Adjusts the backlight and display settings (Display 

Settings, page 19).
Bluetooth: Pairs your device to a smartphone or audio device, 

and allows you to customize the Bluetooth settings (Bluetooth 
Settings, page 19).

Wi-Fi: Allows you to connect to wireless networks (Wi‑Fi 
Settings, page 20).

Tracking: Allows you to customize the inReach tracking settings 
on your Montana 700i/750i device (inReach Tracking 
Settings, page 4).

Messages: Allows you to customize the settings for inReach 
messages on your Montana 700i/750i device (Messages 
Settings, page 3).

Map: Sets the map appearance (Map Settings, page 5).
Recording: Allows you to customize activity recording settings 

(Recording Settings, page 10).
Routing: Allows you to customize how the device calculates 

routes for each activity (Routing Settings, page 20).
Expedition Mode: Allows you to customize settings for turning 

on expedition mode (Turning On Expedition Mode, 
page 20).

Waypoints: Allows you to enter a custom prefix for 
automatically named waypoints.

Tones: Sets the device sounds, such as alarm tones and alerts 
(Setting the Device Tones, page 20).

Heading: Allows you to customize the compass heading 
settings (Heading Settings, page 6).

Altimeter: Allows you to customize the altimeter settings 
(Altimeter Settings, page 6).

Camera: Adjusts the camera settings on your Montana 750i 
device (Camera Settings, page 20).

Geocaching: Allows you to customize your geocache settings 
(Geocaching Settings, page 20).

Sensors: Pairs wireless sensors with your device (Wireless 
Sensors, page 20).

Fitness: Allows you to customize settings for recording fitness 
activities (Fitness Settings, page 20).

Marine: Sets the appearance of marine data on the map 
(Marine Settings, page 21).
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 pontot az adatmezők megjelenítéséhez.

Adatmezők testreszabása
A térképi adatmezők állításához előzetesen kapcsoljuk be az adatmezők 
megjelenítését (Térképi adatmezők megjelenítésének bekapcsolása, 18. ol-
dal).
A térkép, az iránytű, a fedélzeti számítógép, a magasság grafikon és az álla-
pot képernyőhöz tartozó műszerfalakat egyedi igényeink szerint alakíthatjuk.
1.  Egy olyan képernyőn, melyen adatmező megjelenik, válasszunk egy 

adatmezőt.
2.  Válasszunk egy adat kategóriát, majd egy adattípust.

Műszerfalak testreszabása
1.   Válasszunk ki egy képernyőt.
2.   Válasszunk az alábbi lehetőségek közül:
 •  A térképen válasszuk a  > Térkép beállítás > Dashboard pontot.
 •  Az iránytű és a fedélzeti számítógép képernyőn válasszuk a  > Mű-

szerfal csere pontot.
3.  Válasszuk ki a kívánt műszerfalat.

Képernyő elforgatása
 Forgassuk a készüléket vízszintes (fekvő) vagy függőleges (portré) mód-

ba állításához.

AutoLocate Position: Calculates your GPS position using the 
Garmin AutoLocate® feature.

Satellite Setup: Sets the satellite system options (Satellite 
Settings, page 19).

Sending and Receiving Data Wirelessly
Before you can share data wirelessly, you must be within 3 m 
(10 ft.) of a compatible Garmin device.
Your device can send and receive data wirelessly when 
connected with a compatible Garmin device using ANT+ 
technology. You can share waypoints, geocaches, routes, 
tracks, and more.
1 Select Share Wirelessly.
2 Select an option:

• Select Send, and select a type of data.
• Select Receive to receive data from another device. The 

other compatible device must be attempting to send data.
3 Follow the on-screen instructions.

Using the VIRB Remote
Before you can use the VIRB remote function, you must enable 
the remote setting on your VIRB camera. See the VIRB Series 
Owner's Manual for more information.
The VIRB remote function allows you to control your VIRB 
action camera using your device.
1 Turn on your VIRB camera.
2 On your Montana device, select VIRB Remote.

NOTE: You may need to add this application to the main 
menu before you can select it (Customizing the Main Menu, 
page 14).

3 Wait while the device connects to your VIRB camera.
4 Select an option:

• To record video, select .
• To take a photograph, select .

Customizing the Device
Custom Data Fields and Dashboards
Data fields display information about your location or other 
specified data. Dashboards are a custom grouping of data that 
can be helpful to a specific or general task, such as geocaching.

Enabling the Map Data Fields
You can show custom data fields on the map.
1 From the map, select  > Map Setup > Dashboard.
2 Select Large Data Field or Small Data Fields.
3 If necessary, on the map, select  at the top of the screen to 

show the data fields.

Customizing the Data Fields
Before you can change the map data fields, you must enable 
them (Enabling the Map Data Fields, page 18).
You can customize the data fields and dashboards of the map, 
compass, trip computer, and altimeter pages.
1 From a page that displays data fields, select a data field.
2 Select a data field category and a data field.

Customizing Dashboards
1 Select a page.
2 Select an option:

• From the map, select  > Map Setup > Dashboard.
• From the compass or trip computer, select  > Change 

Dashboard.

3 Select a dashboard.

Rotating the Screen
Rotate your device to view in horizontal (landscape) or 
vertical (portrait) mode.

NOTE: While using the inReach features of your Montana 
700i/750i device, you should use the device in vertical 
(portrait) mode, with the antenna pointed toward the sky.

Setup Menu
Select Setup.
System: Allows you to customize system settings (System 

Settings, page 19).
Display: Adjusts the backlight and display settings (Display 

Settings, page 19).
Bluetooth: Pairs your device to a smartphone or audio device, 

and allows you to customize the Bluetooth settings (Bluetooth 
Settings, page 19).

Wi-Fi: Allows you to connect to wireless networks (Wi‑Fi 
Settings, page 20).

Tracking: Allows you to customize the inReach tracking settings 
on your Montana 700i/750i device (inReach Tracking 
Settings, page 4).

Messages: Allows you to customize the settings for inReach 
messages on your Montana 700i/750i device (Messages 
Settings, page 3).

Map: Sets the map appearance (Map Settings, page 5).
Recording: Allows you to customize activity recording settings 

(Recording Settings, page 10).
Routing: Allows you to customize how the device calculates 

routes for each activity (Routing Settings, page 20).
Expedition Mode: Allows you to customize settings for turning 

on expedition mode (Turning On Expedition Mode, 
page 20).

Waypoints: Allows you to enter a custom prefix for 
automatically named waypoints.

Tones: Sets the device sounds, such as alarm tones and alerts 
(Setting the Device Tones, page 20).

Heading: Allows you to customize the compass heading 
settings (Heading Settings, page 6).

Altimeter: Allows you to customize the altimeter settings 
(Altimeter Settings, page 6).

Camera: Adjusts the camera settings on your Montana 750i 
device (Camera Settings, page 20).

Geocaching: Allows you to customize your geocache settings 
(Geocaching Settings, page 20).

Sensors: Pairs wireless sensors with your device (Wireless 
Sensors, page 20).

Fitness: Allows you to customize settings for recording fitness 
activities (Fitness Settings, page 20).

Marine: Sets the appearance of marine data on the map 
(Marine Settings, page 21).

18 Customizing the Device

 MEGJEGYZÉS! A Montana 700i/750i készüléken elérhető inReach funk-
ciók használata során a készüléket használjuk függőleges (portré) mód-
ban, hogy az antenna az ég felé irányuljon.

Beállítások képernyő
Válasszuk a Beállítások pontot.
Rendszer: Rendszerbeállítások módosítása (Rendszerbeállítások, 19. oldal).
Megjelenítés: Háttérvilágítás és kijelző beállítása (Kijelző beállítások, 19. ol-

dal).
Bluetooth: Készülék párosítása okostelefonnal, és Bluetooth beállítások 

módosítása (Bluetooth beállítások, 19. oldal).
Wi-Fi: Csatlakozás vezeték nélküli hálózatokhoz (Wi-Fi beállítások, 20. oldal)
Nyomon követés: inReach nyomon követési beállítások testreszabása a 

Montana 700i/750i készüléken (inReach nyomon követési beállítások, 4. 
oldal).

Üzenetek: inReach üzenetküldési beállítások testreszabása a Montana 
700i/750i készüléken (Üzenetbeállítások, 3. oldal).

Térkép: Térkép kinézetének beállítása (Térkép beállítása, 5. oldal).
Rögzítés: Tevékenységek rögzítési beállításainak módosítása (Rögzítés be-

állítása, 10. oldal).
Útvonaltervezés: A tevékenységek útvonaltervezési módjainak beállítása 

(Útvonaltervezési beállítások, 20. oldal).
Expedíció mód: Expedíció mód aktiválási beállításainak módosítása (Expe-

díció mód bekapcsolása, 20. oldal).
Útpontok: Egyedi előjel beillesztése automatikusan elnevezett útpontoknál.
Hangjelzések: Készülék által kiadott hangok – pl. gombnyomáskor vagy ri-

asztáskor – beállítása (Hang beállítások, 20. oldal).
Irány: Iránytű iránybeállításainak módosítása (Irány beállítások, 6. oldal).
Magasságmérő: Magasságmérő beállításainak módosítása (Magasságmé-

rő beállítások, 6. oldal).
Kamera: Montana 750i készülék kamerájának beállításai (Kamera beállítá-

sok, 20. oldal).
Geoláda-keresés: Geoláda-keresés beállításainak módosítása (Geoláda-

keresési beállítások, 20. oldal).
Mérők: Vezeték nélküli kapcsolattal működő érzékelők párosítása az esz-

közzel (Vezeték nélküli kapcsolattal működő mérők, 20. oldall).
Fitnesz: Fitnesz tevékenységek felvételének beállításai (Fitnesz beállítások, 

20. oldal).
Tengeri: Tengeri adatok megjelenítése vagy elrejtése a térképen (Tengeri 

beállítások, 21. oldal).
Képernyők: Képernyősorrend és főképernyő testreszabása (Képernyők be-

állítása, 21. oldal).
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Helyformátum: Földrajzi tartózkodási hely formátum és dátum beállítások 
módosítása (Helyformátum, 21. oldal).

Mértékegységek: Készülék által használt mértékegységek beállítása (Mér-
tékegységek, 21. oldal).

Idő: Időbeállítások módosítása (Idő beállítások, 21. oldal).
Hozzáférés: Hozzáférési beállítások ().
Profilok: Tevékenységi profilok testreszabása és új tevékenységi profil létre-

hozása (Profilok beállításai, 21. oldal).
Visszaállítás: Felhasználói adatok és beállítások visszaállítása (Adatok tör-

lése, számlálók nullázása, gyári beállítások visszaállítása, 21. oldal).
Névjegy: Készülékinformációk, mint pl. azonosítószám, szoftver verzió, sza-

bályozási információk és felhasználói szerződés megjelenítése (E-cimke 
szabályozási és megfelelőségi információk, 22. oldal).

Rendszerbeállítások
Válasszuk a Beállítások > Rendszer pontot.
Műholdak – A műholdas vételt állíthatjuk be (Műholdas beállítások, 19. oldal).
Feliratok nyelve – a menürendszer nyelvét választhatjuk ki.
 MEGJEGYZÉS! A menürendszer nyelvének módosításával a felhasználó 

által bevitt saját adatok és a térképi adatok, pl. az utcanevek nyelve nem 
változik.

Ki-/bekapcsoló gomb – Gyorsparancsokat rendelhetünk a ki-/bekapcsoló 
gombhoz (Ki-/bekapcsoló gomb testreszabása, 19. oldal).

Speciális beállítások – Üzemmód beállítása külső energiaforrásra történő 
csatlakozás esetén, és arról való lecsatlakozás esetén, valamint a kom-
munikációs interfész módjának beállítása (Soros interfész beállítások, 19. 
oldal).

RINEX naplózás – Vevőfüggetlen Átváltási Formátumú (RINEX) adatok írá-
sát teszi lehetővé rendszerfájlokba. A RINEX egy adatcsere-formátum 
nyers navigációs rendszerek adataihoz.

Elemtípus – az alkalmazott elem, akkumulátor típusának megadását teszi 
lehetővé.

 MEGJEGYZÉS! Ez a beállítás kizárólag a Montana 700 opcionális AA-s 
ceruzaakku (ceruzaelem) csomaggal való működtetése során elérhető.

Műholdas beállítások
Válasszuk a Beállítások > Rendszer > Műholdak pontot.
Műholdas rendszer – Választhatunk a normál GPS mód között, bekapcsol-

hatjuk a több műholdrendszert alkalmazó üzemmódot (Tudnivalók a GPS 
és egyéb műholdas rendszerek beállításairól, 19. oldal), vagy válthatunk 
Demo üzemmódra (kikapcsolt GPS).

WAAS/EGNOS – Kiegészítő műhold-rendszerek bevonása a pozíció meg ha-
tá rozás javítása érdekében. Észak-Amerika területén a WAAS műhold-
rendszer működik, Európa területén az EGNOS rendszer.

Tudnivalók a GPS és egyéb műholdas rendszerek beállításairól
A GPS és egy további műholdas rendszer együttes használata szélsősé-
ges körülmények között is gyors pozíciómeghatározást biztosít, azonban na-
gyobb áramfelvétellel, vagyis az akkumulátor által biztosított működési idő 
csökkenésével jár.
A készülék az alábbi műholdas navigációs rendszereket (GNSS) képes hasz-
nálni. Egyes műholdas navigációs rendszerek nem minden készülékmodell 
számára érhető el.
GPS: az Amerikai Egyesült Államok által kiépített műholdhálózat.
GLONASS: Oroszország által kiépített műholdhálózat.
GALILEO: Az Európai Űrügynökség által kiépített műholdhálózat.

Ki-/bekapcsoló gomb testreszabása
A ki-/bekapcsoló gombot testreszabhatjuk, így gyors hozzáférést biztosítha-
tunk a menükhöz, alkalmazásokhoz és a készülék egyéb funkcióihoz.

1.  Válasszuk a Beállítások > Rendszer > Ki-/bekapcsoló gomb pontot.
2.  Válasszunk az Egyszeri érintés és Dupla érintés lehetőségek között.
3.  Válasszuk ki a kívánt funkciót.

Soros interfész beállítások
Válasszuk a Beállítások > Rendszer > Interfész pontot.
Garmin Spanner – az USB-portot virtuálisan soros porttá alakítja, és ezen 

a virtuális porton át a legtöbb NMEA 0183 kompatibilis térképi szoftverrel 
valós soros port hiányában is képes együttműködni a készülék.

Garmin soros – Garmin kizárólagos tulajdonban álló formátum, amely al-
kalmas útpontok, útvonalak, nyomvonalak számítógép és a készülék  kö-
zötti átvitelére.

NMEA Be/Ki – szabványos NMEA 0183 kimeneti és bemeneti adatátvitelt 
tesz lehetővé.

Szöveg ki – sima szöveges (ASCII kódolású) adatkimenet, amely a pozíció 
és a sebesség adatokat tartalmazza.

MTP – A készüléket mobil eszközként csatlakoztathatjuk Windows operáci-
ós rendszert futtató eszközhöz lehetővé téve médiafájlok automatikus fel-
töltését.

Kijelző beállítások
Válasszuk a Beállítások > Kijelzőt.
Háttérvilágítás késleltetés – megadhatjuk, hogy a háttérvilágítás miután ki-

gyullad – amennyiben érintetlenül hagyjuk a készüléket – mennyi idő után 
kapcsoljon ki, vagy maradjon folyamatosan égve.

Tájolás lezárás – lezárhatjuk a képernyő tájolását portré vagy tájkép mód-
ban, illetve beállíthatjuk, hogy a készülék elforgatásakor a képernyő tájo-
lása is annak megfelelően forduljon el.

Képernyő autom. lezárása – Beállíthatjuk a képernyőt, hogy automatiku-
san lezáródjon.

Energiatak. üzemmód – energiatakarékos működési mód, mellyel az akku-
mulátor által biztosított működési idő meghosszabbítható. Amikor a hát-
térvilágítás kialszik, a kijelző kikEnergiatakarékos mód bekapcsolása, 19. 
oldal).

Megjelenítés – A kijelző hátterének, és a kiválasztás színének állítása nap-
pali és éjjeli üzemmódban (Megjelenítési beállítások, 19. oldal).

Energiatakarékos mód bekapcsolása
Az energiatakarékos mód megnövelt működési időt biztosít az akkumulátorról.
 Az alkalmazás fiókban válasszuk a Beállítás > Kijelző > Akkutakarékos 

üzemmód > Be pontokat.
Energiatakarékos módban a kijelző kikapcsol, amikor a háttérvilágítás késlel-
tetési ideje lejár. A 

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .

Introduction 1

 gombbal kapcsolhatjuk be a kijelzőt, míg a gomb két-
szeri lenyomásával megjeleníthetjük az állapotjelző sávot.

Megjelenítési beállítások
1.  Válasszuk a Beállítások > Kijelző > Megjelenítés-t.
2.  Válasszunk az alábbiak közül:
Mód: A készülék fényes vagy sötét hátteret állít be, illetve az aktuális idő alap-

ján automatikusan kiválasztja a nappali vagy éjjeli színek megjelenítését.
Nappali szín: Nappali színséma testreszabása.
Éjjeli szín: Éjjeli színséma testreszabása.
Vezérlők fekvő nézetben:Fekvő formátumban a vezérlőket áthelyezhetjük 
a bal vagy a jobb szélre.

Bluetooth beállítások
Válasszuk a Beállítások > Bluetooth pontot.
Telefon beállítása: a Bluetooth vezeték nélküli technológiát aktiválhatjuk, 

okostelefont párosíthatunk a készülékkel (Okostelefon párosítása, 7. ol-
dal).

Audió készülék: Vezeték nélküli fülhallgatót párosíthatunk a készülékkel 
(Vezeték nélküli fülhallgató párosítása a készülékkel, 8. oldal).

Telefon beállítása
Válasszuk a Beállítások > Bluetooth > Telefon beállítása pontot.
Állapot – Bluetooth vezeték nélküli technológia aktiválása, és aktuális kap-

csolati állapot megjelenítése.
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Értesítések – Okostelefonos értesítések megjelenítése vagy relrejtése.
Telefon elfeledése – Csatlakoztatott készülék eltávolítása a párosított ké-

szülékek listájából. Ez a beállítás csak párosított készülékeknél érhető el.

Wi-Fi beállítások
Válasszuk a Beállítások > Wi-Fi pontot.
Wi-Fi – Vezeték nélküli technológia aktiválása.
Hálózat hozzáad. – Vezeték nélküli hálózatok keresése és azokhoz való 

csatlakozás.

Útvonaltervezési beállítások
Az elérhető útvonaltervezési beállítások a kiválasztott tevékenység alapján 
változnak.
Válasszuk a Beállítások > Útvonaltervezés pontot.
Közvetlen útvonaltervezés – közvetlen útvonaltervezés be- vagy kikapcso-

lása. Ezzel a funkcióval a készülék az úticélhoz vezető lehető legközvet-
lenebb útvonalat tervezi meg.

Tevékenység – válasszunk egy tevékenységet. A készülék az adott tevé-
kenységre optimalizált útvonalat tervez.

Tervezési mód – az útvonal tervezési módját választhatjuk ki.
Úton tart – a pozíciónkat jelölő ikont mindig a legközelebbi útra helyezi felté-

telezve, hogy közúton közlekedünk. Ez akkor a leghasznosabb, ha úton 
közlekedünk.

Letérés újratervezés – Beállíthatjuk az újratervezése preferenciáinkat, amikor 
aktív útvonaltól távol navigálunk.

Elkerülési beállítások – Beállíthatjuk, hogy a készülék navigálás közben mi-
lyen típusú utakat, terepeket és közlekedési módszereket kerüljön el.

Útvonal tranzíciók – Beállíthatjuk, hogyan tesz át a készülék egyik pontról a 
másikra. Ez csak bizonyos tevékenységeknél elérhető. A Távolság opció-
val a készülék akkor tesz át a következő útpontra, amikor a jelenlegi útpon-
tot adott távolságra megközelítettük.

Expedíció mód bekapcsolása
Az expedíció mód megnövelt működési időt biztosít az akkumulátorról. Expe-
díció módban a képernyő kikapcsol, a készülék kis energiaigényű üzemmód-
ba vált és kevesebb GPS kvetési pontot gyűjt.
1.   Válasszuk a Beállítások > Expedíció mód pontot.
2.   Válasszunk az alábbiak közül:
    •    Felszólítás – a készülék felszólít, hogy amikor kikapcsoljuk, aktiváljuk 

az expedíció módot.
    •    Auto – két perces tétlenség után az expedíció mód automatikusan be-

kapcsol.
    •   Soha – az expedíció mód soha nem kapcsol be.
Expedíció módban a ki-/bekapcsoló gomb melletti piros színű LED égő időn-
két felvilan.

Hang beállítások
Az üzeneteket, forduló figyelmeztetéseket, riasztásokat kísérő hangokat ál-
líthatjuk be.
1.  Válasszuk a Beállítások > Hangok > Hangok > Be pontot.
2.  Letilthatjuk a hangjelzéseket, illetve kiválaszthatjuk az egyes riasztások-

hoz a kívánt dallamokat.

Kamera beállítások
Válasszuk a Beállítások > Kamera pontot.
Fotó felbontás: A fotók felbontását állíthatjuk be.
Fotók mentési helye: Megadhatjuk a fotók tárolási helyét.
Kamera utasítások: Rövid utasításokat jeleníthetünk meg a fotókészítésről.

Geoláda-keresési beállítások
Válasszuk a Beállítások > Geocaching pontot.
Geocaching élő – az élő geoláda-adatok megjelenítését kapcsolhatjuk be 

és ki, illetve törölhetjük a készülék regisztrációját a geocaching.com ol-
dalról (Valós idejű geoláda-hely adatok törlése a készülék memóriájából, 
17. oldal, Geocaching.com regisztráció törlése, 17. oldal).

Geoláda stílus – a letöltött geoláda helyek kilistázása történhet név vagy 
kód szerint.

chirp keresés – chirp kiegészítőt tartalmazó geoláda keresésének engedé-
lyezése (chirp keresés bekapcsolása, 17. oldal).

chirp programozás – a chirp kiegészítő programozása (lásd a chirp saját 
használati útmutatójában).

Szűrőbeállítás – egyedi geoláda keresési szűrők létrehozása és mentése 
(Geoláda szűrő létrehozása és mentése, 16. oldal).

Talált geoládák – megadhatjuk a megtalált geoládák számát. Naplózás 
esetén ez automatikusan növekszik (Keresési kísérlet naplózása, 17. ol-
dal).

Vezeték nélküli kapcsolattal működő mérők
A készülék számos vezeték nélküli ANT+ vagy Bluetooth funkciós mérővel is 
kompatibilis. A kompatibilis mérőkről és ezek beszerzéséről részletesen tájé-
kozódhatunk a Garmin ügyfélszolgálaton.

Mérő beállítások
Válasszuk a Beállítások > Mérők pontot.
Fitnesz: fitnesz kiegészítőket párosíthatunk a készülékkel, mint például 

pulzusszámmérőt, valamint sebesség- és pedálütemmérőt.
Tempe mérő: tempe™ hőmérsékletmérőt párosíthatunk a készülékkel.
XERO: megosztási állapot aktiválását és kikapcsolását teszi lehetővé, illet-

ve kiválaszthatjuk, hogy megosztásaink nyilvános vagy privát állapotú-
ak legyenek.

 MEGJEGYZÉS! A pozíciónkat megoszthatjuk kompatibilis Xero készülék-
ről.

DogTrack: kompatibilis kézi kutyakövető készülékről fogadhatunk adatokat a 
készülékre (Kutya követés, 15. oldal).

inReach távvezérlő: Be- és kikapcsolhatjuk az inReach távvezérlő készülé-
ket és készülékellenőrzést a Montana 700i/750i készüléken.

 MEGJEGYZÉS! Kompatibilis Garmin készüléket párosíthatunk, és a 
Montana készülékről távvezérlésben üzeneteket küldhetünk a segítsé-
gével.

Vezeték nélküli kapcsolattal működő mérő párosítása
Párosítás előtt fel kell vennünk a pulzusszámmérőt vagy telepítenünk kell a 
mérőt. 
Amikor az ANT+ vagy Bluetooth vezeték nélküli technológiával működő mérőt 
első alkalommal csatlakoztatjuk a készülékhez, össze kell hangolnunk a mé-
rőt és a készüléket, úgymond párosítanunk kell ezeket (pl. pulzusszámmérő 
párosítása a készülékkel).
1.   Hozzuk a mérőt és a készüléket három (3) méteres távolságon belül.
      NE FELEDJÜK! Párosítás közben 10 méteres körzeten belül ne legyen 

másik vezeték nélküli mérő.
2.   Válasszuk a Beállítások > Mérők pontot.

3.   Válasszuk ki a mérő típusát.

4.   Válasszuk az Új keresése pontot.
  Amikor az érzékelő párosításra kerül a készülékkel, a keresési állapot 

Keresés-ről átvált Csatlakozva-ra.

Fitnesz beállítások
Válasszuk a Beállítások > Fitnesz pontot.
Auto Lap – a készülék a megadott távolság megtételekor automatikusan új 

kört kezd.
Egyéni – a felhasználói profilunk adatainak megadása. A készülék az infor-

máció segítségével a Garmin Connect-ben pontos edzési információkat 
számít ki.

Pulzustartományok – az öt pulzustartomány beállítása edzési tevékenysé-
gekhez.

Kör automatikus jelölése távolság alapján (Auto Lap)
Az Auto Lap® funkció adott távolság megtételekor automatikusan új kört 
kezd. Ezzel lehetővé válik, hogy összehasonlítsuk az edzés különböző sza-
kaszait.



21

1. Válasszuk a Beállítások > Fitnesz > Auto Lap pontot.
2. Adjuk meg az értéket, majd válasszuk a 

Turns appear in the text bar along the top of the map. Audible 
tones signal turns in the route.

Optional Maps
You can use additional maps with the device, such as BirdsEye 
satellite imagery, City Navigator, and Garmin HuntView™ Plus 
detailed maps. Detailed maps may contain additional points of 
interest, such as restaurants or marine services. For more 
information, go to buy.garmin.com or contact your Garmin 
dealer.
Enabling Maps
You can enable map products installed on your device.
1 From the map, select  > Map Setup > Configure Maps.
2 Select the toggle switch to enable each installed map.

Finding a Location Near Another Location
1 Select  >  > Search Near.
2 Select an option.
3 Select a location.

Waypoints
Waypoints are locations you record and store in the device. 
Waypoints can mark where you are, where you are going, or 
where you have been.

Creating a Waypoint
You can save your current location as a waypoint.
1 Select Mark Waypoint.
2 If necessary, select a field to edit the waypoint.
3 Select Save.

Navigating to a Waypoint
1 Select  > Waypoints.
2 Select a waypoint.
3 Select Go.

By default, your route to the waypoint appears as a straight, 
colored line on the map.

Finding a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint from the list.
3 If necessary, select  to narrow the search.
4 Select an option:

• Select Spell Search to search using the name of the 
waypoint.

• Select Select Symbol to search using the symbol of the 
waypoint.

• Select Search Near to search near a recently found 
location, another waypoint, your current location, or a 
point on the map.

• Select Sort to view the list of waypoints based on nearest 
distance or alphabetical order.

Editing a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select an item to edit, such as the name.
4 Enter the new information, and select .

Deleting a Waypoint
1 Select Waypoint Manager >  > Delete.
2 Select an option:

• To delete one waypoint, select a waypoint.
• To delete multiple waypoints, select multiple waypoints.
• To delete all waypoints, select Select All.

3 Select Delete.

Increasing the Accuracy of a Waypoint Location
You can refine the accuracy of a waypoint location by averaging 
the location data. When averaging, the device takes several 
GPS readings at the same location and uses the average value 
to provide more accuracy.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Average Location.
4 Move to the waypoint location.
5 Select Start.
6 Follow the on-screen instructions.
7 When the confidence status bar reaches 100%, select Save.
For best results, collect four to eight samples for the waypoint, 
waiting at least 90 minutes between samples.

Projecting a Waypoint
You can save a new waypoint by projecting the distance and 
bearing from a saved waypoint to a new location.
For example, if you would like to navigate to a location you 
observe on the other side of a river or stream, you can project a 
waypoint from your current location to the observed location, 
then navigate to the new location after crossing the river or 
stream at a more suitable location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Project Waypoint.
4 Enter the bearing, and select .
5 Select a unit of measure.
6 Enter the distance, and select .
7 Select Save.

Moving a Waypoint on the Map
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Move Waypoint.
4 Select a location on the map.
5 Select Move.

Finding a Location Near a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Find Near Here.
4 Select a category.
The list displays locations near the selected waypoint.

Setting a Waypoint Proximity Alarm
You can add a proximity alarm for a waypoint. Proximity alarms 
alert you when you are within a specified range of a particular 
location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Set Proximity.
4 Enter the radius.

When you enter an area with a proximity alarm, the device 
sounds a tone.

Adding a Waypoint to a Route
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Add to Route.
4 Select a route.

Navigation 9
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Fitnesz felhasználói profil beállítása
A készülék a pontos adatok kiszámításához az általunk megadott ada-
tokat használja fel. Az alábbi felhasználói adatokat adhatjuk meg, illetve 
módosíthatjuk: nem, életkor, testsúly, magasság, valamint élethosszig tar-
tó sportolói adatok (Tudnivalók az élethosszig tartó sportolókról, 21. oldal).
1. Válasszuk a Beállítások > Fitnesz > Felhasználó pontot.

Tudnivalók az élethosszig tartó sportolókról
Élethosszig tartó sportoló az a személy, aki sok éven keresztül (a kisebb sé-
rüléseket leszámítva) intenzíven edz, és nyugalmi pulzusszáma 60 szívdob-
banás per perc (bpm) vagy annál kevesebb.

Tengeri beállítások
Válasszuk a Beállítások > Tengeri pontot.
Tengeri térképmód – választhatunk a tengeri és a halászati térképi megje-

lenítések közül.
Tengeri – a tengeri térképi elemeket különböző színekben jeleníti meg, így a 

tengeri érdekes helyek sokkal feltűnőbbek a térképek. A hajós papírtérké-
pek színvilága tükröződik vissza a képernyőn.

Halászat – (hajós térkép szükséges hozzá) részletesen ábrázolja a meder-
fenék kontúrvonalait és a mélységi helyeket, és a halászatnak leginkább 
megfelelően egyszerűsíti a térképi grafikát.

Megjelenés – a tengeri navigációs segédek megjelenítését állíthatjuk be.
Tengeri riasztás beáll. – beállíthatjuk a készüléket, hogy riasszon, ha le-

horgonyzott állapotban a megadottnál nagyobb mértékben eltávolo-
dik a hajó az eredeti pozíciótól, az eredeti útvonaltól a megadottnál 
nagyobb mértékben eltávolodik a hajó, vagy ha adott mélységű víz-
re kerülünk.

Tengeri riasztások beállítása
1. Válasszuk a Beállítások > Tengeri > Tengeri riasztás beáll. pontot.
2. Válasszuk ki a riasztás típusát.
3. Adjuk meg a kívánt távolságot, majd válasszuk a 

Turns appear in the text bar along the top of the map. Audible 
tones signal turns in the route.

Optional Maps
You can use additional maps with the device, such as BirdsEye 
satellite imagery, City Navigator, and Garmin HuntView™ Plus 
detailed maps. Detailed maps may contain additional points of 
interest, such as restaurants or marine services. For more 
information, go to buy.garmin.com or contact your Garmin 
dealer.
Enabling Maps
You can enable map products installed on your device.
1 From the map, select  > Map Setup > Configure Maps.
2 Select the toggle switch to enable each installed map.

Finding a Location Near Another Location
1 Select  >  > Search Near.
2 Select an option.
3 Select a location.

Waypoints
Waypoints are locations you record and store in the device. 
Waypoints can mark where you are, where you are going, or 
where you have been.

Creating a Waypoint
You can save your current location as a waypoint.
1 Select Mark Waypoint.
2 If necessary, select a field to edit the waypoint.
3 Select Save.

Navigating to a Waypoint
1 Select  > Waypoints.
2 Select a waypoint.
3 Select Go.

By default, your route to the waypoint appears as a straight, 
colored line on the map.

Finding a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint from the list.
3 If necessary, select  to narrow the search.
4 Select an option:

• Select Spell Search to search using the name of the 
waypoint.

• Select Select Symbol to search using the symbol of the 
waypoint.

• Select Search Near to search near a recently found 
location, another waypoint, your current location, or a 
point on the map.

• Select Sort to view the list of waypoints based on nearest 
distance or alphabetical order.

Editing a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select an item to edit, such as the name.
4 Enter the new information, and select .

Deleting a Waypoint
1 Select Waypoint Manager >  > Delete.
2 Select an option:

• To delete one waypoint, select a waypoint.
• To delete multiple waypoints, select multiple waypoints.
• To delete all waypoints, select Select All.

3 Select Delete.

Increasing the Accuracy of a Waypoint Location
You can refine the accuracy of a waypoint location by averaging 
the location data. When averaging, the device takes several 
GPS readings at the same location and uses the average value 
to provide more accuracy.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Average Location.
4 Move to the waypoint location.
5 Select Start.
6 Follow the on-screen instructions.
7 When the confidence status bar reaches 100%, select Save.
For best results, collect four to eight samples for the waypoint, 
waiting at least 90 minutes between samples.

Projecting a Waypoint
You can save a new waypoint by projecting the distance and 
bearing from a saved waypoint to a new location.
For example, if you would like to navigate to a location you 
observe on the other side of a river or stream, you can project a 
waypoint from your current location to the observed location, 
then navigate to the new location after crossing the river or 
stream at a more suitable location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Project Waypoint.
4 Enter the bearing, and select .
5 Select a unit of measure.
6 Enter the distance, and select .
7 Select Save.

Moving a Waypoint on the Map
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Move Waypoint.
4 Select a location on the map.
5 Select Move.

Finding a Location Near a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Find Near Here.
4 Select a category.
The list displays locations near the selected waypoint.

Setting a Waypoint Proximity Alarm
You can add a proximity alarm for a waypoint. Proximity alarms 
alert you when you are within a specified range of a particular 
location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Set Proximity.
4 Enter the radius.

When you enter an area with a proximity alarm, the device 
sounds a tone.

Adding a Waypoint to a Route
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Add to Route.
4 Select a route.
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Képernyők beállítása
Válasszuk a Beállítások > Képernyők pontot.
Képernyő stílus – Főképernyő megjelenítésének módosítása.
Főképernyő – A főképernyőn található menüpontokat mozgathatjuk, újakat 

adhatunk hozzá vagy meglévőket távolíthatunk el (Főmenü személyre 
szabása, 14. oldal).

Kedvencek – A kedvencek sávban található menüpontokat mozgathatjuk, 
újakat adhatunk hozzá vagy meglévőket távolíthatunk el (Kedvencek sáv 
testreszabása, 21. oldal).

Beállítás – Menüpontok sorrendjének módosítása a Beállítás menüben.
Keresés – Menüpontok sorrendjének módosítása a Keresés menüben.

Kedvencek sáv testreszabása
A kedvencek sávban található menüpontokat mozgathatjuk, újakat adhatunk 
hozzá vagy meglévőket távolíthatunk el,

• Nyomjuk le hosszan bármelyik ikont a kedvencek sávban, majd húzzuk 
azt el egy másik helyre.

• Válasszuk a Beállítások > Képernyők > Kedvencek pontot, majd vá-
lasszunk ki egy képernyőt a sorrend megváltoztatásához vagy a ked-
vencek sávból történő eltávolításához.

• Új képernyő hozzáadásához a kedvencek sávhoz távolítsunk el egy 
meglévő képernyőt a sávból, majd válasszuk a Képernyő hozzáadása.

Helyformátum
MEGJEGYZÉS! Csakis a készülékétől eltérő formátumot használó térkép al-
kalmazása esetén változtassuk meg a helyformátumot.
Válasszuk a Beállítások > Helyformátum pontot.
Helyformátum – a koordináták kijelzési formátuma.
Térkép-alappont – a térkép felosztásának alapját adó kooordináta-rendszer.
Szferoid térkép – a készülék által alkalmazott koordináta-rendszer. Az alap-

értelmezett a WGS 84.

Mértékegységek
A távolság/sebesség, a magasság, a vízmélység, a hőmérséklet, a légnyo-
más mértékegységét adhatjuk meg.
1.   Válasszuk a Beállítások > Mértékegységek pontot. 
2.  Válasszuk ki az adattípust.
3.  Válasszuk ki a kívánt mértékegységet.

Idő beállítások
Válasszuk a Beállítások > Idő pontot.
Időformátum – 12 és 24 órás kijelzési módok között választhatunk.
Időzóna – meghatározhatjuk az időzónát. Automatikus esetén a jelenlegi 

tartózkodási hely függvényében a készülék maga állítja be a zónát.
Nyári időszámítás – beállíthatjuk a készüléket, hogy nyári időszámítás sze-
rint jelezze az időt.

Akadálymentesítési funkciók
Válasszuk a Beállítások > Akadálymentesítés pontot.
Érintési érzékenység – megadhatjuk az érintőképernyő érintési érzékeny-

ségét (Érintőképernyő érzékenység beállítása, 21. oldal).
Betűméret – beállíthatjuk a készüléken megjelenített szövegek betűmé-

retét.
Görgetési vezérlők – görgethető képernyőknél, listáknál és térképeknél gör-

gető nyilakat jeleníthetünk meg a térképen.

Érintőképernyő érzékenység beállítása
Az érintőképernyő érzékenységét az éppen végzett tevékenységünknek 
megfelelően állíthatjuk.
1.  Válasszuk a Beállítás > Akadálymentesítés > Érintési érzékenység 

pontot.
2. Válasszunk az elérhető lehetőségek közül.
 TIPP! A tevékenységünknek megfelelően kesztyűvel és kesztyű nélkül is 

kipróbálhatjuk az érintőképernyő beállításait.

Profilok beállításai
A profil beállítások összességét jelenti, amely beállításokkal egy adott alkal-
mazási módhoz optimalizáljuk a készülék működését. Például a beállítások 
és adatmezők másak, amikor a készüléket vadászatra, megint másak, ami-
kor geoláda-keresésre használjuk.
Egy adott profil alkalmazása során a különféle beállítások módosítása, pl. az 
adatmezők, mértékegységek, pozíció beállítások módosítása az adott profil 
részeként automatikusan mentésre kerül.

Saját profil létrehozása
Egy adott tevékenységhez, túrához igazíthatjuk a készülék beállításait. 
1.   A főmenüben válasszuk a Beállítás > Profilok > Profil létrehozása > OK 

pontot.

2.   Adjuk meg a kívánt beállításokat és adatmezőket.

Profil átnevezése
1.   Válasszuk ki a Beállítások > Profilok pontot.
2.   Válasszuk ki a profilt.
3.    Válasszuk a Név szerkesztése pontot.
4.  Adjuk meg az új nevet.

Profil törlése
NE FELEDJÜK! Aktív profil törlése előtt először át kell váltanunk egy másik 
profilra. A profil nem törölhető, amíg a készülék azt használja.
1.   Válasszuk ki a Beállítások > Profilok pontokat.

2.   Válasszuk ki a profilt, majd válasszuk a Törlés pontot.

Adatok törlése, számlálók nullázása, gyári beállítások 
visszaállítása
1.   Válasszuk a Beállítás > Visszaállítás pontot.
2.   Válasszunk az alábbi lehetőségek közül:
 •  Fedélzeti (túra) adat, pl. távolság és átlagértékek törléséhez, nullázásá-

hoz válasszuk az Útadat nullázás pontot.
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 •  Az összes mentett útpont törléséhez válasszzuk az Összes útpont tör-
lése pontot.

 •  Az aktuális tevékenység megkezdése óta rögzített adatok törléséhez vá-
lasszuk az Aktuális tevékenység törlése pontot.

    MEGJEGYZÉS! A törlést követően a készülék tovább menti az aktuális 
tevékenység adatait.

 •  Az aktuális tevékenységi profil beállításait töröljük és a gyári alapbeál-
lításokat érvényesítjük ezen tevékenység profilra vonatkozóan a Profil 
beállítások visszaállítása ponttal.

 •  A készülék összes beállítását a gyári alapértékekre állítjuk vissza az 
Összes beállítás visszaállítása ponttal.

    NE FELEDJÜK! Az összes beállítás visszaállításával a geoláda kere-
sési tevékenységet is töröljük a készülékből, azonban a mentett fel-
használói adatok – beleértve a pályákat és útpontokat is – megmarad-
nak.

 •  Az összes mentett felhasználói adat törléséhez, és a készülék minden 
beállításának visszaállításához a gyári értékekre válasszuk az Összes 
törlése pontot.

    NE FELEDJÜK! Az összes beállítás törlésével elvesznek a személyes 
adatok, naplók, mentett felhasználói adatok, beleértve a pályákat és út-
pontokat is.

Képernyő beállításainak visszaállítása gyári értékekre
1.  Nyissuk meg a képernyőt, melynek beállításait gyári értékre kívánjuk visz-

szaállítani.
2.  Válasszuk a  > Alapbeáll. visszaállítása pontot.

Készülék információk
Terméktámogatás, frissítések
Számítógépünkön telepítsük a Garmin Express™-t (www.garmin.com/
express). Okostelefonunkra telepíthetjük a Garmin Explore alkalmazást, 
amellyel feltölthhetjük útpontjainkat, útvonalainkat, pályáinkat és tevékeny-
ségeinket. 
A Garmin Express szoftver az alábbi szolgáltatásokhoz biztosít hozzáférést:
•  termékregisztráció,
•  szoftverfrissítések,
• térképi frissítések.

Garmin Express telepítése
1. Az USB-kábellel csatlakoztassuk az Edge készüléket számítógépünk-

höz.
2. Lépjünk fel a garmin.com/express oldalra.
3. Kövessük a képernyőn megjelenő utasításokat.

További tudnivalók
A termékről több információt tudhatunk meg a Garmin weboldalon.
•  További útmutatók, cikkek és szoftverfrissítések eléréséhez látogassunk 

el a www.garmin.hu oldalra.
•  Az opcionális kiegészítőkről és cserealkatrészekről a Garmin ügyfél-

szolgálaton tudhatunk meg bővebb információkat.

E-cimke szabályozási és megfelelőségi információk
A készülék elektronikus címkével rendelkezik. Az e-címke olyan szabályozá-
si információkat tartalmazhat, mint az FCC által biztosított azonosítószámok, 
vagy regionális megfelelőzésgi jelzések, valamint alkalmazható termék- és 
engedélyinformációk.
1.   Válasszuk a Beállítás pontot.
2.   Válasszuk a Készülékinformációk pontot.

AA ceruzaelemek behelyezése
A csomag részét képező lítium-ion akkumulátor (Lítium-ion akkumulátor be-
helyezése, 1. oldal) helyett (külön megvásárolható) három AA típusú ceruza-
elemmel (vagy ceruzaakkuval) is használhatjuk a készüléket. Ez akkor hasz-
nos, amikor éppen úton vagyunk, és nincs lehetőségünk feltölteni a lítium-ion 
akkumulátort. A Garmin a leghatékonyabb működéshez lítium AA ceruzaele-
meket ajánl.
MEGJEGYZÉS! A külön megvásárolható elemcsomag kizárólag a Montana 
700 készülékkel kompatibilis.
1.  Fordítsuk el a D-gyűrűt az óramutatóval ellentétes irányba a lítium-ion 

elemtartó eltávolításához a Montana 700 készülékből.
2.  Csúsztassuk el a tolózárat az elemtartó felnyitásához.

2 Select an option:
• To reset data specific to a trip, such as distance and 

averages, select Reset Trip Data.
• To delete all saved waypoints, select Delete All 

Waypoints.
• To clear the data recorded since you started your current 

activity, select Clear Current Activity.
NOTE: The device continues to record new data for the 
current activity.

• To reset only the settings for your current activity profile to 
the factory default values, select Reset Profile Settings.

• To reset all device settings and profiles to the factory 
default values, select Reset All Settings.
NOTE: Resetting all settings clears all geocaching activity 
from your device. It does not remove your saved user 
data, such as tracks and waypoints.

• To remove all saved user data and reset all settings on 
the device to the factory default values, select Delete All.
NOTE: Deleting all settings removes your personal data, 
history, and saved user data, including tracks and 
waypoints.

Restoring Default Page Settings
1 Open a page for which you will restore the settings.
2 Select  > Restore Defaults.

Device Information
Product Updates
On your computer, install Garmin Express (www.garmin.com
/express). On your smartphone, you can install the Garmin 
Explore app to upload your waypoints, routes, tracks, and 
activities.
Garmin Express provides easy access to these services for 
Garmin devices:
• Software updates
• Map updates
• Product registration

Setting Up Garmin Express
1 Connect the device to your computer using a USB cable.
2 Go to garmin.com/express.
3 Follow the on-screen instructions.

Getting More Information
You can find more information about this product on the Garmin 
website.
• Go to support.garmin.com for additional manuals, articles, 

and software updates.
• Go to buy.garmin.com, or contact your Garmin dealer for 

information about optional accessories and replacement 
parts.

Viewing E-label Regulatory and Compliance 
Information
The label for this device is provided electronically. The e-label 
may provide regulatory information, such as identification 
numbers provided by the FCC or regional compliance markings, 
as well as applicable product and licensing information.
1 Select Setup.
2 Select About.

Installing AA Batteries
Instead of the included lithium-ion battery pack (Installing the 
Lithium-ion Battery, page 1), you can use three AA batteries with 
an optional AA battery pack (not included). This is useful when 
you are on the trail and cannot charge the lithium-ion battery 
pack. Garmin recommends lithium AA batteries for best results.
NOTE: The optional AA battery pack is compatible with the 
Montana 700 device only.
1 Turn the D-ring counterclockwise to remove the lithium-ion 

battery pack from the Montana 700 device.
2 Slide the latch to open the AA battery pack.

3 Insert three AA batteries, observing polarity, and close the 
battery pack.

4 Insert the AA battery pack into the back of the device, turn 
the D-ring clockwise, and press the D-ring flat against the 
back of the device.

5 Hold .
6 Select Setup > System > Battery Type.
7 Select Alkaline, Lithium, NiMH, or Precharged NiMH.

NOTICE
To prevent corrosion, remove the batteries from the battery pack 
when not in use, and store the battery pack in a dry location.

Device Care
NOTICE

Do not store the device where prolonged exposure to extreme 
temperatures can occur, because it can cause permanent 
damage.
Never use a hard or sharp object to operate the touchscreen, or 
damage may result.
Avoid chemical cleaners, solvents, sunscreen, and insect 
repellents that can damage plastic components and finishes.
Secure the weather cap tightly to prevent damage to the USB 
port.
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3.  Helyezzük be a három ceruzaelemet ügyelve a polaritásukra, majd zárjuk 
vissza az elemtartót.

2 Select an option:
• To reset data specific to a trip, such as distance and 

averages, select Reset Trip Data.
• To delete all saved waypoints, select Delete All 

Waypoints.
• To clear the data recorded since you started your current 

activity, select Clear Current Activity.
NOTE: The device continues to record new data for the 
current activity.

• To reset only the settings for your current activity profile to 
the factory default values, select Reset Profile Settings.

• To reset all device settings and profiles to the factory 
default values, select Reset All Settings.
NOTE: Resetting all settings clears all geocaching activity 
from your device. It does not remove your saved user 
data, such as tracks and waypoints.

• To remove all saved user data and reset all settings on 
the device to the factory default values, select Delete All.
NOTE: Deleting all settings removes your personal data, 
history, and saved user data, including tracks and 
waypoints.

Restoring Default Page Settings
1 Open a page for which you will restore the settings.
2 Select  > Restore Defaults.

Device Information
Product Updates
On your computer, install Garmin Express (www.garmin.com
/express). On your smartphone, you can install the Garmin 
Explore app to upload your waypoints, routes, tracks, and 
activities.
Garmin Express provides easy access to these services for 
Garmin devices:
• Software updates
• Map updates
• Product registration

Setting Up Garmin Express
1 Connect the device to your computer using a USB cable.
2 Go to garmin.com/express.
3 Follow the on-screen instructions.

Getting More Information
You can find more information about this product on the Garmin 
website.
• Go to support.garmin.com for additional manuals, articles, 

and software updates.
• Go to buy.garmin.com, or contact your Garmin dealer for 

information about optional accessories and replacement 
parts.

Viewing E-label Regulatory and Compliance 
Information
The label for this device is provided electronically. The e-label 
may provide regulatory information, such as identification 
numbers provided by the FCC or regional compliance markings, 
as well as applicable product and licensing information.
1 Select Setup.
2 Select About.

Installing AA Batteries
Instead of the included lithium-ion battery pack (Installing the 
Lithium-ion Battery, page 1), you can use three AA batteries with 
an optional AA battery pack (not included). This is useful when 
you are on the trail and cannot charge the lithium-ion battery 
pack. Garmin recommends lithium AA batteries for best results.
NOTE: The optional AA battery pack is compatible with the 
Montana 700 device only.
1 Turn the D-ring counterclockwise to remove the lithium-ion 

battery pack from the Montana 700 device.
2 Slide the latch to open the AA battery pack.

3 Insert three AA batteries, observing polarity, and close the 
battery pack.

4 Insert the AA battery pack into the back of the device, turn 
the D-ring clockwise, and press the D-ring flat against the 
back of the device.

5 Hold .
6 Select Setup > System > Battery Type.
7 Select Alkaline, Lithium, NiMH, or Precharged NiMH.

NOTICE
To prevent corrosion, remove the batteries from the battery pack 
when not in use, and store the battery pack in a dry location.

Device Care
NOTICE

Do not store the device where prolonged exposure to extreme 
temperatures can occur, because it can cause permanent 
damage.
Never use a hard or sharp object to operate the touchscreen, or 
damage may result.
Avoid chemical cleaners, solvents, sunscreen, and insect 
repellents that can damage plastic components and finishes.
Secure the weather cap tightly to prevent damage to the USB 
port.
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4.  Helyezzük vissza az elemtartót a készülék hátoldalába, fordítsuk a D-gyű-
rűt az óra mutatóval megegyező irányba, majd nyomjuk rá a készülék hát-
oldalára, amíg laposan nem fekszik.

5.  Nyomjuk le hosszan a 

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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 pontot.
6.  Válasszuk a Beállítások > Rendszer > Akkumulátortíp. pontot.
7.  Válasszunk az Alkáli, Lítium, NiMH és Előre feltöltött NiMH lehetősé-

gek közül.

Megjegyzés!
A rozsdásodást megelőzendő vegyük ki a ceruzaelemeket az elemtartóból, 
amikor nem használjuk, és tároljuk a tartót száraz helyen.

Ápolás, tisztítás
Ne tároljuk olyan helyen a készüléket, ahol tartósan szélsőséges hőmérsék-
leti viszonyoknak van kitéve, mivel ez kárt tehet a készülékben.

Ne használjunk durva vagy éles tárgyakat az érintőképernyő kezeléséhez, 
különben károsíthatjuk azt.

Ne tegyük ki a készüléket kémiai tisztítószereknek, oldószereknek, naptej-
nek és rovarirtónak, mivel kárt tehetnek a készülék műanyag alkatrészeiben 
és külalakján.

A USB port károsodását megelőzendő ügyeljünk arra, hogy az USB port eső-
védő sapkája mindig szorosan a helyén legyen.

http://www.garmin.com/express
http://www.garmin.com/express
http://www.garmin.com/express
http://www.garmin.hu
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A külső antennatartó károsodását megelőzendő ügyeljünk arra, hogy a külső 
antennatartó esővédő sapkája mindig szorosan a helyén legyen.

Kerüljük az erős ütéseket és a durva kezelést, mivel ezzel csökkentjük a ké-
szülék üzemi élettartamát.

Készülék tisztítása
1.   Enyhén szappanos vízzel megnedvesített törlőruhával töröljük át a készü-

léket.
2.   Töröljük át szárazra.
Tisztítás után hagyjuk, hogy a készülék teljesen megszáradjon.

Érintőképernyő tisztítása
1.   Puha, tiszta, szöszmentes törlőkendőt használjunk.
2.   Ha szükséges, vízzel enyhén nedvesítsük meg a kendőt.
3.   Nedves kendő használata esetén kapcsoljuk ki a készüléket, húzzuk ki a 

töltőkábelt.
4.  Finoman töröljük át a kijelzőt.

Adatkezelés
MEGJEGYZÉS! A készülék nem kompatibilis a Windows 95 / 98 / Me, Win-
dows NT® verziókkal, valamint a Mac OS 10.3-as és korábbi verziókkal.

Ismert fájlformátumok
A készülék az alábbi fájlformátumokat támogatja:

• Garmin Explore-ról származó fájlok.
• GPX útvonal, pálya és útpont fájlok.
• GPX geoláda helyeket tartalmazó fájlok (Geoláda-helyek letöltése szá-

mítógép használatával, 16. oldal).
• JPEG képfájlok.
• A Garmin POI Loaderrel letöltött GPI saját érdekes hely (POI) adatbázis 

fájlok (további információk: www.garmin.com/products/poiloader).
• FIT fáljok az edzési tevékenységek Garmin Connectre történő feltölté-

séhez.

Memóriakártya behelyezése
 Vigyázat!

Ne használjunk éles tárgyat az elemek kivételéhez.
A készülék tárhelyének kiegészítéséhez, illetve előre feltöltött térképi adat-
bázisok hozzáadásához a készülékbe maximum 32GB tárhellyel rendelkező 
microSD memóriakártyát telepíthetünk.
1.  Forgassuk el D-gyűrűt az óramutató járásával ellentétes irányba, majd 

húzzuk fel az akkumulátor eltávolításához.
2.  Csúsztassuk a kártyatartó tálcát  a 

Secure the weather cap tightly to prevent damage to the 
external antenna port.
Avoid extreme shock and harsh treatment, because it can 
degrade the life of the product.

Cleaning the Device
1 Wipe the device using a cloth dampened with a mild 

detergent solution.
2 Wipe it dry.
After cleaning, allow the device to dry completely.

Cleaning the Touchscreen
1 Use a soft, clean, lint-free cloth.
2 If necessary, lightly dampen the cloth with water.
3 If using a dampened cloth, turn off the device and disconnect 

the device from power.
4 Gently wipe the screen with the cloth.

Data Management
NOTE: The device is not compatible with Windows® 95, 98, Me, 
Windows NT®, and Mac® OS 10.3 and earlier.

File Types
The handheld device supports these file types:
• Files from Garmin Explore.
• GPX route, track, and waypoint files.
• GPX geocache files (Downloading Geocaches Using a 

Computer, page 16).
• JPEG photo files.
• GPI custom POI files from the Garmin POI Loader. Go to 

www.garmin.com/products/poiloader.
• FIT files for exporting to Garmin Connect.

Installing a Memory Card

 WARNING
Do not use a sharp object to remove user-replaceable batteries.

You can install a microSD memory card, up to 32 GB, in the 
handheld device for additional storage or pre-loaded maps.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

battery pack.
2 Slide the card holder  to  and lift up.
3 Place the memory card with the gold contacts facing down.

4 Close the card holder.
5 Slide the card holder to  to lock it.
6 Replace the battery pack.

Connecting the Device to Your Computer
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.

1 Pull up the weather cap from the USB port.
2 Plug the small end of the USB cable into the USB port on the 

device.
3 Plug the large end of the USB cable into a computer USB 

port.
Your device and memory card (optional) appear as 
removable drives in My Computer on Windows computers 
and as mounted volumes on Mac computers.

Transferring Files to Your Device
1 Connect the device to your computer.

On Windows computers, the device appears as a removable 
drive or a portable device, and the memory card may appear 
as a second removable drive. On Mac computers, the device 
and memory card appear as mounted volumes.
NOTE: Some computers with multiple network drives may not 
display device drives properly. See your operating system 
documentation to learn how to map the drive.

2 On your computer, open the file browser.
3 Select a file.
4 Select Edit > Copy.
5 Open the portable device, drive, or volume for the device or 

memory card.
6 Browse to a folder.
7 Select Edit > Paste.

The file appears in the list of files in the device memory or on 
the memory card.

Deleting Files
NOTICE

If you do not know the purpose of a file, do not delete it. Your 
device memory contains important system files that should not 
be deleted.

1 Open the Garmin drive or volume.
2 If necessary, open a folder or volume.
3 Select a file.
4 Press the Delete key on your keyboard.

NOTE: If you are using an Apple® computer, you must empty 
the Trash folder to completely remove the files.

Using Garmin Connect
1 Connect the device to your computer using the USB cable.
2 Go to connect.garmin.com.
3 Follow the on-screen instructions.

Disconnecting the USB Cable
If your device is connected to your computer as a removable 
drive or volume, you must safely disconnect your device from 
your computer to avoid data loss. If your device is connected to 
your Windows computer as a portable device, it is not necessary 
to safely disconnect the device.
1 Complete an action:

• For Windows computers, select the Safely Remove 
Hardware icon in the system tray, and select your device.

• For Apple computers, select the device, and select File > 
Eject.

2 Disconnect the cable from your computer.
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 állásba, majd emeljük fel.
3.  Helyezzük be a memóriakártyát úgy, hogy az aranyszínű érintkezőpontok 

lefelé irányuljanak.

Secure the weather cap tightly to prevent damage to the 
external antenna port.
Avoid extreme shock and harsh treatment, because it can 
degrade the life of the product.

Cleaning the Device
1 Wipe the device using a cloth dampened with a mild 

detergent solution.
2 Wipe it dry.
After cleaning, allow the device to dry completely.

Cleaning the Touchscreen
1 Use a soft, clean, lint-free cloth.
2 If necessary, lightly dampen the cloth with water.
3 If using a dampened cloth, turn off the device and disconnect 

the device from power.
4 Gently wipe the screen with the cloth.

Data Management
NOTE: The device is not compatible with Windows® 95, 98, Me, 
Windows NT®, and Mac® OS 10.3 and earlier.

File Types
The handheld device supports these file types:
• Files from Garmin Explore.
• GPX route, track, and waypoint files.
• GPX geocache files (Downloading Geocaches Using a 

Computer, page 16).
• JPEG photo files.
• GPI custom POI files from the Garmin POI Loader. Go to 

www.garmin.com/products/poiloader.
• FIT files for exporting to Garmin Connect.

Installing a Memory Card

 WARNING
Do not use a sharp object to remove user-replaceable batteries.

You can install a microSD memory card, up to 32 GB, in the 
handheld device for additional storage or pre-loaded maps.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

battery pack.
2 Slide the card holder  to  and lift up.
3 Place the memory card with the gold contacts facing down.

4 Close the card holder.
5 Slide the card holder to  to lock it.
6 Replace the battery pack.

Connecting the Device to Your Computer
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.

1 Pull up the weather cap from the USB port.
2 Plug the small end of the USB cable into the USB port on the 

device.
3 Plug the large end of the USB cable into a computer USB 

port.
Your device and memory card (optional) appear as 
removable drives in My Computer on Windows computers 
and as mounted volumes on Mac computers.

Transferring Files to Your Device
1 Connect the device to your computer.

On Windows computers, the device appears as a removable 
drive or a portable device, and the memory card may appear 
as a second removable drive. On Mac computers, the device 
and memory card appear as mounted volumes.
NOTE: Some computers with multiple network drives may not 
display device drives properly. See your operating system 
documentation to learn how to map the drive.

2 On your computer, open the file browser.
3 Select a file.
4 Select Edit > Copy.
5 Open the portable device, drive, or volume for the device or 

memory card.
6 Browse to a folder.
7 Select Edit > Paste.

The file appears in the list of files in the device memory or on 
the memory card.

Deleting Files
NOTICE

If you do not know the purpose of a file, do not delete it. Your 
device memory contains important system files that should not 
be deleted.

1 Open the Garmin drive or volume.
2 If necessary, open a folder or volume.
3 Select a file.
4 Press the Delete key on your keyboard.

NOTE: If you are using an Apple® computer, you must empty 
the Trash folder to completely remove the files.

Using Garmin Connect
1 Connect the device to your computer using the USB cable.
2 Go to connect.garmin.com.
3 Follow the on-screen instructions.

Disconnecting the USB Cable
If your device is connected to your computer as a removable 
drive or volume, you must safely disconnect your device from 
your computer to avoid data loss. If your device is connected to 
your Windows computer as a portable device, it is not necessary 
to safely disconnect the device.
1 Complete an action:

• For Windows computers, select the Safely Remove 
Hardware icon in the system tray, and select your device.

• For Apple computers, select the device, and select File > 
Eject.

2 Disconnect the cable from your computer.
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4.  Zárjuk vissza a kártyatartó tálcát.
5.  Csúsztassuk a kártyatartó tálcát a 

Secure the weather cap tightly to prevent damage to the 
external antenna port.
Avoid extreme shock and harsh treatment, because it can 
degrade the life of the product.

Cleaning the Device
1 Wipe the device using a cloth dampened with a mild 

detergent solution.
2 Wipe it dry.
After cleaning, allow the device to dry completely.

Cleaning the Touchscreen
1 Use a soft, clean, lint-free cloth.
2 If necessary, lightly dampen the cloth with water.
3 If using a dampened cloth, turn off the device and disconnect 

the device from power.
4 Gently wipe the screen with the cloth.

Data Management
NOTE: The device is not compatible with Windows® 95, 98, Me, 
Windows NT®, and Mac® OS 10.3 and earlier.

File Types
The handheld device supports these file types:
• Files from Garmin Explore.
• GPX route, track, and waypoint files.
• GPX geocache files (Downloading Geocaches Using a 

Computer, page 16).
• JPEG photo files.
• GPI custom POI files from the Garmin POI Loader. Go to 

www.garmin.com/products/poiloader.
• FIT files for exporting to Garmin Connect.

Installing a Memory Card

 WARNING
Do not use a sharp object to remove user-replaceable batteries.

You can install a microSD memory card, up to 32 GB, in the 
handheld device for additional storage or pre-loaded maps.
1 Turn the D-ring counter-clockwise, and pull up to remove the 

battery pack.
2 Slide the card holder  to  and lift up.
3 Place the memory card with the gold contacts facing down.

4 Close the card holder.
5 Slide the card holder to  to lock it.
6 Replace the battery pack.

Connecting the Device to Your Computer
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.

1 Pull up the weather cap from the USB port.
2 Plug the small end of the USB cable into the USB port on the 

device.
3 Plug the large end of the USB cable into a computer USB 

port.
Your device and memory card (optional) appear as 
removable drives in My Computer on Windows computers 
and as mounted volumes on Mac computers.

Transferring Files to Your Device
1 Connect the device to your computer.

On Windows computers, the device appears as a removable 
drive or a portable device, and the memory card may appear 
as a second removable drive. On Mac computers, the device 
and memory card appear as mounted volumes.
NOTE: Some computers with multiple network drives may not 
display device drives properly. See your operating system 
documentation to learn how to map the drive.

2 On your computer, open the file browser.
3 Select a file.
4 Select Edit > Copy.
5 Open the portable device, drive, or volume for the device or 

memory card.
6 Browse to a folder.
7 Select Edit > Paste.

The file appears in the list of files in the device memory or on 
the memory card.

Deleting Files
NOTICE

If you do not know the purpose of a file, do not delete it. Your 
device memory contains important system files that should not 
be deleted.

1 Open the Garmin drive or volume.
2 If necessary, open a folder or volume.
3 Select a file.
4 Press the Delete key on your keyboard.

NOTE: If you are using an Apple® computer, you must empty 
the Trash folder to completely remove the files.

Using Garmin Connect
1 Connect the device to your computer using the USB cable.
2 Go to connect.garmin.com.
3 Follow the on-screen instructions.

Disconnecting the USB Cable
If your device is connected to your computer as a removable 
drive or volume, you must safely disconnect your device from 
your computer to avoid data loss. If your device is connected to 
your Windows computer as a portable device, it is not necessary 
to safely disconnect the device.
1 Complete an action:

• For Windows computers, select the Safely Remove 
Hardware icon in the system tray, and select your device.

• For Apple computers, select the device, and select File > 
Eject.

2 Disconnect the cable from your computer.

Device Information 23

 állásba a lezárásához.
6.  Helyezzük vissza az akkumulátort.

Készülék csatlakoztatása számítógéphez
Figyelem!

A rozsdásodást megelőzendő töltés vagy számítógéphez történő csatlakoz-
tatás előtt alaposan szárítsuk meg az USB portot, az esővédő sapkát, és a 
környező felületet.

1.   A készüléken hajtsuk fel az USB portról az esővédő gumisapkát.
2.   Helyezzük az USB-kábel kisebbik végét az USB portba.
3.   Csatlakoztassuk az USB-kábel nagyobbik végét a számítógép USB-

portjához.
 A készülék és a memóriakártya (amennyiben be van helyezve) a Win-

dows operációs rendszer Sajátgép (Számítógép) ablakában mint cserél-
hető háttértárak jelennek meg, valamint külső kötetként Macintosh számí-
tógépen.

Fájlok letöltése számítógépről a készülékre
1. Csatlakoztatnunk kell a készüléket a számítógéphez. 
 A készülék és a memóriakártya (amennyiben be van helyezve) a Win-

dows operációs rendszer Sajátgép (Számítógép) ablakában mint cserél-
hető háttértárak jelennek meg, valamint külső kötetként Macintosh számí-
tógépen.

 NE FELEDJÜK! Számos hálózati meghajtóval rendelkező számító-
gépeken előfordulhat, hogy nem marad betűjel a háttértár meghajtók 
megjelenítéséhez. Az operációs rendszer súgójában találunk megol-
dást.

2.   A számítógépen nyissuk meg az intézőt, és keressük meg a fájlt.
3.  Jelöljük ki a fájlt.
4.   Kattintsunk a Szerkesztés > Másolás menüpontra a számítógépen.
5.   Nyissuk meg a készülék memóriájának vagy a memóriakártya tartalmát 

jelölő mobil eszközt, meghajtót, kötetet.
6. Keressük ki a kívánt mappát.
7.   Kattintsunk a Szerkesztés > Beillesztés menüpontra a számítógépen.
 A fájl megjelenik a memóriakártyán vagy a készülék memóriáján belül ta-

lálható mappa fájljait mutató listában.

Fájlok törlése
Megjegyzés!

Amennyiben nem ismerjük a fájl funkcióját, ne töröljük azt. A készülék memó-
riája fontos rendszerfájlokat tartalmaz, melyeket tilos törölni.

1.   Nyissuk meg a „Garmin” vagy a memóriakártya meghajtót, kötetet.
2.   Amennyiben szükséges, nyissuk meg a fájlt tartalmazó mappát.
3.   Jelöljük ki a fájl(oka)t.
4.   A számítógép billentyűzetén nyomjuk le a Delete gombot.
 FIGYELEM! Amennyiben Apple számítógépet használunk, a fájlok végle-

ges törléséhez ürítenünk kell a Kuka mappát.

Garmin Connect használata
1.  Csatlakoztassuk a készüléket a számítógéppel az USB kábel segítségé-

vel.
2.  Lépjünk fel a connect.garmin.com oldalra.
3.  Kövessük a képernyőn megjelenő utasításokat.

USB-kapcsolat bontása
Amennyiben az eszköz cserélhető háttértárként vagy kötetként van csatla-
koztatva, az adatvesztés elkerülése érdekében az alábbi biztonsági protokoll 
szerint bontsuk a kapcsolatot. Amennyiben a készülék Windows számítógép-
hez mobil eszközként került csatlakoztatásra, erre nincs szükség.
1.   Válasszunk az alábbi műveletek között:
 •    Windows számítógépen kattintsunk a tálcán a Hardver biztonságos 

eltávolítása ikonra és válasszuk ki a készülékünket.
 •    Macintosh számítógépen válasszuk ki a készüléket, majd válasszuk a 

Fájl > Eltávolít pontokat.
2.   Húzzuk ki az USB-kábelt a számítógép USB-portjából.

http://www.garmin.com/products/poiloader
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Műszaki adatok
Montana 700i/750i  
akkumulátor típusa

Újratölthető lítium-ion akkumulátor

Montana 700 Újratölthető lítium-ion akkumulátor, vagy há-
rom darab AA ceruzaelem (-akku) (NiMH, al-
káli vagy lítium). A lítium javasolt.
MEGJEGYZÉS! Az opcionális elemtartó kü-
lön megvásárolható.

Akkumulátorról biztosított 
működési idő

Max. 18 óra GPS üzemmódban.
Max. 2 hét expedíciós üzemmódban.

Vízállóság A készülék IEC 60529 IPX7* besorolással 
vízhatlan.

Működési hőmérsékleti 
tartomány

-20° ~ +60°C

Akkumulátortöltés  
hőmérsékleti tartománya

0 ~ 45°C

Iránytű biztonsági  
távolság

60 mm

Vezeték nélküli  
frekvenciák

2.4 GHz @ 16.91 dBm névleges
1.6 GHz @ 31.7 dBm névleges

*  A készülék vízzel való véletlenszerű érintkezés esetén 1 m-ig vízhatlan ma-
rad. További információkért lásd a www.garmin.hu/vizallo weboldalt.

Függelék
Adatmezők
Egyes adattípusok megjelenítéséhez vezeték nélküli kapcsolattal működő ki-
egészítő vagy aktív navigáció szükséges.
24 órás max. hőmérs.: Az utolsó 24 órában mért legnagyobb hőmérséklet.
24 órás min. hőmérs.: Az utolsó 24 órában mért legkisebb hőmérséklet.
A GPS pontossága: Az a terület, melyen belül a meghatározott pozíció már 

nem pontosítható. Pl. pozíciónk egy 3.65 méteres körben határozható 
meg.

Akkumulátor szintje: Akkumulátor aktuális töltöttségi szintje.
Állásidő: Az utolsó nullázás óta az álló helyzetben eltelt összesített idő.
Átl. HR%Max: Az aktuális tevékenység átlagos pulzusszáma a maximális 

pulzusszám százalékaként kifejezve.
Átlag emelkedés: Az utolsó nullázás óta az átlagos függőleges emelkedé-

si távolság.
Átlag köridő: Az aktuális tevékenység átlagos körideje.
Átlag süllyedés: Az utolsó nullázás óta az átlagos függőleges ereszkedé-

si távolság.
Átlagos pedálütem: Kerékpározás. Az aktuális tevékenység eddig mért pe-

dálütem átlagértéke.
Átl. pulzusszám: Az aktuális tevékenység átlagos pulzusszáma.
Autós forduló: Az útvonalon a következő forduló iránya. Az adat megjelení-

téséhez navigáció szükséges.
Barométer: A kalibrált aktuális barometrikus nyomás.
Célpont távolsága: Távolság a végcélig. Navigáció alatt jelenik csak meg 

az adat.
Cél pozíció: A végcél pozíciója. Aktív navigáció esetén jelenik meg.
Cél útpont: Az utolsó útpont a célpontig (navigáció során jelenik meg).
Dátum: Az aktuális nap, hónap, év.
Eltelt tevékenységi idő: A rögzített teljes időtartam. Pl. amennyiben elindít-

juk a számlálót és 10 percen át futunk, majd 5 percre leállítjuk a számlá-
lót, majd újraindítjuk és futunk 20 percet, az eltelt idő 35 perc.

Érkezési idő a célhoz: Célba érkezés becsült pontos ideje (a cél helyi ideje 
szerint). Navigáció alatt jelenik csak meg az adat.

Érkezési idő a köv. útponthoz: Következő útponthoz való érkezés becsült 
pontos ideje (a cél helyi ideje szerint). Navigáció alatt jelenik csak meg 
az adat.

Fokozat: Az emelkedés és a lefutott távolság aránya, vagyis az emelkedési 
szög: ha 20 méter távon 1 métert emelkedünk, akkor 5%.

Földf.től mért magasság: Jelenlegi pozíciónk talajszint feletti magassága.
Forduló: Fokban kifejezve az aktuális célirány és a pálya irány közötti kü-

lönbség. L jelenti a bal, R a jobb oldalra történő fordulást. Aktív navigáció 
mellett jelenik meg.

Függőleges sebesség: Ereszkedés, emelkedés idő szerinti üteme.
Függőleges sebesség a célig: Ereszkedés, emelkedés üteme egy adott 

magasságra vonatkoztatva. Aktív navigáció mellett jelenik meg.
Függőleges táv a célig: Pillanatnyi pozíciónk és a végcél közötti magasság-

különbség. Aktív navigáció mellett jelenik meg.
Függőleges távolság a köv.-ig: Pillanatnyi pozíciónk és a következő útpont 

közötti magasságkülönbség. Aktív navigáció mellett jelenik meg.
GPS-irány: A GPS-pozíció által számított haladási irány.
GPS jelerősség: A műholdas jelek vételi stabilitása.
GPS magasság: Aktuális pozíciónk magassága a GPS-pozíciómeghatározás 

alapján.
Hőmérséklet: A levegő hőmérséklete. Testhőmérsékletünk befolyásolhatja 

a hőfokmérőt. Az adat megjelenítéséhez a készüléket tempe hőfokmérő-
vel kell csatlakoztatni.

Idő a célig: A cél eléréséig becsült hátralévő időtartam. Aktív navigáció mel-
lett jelenik meg.

Idő a következő pontig: Az útvonalon vagy pályán következő pont eléréséig 
szükséges becsült idő. Aktív navigáció mellett jelenik meg.

Irány: Aktuális haladási irányunk.
Irányba: A kiindulási pontot és a célt összekötő egyenes vonal iránya. Az 

adat megjelenítéséhez navigáció szükséges.
Iránytűs haladási irány: Az iránytű szerinti haladási irányunk.
Jelenlegi kör: Az aktuális kör stopperideje.
Kalóriaszám: Az elégetett kalória összmennyisége.
Kör emelkedése: Az aktuális kör során mért emelkedés függőleges távol-

sága.
Körök: Az aktuális tevékenység során befejezett körök száma.
Kör pedálüteme: Az aktuális kör átlagos pedálüteme.
Kör pulzusszáma: Aktuális kör átlagos pulzusszáma.
Kör pulzusszáma (%): Az adott körben a maximális pulzusszám százaléka-

ként kifejezett pulzusszám átlagértéke.
Körsebesség: Az aktuális kör átlagsebessége.
Kör süllyedése: Az aktuális kör során mért ereszkedés függőleges távol-

sága.
Körtávolság: Az aktuális körön megtett távolság.
Körny. nyomás: A kalibrálás nélküli környezeti nyomás.
Következő útpont: Az útvonalon a következő útpont (navigáció során).
Kurzor: A következő útpont vagy forduló irányát jelző mutató. Aktív navigá-

ció mellett jelenik meg.
Legkisebb magasság: Az utolsó nullázás óta elért legkisebb magasság.
Legnagyobb magasság: Az utolsó nullázás óta elért legnagyobb magas-

ság.
Letérés: Az a távolság, mellyel balra vagy jobbra letértünk az eredeti útvo-

nalról. Aktív navigáció mellett jelenik meg.
Magasság: Aktuális pozíciónk tengerszint feletti vagy alatti magassága.
Max. emelkedés: Az utolsó nullázás óta a legnagyobb emelkedési ütem láb/

perc vagy méter/perc szerint.

http://www.garmin.hu/vizallo


25

Maximális sebesség: Az utolsó nullázás óta mért legnagyobb sebesség.
Max. süllyedés: Az utolsó nullázás óta a legnagyobb süllyedés ütem láb/

perc vagy méter/perc szerint.
Mozgás átlagsebessége: Az utolsó nullázás óta a mozgás során mért se-

besség átlagértéke.
Mozgásban eltelt idő: Az utolsó nullázás óta a mozgás közben eltelt összidő.
Napkelte: A napkelte GPS pozíciónkban jellemző időpontja.
Napnyugta: A naplemente GPS pozíciónkban jellemző időpontja.
Pálya: A kiindulási pontot és a célt összekötő egyenes vonal iránya. Ez az 

útirány mint tervezett vagy kijelölt útvonal tekinthető (csak navigáció mel-
lett jelenik meg).

Pályához: Ezt az irányt követve viszszatérünk az útvonalhoz. Aktív navigá-
ció mellett jelenik meg.

Pedálütem (kerékpározás): A pedálkar fordulatszáma, vagyis a pedálkar ál-
tal egy perc alatt megtett teljes körök száma. Kerékpáros pedálütemmérő 
csatlakoztatása szükséges a méréséhez.

Pontos idő: Időbeállításoknak (időzóna, nyári időszámítás stb.) megfelelő 
pontos idő.

Pozíció (lat./lon.): Pillanatnyi pozíciónk hoszszúsági és szélességi koordi-
náta szerint, függetlenül a kiválasztott helyformátumtól.

Pozíció (kiválasztott): Pillanatnyi pozíciónk a kiválasztott helyformátum 
szerint.

Pulzusszám: A pulzusszám szívdobbanás/perc szerint (bpm). Kompatibilis 
pulzusmérő csatlakoztatása szükséges.

Pulzusszám - % Max: Az aktuális pulzusszám a maximális pulzusszám szá-
zalékértékeként.

Pulzustartomány: Az aktuális pulzustartomány (1-5). Alapértelmezés a 
tartományoka felhasználói profil és a maximális pulzusszám (220 mínusz 
a korunk) szerint kerülnek meghatározásra.

Riasztási időzítő: A visszaszámláló időzítő aktuális ideje.
Sebesség: Az aktuális haladási sebesség.
Sebességkorlát: Az adott útszakaszra betáplált sebességhatár. Nem mind-

egyik térkép tartalmazza, nem minden útra vonatkozóan ismert. Az út 
mellett kihelyezett útjelző táblák, feliratok mindig elsőbbséget élveznek.

Semmi: Ez egy üres adatmező.
Siklásarány: A vízszintesen és a függőlegesen megtett távolságaránya.
Siklásarány célig: A vízszintes és a függőleges távolság arány, amely a cél-

ként kitűzött magasság eléréséhez szükséges (csak navigáció mellett je-
lenik meg).

Stopperidőzítő: Az aktuális tevékenység stopperideje.
Teljes kör.: Az összes befejezett kör stopperideje.
Távolság a következőig: Az útvonalon a következő útpontig hátralevő távol-

ság (navigáció során jelenik meg).
Teljes emelkedés: A tevékenység során vagy az utolsó nullázás óta a teljes 

emelkedési távolság.
Teljes süllyedés: A tevékenység során vagy az utolsó nullázás óta a teljes 

ereszkedési távolság.
Teljes út átlagsebesség: Az utolsó nullázás óta a mozgó és álló helyzetben 

együttesen mért sebesség átlagértéke.
Tevékenység távolság: Az aktuális nyomvonal mentén megtett távolság.
Utazási idő: Az utolsó nullázás óta mozgásban és állva töltött összesített 

idő.
Utazási kilométerszámláló: Az utolsó nullázás óta megtett összesített tá-

volság.
Útmérő: A teljes eddig megtett távolság. A túraadatok törlésekor nem nul-

lázódik.

Utolsó kör emelkedés: Az utolsó befejezett kör során mért emelkedés füg-
gőleges távolsága.

Utolsó köridő: Az utolsó befejezett kör stopperideje.
Utolsó kör pedálütem: Az utoljára befejezett kör átlagos pedálüteme.
Utolsó kör pulzussz.: Az utoljára befejezett kör átlagos pulzusszáma.
Utolsó kör sebessége: Az utoljára befejezett kör átlagsebessége.
Utolsó kör süllyedés: Az utolsó befejezett kör során mért süllyedés függő-

leges távolsága.
Utolsó kör távolság: Az utolsó körön (szakaszon) megtett táv.
Velocity made good: A sebesség, amellyel közelítjük a célt a pálya mentén. 

Navigáció mellett jelenik meg.
Víz hőmérséklete: Vízhőfok. NMEA 0183® kompatibilis, a vízhőfok mérésé-

re alkalmas mélységmérőhöz történő csatlakoztatás szükséges.
Vízmélység: Vízmélység. NMEA 0183® kompatibilis vízmélységmérőhöz 

történő csatlakoztatás szükséges.

Külön megvásárolható opcionális kiegészítők
Opcionális kiegészítőket – tartókat, pántokat, térképeke, fitnesz kiegészítő-
ket és cserealkatrészeket – a Garmin ügyfélszolgálaton találhatunk.

tempe™ hőfokmérő
A tempe egy ANT+ vezeték nélküli hőfokmérő. A mérőt pánttal, kábelkötöző-
vel rögzíthetjük egy helyen, ahol külső levegő éri, és így pontos hőmérsékle-
ti adatokat kapunk. A hőmérsékleti adatok fogadásához először párosítanunk 
kell a mérőt és a készüléket.

Tippek az ANT+ kiegészítő párosításához
• Ellenőrizzük, hogy az ANT+ kiegészítő kompatibilis legyen a Garmin ké-

szülékkel.
• Párosítás előtt minden egyéb ANT+ mérőt vigyünk 10 méternél távolabb.
• Az készüléket vigyük az ANT+ mérőhöz 3 méteres távolságon belül.
• Párosítást követően a készülék már automatikusan felismeri az ANT+ ki-

egészítőt, amint az működésbe lép. Amennyiben a készülékek megfele-
lően működnek, ez a művelet automatikusan zajlik, ahogy bekapcsoljuk a 
készüléket, és aktiváljuk a mérőt (elkezdünk pedálozni vagy felhelyeztük 
mellkasunkra a szívritmusmérőt).

• Párosítást követően a készülék már csakis a párosított mérőtől fogad el 
adatokat, nyugodtan közel mehetünk más mérőkhöz.

Hibaelhárítás
Energiatakarékos használat
Az alábbiakkal megnövelhetjük az akkumulátor által biztosított működési időt.

• Kapcsoljuk ki a képernyőt (Ki-/bekapcsoló gomb, 2. oldal)
• Csökkentsük a háttérvilágítás fényerejét (Háttérvilágítás fényerejének ál-

lítása, 2. oldal).
• Csökkentsük a háttérvilágítás késleltetési idejét (Kijelző beállítások, 19. ol-

dal).
• Csökkentsük a zseblámpa fényerejét vagy a villogási frekvenciát (Zseb-

lámpa funkció, 15. oldal).
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• Használjuk az energiatakarékos módot (Energiatakarékos használat, 25. 
oldal).

• Használjuk az expedíció módot (Expedíció mód bekapcsolása, 20. oldal).
• Kapcsoljuk ki a vezeték nélküli kapcsolatot (Wi-Fi kapcsolat beállítása, 

8. oldal).
• Kapcsoljuk ki a Bluetooth® technológiát (Bluetooth beállítások, 19. oldal).
• Kapcsoljuk ki a további műholdas rendszereket (Tudnivalók a GPS és 

egyéb műholdas rendszerek beállításairól, 19. oldal).

Újraindítás lefagyás esetén
Amennyiben a készülék gombnyomásra, érintésre nem reagál, az alábbiak 
szerint indíthatjuk újra. A művelettel semmilyen beállítás, saját adat nem tör-
lődik.
1.  Vegyük ki az akkumulátort.
2.  Helyezzük vissza az akkumulátort
3.  Nyomjuk le hosszan a 

Introduction
 WARNING

See the Important Safety and Product Information guide in the 
product box for product warnings and other important 
information.

Device Overviews
Montana 700i/750i Device Overview

Iridium® and GNSS antenna

SOS button

Camera lens (Montana 750i only)

Flashlight
Camera flash (Montana 750i only)
Power button

microSD® card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

External Iridium and GNSS antenna port (under weather cap)

Montana 700 Device Overview

GNSS antenna

Flashlight

Power button

microSD card slot (under battery pack)

Battery pack D-ring

Micro-USB port (under weather cap)

Status LED
The status LED  indicates the device status.

LED Activity Status
Double flashing green You have an unread inReach® message.
Flashing green The device is in expedition mode.
Flashing red An inReach message failed to send.

The device is below 10-percent battery 
power.

Alternating red and green 
flashes

The device is in SOS mode.

Installing the Lithium-ion Battery
1 Locate the Lithium-ion battery pack included in the product 

box.
2 Verify the gasket and battery compartment are free of debris.
3 Insert the battery pack into the back of the device.

4 Turn the D-ring clockwise to secure the battery pack onto the 
device.

5 Press the D-ring flat against the back of the device.
You should leave the battery installed in the device to keep 
moisture and debris away from the battery contacts and 
microSD card slot.

Charging the Battery Pack
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather 
cap, and the surrounding area before charging or connecting to 
a computer.
Do not attempt to use the device to charge a battery that was 
not provided by Garmin®. Attempting to charge a battery that 
was not provided by Garmin can damage the device and void 
the warranty.

Before you can connect the USB cable to your device, you may 
need to remove optional mount accessories.
NOTE: The device does not charge when outside the approved 
temperature range (Specifications, page 24).
You can charge the battery using a standard wall outlet or a 
USB port on your computer.
1 Pull up the weather cap  from the USB port .
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A menürendszer nem a kívánt nyelven jelenik meg
Amennyiben véletlenül nem a megfelelő nyelvet választottuk ki, megváltoz-
tathatjuk a készülék nyelvét.
1.  Válasszuk a 

• Use battery save mode (Turning On Battery Save Mode, 
page 19).

• Use expedition mode (Turning On Expedition Mode, 
page 20).

• Turn off wireless connectivity (Wi‑Fi Settings, page 20).
• Turn off Bluetooth technology (Bluetooth Settings, page 19).
• Turn off additional satellite systems (GPS and Other Satellite 

Systems, page 19).

Restarting the Device
If the device stops responding, you may need to restart it. This 
does not erase any of your data or settings.
1 Remove the batteries.
2 Reinstall the batteries.
3 Hold .

My device is in the wrong language
You can change the device language selection if you have 
accidently selected the wrong language on the device.
1 Select .
2 Select .
3 Select .
4 Select the second item in the list.
5 Select the first item in the list.
6 Select your language.

About Heart Rate Zones
Many athletes use heart rate zones to measure and increase 
their cardiovascular strength and improve their level of fitness. A 
heart rate zone is a set range of heartbeats per minute. The five 
commonly accepted heart rate zones are numbered from 1 to 5 
according to increasing intensity. Generally, heart rate zones are 
calculated based on percentages of your maximum heart rate.

Fitness Goals
Knowing your heart rate zones can help you measure and 
improve your fitness by understanding and applying these 
principles.
• Your heart rate is a good measure of exercise intensity.
• Training in certain heart rate zones can help you improve 

cardiovascular capacity and strength.
If you know your maximum heart rate, you can use the table 
(Heart Rate Zone Calculations, page 26) to determine the best 
heart rate zone for your fitness objectives.
If you do not know your maximum heart rate, use one of the 
calculators available on the Internet. Some gyms and health 
centers can provide a test that measures maximum heart rate. 
The default maximum heart rate is 220 minus your age.

Heart Rate Zone Calculations
Zone % of 

Maximum 
Heart Rate

Perceived Exertion Benefits

1 50–60% Relaxed, easy pace, 
rhythmic breathing

Beginning-level 
aerobic training, 
reduces stress

2 60–70% Comfortable pace, 
slightly deeper 
breathing, conversation 
possible

Basic cardiovascular 
training, good 
recovery pace

3 70–80% Moderate pace, more 
difficult to hold 
conversation

Improved aerobic 
capacity, optimal 
cardiovascular training

Zone % of 
Maximum 
Heart Rate

Perceived Exertion Benefits

4 80–90% Fast pace and a bit 
uncomfortable, breathing 
forceful

Improved anaerobic 
capacity and 
threshold, improved 
speed

5 90–100% Sprinting pace, 
unsustainable for long 
period of time, labored 
breathing

Anaerobic and 
muscular endurance, 
increased power
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4.  Válasszuk ki a listából a második elemet.
5.  Válasszuk ki a listából az első elemet.
6.  Válasszuk ki a kívánt nyelvet.

Tudnivalók a pulzustartományokról
Sok atléta használja a pulzustartományokat szív- és érrendszerének erőssé-
gi mérésére, valamint kondíciójának javítására. A pulzustartomány a percen-
kénti szívdobbanásokban meghatározott értéktartomány. A leggyakrabban
alkalmazott öt tartományt 1-5-ig számozzák, ahol nagyobb szám nagyobb in-
tenzitást jelez. A tartományok általában legnagyobb pulzusszámunk százalé-
kában kerülnek meghatározásra.

Edzési célok
Ismerve a pulzustartományunkat, mér hetjük és javíthatjuk kondí ciónkat a kö-
vetkező elvek szerint:
•   Pulzusunk jól jellemzi az edzés intenzitását.
•   Adott pulzustartományban dolgozva javíthatjuk szív- és érrendszerünk 

terhelhetőségét és erejét.
Amennyiben ismerjük maximális pulzusszámunkat, a táblázat (Pulzustarto-
mány kiosztási táblázat, 26. oldal) segítségével meghatározhatjuk az edzési 
céljaink elérését szolgáló legjobb pulzustartományokat.
Ha nem ismerjük maximális pulzusszámunkat, alkalmazzuk az interneten 
fellelhető valamelyik kal kulátor prog ra mot. Egyes edzőtermekben és egész-
ségközpontokban lehetőség van a maximális pulzusszám megállapítására 
szolgáló erőnléti felmérés elvégzésére. Hüvelykujj-szabályként 220-ból ki-
vonjuk korunkat, és megkapjuk a maximális pulzusszámot.

Pulzustartomány kiosztási táblázat

Zóna Maximális  
pulzus %-a

Érzékelhető  
igénybevétel Eredmény

1 50%–60% Nyugodt, könnyű tempó; 
ütemes légzés

Szabályzott légzést 
igénylő edzés kezdő 
szintje; stressz csökkentő 

2 60%–70%
Kényelmes tempó; eny-
hén mélyebb légzés, 
társalgás lehetséges

Alap szív- és érrendsze-
ri edzés; jó bemelegítési, 
rekreációs tempó

3 70%–80%
Mérsékelt temó; társal-
gás nehezebben foly-
tatható

Fokozott légzőrendszeri 
terhelés; optimális szív-
rendszeri edzés

4 80%–90%
A tempó gyors és kicsit 
kényelmetlen; erőteljes 
légzés

Fokozott légzőrendszeri 
terhelés, fokozott sebes-
ség

5 90%–100%
A tempó sprintre vált, 
hosszú ideig nem tart-
ható; nehéz légzés

Levegővétel ritkul, nagy 
izomzati megerőltetés, 
nagyfokú energiafel-
emésztés

Garmin ügyfélszolgálat
Amennyiben bármilyen probléma lépne fel a készülék használata során, 
vagy kérdése volna, kérjük hívja a Navi-Gate Kft. ügyfélszolgálatát a 06-
1-801-2830-as telefonszámon, vagy küldjön levelet a support@garmin.hu 
email címre.
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